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About This Guide

The following topics explain how to use this guide.

* Document Objectives, on page xlix

* Related Documentation, on page xlix

* Document Conventions, on page xlix

» Communications, Services, and Additional Information, on page li

Document Objectives

The purpose of this guide is to help you configure general operations for the Cisco ASA series using the
Adaptive Security Device Manager (ASDM). This guide does not cover every feature, but describes only the
most common configuration scenarios.

Throughout this guide, the term “ASA” applies generically to supported models, unless specified otherwise.

Note ASDM supports many ASA versions. The ASDM documentation and online help includes all of the latest
features supported by the ASA. If you are running an older version of ASA software, the documentation might
include features that are not supported in your version. Please refer to the feature history table for each chapter
to determine when features were added. For the minimum supported version of ASDM for each ASA version,
see Cisco ASA Series Compatibility.

Related Documentation

For more information, see Navigating the Cisco ASA Series Documentation at http://www.cisco.com/go/asadocs.

Document Conventions

This document adheres to the following text, display, and alert conventions.
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Text Conventions

About This Guide |

Convention Indication
boldface Commands, keywords, button labels, field names, and user-entered text appear
in boldface. For menu-based commands, the full path to the command is shown.
italic Variables, for which you supply values, are presented in an italic typeface.
Italic type is also used for document titles, and for general emphasis.
monospace Terminal sessions and information that the system displays appear inmonospace
type.
{x|y|z} Required alternative keywords are grouped in braces and separated by vertical
bars.
[ Elements in square brackets are optional.
[x]y]z] Optional alternative keywords are grouped in square brackets and separated by
vertical bars.
[1] Default responses to system prompts are also in square brackets.
<> Non-printing characters such as passwords are in angle brackets.
L# An exclamation point (!) or a number sign (#) at the beginning of a line of code
indicates a comment line.
Reader Alerts

This document uses the following for reader alerts:

Means reader take note. Notes contain helpful suggestions or references to material not covered in the manual.

Means the following information will help you solve a problem.

Caution

Means reader be careful. In this situation, you might do something that could result in equipment damage or

loss of data.

Timesaver

Means the described action savestime. You can save time by performing the action described in the paragraph.
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A

Warning  Means reader be warned. In this situation, you might perform an action that could result in bodily
injury.

Communications, Services, and Additional Information

* To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.
* To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.
* To submit a service request, visit Cisco Support.

* To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit
Cisco Marketplace.

* To obtain general networking, training, and certification titles, visit Cisco Press.

* To find warranty information for a specific product or product family, access Cisco Warranty Finder.

Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system
that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides
you with detailed defect information about your products and software.
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PART I

Getting Started with the ASA

* Introduction to the Cisco ASA, on page 1

* Getting Started, on page 19

* ASDM Graphical User Interface, on page 55

* Licenses: Product Authorization Key Licensing, on page 93

* Licenses: Smart Software Licensing (ASAv, ASA on Firepower), on page 143
* Logical Devices for the Firepower 4100/9300, on page 189

* Transparent or Routed Firewall Mode, on page 205

* Startup Wizard, on page 231






CHAPTER 1

Introduction to the Cisco ASA

The Cisco ASA provides advanced stateful firewall and VPN concentrator functionality in one device as well
as integrated services with add-on modules. The ASA includes many advanced features, such as multiple
security contexts (similar to virtualized firewalls), clustering (combining multiple firewalls into a single
firewall), transparent (Layer 2) firewall or routed (Layer 3) firewall operation, advanced inspection engines,
IPsec VPN, SSL VPN, and clientless SSL. VPN support, and many more features.

\}

Note ASDM supports many ASA versions. The ASDM documentation and online help includes all of the latest
features supported by the ASA. If you are running an older version of ASA software, the documentation might
include features that are not supported in your version. Please refer to the feature history table for each chapter
to determine when features were added. For the minimum supported version of ASDM for each ASA version,
see Cisco ASA Compatibility. See also Special, Deprecated, and Legacy Services, on page 17.

* ASDM Requirements, on page 1

» Hardware and Software Compatibility, on page 4

* VPN Compatibility, on page 5

* New Features, on page 5

* Firewall Functional Overview, on page 12

* VPN Functional Overview, on page 16

* Security Context Overview, on page 16

* ASA Clustering Overview, on page 17

* Special, Deprecated, and Legacy Services, on page 17

ASDM Requirements

ASDM Java Requirements

You can install ASDM using Oracle JRE 8.0. OpenJRE is not supported.

\}

Note ASDM is not tested on Linux.
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[l AsDM Compatibility Notes

Table 1: ASA and ASA FirePOWER: ASDM Operating System and Browser Requirements

Operating System Browser Oracle JRE
Internet |Firefox |Safari | Chrome
Explorer
Microsoft Windows (English and Japanese): Yes Yes No Yes 8.0
10 support
8
7
Server 2012 R2
Server 2012
Server 2008
Apple OS X 10.4 and later No Yes Yes Yes (64-bit |8.0
support version
only)
ASDM Compatibility Notes
The following table lists compatibility caveats for ASDM.
Conditions Notes
Windows 10 "This app can't run on your PC" error message.

When you install the ASDM Launcher, Windows 10 might replace
the ASDM shortcut target with the Windows Scripting Host path,
which causes this error. To fix the shortcut target:

1. Choose Start > Cisco ASDM-IDM Launcher, and right-click
the Cisco ASDM-IDM Launcher application.

2. Choose More > Open file location.
Windows opens the directory with the shortcut icon.

3. Right click the shortcut icon, and choose Properties.

4. Change the Target to:
C:\Windows\System32\wscript.exe invisible.vbs run.bat

5. Click OK.

0S X On OS X, you may be prompted to install Java the first time you
run ASDM,; follow the prompts as necessary. ASDM will launch
after the installation completes.
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Conditions

Notes

OS X 10.8 and later

You need to allow ASDM to run because it is not signed with an
Apple Developer ID. If you do not change your security
preferences, you see an error screen.

b “Cisco ASDM-IDM” can't be opened
& b because it is from an unidentified
o F developer.

Your security preferences allow installation of only
apps from the Mac App Store and identified
developers.

1. To allow ASDM to run, right-click (or Ctrl-Click) the Cisco
ASDM-IDM Launcher icon, and choose Open.

4 Chess.app Mar 21, 2013 2:14 PM 1

A
2 Cisco Jabber.app
| Contacts.app

Show Package Contents

Move to Trash

1 of 62 selec
Get Info
Compress "Cisco ASDM-IDM.app”

Burn “Cisco ASDM-IDM.app” to Disc...
Duplicate

Make Alias

Quick Look “Cisco ASDM-IDM.app”
Share >

Copy "Cisco ASDM-1DM.app”

Show View Options

Label:
x| = .

ariosz

2. You see a similar error screen; however, you can open ASDM
from this screen. Click Open. The ASDM-IDM Launcher
opens.

™ “Cisco ASDM-IDM.app” is from an

4 } unidentified developer. Are you sure you
° want to open it?

Opening “Cisco ASDM-1DM.app” will always allow it
1o run on this Mac.

Google Chrome.app downloaded this file on
December 4, 2013 from 10.E6.118.3.

7 . Qpen st Cancel

371053
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Conditions

Notes

Requires Strong Encryption license
(3DES/AES) on ASA

Note Smart licensing models allow
initial access with ASDM
without the Strong Encryption

license.

ASDM requires an SSL connection to the ASA. You can request
a 3DES license from Cisco:

1. Go to www.cisco.com/go/license.
2. Click Continue to Product License Registration.

3. Inthe Licensing Portal, click Get Other Licenses next to the
text field.

4. Choose IPS, Crypto, Other... from the drop-down list.
5. Type ASA in to the Search by Keyword field.

6. Select Cisco ASA 3DES/AES License in the Product list,
and click Next.

7. Enter the serial number of the ASA, and follow the prompts
to request a 3DES/AES license for the ASA.

* Self-signed certificate or an untrusted
certificate

* [Pv6

* Firefox and Safari

When the ASA uses a self-signed certificate or an untrusted
certificate, Firefox and Safari are unable to add security exceptions
when browsing using HTTPS over IPv6. See
https://bugzilla.mozilla.org/show_bug.cgi?id=633001. This caveat
affects all SSL connections originating from Firefox or Safari to
the ASA (including ASDM connections). To avoid this caveat,
configure a proper certificate for the ASA that is issued by a
trusted certificate authority.

* SSL encryption on the ASA must
include both RC4-MDS5 and
RC4-SHAT or disable SSL false start
in Chrome.

e Chrome

If you change the SSL encryption on the ASA to exclude both
RC4-MDS5 and RC4-SHAI algorithms (these algorithms are
enabled by default), then Chrome cannot launch ASDM due to
the Chrome “SSL false start” feature. We suggest re-enabling one
of these algorithms (see the Configuration > Device
Management > Advanced > SSL Settings pane); or you can
disable SSL false start in Chrome using the
--disable-ssl-false-start flag according to Run Chromium with
flags.

IE9 for servers

For Internet Explorer 9.0 for servers, the “Do not save encrypted
pages to disk” option is enabled by default (See Tools > Internet
Options > Advanced). This option causes the initial ASDM
download to fail. Be sure to disable this option to allow ASDM
to download.

Hardware and Software Compatibility

For a complete list of supported hardware and software, see Cisco ASA Compatibility.
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VPN Compatibility

See Supported VPN Platforms, Cisco ASA Series.

New Features

This section lists new features for each release.

\}

Note New, changed, and deprecated syslog messages are listed in the syslog message guide.

New Features in ASA 9.8(4)

Released: April 24, 2019

Feature Description

VPN Features

Add subdomains to webVPN HSTS | Allows domain owners to submit what domains should be included in the HSTS preload list
for web browsers.

New/Modified screens:

Configuration > Remote Access VPN > Clientless SSL VPN Access > Advanced > Proxies
> Enable HSTS Subdomainsfield

Alsoin 9.12(1).

Administrative Features

Allow non-browser-based HTTPS | You can allow non-browser-based HTTPS clients to access HTTPS services on the ASA. By
clients to access the ASA default, ASDM, CSM, and REST API are allowed. Many specialty clients (for example, python
libraries, curl, and wget) do not support Cross-site request forgery (CSRF) token-based
authentication, so you need to specifically allow these clients to use the ASA basic
authentication method. For security purposes, you should only allow required clients.

New/Modified screens.

Configuration > Device Management > Management Access > HTTP Non-Browser Client
Support

Alsoin 9.12(1).
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. New Features in ASA 9.8(3)/ASDM 7.9(2.152)

Feature

Description

show tech-support includes
additional output

The output of the show tech-support is enhanced to display the output of the following:

« show ipv6 interface
« show aaa-server

« show fragment

New/Modified commands: show tech-support
Alsoin 9.12(1).

Support to enable and disable the
results for free memory and used
memory statistics during SNMP walk
operations

To avoid overutilization of CPU resources, you can enable and disable the query of free
memory and used memory statistics collected through SNMP walk operations.

New or modified screen: Configuration > Device Management > Management Access >
SNMP

Also in 9.10(2).

New Features in ASA 9.8(3)/ASDM 7.9(2.152)

Released: July 2, 2018

Feature

Description

Platform Features

Firepower 2100 Active LED now
lights amber when in standby mode

Formerly, the Active LED was unlit in standby mode.

Firewall Features

Support for removing the logout
button from the cut-through proxy
login page.

If you configure the cut-through proxy to obtain user identity information (the AAA
authentication listener), you can now remove the logout button from the page. This is useful
in case where users connect from behind a NAT device and cannot be distinguished by IP
address. When one user logs out, it logs out all users of the IP address.

New/Modified commands: aaa authentication listener no-logout-button.

No ASDM support.

Trustsec SXP connection
configurable delete hold down timer

The default SXP connection hold down timer is 120 seconds. You can now configure this
timer, between 120 to 64000 seconds.

New/Modified commands: cts sxp delete-hold-down period, show cts sxp connection brief,
show cts sxp connections

No ASDM support.

VPN Features
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Feature Description
Support for legacy SAML If you deploy an ASA with the fix for CSCvg65072, then the default SAML behavior is to
authentication use the embedded browser, which is not supported on AnyConnect 4.4 or 4.5. Therefore, to

continue to use AnyConnect 4.4 or 4.5, you must enable the legacy external browser SAML
authentication method. Because of security limitations, use this option only as part of a
temporary plan to migrate to AnyConnect 4.6. This option will be deprecated in the near future.

New/Modified screens:

Configuration > Remote Access VPN > Network (Client) Access > AnyConnect
Connection Profiles page > Connection Profiles area > Add button > Add AnyConnect
Connection Profile dialog box

Configuration > Remote Access VPN > Clientless SSL VPN Access > Connection
Profiles > page > Connection Profiles area > Add button > Add Clientless SSL VPN
Connection Profile dialog box

New/Modified options: SAML External Browser check box

Interface Features

Unique MAC address generation for
single context mode

You can now enable unique MAC address generation for VLAN subinterfaces in single context
mode. Normally, subinterfaces share the same MAC address with the main interface. Because
IPv6 link-local addresses are generated based on the MAC address, this feature allows for
unique IPv6 link-local addresses.

New or modified command: mac-address auto
No ASDM support.
Alsoin 9.9(2) and later.

New Features in ASDM 7.8(2.151)

Released: October 12, 2017

Feature

Description

Firewall Features

Ethertype access control list changes

EtherType access control lists now support Ethernet II IPX (EII IPX). In addition, new
keywords are added to the DSAP keyword to support common DSAP values: BPDU (0x42),
IPX (0xE0), Raw IPX (0xFF), and ISIS (0xFE). Consequently, existing EtherType access
contol entries that use the BPDU or ISIS keywords will be converted automatically to use the
DSAP specification, and rules for IPX will be converted to 3 rules (DSAP IPX, DSAP Raw
IPX, and EII IPX). In addition, packet capture that uses IPX as an EtherType value has been
deprecated, because IPX corresponds to 3 separate EtherTypes.

This feature is supported in 9.8(2.9) and other interim releases. For more information, see
CSCvf57908.

We modified the following screens: Configuration > Firewall > Ethertype Rules.
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New Features in ASA 9.8(2)/ASDM 7.8(2)

Released: August 28, 2017

Feature

Description

Platform Features

ASA for the Firepower 2100 series

We introduced the ASA for the Firepower 2110, 2120, 2130, and 2140. Similar to the Firepower
4100 and 9300, the Firepower 2100 runs the base FXOS operating system and then the ASA
operating system as an application. The Firepower 2100 implementation couples FXOS more
closely with the ASA than the Firepower 4100 and 9300 do (pared down FXOS functions,
single device image bundle, easy management access for both ASA and FXOS).

FXOS owns configuring hardware settings for interfaces, including creating EtherChannels,
as well as NTP services, hardware monitoring, and other basic functions. You can use the
Firepower Chassis Manager or the FXOS CLI for this configuration. The ASA owns all other
functionality, including Smart Licensing (unlike the Firepower 4100 and 9300). The ASA and
FXOS each have their own IP address on the Management 1/1 interface, and you can configure
management of both the ASA and FXOS instances from any data interface.

We introduced the following screens:

Configuration > Device Management > Management Access > FXOS Remote Management

Department of Defense Unified
Capabilities Approved Products List

The ASA was updated to comply with the Unified Capabilities Approved Products List (UC
APL) requirements. In this release, when you enter the fips enable command, the ASA will
reload. Both failover peers must be in the same FIPS mode before you enable failover.

We modified the following command: fips enable

ASAv for Amazon Web Services M4
instance support

You can now deploy the ASAv as an M4 instance.

We did not modify any screens.

ASAVS5 1.5 GB RAM capability

Starting in Version 9.7(1), the ASAvS5 may experience memory exhaustion where certain
functions such as enabling AnyConnect or downloading files to the ASAv fail. You can now
assign 1.5 GB (up from 1 GB) of RAM to the ASAvVS.

We did not modify any screens.

VPN Features

HTTP Strict Transport Security
(HSTS) header support

HSTS protects websites against protocol downgrade attacks and cookie hijacking on clientless
SSL VPN. It lets web servers declare that web browsers (or other complying user agents)
should only interact with it using secure HTTPS connections, and never via the insecure HTTP
protocol. HSTS is an IETF standards track protocol and is specified in RFC 6797.

We modified the following screens: Configuration > Remote Access VPN > Clientless SSL
VPN Access > Advanced > Proxies

Interface Features

VLAN support for the ASAv50

The ASAvV50 now supports VLANS on the ixgbe-vf vNIC for SR-IOV interfaces.

We did not modify any screens.
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New Features in ASA

New Features in ASA 9.8(1.200) [}

9.8(1.200)

Released: July 30, 2017

)

Note This release is
9.8(2).

only supported on the ASAv for Microsoft Azure. These features are not supported in Version

Feature

Description

High Availability and Scalability F

eatures

Active/Backup High Availability for
ASAv on Microsoft Azure

A stateless Active/Backup solution that allows for a failure of the active ASAv to trigger an
automatic failover of the system to the backup ASAv in the Microsoft Azure public cloud.

We introduced the following commands: failover cloud

No ASDM support.

New Features in ASDM 7.8(1.150)

Released: June 20, 2017

There are no new features in this release.

New Features in ASA

9.8(1)/ASDM 7.8(1)

Released: May 15, 2017

Feature

Description

Platform Features

ASAv50 platform

The ASAv virtual platform has added a high-end performance ASAv50 platform that provides
10 Gbps Firewall throughput levels. The ASAv50 requires ixgbe-vf vINICs, which are supported
on VMware and KVM only.

SR-IOV on the ASAv platform

The ASAv virtual platform supports Single Root I/O Virtualization (SR-IOV) interfaces,
which allows multiple VMs to share a single PCle network adapter inside a host. ASAv
SR-IOV support is available on VMware, KVM, and AWS only.

Automatic ASP load balancing now
supported for the ASAv

Formerly, you could only manually enable and disable ASP load balancing.

We modified the following screen: Configuration > Device Management > Advanced >
ASP Load Balancing

Firewall Features
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Feature

Description

Support for setting the TLS proxy
server SSL cipher suite

You can now set the SSL cipher suite when the ASA acts as a TLS proxy server. Formerly,
you could only set global settings for the ASA on the Configuration > Device Management >
Advanced > SSL Settings > Encryption page.

We modified the following screen: Configuration > Firewall > Unified Communications >
TLS Proxy, Add/Edit dialog boxes, Server Configuration page.

Global timeout for ICMP errors

You can now set the idle time before the ASA removes an ICMP connection after receiving
an ICMP echo-reply packet. When this timeout is disabled (the default), and you enable ICMP
inspection, then the ASA removes the ICMP connection as soon as an echo-reply is received,;
thus any ICMP errors that are generated for the (now closed) connection are dropped. This
timeout delays the removal of ICMP connections so you can receive important ICMP errors.

We modified the following screen: Configuration > Firewall > Advanced > Global Timeouts.

High Availability and Scalability Features

Improved cluster unit health-check
failure detection

You can now configure a lower holdtime for the unit health check: .3 seconds minimum. The
previous minimum was .8 seconds. This feature changes the unit health check messaging
scheme to heartbeats in the data plane from keepalives in the control plane. Using heartbeats
improves the reliability and the responsiveness of clustering by not being susceptible to control
plane CPU hogging and scheduling delays. Note that configuring a lower holdtime increases
cluster control link messaging activity. We suggest that you analyze your network before you
configure a low holdtime; for example, make sure a ping from one unit to another over the
cluster control link returns within the holdtime/3, because there will be three heartbeat messages
during one holdtime interval. If you downgrade your ASA software after setting the hold time
to .3 - .7, this setting will revert to the default of 3 seconds because the new setting is
unsupported.

We modified the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster

Configurable debounce time to mark
an interface as failed for the
Firepower 4100/9300 chassis

You can now configure the debounce time before the ASA considers an interface to be failed,
and the unit is removed from the cluster. This feature allows for faster detection of interface
failures. Note that configuring a lower debounce time increases the chances of false-positives.
When an interface status update occurs, the ASA waits the number of milliseconds specified
before marking the interface as failed and the unit is removed from the cluster. The default
debounce time is 500 ms, with a range of 300 ms to 9 seconds.

New or modified screen: Configuration > Device Management > High Availability and
Scalability > ASA Cluster

VPN Features
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Feature

Description

Support for IKEv2, certificate based
authentication, and ACL in VTI

Virtual Tunnel Interface (VTI) now supports BGP (static VTI). You can now use IKEv2 in
standalone and high availability modes. You can use certificate based authentication by setting
up a trustpoint in the IPsec profile. You can also apply access lists on VTI using access-group
commands to filter ingress traffic.

We introduced options to select the trustpoint for certificate based authentication in the
following screen:

Configuration > Site-to-Site VPN > Advanced > IPsec Proposals (Transform Sets) >
IPsec Profile > Add

Mobile IKEv2 (MobIKE) is enabled
by default

Mobile devices operating as remote access clients require transparent IP address changes while
moving. Supporting MobIKE on ASA allows a current IKE security association (SA) to be
updated without deleting the current SA. MobIKE is “always on.”

SAML 2.0 SSO Updates

The default signing method for a signature in a SAML request changed from SHA 1 to SHA2,
and you can configure which signing method you prefer: rsa-shal, rsa-sha256, rsa-sha384, or
rsa-sha512.

We introduced changes to the following screen: Configuration > Remote Access VPN >
Clientless SSL VPN Access > Advanced > Single Sign On Servers > Add.

Change for tunnelgroup
webvpn-attributes

We changed the pre-fill-username and secondary-pre-fill-username value from ssl-client
to client.

AAA Features

Login history

By default, the login history is saved for 90 days. You can disable this feature or change the
duration, up to 365 days. This feature only applies to usernames in the local database when
you enable local AAA authentication for one or more of the management methods (SSH,
ASDM, Telnet, and so on).

We introduced the following screen: Configuration > Device Management > Users/AAA >
Login History

Password policy enforcement to
prohibit the reuse of passwords, and
prohibit use of a password matching
a username

You can now prohibit the reuse of previous passwords for up to 7 generations, and you can
also prohibit the use of a password that matches a username.

We modified the following screen: Configuration > Device Management > Users/AAA >
Password Policy
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. Firewall Functional Overview

Feature

Description

Separate authentication for users with | In releases prior to 9.6(2), you could enable SSH public key authentication (ssh authentication)
SSH public key authentication and | without also explicitly enabling AAA SSH authentication with the Local user database (aaa

users with passwords

authentication ssh console LOCAL). In 9.6(2), the ASA required you to explicitly enable
AAA SSH authentication. In this release, you no longer have to explicitly enable AAA SSH
authentication; when you configure the ssh authentication command for a user, local
authentication is enabled by default for users with this type of authentication. Moreover, when
you explicitly configure AAA SSH authentication, this configuration only applies for usernames
with passwords, and you can use any AAA server type (aaa authentication ssh console
radius_1, for example). For example, some users can use public key authentication using the
local database, and other users can use passwords with RADIUS.

We did not modify any screens.

Also in Version 9.6(3).

Monitoring and Troubleshooting Features

Saving currently-running packet Formerly, active packet captures were lost if the ASA crashed. Now, packet captures are saved
captures when the ASA crashes to disk O at the time of the crash with the filename [context_name.]capture_name.pcap.

We did not modify any screens.

Firewall Functional Overview

Firewalls protect inside networks from unauthorized access by users on an outside network. A firewall can
also protect inside networks from each other, for example, by keeping a human resources network separate
from a user network. If you have network resources that need to be available to an outside user, such as a web
or FTP server, you can place these resources on a separate network behind the firewall, called a
demilitarized zone (DMZ). The firewall allows limited access to the DMZ, but because the DMZ only includes
the public servers, an attack there only affects the servers and does not affect the other inside networks. You
can also control when inside users access outside networks (for example, access to the Internet), by allowing
only certain addresses out, by requiring authentication or authorization, or by coordinating with an external
URL filtering server.

When discussing networks connected to a firewall, the outside network is in front of the firewall, the inside
network is protected and behind the firewall, and a DMZ, while behind the firewall, allows limited access to
outside users. Because the ASA lets you configure many interfaces with varied security policies, including
many inside interfaces, many DMZs, and even many outside interfaces if desired, these terms are used in a
general sense only.

Security Policy Overview

A security policy determines which traffic is allowed to pass through the firewall to access another network.
By default, the ASA allows traffic to flow freely from an inside network (higher security level) to an outside
network (lower security level). You can apply actions to traffic to customize the security policy.
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Permitting or Denying Traffic with Access Rules

You can apply access rules to limit traffic from inside to outside, or allow traffic from outside to inside. For
bridge group interfaces, you can also apply an EtherType access rule to allow non-IP traffic.

Applying NAT
Some of the benefits of NAT include the following:
* You can use private addresses on your inside networks. Private addresses are not routable on the Internet.
* NAT hides the local addresses from other networks, so attackers cannot learn the real address of a host.

* NAT can resolve IP routing problems by supporting overlapping IP addresses.

Protecting from IP Fragments

The ASA provides IP fragment protection. This feature performs full reassembly of all ICMP error messages
and virtual reassembly of the remaining IP fragments that are routed through the ASA. Fragments that fail
the security check are dropped and logged. Virtual reassembly cannot be disabled.

Applying HTTP, HTTPS, or FTP Filtering

Although you can use access lists to prevent outbound access to specific websites or FTP servers, configuring
and managing web usage this way is not practical because of the size and dynamic nature of the Internet.

You can configure Cloud Web Security on the ASA, or install an ASA module that provides URL and other
filtering services, such as ASA CX or ASA FirePOWER. You can also use the ASA in conjunction with an
external product such as the Cisco Web Security Appliance (WSA).

Applying Application Inspection

Inspection engines are required for services that embed IP addressing information in the user data packet or
that open secondary channels on dynamically assigned ports. These protocols require the ASA to do a deep
packet inspection.

Sending Traffic to Supported Hardware or Software Modules

Some ASA models allow you to configure software modules, or to insert hardware modules into the chassis,
to provide advanced services. These modules provide additional traffic inspection and can block traffic based
on your configured policies. You can send traffic to these modules to take advantage of these advanced
services.

Applying QoS Policies

Some network traffic, such as voice and streaming video, cannot tolerate long latency times. QoS is a network
feature that lets you give priority to these types of traffic. QoS refers to the capability of a network to provide
better service to selected network traffic.

Applying Connection Limits and TCP Normalization

You can limit TCP and UDP connections and embryonic connections. Limiting the number of connections
and embryonic connections protects you from a DoS attack. The ASA uses the embryonic limit to trigger
TCP Intercept, which protects inside systems from a DoS attack perpetrated by flooding an interface with
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TCP SYN packets. An embryonic connection is a connection request that has not finished the necessary
handshake between source and destination.

TCP normalization is a feature consisting of advanced TCP connection settings designed to drop packets that
do not appear normal.

Enabling Threat Detection

You can configure scanning threat detection and basic threat detection, and also how to use statistics to analyze
threats.

Basic threat detection detects activity that might be related to an attack, such as a DoS attack, and automatically
sends a system log message.

A typical scanning attack consists of a host that tests the accessibility of every IP address in a subnet (by
scanning through many hosts in the subnet or sweeping through many ports in a host or subnet). The scanning
threat detection feature determines when a host is performing a scan. Unlike IPS scan detection that is based
on traffic signatures, the ASA scanning threat detection feature maintains an extensive database that contains
host statistics that can be analyzed for scanning activity.

The host database tracks suspicious activity such as connections with no return activity, access of closed
service ports, vulnerable TCP behaviors such as non-random IPID, and many more behaviors.

You can configure the ASA to send system log messages about an attacker or you can automatically shun the
host.

Firewall Mode Overview

The ASA runs in two different firewall modes:

* Routed

* Transparent

In routed mode, the ASA is considered to be a router hop in the network.

In transparent mode, the ASA acts like a “bump in the wire,” or a “stealth firewall,” and is not considered a
router hop. The ASA connects to the same network on its inside and outside interfaces in a "bridge group".

You might use a transparent firewall to simplify your network configuration. Transparent mode is also useful
if you want the firewall to be invisible to attackers. You can also use a transparent firewall for traffic that
would otherwise be blocked in routed mode. For example, a transparent firewall can allow multicast streams
using an EtherType access list.

Routed mode supports Integrated Routing and Bridging, so you can also configure bridge groups in routed
mode, and route between bridge groups and regular interfaces. In routed mode, you can replicate transparent
mode functionality; if you do not need multiple context mode or clustering, you might consider using routed
mode instead.

Stateful Inspection Overview

All traffic that goes through the ASA is inspected using the Adaptive Security Algorithm and either allowed
through or dropped. A simple packet filter can check for the correct source address, destination address, and
ports, but it does not check that the packet sequence or flags are correct. A filter also checks every packet
against the filter, which can be a slow process.
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\}

Note The TCP state bypass feature allows you to customize the packet flow.

A stateful firewall like the ASA, however, takes into consideration the state of a packet:
¢ Is this a new connection?

If it is a new connection, the ASA has to check the packet against access lists and perform other tasks to
determine if the packet is allowed or denied. To perform this check, the first packet of the session goes
through the “session management path,” and depending on the type of traffic, it might also pass through
the “control plane path.”

The session management path is responsible for the following tasks:

* Performing the access list checks
* Performing route lookups
* Allocating NAT translations (xlates)
* Establishing sessions in the “fast path”
The ASA creates forward and reverse flows in the fast path for TCP traffic; the ASA also creates

connection state information for connectionless protocols like UDP, ICMP (when you enable ICMP
inspection), so that they can also use the fast path.

A\

Note  For other IP protocols, like SCTP, the ASA does not create reverse path flows.
As aresult, ICMP error packets that refer to these connections are dropped.

Some packets that require Layer 7 inspection (the packet payload must be inspected or altered) are passed
on to the control plane path. Layer 7 inspection engines are required for protocols that have two or more
channels: a data channel, which uses well-known port numbers, and a control channel, which uses different
port numbers for each session. These protocols include FTP, H.323, and SNMP.

* Is this an established connection?

If the connection is already established, the ASA does not need to re-check packets; most matching
packets can go through the “fast” path in both directions. The fast path is responsible for the following
tasks:

* [P checksum verification

* Session lookup

» TCP sequence number check

* NAT translations based on existing sessions

 Layer 3 and Layer 4 header adjustments

Data packets for protocols that require Layer 7 inspection can also go through the fast path.

Some established session packets must continue to go through the session management path or the control
plane path. Packets that go through the session management path include HTTP packets that require
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inspection or content filtering. Packets that go through the control plane path include the control packets
for protocols that require Layer 7 inspection.

VPN Functional Overview

A VPN is a secure connection across a TCP/IP network (such as the Internet) that appears as a private
connection. This secure connection is called a tunnel. The ASA uses tunneling protocols to negotiate security
parameters, create and manage tunnels, encapsulate packets, transmit or receive them through the tunnel, and
unencapsulate them. The ASA functions as a bidirectional tunnel endpoint: it can receive plain packets,
encapsulate them, and send them to the other end of the tunnel where they are unencapsulated and sent to
their final destination. It can also receive encapsulated packets, unencapsulate them, and send them to their
final destination. The ASA invokes various standard protocols to accomplish these functions.

The ASA performs the following functions:
* Establishes tunnels
* Negotiates tunnel parameters
* Authenticates users
* Assigns user addresses
* Encrypts and decrypts data
* Manages security keys
* Manages data transfer across the tunnel

* Manages data transfer inbound and outbound as a tunnel endpoint or router

The ASA invokes various standard protocols to accomplish these functions.

Security Context Overview

You can partition a single ASA into multiple virtual devices, known as security contexts. Each context is an
independent device, with its own security policy, interfaces, and administrators. Multiple contexts are similar
to having multiple standalone devices. Many features are supported in multiple context mode, including
routing tables, firewall features, IPS, and management; however, some features are not supported. See the
feature chapters for more information.

In multiple context mode, the ASA includes a configuration for each context that identifies the security policy,
interfaces, and almost all the options you can configure on a standalone device. The system administrator
adds and manages contexts by configuring them in the system configuration, which, like a single mode
configuration, is the startup configuration. The system configuration identifies basic settings for the ASA.
The system configuration does not include any network interfaces or network settings for itself; rather, when
the system needs to access network resources (such as downloading the contexts from the server), it uses one
of the contexts that is designated as the admin context.

The admin context is just like any other context, except that when a user logs into the admin context, then
that user has system administrator rights and can access the system and all other contexts.
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ASA Clustering Overview

ASA Clustering lets you group multiple ASAs together as a single logical device. A cluster provides all the
convenience of a single device (management, integration into a network) while achieving the increased
throughput and redundancy of multiple devices.

You perform all configuration (aside from the bootstrap configuration) on the control unit only; the configuration
is then replicated to the member units.

Special, Deprecated, and Legacy Services

For some services, documentation is located outside of the main configuration guides and online help.
Special Services Guides

Special services allow the ASA to interoperate with other Cisco products; for example, by providing a
security proxy for phone services (Unified Communications), or by providing Botnet traffic filtering in
conjunction with the dynamic database from the Cisco update server, or by providing WCCP services
for the Cisco Web Security Appliance. Some of these special services are covered in separate guides:

* Cisco ASA Botnet Traffic Filter Guide

* Cisco ASA NetFlow Implementation Guide

* Cisco ASA Unified Communications Guide
* Cisco ASA WCCP Traffic Redirection Guide

* SNMP Version 3 Tools Implementation Guide

Deprecated Services

For deprecated features, see the configuration guide for your ASA version. Similarly, for redesigned
features such as NAT between Version 8.2 and 8.3 or transparent mode interfaces between Version 8.3
and 8.4, refer to the configuration guide for your version. Although ASDM is backwards compatible
with previous ASA releases, the configuration guide and online help only cover the latest release.

Legacy Services Guide

Legacy services are still supported on the ASA, however there may be better alternative services that
you can use instead. Legacy services are covered in a separate guide:

Cisco ASA Legacy Feature Guide

This guide includes the following chapters:
* Configuring RIP
* AAA Rules for Network Access

* Using Protection Tools, which includes Preventing IP Spoofing (ip verify reverse-path), Configuring
the Fragment Size (fragment), Blocking Unwanted Connections (shun), Configuring TCP Options
(for ASDM), and Configuring IP Audit for Basic IPS Support (ip audit).

* Configuring Filtering Services
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CHAPTER 2

Getting Started

This chapter describes how to get started with your Cisco ASA.

* Access the Console for the Command-Line Interface, on page 19
* Configure ASDM Access, on page 29

* Start ASDM, on page 35

* Customize ASDM Operation, on page 36

* Factory Default Configurations, on page 38

* Get Started with the Configuration, on page 51

* Use the Command Line Interface Tool in ASDM, on page 52

» Apply Configuration Changes to Connections, on page 53

Access the Console for the Command-Line Interface

In some cases, you may need to use the CLI to configure basic settings for ASDM access.

For initial configuration, access the CLI directly from the console port. Later, you can configure remote access
using Telnet or SSH according to #unique 41. If your system is already in multiple context mode, then
accessing the console port places you in the system execution space.

N

Note For ASAv console access, see the ASAv quick start guide.

Access the Appliance Console

Follow these steps to access the appliance console.

Procedure

Step 1 Connect a computer to the console port using the provided console cable, and connect to the console using a
terminal emulator set for 9600 baud, 8 data bits, no parity, 1 stop bit, no flow control.

See the hardware guide for your ASA for more information about the console cable.

Step 2 Press the Enter key to see the following prompt:
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ciscoasa>

This prompt indicates that you are in user EXEC mode. Only basic commands are available from user EXEC
mode.

Step 3 Access privileged EXEC mode.
enable

You are prompted for the password. By default, the password is blank, and you can press the Enter key to
continue. See Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 567 to change
the enable password.

Example:

ciscoasa> enable
Password:
ciscoasa#

All non-configuration commands are available in privileged EXEC mode. You can also enter configuration
mode from privileged EXEC mode.

To exit privileged mode, enter the disable, exit, or quit command.

Step 4 Access global configuration mode.
configure terminal

Example:

ciscoasa# configure terminal
ciscoasa(config) #

You can begin to configure the ASA from global configuration mode. To exit global configuration mode,
enter the exit, quit, or end command.

Access the Firepower 2100 Console

The Firepower 2100 console port connects you to the FXOS CLI. From the FXOS CLI, you can then connect
to the ASA console, and back again. If you SSH to FXOS, you can also connect to the ASA CLI; a connection
from SSH is not a console connection, so you can have multiple ASA connections from an FXOS SSH
connection. Similarly, if you SSH to the ASA, you can connect to the FXOS CLI.

Before you begin

You can only have one console connection at a time. When you connect to the ASA console from the FXOS
console, this connection is a persistent console connection, not like a Telnet or SSH connection.
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Step 1

Step 2

Step 3

Step 4

Access the Firepower 2100 Console .

Procedure

Connect your management computer to the console port. The Firepower 2100 ships with a DB-9 to RJ-45
serial cable, so you will need a third party serial-to-USB cable to make the connection. Be sure to install any
necessary USB serial drivers for your operating system. Use the following serial settings:

* 9600 baud
* 8 data bits
* No parity

* 1 stop bit

You connect to the FXOS CLI. Enter the user credentials; by default, you can log in with the admin user and
the default password, Admin123.

Connect to the ASA:
connect asa

Example:

firepower-2100# connect asa

Attaching to Diagnostic CLI ... Press 'Ctrl+a then d' to detach.
Type help or '?' for a list of available commands.
ciscoasa>

Access privileged EXEC mode.
enable

You are prompted for the password. By default, the password is blank, and you can press the Enter key to
continue. See Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 567 to change
the enable password.

Example:

ciscoasa> enable
Password:
ciscoasa#

All non-configuration commands are available in privileged EXEC mode. You can also enter configuration
mode from privileged EXEC mode.

To exit privileged mode, enter the disable, exit, or quit command.

Access global configuration mode.
configure terminal

Example:

ciscoasa# configure terminal
ciscoasa(config) #
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Step 5
Step 6

You can begin to configure the ASA from global configuration mode. To exit global configuration mode,
enter the exit, quit, or end command.

To return to the FXOS console, enter Ctrl+a, d.
If you SSH to the ASA (after you configure SSH access in the ASA), connect to the FXOS CLI.

connect fxos

You are prompted to authenticate for FXOS; use the default username: admin and password: Admin123. To
return to the ASA CLI, enter exit or type Ctrl-Shift-6, x.

Example:

ciscoasa# connect fxos
Connecting to fxos.
Connected to fxos. Escape character sequence is 'CTRL-"X'.

FXOS 2.2(2.32) kp2110

kp2110 login: admin

Password: Adminl23

Last login: Sat Jan 23 16:20:16 UTC 2017 on pts/1

Successful login attempts for user 'admin' : 4

Cisco Firepower Extensible Operating System (FX-0S) Software

[..]

kp2110#

kp2110# exit

Remote card closed command session. Press any key to continue.
Connection with fxos terminated.

Type help or '?' for a list of available commands.

ciscoasa#

Access the ASA Console on the Firepower 4100/9300 Chassis

Step 1

For initial configuration, access the command-line interface by connecting to the Firepower 4100/9300 chassis
supervisor (either to the console port or remotely using Telnet or SSH) and then connecting to the ASA security
module.

Procedure

Connect to the Firepower 4100/9300 chassis supervisor CLI (console or SSH), and then session to the ASA:
connect module slot console

The first time you access the module, you access the FXOS module CLI. You must then connect to the ASA
application.

connect asa

Example:

Firepower# connect module 1 console
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Step 2

Step 3

Step 4

Step 5

Access the ASA Services Module Console .

Firepower-modulel> connect asa

asa>

Access privileged EXEC mode, which is the highest privilege level.
enable

You are prompted for the password. By default, the password is blank, and you can press the Enter key to
continue. See Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 567 to change
the enable password.

Example:

asa> enable
Password:
asa#

All non-configuration commands are available in privileged EXEC mode. You can also enter configuration
mode from privileged EXEC mode.

To exit privileged mode, enter the disable, exit, or quit command.
Enter global configuration mode.

configure terminal

Example:

asa# configure terminal
asa (config) #

To exit global configuration mode, enter the disable, exit, or quit command.

Exit the application console to the FXOS module CLI by entering Ctrl-a, d
You might want to use the FXOS module CLI for troubleshooting purposes.
Return to the supervisor level of the FXOS CLI.
a) Enter ~

You exit to the Telnet application.
b) To exit the Telnet application, enter:

telnet>quit

Access the ASA Services Module Console

For initial configuration, access the command-line interface by connecting to the switch (either to the console
port or remotely using Telnet or SSH) and then connecting to the ASASM. The ASASM does not include a
factory default configuration, so you must perform some configuration at the CLI before you can access it
using ASDM. This section describes how to access the ASASM CLI.
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About Connection Methods

From the switch CLI, you can use two methods to connect to the ASASM:

» Virtual console connection—Using the service-module session command, you create a virtual console
connection to the ASASM, with all the benefits and limitations of an actual console connection.

Benefits include:

* The connection is persistent across reloads and does not time out.
* You can stay connected through ASASM reloads and view startup messages.
* You can access ROMMON if the ASASM cannot load the image.

* No initial password configuration is required.

Limitations include:

* The connection is slow (9600 baud).
* You can only have one console connection active at a time.

* You cannot use this command in conjunction with a terminal server where Ctrl-Shift-6, X is the
escape sequence to return to the terminal server prompt. Ctrl-Shift-6, X is also the sequence to
escape the ASASM console and return to the switch prompt. Therefore, if you try to exit the ASASM
console in this situation, you instead exit all the way to the terminal server prompt. If you reconnect
the terminal server to the switch, the ASASM console session is still active; you can never exit to
the switch prompt. You must use a direct serial connection to return the console to the switch prompt.
In this case, either change the terminal server or switch escape character in Cisco I0S software, or
use the Telnet session command instead.

A

Note Because of the persistence of the console connection, if you do not properly log
out of the ASASM, the connection may exist longer than intended. If someone
else wants to log in, they will need to kill the existing connection.

* Telnet connection—Using the session command, you create a Telnet connection to the ASASM.

N

Note  You cannot connect using this method for a new ASASM; this method requires
you to configure a Telnet login password on the ASASM (there is no default
password). After you set a password using the passwd command, you can use
this method.

Benefits include:

* You can have multiple sessions to the ASASM at the same time.

e The Telnet session is a fast connection.

Limitations include:

¢ The Telnet session is terminated when the ASASM reloads, and can time out.
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* You cannot access the ASASM until it completely loads; you cannot access ROMMON.

* You must first set a Telnet login password; there is no default password.

Log Into the ASA Services Module

For initial configuration, access the command-line interface by connecting to the switch (either to the switch
console port or remotely using Telnet or SSH) and then connecting to the ASASM.

Step 1

If your system is already in multiple context mode, then accessing the ASASM from the switch places you
in the system execution space.

Later, you can configure remote access directly to the ASASM using Telnet or SSH.

Procedure

From the switch, perform one of the following:

Available for initial access—From the switch CLI, enter this command to gain console access to the
ASASM:

service-module session [switch {1|2}] slot number

Example:

Router# service-module session slot 3

ciscoasa>

For a switch in a VSS, enter the switch argument.

To view the module slot numbers, enter the show module command at the switch prompt.

You access user EXEC mode.

Available after you configure a login password—From the switch CLI, enter this command to Telnet to
the ASASM over the backplane:

session [switch {1 || 2}] slot number processor 1

You are prompted for the login password:
ciscoasa passwd:
Example:

Router# session slot 3 processor 1
ciscoasa passwd: cisco
ciscoasa>

For a switch in a VSS, enter the switch argument.

The session slot processor 0 command, which is supported on other services modules, is not supported
on the ASASM; the ASASM does not have a processor 0.

To view the module slot numbers, enter the show module command at the switch prompt.
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Step 2

Step 3

Enter the login password to the ASASM. Set the password using the passwd command. There is no
default password.

You access user EXEC mode.

Access privileged EXEC mode, which is the highest privilege level.
enable

You are prompted for the password. By default, the password is blank, and you can press the Enter key to
continue. See Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 567 to change
the enable password.

Example:

ciscoasa> enable
Password:
ciscoasa#

All non-configuration commands are available in privileged EXEC mode. You can also enter configuration
mode from privileged EXEC mode.

To exit privileged mode, enter the disable, exit, or quit command.

Access global configuration mode:
configure terminal

To exit global configuration mode, enter the disable, exit, or quit command.

Related Topics
Guidelines for Management Access
Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 567

Log Out of a Console Session

If you do not log out of the ASASM, the console connection persists; there is no timeout. To end the ASASM
console session and access the switch CLI, perform the following steps.

To kill another user’s active connection, which may have been unintentionally left open, see Kill an Active
Console Connection, on page 27.

Procedure

To return to the switch CLI, type the following:
Ctrl-Shift-6, x

You return to the switch prompt:

asasm# [Ctrl-Shift-6, x]
Router#
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Note Shift-6 on US and UK keyboards issues the caret (*) character. If you have a different keyboard
and cannot issue the caret (") character as a standalone character, you can temporarily or permanently
change the escape character to a different character. Use the terminal escape-character ascii_number
command (to change for this session) or the default escape-character ascii_number command (to
change permanently). For example, to change the sequence for the current session to Ctrl-w, X,
enter terminal escape-character 23.

Kill an Active Console Connection

Because of the persistence of a console connection, if you do not properly log out of the ASASM, the connection
may exist longer than intended. If someone else wants to log in, they will need to kill the existing connection.

Procedure

Step 1 From the switch CLI, show the connected users using the show users command. A console user is called
“con”. The Host address shown is 127.0.0.90t0, where sot is the slot number of the module.

show users

For example, the following command output shows a user “con” on line 0 on a module in slot 2:

Router# show users

Line User Host (s) Idle Location
* 0 con 0 127.0.0.20 00:00:02
Step 2 To clear the line with the console connection, enter the following command:

clear line number

For example:

Router# clear line 0

Log Out of a Telnet Session

To end the Telnet session and access the switch CLI, perform the following steps.

Procedure

To return to the switch CLI, type exit from the ASASM privileged or user EXEC mode. If you are in a
configuration mode, enter exit repeatedly until you exit the Telnet session.

You return to the switch prompt:

asasm# exit
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Router#

Note You can alternatively escape the Telnet session using the escape sequence Ctrl-Shift-6, x; this
escape sequence lets you resume the Telnet session by pressing the Enter key at the switch prompt.
To disconnect your Telnet session from the switch, enter disconnect at the switch CLIL. If you do
not disconnect the session, it will eventually time out according to the ASASM configuration.

Access the Software Module Console

)

If you have a software module installed, such as the ASA FirePOWER module on the ASA 5506-X, you can
session to the module console.

Note

You cannot access the hardware module CLI over the ASA backplane using the session command.

Procedure

From the ASA CLI, session to the module:
session {sfr | cxsc | ips} console

Example:

ciscoasa# session sfr console
Opening console session with module sfr.
Connected to module sfr. Escape character sequence is 'CTRL-"X'.

Cisco ASA SFR Boot Image 5.3.1
asasfr login: admin
Password: Adminl23

Access the ASA 5506W-X Wireless Access Point Console

Step 1

To access the wireless access point console, perform the following steps.

Procedure

From the ASA CLI, session to the access point:
session wlan console

Example:

ciscoasa# session wlan console

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8



| Getting Started with the ASA
Configure ASDM Access .

opening console session with module wlan
connected to module wlan. Escape character sequence is ‘CTRL-"X’

ap>

Step 2 See the Cisco I0S Configuration Guide for Autonomous Aironet Access Points for information about the
access point CLI.

Configure ASDM Access

This section describes how to access ASDM with a default configuration and how to configure access if you
do not have a default configuration.

Use the Factory Default Configuration for ASDM Access (Appliances, ASAv)

With a factory default configuration, ASDM connectivity is pre-configured with default network settings.

Procedure

Connect to ASDM using the following interface and network settings:
» The management interface depends on your model:

* Firepower 2100—Management 1/1 (192.168.45.1). Management hosts are limited to the
192.168.45.0/24 network.

* Firepower 4100/9300—The Management type interface and IP address of your choice defined when
you deployed. Management hosts are allowed from any network.

* ASA 5506-X, ASA 5506W-X—Inside GigabitEthernet 1/2 through 1/8, and wifi GigabitEthernet
1/9 (192.168.10.1). Inside hosts are limited to the 192.168.1.0/24 network, and wifi hosts are limited
to 192.168.10.0/24.

* ASA 5508-X, and ASA 5516-X—Inside GigabitEthernet 1/2 (192.168.1.1). Inside hosts are limited
to the 192.168.1.0/24 network.

* ASA 5512-X and higher—Management 0/0 (192.168.1.1). Management hosts are limited to the
192.168.1.0/24 network.

* ASAv—Management 0/0 (set during deployment). Management hosts are limited to the management
network.

* ISA 3000—Management 1/1 (192.168.1.1). Management hosts are limited to the 192.168.1.0/24
network.

Note If you change to multiple context mode, you can access ASDM from the admin context using the
network settings above.
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Related Topics
Factory Default Configurations, on page 38
Enable or Disable Multiple Context Mode, on page 253
Start ASDM, on page 35

Customize ASDM Access

)

This procedure applies to all models except the ASA Services Module.
Use this procedure if one or more of the following conditions applies:
* You do not have a factory default configuration
* You want to change to transparent firewall mode
* You want to change to multiple context mode
For routed, single mode, for quick and easy ASDM access, we recommend applying the factory default
configuration with the option to set your own management IP address. Use the procedure in this section only

if you have special needs such as setting transparent or multiple context mode, or if you have other configuration
that you need to preserve.

Note

Step 1
Step 2

Step 3

For the ASAv, you can configure transparent mode when you deploy, so this procedure is primarily useful
after you deploy if you need to clear your configuration, for example.

Procedure

Access the CLI at the console port.

(Optional) Enable transparent firewall mode:
This command clears your configuration.

firewall transparent

Configure the management interface:

interface interface id
nameif name
security-level level
no shutdown
ip address ip address mask

Example:

ciscoasa(config)# interface management 0/0
ciscoasa(config-if) # nameif management
ciscoasa(config-if)# security-level 100
ciscoasa(config-if)# no shutdown

ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0
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The security-level is a number between 1 and 100, where 100 is the most secure.

Step 4 (For directly-connected management hosts) Set the DHCP pool for the management network:

dhcpd address ip address-ip address interface name
dhcpd enable interface name

Example:

ciscoasa(config) # dhcpd address 192.168.1.2-192.168.1.254 management
ciscoasa(config) # dhcpd enable management

Make sure you do not include the interface address in the range.
Step 5 (For remote management hosts) Configure a route to the management hosts:
route management_ifc management_host_ip mask gateway ip 1

Example:

ciscoasa(config)# route management 10.1.1.0 255.255.255.0 192.168.1.50 1

Step 6 Enable the HTTP server for ASDM:
http server enable

Step 7 Allow the management host(s) to access ASDM:
http ip_address mask interface_name

Example:

ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

Step 8 Save the configuration:

write memory
Step 9 (Optional) Set the mode to multiple mode:

mode multiple

When prompted, confirm that you want to convert the existing configuration to be the admin context. You
are then prompted to reload the ASA.

Examples

The following configuration converts the firewall mode to transparent mode, configures the
Management 0/0 interface, and enables ASDM for a management host:

firewall transparent
interface management 0/0
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ip address 192.168.1.1 255.255.255.0
nameif management

security-level 100

no shutdown

dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management

http server enable

http 192.168.1.0 255.255.255.0 management

Related Topics
Restore the Factory Default Configuration, on page 39
Set the Firewall Mode (Single Mode), on page 215
Access the Appliance Console, on page 19
Start ASDM, on page 35

Configure ASDM Access for the ASA Services Module

Step 1
Step 2

Step 3

Because the ASASM does not have physical interfaces, it does not come pre-configured for ASDM access;
you must configure ASDM access using the CLI on the ASASM. To configure the ASASM for ASDM access,
perform the following steps.

Before you begin
Assign a VLAN interface to the ASASM according to ASASM quick start guide.

Procedure

Connect to the ASASM and access global configuration mode.

(Optional) Enable transparent firewall mode:
firewall transparent

This command clears your configuration.

Do one of the following to configure a management interface, depending on your mode:

* Routed mode—Configure an interface in routed mode:

interface vlan number
ip address ip address [mask]
nameif name
security-level level

Example:

ciscoasa(config) # interface vlan 1

ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0
ciscoasa(config-if)# nameif inside

ciscoasa (config-if)# security-level 100

The security-level is a number between 1 and 100, where 100 is the most secure.
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Step 4

Step 5

Step 6

Step 7

Configure ASDM Access for the ASA Services Module .

* Transparent mode—Configure a bridge virtual interface and assigns a management VLAN to the bridge
group:

interface bvi number
ip address ip address [mask]

interface vlan number
bridge-group bvi number
nameif name
security-level level

Example:

ciscoasa(config)# interface bvi 1
ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0

ciscoasa
ciscoasa
ciscoasa
ciscoasa

config) # interface vlan 1
config-if)# bridge-group 1
config-if) # nameif inside
config-if)# security-level 100

The security-level is a number between 1 and 100, where 100 is the most secure.

(For directly-connected management hosts) Enable DHCP for the management host on the management
interface network:

dhcpd address ip address-ip address interface name
dhcpd enable interface name

Example:

ciscoasa(config) # dhcpd address 192.168.1.2-192.168.1.254 inside
ciscoasa (config)# dhcpd enable inside

Make sure you do not include the management address in the range.

(For remote management hosts) Configure a route to the management hosts:
route management_ifc management_host_ip mask gateway ip 1

Example:

ciscoasa(config) # route management 10.1.1.0 255.255.255.0 192.168.1.50

Enable the HTTP server for ASDM:

http server enable

Allow the management host to access ASDM:
http ip_address mask interface_name

Example:
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ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

Step 8 Save the configuration:

write memory

Step 9 (Optional) Set the mode to multiple mode:
mode multiple

When prompted, confirm that you want to convert the existing configuration to be the admin context. You
are then prompted to reload the ASASM.

Examples

The following routed mode configuration configures the VLAN 1 interface and enables ASDM for
a management host:

interface vlan 1

nameif inside

ip address 192.168.1.1 255.255.255.0
security-level 100

dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside

http server enable

http 192.168.1.0 255.255.255.0 inside

The following configuration converts the firewall mode to transparent mode, configures the VLAN
1 interface and assigns it to BVI 1, and enables ASDM for a management host:

firewall transparent
interface bvi 1

ip address 192.168.1.1 255.255.255.0
interface vlan 1

bridge-group 1

nameif inside

security-level 100

dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside

http server enable

http 192.168.1.0 255.255.255.0 inside

Related Topics
Access the ASA Services Module Console, on page 23
About Connection Methods, on page 24
Log Out of a Console Session, on page 26
Kill an Active Console Connection, on page 27
Log Out of a Telnet Session, on page 27
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Set the Firewall Mode (Single Mode), on page 215

Start ASDM

\}

You can start ASDM using two methods:

* ASDM-IDM Launcher—The Launcher is an application downloaded from the ASA using a web browser
that you can use to connect to any ASA IP address. You do not need to re-download the launcher if you
want to connect to other ASAs.

+ Java Web Start—For each ASA that you manage, you need to connect with a web browser and then save
or launch the Java Web Start application. You can optionally save the shortcut to your computer; however
you need separate shortcuts for each ASA IP address.

Note

Step 1

Step 2

If you use web start, clear the Java cache or you might lose changes to some pre-login policies such as Hostscan.
This problem does not occur if you use the launcher.

Within ASDM, you can choose a different ASA IP address to manage; the difference between the Launcher
and Java Web Start functionality rests primarily in how you initially connect to the ASA and launch ASDM.

This section describes how to connect to ASDM initially, and then launch ASDM using the Launcher or the
Java Web Start.

ASDM stores files in the local \Users\<user id>\.asdm directory, including cache, log, and preferences, and
also in the Temp directory, including AnyConnect profiles.

Procedure

On the computer that you specified as the ASDM client, enter the following URL:
https://asa_ip_address/admin
Note Be sure to specify https://, and not http:// or just the IP address (which defaults to HTTP); the ASA
does not automatically forward an HTTP request to HTTPS.
The ASDM launch page appears with the following buttons:
* Install ASDM Launcher and Run ASDM

* Run ASDM

* Run Startup Wizard

To download the Launcher:

a) Click Install ASDM Launcher and Run ASDM.

b) Leave the username and password fields empty (for a new installation), and click OK. With no HTTPS
authentication configured, you can gain access to ASDM with no username and the enable password,
which is blank by default. Note: If you enabled HTTPS authentication, enter your username and associated
password. Even without authentication, if you enter a username and password at the login screen (instead
of leaving the username blank), ASDM checks the local database for a match.
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Step 3

¢) Save the installer to your computer, and then start the installer. The ASDM-IDM Launcher opens
automatically after installation is complete.

d) Enter the management IP address, the same username and password (blank for a new installation), and
then click OK.

To use Java Web Start:

a) Click Run ASDM or Run Startup Wizard.

b) Save the shortcut to your computer when prompted. You can optionally open it instead of saving it.

c) Start Java Web Start from the shortcut.

d) Accept any certificates according to the dialog boxes that appear. The Cisco ASDM-IDM Launcher
appears.

e) Leave the username and password fields empty (for a new installation), and click OK. With no HTTPS
authentication configured, you can gain access to ASDM with no username and the enable password,
which is blank by default. Note: If you enabled HTTPS authentication, enter your username and associated
password. Even without authentication, if you enter a username and password at the login screen (instead
of leaving the username blank), ASDM checks the local database for a match.

Customize ASDM Operation

You can install an identity certificate to successfully launch ASDM as well as increase the ASDM heap
memory so it can handle larger configurations.

Install an Identity Certificate for ASDM

When using Java 7 update 51 and later, the ASDM Launcher requires a trusted certificate. An easy approach
to fulfill the certificate requirements is to install a self-signed identity certificate. You can use Java Web Start
to launch ASDM until you install a certificate.

See the following document to install a self-signed identity certificate on the ASA for use with ASDM, and
to register the certificate with Java.

http://www.cisco.com/go/asdm-certificate

Increase the ASDM Configuration Memory

ASDM supports a maximum configuration size of 512 KB. If you exceed this amount you may experience
performance issues. For example, when you load the configuration, the status dialog box shows the percentage
of the configuration that is complete, yet with large configurations it stops incrementing and appears to suspend
operation, even though ASDM might still be processing the configuration. If this situation occurs, we
recommend that you consider increasing the ASDM system heap memory.

Increase the ASDM Configuration Memory in Windows

To increase the ASDM heap memory size, edit the run.bat file by performing the following procedure.
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Procedure

Step 1 Go to the ASDM installation directory, for example C:\Program Files (x86)\Cisco Systems\ASDM.
Step 2 Edit the run.bat file with any text editor.

Step 3 In the line that starts with “start javaw.exe”, change the argument prefixed with “-Xmx" to specify your desired
heap size. For example, change it to -Xmx768M for 768 MB or -Xmx1G for 1 GB.

Step 4 Save the run.bat file.

Increase the ASDM Configuration Memory in Mac 0S

To increase the ASDM heap memory size, edit the Info.plist file by performing the following procedure.

Procedure

Step 1 Right-click the Cisco ASDM-IDM icon, and choose Show Package Contents.

Step 2 In the Contents folder, double-click the Info.plist file. If you have Developer tools installed, it opens in the
Property List Editor. Otherwise, it opens in TextEdit.

Step 3 Under Java > VMOptions, change the string prefixed with “-Xmx” to specify your desired heap size. For
example, change it to -Xmx768M for 768 MB or -Xmx1G for 1 GB.

<key>CFBundleIconFile</key:>
<stringrasdm3Z.jicng</string:-

<key>VMOptions</lkey:>
<string>-EmsHdm -Xmxz5 12m|</string>

<key>CFBundleDocumentTypes</key>
<arrayx

Step 4 If this file is locked, you see an error such as the following:

The file “Info.plist” is locked because you
haven't made any changes to it recently.

,;' If you want to make changes to this document, click
Unlock. To keep the file unchanged and work with a copy,
click Duplicate.

Unlock Cancel [ Duplicate |

TaE4

Step 5 Click Unlock and save the file.
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If you do not see the Unlock dialog box, exit the editor, right-click the Cisco ASDM-IDM icon, choose Copy
Cisco ASDM-IDM, and paste it to a location where you have write permissions, such as the Desktop. Then
change the heap size from this copy.

Factory Default Configurations

The factory default configuration is the configuration applied by Cisco to new ASAs.

ASA 5506-X—The factory default configuration enables a functional inside/outside configuration. You
can manage the ASA using ASDM from the inside interfaces, which are placed in a bridge group using
Integrated Routing and Bridging.

ASA 5508-X and 5516-X—The factory default configuration enables a functional inside/outside
configuration. You can manage the ASA using ASDM from the inside interface.

ASA 5512-X through ASA 5585-X—The factory default configuration configures an interface for
management so that you can connect to it using ASDM, with which you can then complete your
configuration.

Firepower 2100—The factory default configuration enables a functional inside/outside configuration.
You can manage the ASA using the Firepower Chassis Manager and ASDM from the management
interface.

Firepower 4100/9300 chassis—When you deploy the standalone or cluster of ASAs, the factory default
configuration configures an interface for management so that you can connect to it using ASDM, with
which you can then complete your configuration.

ASAv—Depending on your hypervisor, as part of deployment, the deployment configuration (the initial
virtual deployment settings) configures an interface for management so that you can connect to it using
ASDM, with which you can then complete your configuration. You can also configure failover IP
addresses. You can also apply a “factory default” configuration if desired.

ASASM—No default configuration. See Access the ASA Services Module Console, on page 23 to start
configuration.

ISA 3000—The factory default configuration is an almost-complete transparent firewall mode
configuration with all inside and outside interfaces on the same network; you can connect to the
management interface with ASDM to set the IP address of your network. Hardware bypass is enabled
for two interface pairs, and all traffic is sent to the ASA FirePOWER module in Inline Tap Monitor-Only
Mode. This mode sends a duplicate stream of traffic to the ASA Firepower module for monitoring
purposes only.

For appliances and the Firepower 4100/9300 chassis, the factory default configuration is available only for
routed firewall mode and single context mode, except for the ISA 3000, where the factory default configuration
is only available in transparent mode. For the ASAv, you can choose transparent or routed mode at deployment.
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Note

In addition to the image files and the (hidden) default configuration, the following folders and files are standard
in flash memory: log/, crypto_archive/, and coredumpinfo/coredump.cfg. The date on these files may not
match the date of the image files in flash memory. These files aid in potential troubleshooting; they do not
indicate that a failure has occurred.

Restore the Factory Default Configuration

\)

This section describes how to restore the factory default configuration. Both CLI and ASDM procedures are
provided. For the ASAwv, this procedure erases the deployment configuration and applies the same factory
default configuration as for the ASA 5525-X.

Note

Step 1

On the ASASM, restoring the factory default configuration simply erases the configuration; there is no factory
default configuration.

On the Firepower 4100/9300, restoring the factory default configuration simply erases the configuration; to
restore the default configuration, you must re-deploy the ASA from the supervisor.

Before you begin

This feature is available only in routed firewall mode, except for the ISA 3000, where this command is only
supported in transparent mode. In addition, this feature is available only in single context mode; an ASA with
a cleared configuration does not have any defined contexts to configure automatically using this feature.

Procedure

Restore the factory default configuration:
configure factory-default [ip_address [mask]]

Example:

ciscoasa (config)# configure factory-default 10.1.1.1 255.255.255.0

If you specify the ip_address, then you set the inside or management interface IP address, depending on your
model, instead of using the default IP address. See the following model guidelines for which interface is set
by the ip_address option:

* Firepower 2100—Sets the management interface IP address.

* Firepower 4100/9300—No effect.

» ASAv—Sets the management interface IP address.

* ASA 5506-X—Sets the inside interface IP address.

* ASA 5508-X and 5516-X—Sets the inside interface IP address.

* ASA 5512-X, 5515-X, 5525-X, 5545-X, 5555-X—Sets the management interface IP address.
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Step 2

Step 3

* ASA 5585-X—Sets the management interface IP address.
* ISA 3000—Sets the management interface IP address.

* ASASM—No effect.

The http command uses the subnet you specify. Similarly, the dhcpd address command range consists of
all available addresses higher than the IP address you specify. For example, if you specify 10.5.6.78 with a
subnet mask of 255.255.255.0, then the DHCP address range will be 10.5.6.79-10.5.6.254.

For the Firepower 2100: This model does not use the boot system command; packages are managed by FXOS.

For all other models: This command clears the boot system command, if present, along with the rest of the
configuration. The boot system command lets you boot from a specific image. The next time you reload the
ASA after restoring the factory configuration, it boots from the first image in internal flash memorys; if you
do not have an image in internal flash memory, the ASA does not boot.

Example:

docs-bxb-asa3 (config)# configure factory-default 10.86.203.151 255.255.254.0
Based on the management IP address and mask, the DHCP address
pool size is reduced to 103 from the platform limit 256

WARNING: The boot system configuration will be cleared.

The first image found in diskO:/ will be used to boot the
system on the next reload.

Verify there is a valid image on disk0:/ or the system will
not boot.

Begin to apply factory-default configuration:

Clear all configuration

WARNING: The new maximum-session limit will take effect after the running-config is saved
and the system boots next time. Command accepted

WARNING: Local user database is empty and there are still 'aaa' commands for 'LOCAL'.
Executing command: interface management0/0

Executing command: nameif management

INFO: Security level for "management" set to 0 by default.

Executing command: ip address 10.86.203.151 255.255.254.0

Executing command: security-level 100

Executing command: no shutdown

Executing command: exit

Executing command: http server enable

Executing command: http 10.86.202.0 255.255.254.0 management

Executing command: dhcpd address 10.86.203.152-10.86.203.254 management

Executing command: dhcpd enable management

Executing command: logging asdm informational

Factory-default configuration is completed

ciscoasa(config) #

Save the default configuration to flash memory:
write memory

This command saves the running configuration to the default location for the startup configuration, even if
you previously configured the boot config command to set a different location; when the configuration was
cleared, this path was also cleared.

(ASDM procedure.) In the main ASDM application window, do the following:
a) Choose File > Reset Device to the Factory Default Configuration.

The Reset Device to the Default Configuration dialog box appears.
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b) (Optional) Enter the Management IP address of the management or inside interface, instead of using
the default address.

See the previous CLI step for details about which interface IP is set per model.

¢) (Optional) Choose the Management Subnet Mask from the drop-down list.
d) Click OK.

A confirmation dialog box appears.

Note For the Firepower 2100: This model does not use the boot image location; packages are managed
by FXOS.

For all other models: This action also clears the location of the boot image, if present, along
with the rest of the configuration. The Configuration > Device Management > System
Image/Configuration > Boot Image/Configuration pane lets you boot from a specific image,
including an image on the external memory. The next time you reload the ASA after restoring
the factory configuration, it boots from the first image in internal flash memory; if you do not
have an image in internal flash memory, the ASA does not boot.

e) Click Yes.

f) After you restore the default configuration, save this configuration to internal flash memory. Choose File
> Save Running Configuration to Flash.

Choosing this option saves the running configuration to the default location for the startup configuration,
even if you have previously configured a different location. When the configuration was cleared, this path
was also cleared.

Restore the ASAv Deployment Configuration

Step 1

Step 2

Step 3

This section describes how to restore the ASAv deployment (Day 0) configuration.

Procedure

For failover, power off the standby unit.

To prevent the standby unit from becoming active, you must power it off. If you leave it on, when you erase
the active unit configuration, then the standby unit becomes active. When the former active unit reloads and
reconnects over the failover link, the old configuration will sync from the new active unit, wiping out the
deployment configuration you wanted.

Restore the deployment configuration after you reload. For failover, enter this command on the active unit:
write erase

Note The ASAv boots the current running image, so you are not reverted to the original boot image. To
use the original boot image, see the boot image command.

Do not save the configuration.

Reload the ASAv and load the deployment configuration:
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reload

Step 4 For failover, power on the standby unit.

After the active unit reloads, power on the standby unit. The deployment configuration will sync to the standby
unit.

ASA 5506-X Series Default Configuration

The default factory configuration for the ASA 5506-X series configures the following:

* Integrated Routing and Bridging functionality—GigabitEthernet 1/2 through 1/8 belong to bridge group
1; Bridge Virtual Interface (BVI) 1

* inside --> outside traffic flow—GigabitEthernet 1/1 (outside), BVI 1 (inside)

* outside IP address from DHCP, inside IP address—192.168.1.1

* (ASA 5506W-X) wifi <--> inside, wifi --> outside traffic flow—GigabitEthernet 1/9 (wifi)
* (ASA 5506W-X) wifi IP address—192.168.10.1

* DHCP for clients on inside and wifi. The access point itself and all its clients use the ASA as the DHCP
server.

» Management 1/1 interface is Up, but otherwise unconfigured. The ASA FirePOWER module can then
use this interface to access the ASA inside network and use the inside interface as the gateway to the
Internet.

* ASDM access—inside and wifi hosts allowed.

* NAT—Interface PAT for all traffic from inside, wifi, and management to outside.

The configuration consists of the following commands:

interface Managementl/1
management-only
no nameif
no security-level
no ip address
no shutdown

interface GigabitEthernetl/1
nameif outside
security-level O
ip address dhcp setroute
no shutdown

|

interface GigabitEthernetl/2
nameif inside 1
security-level 100
bridge-group 1
no shutdown

interface GigabitEthernetl/3
nameif inside 2
security-level 100
no shutdown
bridge-group 1
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interface GigabitEthernetl/4

nameif inside 3

security-level 100

no shutdown

bridge-group 1
interface GigabitEthernetl/5

nameif inside 4

security-level 100

no shutdown

bridge-group 1
interface GigabitEthernetl/6

nameif inside 5

security-level 100

no shutdown

bridge-group 1
interface GigabitEthernetl/7

nameif inside 6

security-level 100

no shutdown

bridge-group 1
interface GigabitEthernetl/8

nameif inside 7

security-level 100

no shutdown

bridge-group 1
|
interface bvi 1

nameif inside

security-level 100

ip address 192.168.1.1 255.255.255.0
|
object network obj anyl

subnet 0.0.0.0 0.0.0.0

nat (inside_1,outside) dynamic interface
object network obj any2

subnet 0.0.0.0 0.0.0.0

nat (inside_2,outside) dynamic interface
object network obj any3

subnet 0.0.0.0 0.0.0.0

nat (inside_3,outside) dynamic interface
object network obj any4

subnet 0.0.0.0 0.0.0.0

nat (inside_4,outside) dynamic interface
object network obj any5

subnet 0.0.0.0 0.0.0.0

nat (inside_5,outside) dynamic interface
object network obj any6

subnet 0.0.0.0 0.0.0.0

nat (inside_ 6,outside) dynamic interface
object network obj any7

subnet 0.0.0.0 0.0.0.0

nat (inside_7,outside) dynamic interface
|
same-security-traffic permit inter-interface
|

http server enable

http 192.168.1.0 255.255.255.0 inside 1
http 192.168.1.0 255.255.255.0 inside 2
http 192.168.1.0 255.255.255.0 inside 3
http 192.168.1.0 255.255.255.0 inside 4
http 192.168.1.0 255.255.255.0 inside 5
http 192.168.1.0 255.255.255.0 inside 6

1.0 255.255.255.0 inside 7

http 192.168.
I
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dhcpd auto_config outside

dhcpd address 192.168.1.5-192.168.1.254 inside
dhcpd enable inside

|

logging asdm informational

For the ASA 5506W-X, the following commands are also included:

interface GigabitEthernet 1/9
security-level 100
nameif wifi
ip address 192.168.10.1 255.255.255.0

no shutdown

|

object network obj any wifi
subnet 0.0.0.0 0.0.0.0

nat (wifi,outside) dynamic interface
|

http 192.168.10.0 255.255.255.0 wifi
|

dhcpd address 192.168.10.2-192.168.10.254 wifi
dhcpd enable wifi

ASA 5508-X and 5516-X Default Configuration

The default factory configuration for the ASA 5508-X and 5516-X configures the following:
* inside --> outside traffic flow—GigabitEthernet 1/1 (outside), GigabitEthernet 1/2 (inside)
« outside IP address from DHCP
« inside IP address—192.168.1.1
* DHCP server on inside.
* Default route from outside DHCP

» Management 1/1 interface is Up, but otherwise unconfigured. The ASA FirePOWER module can then
use this interface to access the ASA inside network and use the inside interface as the gateway to the
Internet.

* ASDM access—inside hosts allowed.

* NAT—Interface PAT for all traffic from inside and management to outside.

The configuration consists of the following commands:

interface Managementl/1
management-only
no nameif
no security-level
no ip address
no shutdown

interface GigabitEthernetl/1
nameif outside
security-level 0
ip address dhcp setroute
no shutdown
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interface GigabitEthernetl/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
|
object network obj any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface
|
http server enable
http 192.168.1.0 255.255.255.0 inside
|

dhcpd auto_config outside

dhcpd address 192.168.1.5-192.168.1.254 inside
dhcpd enable inside

|

logging asdm informational

ASA 5512-X through ASA 5585-X Default Configuration

The default factory configuration for the ASA 5512-X through ASA 5585-X configures the following:
» Management interface—Management 0/0 (management).
* [P address—The management address is 192.168.1.1/24.

* DHCP server—Enabled for management hosts so that a computer connecting to the management interface
receives an address between 192.168.1.2 and 192.168.1.254.

» ASDM access—Management hosts allowed.

The configuration consists of the following commands:

interface management 0/0
ip address 192.168.1.1 255.255.255.0
nameif management
security-level 100
no shutdown
|
asdm logging informational
asdm history enable
|
http server enable
http 192.168.1.0 255.255.255.0 management
|
dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management

Firepower 2100 Default Configuration

ASA Configuration
The default factory configuration for the ASA on the Firepower 2100 configures the following:

« inside—outside traffic flow—Ethernet 1/1 (outside), Ethernet 1/2 (inside)
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« outside IP address from DHCP, inside IP address—192.168.1.1

* DHCP server on inside interface

+ Default route from outside DHCP

* management—Management 1/1 (management), IP address 192.168.45.1
* ASDM access—Management hosts allowed.

* NAT—Interface PAT for all traffic from inside to outside.

» FXOS management traffic initiation—The FXOS chassis can initiate management traffic on the ASA
outside interface.

* DNS servers—OpenDNS servers are pre-configured.
The configuration consists of the following commands:

interface Managementl/1
management-only
nameif management
security-level 100
ip address 192.168.45.1 255.255.255.0
no shutdown
|
interface Ethernetl/1
nameif outside
security-level 0
ip address dhcp setroute
no shutdown
|
interface Ethernetl/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
|
object network obj any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface
|
http server enable
http 192.168.45.0 255.255.255.0 management
|
dhcpd auto config outside
dhcpd address 192.168.1.20-192.168.1.254 inside
dhcpd enable inside
|
ip-client outside
|
dns domain-lookup outside
dns server-group DefaultDNS
name-server 208.67.222.222 outside
name-server 208.67.220.220 outside

FXO0S Configuration
The default factory configuration for FXOS on the Firepower 2100 configures the following:
» Management 1/1—IP address 192.168.45.45
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* Default gateway—ASA data interfaces

» Firepower Chassis Manager and SSH access—From the management network only.
« Default Username—admin, with the default password Admin123

* DHCP server—Client IP address range 192.168.45.10-192.168.45.12

* NTP server—Cisco NTP servers: 0.sourcefire.pool.ntp.org, 1.sourcefire.pool.ntp.org,
2.sourcefire.pool.ntp.org

* DNS Servers—OpenDNS: 208.67.222.222, 208.67.220.220
» Ethernet 1/1 and Ethernet 1/2—Enabled

Firepower 4100/9300 Chassis Default Configuration

When you deploy the ASA on the Firepower 4100/9300 chassis, you can pre-set many parameters that let
you connect to the Management interface using ASDM. A typical configuration includes the following settings:

» Management interface:
* Management type interface of your choice defined on the Firepower 4100/9300 Chassis supervisor
* Named “management”
* [P address of your choice
* Security level 0

* Management-only

* Default route through the management interface

» ASDM access—All hosts allowed.

The configuration for a standalone unit consists of the following commands. For additional configuration for
clustered units, see Create an ASA Cluster, on page 422.

interface <management ifc>
management-only
ip address <ip address> <mask>
ipv6 address <ipv6_address>
ipv6 enable
nameif management
security-level 0
no shutdown
!
http server enable
http 0.0.0.0 0.0.0.0 management
http ::/0 management
!
route management 0.0.0.0 0.0.0.0 <gateway ip> 1
ipv6 route management ::/0 <gateway ipvé6>
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ISA 3000 Default Configuration

The default factory configuration for the ISA 3000 configures the following:

» Transparent firewall mode—A transparent firewall is a Layer 2 firewall that acts like a “bump in the
wire,” or a “stealth firewall,” and is not seen as a router hop to connected devices.

« 1 Bridge Virtual Interface—All member interfaces are in the same network (IP address not
pre-configured; you must set to match your network): GigabitEthernet 1/1 (outsidel), GigabitEthernet
1/2 (insidel), GigabitEthernet 1/3 (outside2), GigabitEthernet 1/4 (inside2)

« All inside and outside interfaces can communicate with each other.
» Management 1/1 interface—192.168.1.1/24 for ASDM access.

* DHCP for clients on management.

» ASDM access—Management hosts allowed.

» Hardware bypass is enabled for the following interface pairs: GigabitEthernet 1/1 & 1/2; GigabitEthernet
1/3 & 1/4

N

Note When the ISA 3000 loses power and goes into hardware bypass mode, only the
above interface pairs can communicate; insidel and inside2, and outsidel and
outside2 can no longer communicate. Any existing connections between these
interfaces will be lost. When the power comes back on, there is a brief connection
interruption as the ASA takes over the flows.

» ASA FirePOWER module—All traffic is sent to the module in Inline Tap Monitor-Only Mode. This
mode sends a duplicate stream of traffic to the ASA Firepower module for monitoring purposes only.

* Precision Time Protocol—PTP traffic is not sent to the FirePOWER module.

The configuration consists of the following commands:

firewall transparent

interface GigabitEthernetl/1
bridge-group 1
nameif outsidel
security-level 0
no shutdown

interface GigabitEthernetl/2
bridge-group 1
nameif insidel
security-level 100
no shutdown

interface GigabitEthernetl/3
bridge-group 1
nameif outside?2
security-level 0
no shutdown

interface GigabitEthernetl/4
bridge-group 1
nameif inside2
security-level 100
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no shutdown
interface Managementl/1

management-only

no shutdown

nameif management

security-level 100

ip address 192.168.1.1 255.255.255.0
interface BVIL

no ip address

access-list allowAll extended permit ip any any
access-group allowAll in interface outsidel
access-group allowAll in interface outside2

same-security-traffic permit inter-interface

hardware-bypass GigabitEthernet 1/1-1/2
hardware-bypass GigabitEthernet 1/3-1/4

http server enable
http 192.168.1.0 255.255.255.0 management

dhcpd address 192.168.1.5-192.168.1.254 management

dhcpd enable management

access-list sfrAccessList extended permit ip any any
class-map sfrclass
match access-1list sfrAccessList
policy-map global policy
class sfrclass
sfr fail-open monitor-only
service-policy global policy global

ASAv Deployment Configuration

When you deploy the ASAv, you can pre-set many parameters that let you connect to the Management 0/0
interface using ASDM. A typical configuration includes the following settings:

* Routed or Transparent firewall mode

* Management 0/0 interface:

* Named “management”
* IP address or DHCP

* Security level 0

» Static route for the management host IP address (if it is not on the management subnet)

* HTTP server enabled or disabled

* HTTP access for the management host IP address

* (Optional) Failover link IP addresses for GigabitEthernet 0/8, and the Management 0/0 standby IP address
* DNS server

* Smart licensing ID token
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* Smart licensing Throughput Level and Standard Feature Tier
* (Optional) Smart Call Home HTTP Proxy URL and port

* (Optional) SSH management settings:
* Client IP addresses

* Local username and password

* Authentication required for SSH using the LOCAL database
* (Optional) REST API enabled or disabled

N

Note To successfully register the ASAv with the Cisco Licensing Authority, the ASAv requires Internet access.
You might need to perform additional configuration after deployment to achieve Internet access and successful
license registration.

See the following sample configuration for a standalone unit:

interface Management0/0
nameif management
security-level 0
ip address ip address

no shutdown
http server enable
http managemment host IP mask management
route management management host IP mask gateway ip 1
dns server-group DefaultDNS
name-server ip address
call-home
http-proxy ip address port port
license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id token
aaa authentication ssh console LOCAL
username username password password
ssh source IP address mask management
rest-api image boot:/path
rest-api agent

See the following sample configuration for a primary unit in a failover pair:

nameif management
security-level 0
ip address ip address standby standby ip

no shutdown
route management management host IP mask gateway ip 1
http server enable
http managemment host IP mask management
dns server-group DefaultDNS
name-server ip address
call-home
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http-proxy ip address port port
license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id token
aaa authentication ssh console LOCAL
username username password password
ssh source IP address mask management
rest-api image boot:/path
rest-api agent
failover
failover lan unit primary
failover lan interface fover gigabitethernet0/8
failover link fover gigabitethernet0/8
failover interface ip fover primary ip mask standby standby ip

Get Started with the Configuration

N

To configure and monitor the ASA, perform the following steps.

Note

Step 1
Step 2

Step 3
Step 4

Step 5
Step 6
Step 7

Step 8

ASDM supports up to a maximum of a 512 KB configuration. If you exceed this amount, you may experience
performance issues. See Increase the ASDM Configuration Memory, on page 36.

Procedure

For initial configuration using the Startup Wizard, choose Wizards > Startup Wizard.

To use the IPsec VPN Wizard to configure IPsec VPN connections, choose Wizards > IPsec VPN Wizard
and complete each screen that appears.

To use the SSL VPN Wizard to configure SSL VPN connections, choose Wizards > SSL VPN Wizard and
complete each screen that appears.

To configure high availability and scalability settings, choose Wizards > High Availability and Scalability
Wizard.

To use the Packet Capture Wizard to configure packet capture, choose Wizards > Packet Capture Wizard.
To display different colors and styles available in the ASDM GUI, choose View > Office Look and Feel.

To configure features, click the Configuration button on the toolbar and then click one of the feature buttons
to display the associated configuration pane.

Note If the Configuration screen is blank, click Refresh on the toolbar to display the screen content.

To monitor the ASA, click the Monitoring button on the toolbar and then click a feature button to display
the associated monitoring pane.
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Use the Command Line Interface Tool in ASDM

This section tells how to enter commands using ASDM, and how to work with the CLI.

Use the Command Line Interface Tool

Step 1

Step 2

Step 3
Step 4
Step 5

This feature provides a text-based tool for sending commands to the ASA and viewing the results.

The commands you can enter with the CLI tool depend on your user privileges. Review your privilege level
in the status bar at the bottom of the main ASDM application window to ensure that you have the required
privileges to execute privileged-level CLI commands.

Before you begin

» Commands entered via the ASDM CLI tool might function differently from those entered through a
terminal connection to the ASA.

» Command errors—If an error occurs because you entered an incorrect command, the incorrect command
is skipped and the remaining commands are processed. A message appears in the Response area to inform
you whether or not any error occurred, as well as other related information.

* Interactive commands—Interactive commands are not supported in the CLI tool. To use these commands
in ASDM, use the noconfirm keyword if available, as shown in the following command:

crypto key generate rsa modulus 1024 noconfirm

* Avoid conflicts with other administrators—Multiple administrative users can update the running
configuration of the ASA. Before using the ASDM CLI tool to make configuration changes, check for
other active administrative sessions. If more than one user is configuring the ASA at the same time, the
most recent changes take effect.

To view other administrative sessions that are currently active on the same ASA, choose Monitoring >
Properties > Device Access.

Procedure

In the main ASDM application window, choose Tools > Command Line Interface.

The Command Line Interface dialog box appears.

Choose the type of command (single line or multiple line) that you want, and then choose the command from
the drop-down list, or type it in the field provided.

Click Send to execute the command.
To enter a new command, click Clear Response, and then choose (or type) another command to execute.

Check the Enable context-sensitive help (?) check box to provide context-sensitive help for this feature.
Uncheck this check box to disable the context-sensitive help.
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Step 6 After you have closed the Command Line Interface dialog box, if you changed the configuration, click
Refresh to view the changes in ASDM.

Show Commands Ignored by ASDM on the Device

This feature lets you show the list of commands that ASDM does not support. Typically, ASDM ignores them.
ASDM does not change or remove these commands from your running configuration. See Unsupported
Commands, on page 89 for more information.

Procedure

Step 1 In the main ASDM application window, choose Tools > Show Commands Ignored by ASDM on Device.
Step 2 Click OK when you are done.

Apply Configuration Changes to Connections

When you make security policy changes to the configuration, all new connections use the new security policy.
Existing connections continue to use the policy that was configured at the time of the connection establishment.
show command output for old connections reflect the old configuration, and in some cases will not include
data about the old connections.

For example, if you remove a QoS service-policy from an interface, then re-add a modified version, then the
show service-policy command only displays QoS counters associated with new connections that match the
new service policy; existing connections on the old policy no longer show in the command output.

To ensure that all connections use the new policy, you need to disconnect the current connections so that they
can reconnect using the new policy.

To disconnect connections, enter one of the following commands:
» clear local-host [ip_address] [all]

This command reinitializes per-client run-time states such as connection limits and embryonic limits.
As a result, this command removes any connection that uses those limits. See the show local-host all
command to view all current connections per host.

With no arguments, this command clears all affected through-the-box connections. To also clear to-the-box
connections (including your current management session), use the all keyword. To clear connections to
and from a particular IP address, use the ip_address argument.

« clear conn [all] [protocol {tcp | udp}] [address src_ip [-src_ip] [netmask mask]] [port src_port
[-src_port]] [address dest_ip [-dest_ip] [netmask mask]] [port dest_port [-dest_port]]

This command terminates connections in any state. See the show conn command to view all current
connections.

With no arguments, this command clears all through-the-box connections. To also clear to-the-box
connections (including your current management session), use the all keyword. To clear specific
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connections based on the source IP address, destination IP address, port, and/or protocol, you can specify
the desired options.
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ASDM Graphical User Interface

This chapter describes how to use the ASDM user interface.

» About the ASDM User Interface, on page 55

* Navigate the ASDM User Interface, on page 58

* Menus, on page 59

* Toolbar, on page 64

* ASDM Assistant, on page 65

* Status Bar, on page 66

* Device List, on page 66

* Common Buttons, on page 67

» Keyboard Shortcuts, on page 68

* Find Function in ASDM Panes, on page 70

* Find Function in Rule Lists, on page 70

* Enable Extended Screen Reader Support, on page 71
* Organizational Folder, on page 71

* Home Pane (Single Mode and Context), on page 72
* Home Pane (System), on page 85

* Define ASDM Preferences, on page 86

* Search with the ASDM Assistant, on page 88

* Enable History Metrics, on page 89

» Unsupported Commands, on page 89

About the ASDM User Interface

The ASDM user interface is designed to provide easy access to the many features that the ASA supports. The
ASDM user interface includes the following elements:

* A menu bar that provides quick access to files, tools, wizards, and help. Many menu items also have
keyboard shortcuts.

* A toolbar that enables you to navigate ASDM. From the toolbar you can access the Home, Configuration,
and Monitoring panes. You can also get help and navigate between panes.

* A dockable left Navigation pane to move through the Configuration and Monitoring panes. You can
click one of the three buttons in the header to maximize or restore this pane, make it a floating pane that
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you can move, hide it, or close it. To access the Configuration and Monitoring panes, you can do one
of the following:

* Click links on the left side of the application window in the left Navigation pane. The Content
pane then displays the path (for example, Configuration > Device Setup > Startup Wizard) in
the title bar of the selected pane.

* If you know the exact path, you can type it directly into the title bar of the Content pane on the
right side of the application window, without clicking any links in the left Navigation pane.

» A maximize and restore button in the right corner of the Content pane that lets you hide and show the
left Navigation pane.

* A dockable Device List pane with a list of devices that you can access through ASDM. You can click
one of the three buttons in the header to maximize or restore this pane, make it a floating pane that you
can move, hide it, or close it.

* A status bar that shows the time, connection status, user, memory status, running configuration status,
privilege level, and SSL status at the bottom of the application window.

* A left Navigation pane that shows various objects that you can use in the rules tables when you create
access rules, NAT rules, AAA rules, filter rules, and service rules. The tab titles within the pane change
according to the feature that you are viewing. In addition, the ASDM Assistant appears in this pane.

The following figure shows the elements of the ASDM user interface.
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About the ASDM User Interface .
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GUI Element Description
7 Content Pane
8 Status Bar

\}

Note  Tool tips have been added for various parts of the GUI, including Wizards, the Configuration and Monitoring
panes, and the Status Bar. To view tool tips, hover your mouse over a specific user interface element, such
as an icon in the status bar.

Navigate the ASDM User Interface

To move efficiently throughout the ASDM user interface, you may use a combination of menus, the toolbar,
dockable panes, and the left and right Navigation panes, which are described in the previous section. The
available functions appear in a list of buttons below the Device List pane. An example list could include the
following function buttons:

« Device Setup

* Firewall

* Botnet Traffic Filter
» Remote Access VPN
» Site to Site VPN

« Device Management
The list of function buttons that appears is based on the licensed features that you have purchased. Click each

button to access the first pane in the selected function for either the Configuration view or the Monitoring
view. The function buttons are not available in the Home view.

To change the display of function buttons, perform the following steps:

Procedure

Step 1 Choose the drop-down list below the last function button to display a context menu.

Step 2 Choose one of the following options:
¢ Click Show More Buttons to show more buttons.
« Click Show Fewer Buttons to show fewer buttons.

« Click Add or Remove Buttons to add or remove buttons, then click the button to add or remove from
the list that appears.

« Choose Option to display the Option dialog box, which displays a list of the buttons in their current
order. Then choose one of the following:

* Click Move Up to move up a button in the list.
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* Click Move Down to move down a button in the list.

* Click Reset to return the order of the items in the list to the default setting.

Click OK to save your settings and close this dialog box.

You can access ASDM menus using the mouse or keyboard.

The File menu lets you manage ASA configurations.

File Menu Item

Description

Refresh ASDM with the Running
Configuration on the Device

Loads a copy of the running configuration into ASDM.

Reset Device to the Factory
Default Configuration

Restores the configuration to the factory default.

Show Running Configuration in
New Window

Displays the current running configuration in a new window.

Save Running Configuration to
Flash

Writes a copy of the running configuration to flash memory.

Save Running Configuration to
TFTP Server

Stores a copy of the current running configuration file on a TFTP server.

Save Running Configuration to
Standby Unit

Sends a copy of the running configuration file on the primary unit to
the running configuration of a failover standby unit.

Save Internal Log Buffer to Flash

Saves the internal log buffer to flash memory.

Deploy FirePOWER Changes

Saves configuration changes made to ASA FirePOWER module policies
to the module. This option is available only if you install an ASA
FirePOWER module and manage it through ASDM.

Print

Prints the current page. We recommend landscape page orientation when
you print rules. When you use Internet Explorer, permission to print
was already granted when you originally accepted the signed applet.

Clear ASDM Cache

Removes local ASDM images. ASDM downloads images locally when
you connect to ASDM.

Clear ASDM Password Cache

Removes the password cache if you have defined a new password and
still have a existing password that is different than the new password.
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Clear Internal Log Buffer Empties the syslog message buffer.
Exit Closes ASDM.

View Menu

The View menu lets you display various parts of the ASDM user interface. Certain items are dependent on
the current view. You cannot select items that cannot be displayed in the current view.

View Menu ltem Description

Home Displays the Home view.

Configuration Displays the Configuration view.

Monitoring Displays the Monitoring view.

Device List Displays a list of devices in a dockable pane.
Navigation Shows and hides the display of the Navigation pane

in the Configuration and Monitoring views.

ASDM Assistant Searches and finds useful ASDM procedural help
about certain tasks.

Latest ASDM Syslog Messages Shows and hides the display of the Latest ASDM
Syslog Messages pane in the Home view. This pane
is only available in the Home view. If you do not have
sufficient memory to upgrade to the most current
release, syslog message %ASA-1-211004 is generated,
indicating what the installed memory is and what the
required memory is. This message reappears every
24 hours until the memory is upgraded.

Addresses Shows and hides the display of the Addresses pane.
The Addresses pane is only available for the Access
Rules, NAT Rules, Service Policy Rules, AAA
Rules, and Filter Rules panes in the Configuration
view.

Services Shows and hides the display of the Services pane.
The Services pane is only available for the Access
Rules, NAT Rules, Service Policy Rules, AAA
Rules, and Filter Rules panes in the Configuration
view.

Time Ranges Shows and hides the display of the Time Ranges
pane. The Time Ranges pane is only available for the
Access Rules, Service Policy Rules, AAA Rules,
and Filter Rules panes in the Configuration view.
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View Menu Item

Description

Select Next Pane

Highlights the next pane shown in a multi-pane
display, for example, going from the Service Policies
Rules pane to the Address pane beside it.

Select Previous Pane

Highlights the previous pane shown in multi-pane
displays.

Back Returns to the previous pane.
Forward Goes to the next pane previously visited.
Find in ASDM Locates an item for which you are searching, such as

a feature or the ASDM Assistant.

Reset Layout

Returns the layout to the default configuration.

Office Look and Feel

Changes the screen fonts and colors to the Microsoft
Office settings.

The Tools menu provides you with the following series of tools to use in ASDM.

Tools Menu Item

Description

Command Line Interface

Sends commands to the ASA and view the results.

Show Commands Ignored by ASDM on Device

Displays unsupported commands that have been
ignored by ASDM.

Packet Tracer

Traces a packet from a specified source address and
interface to a destination. You can specify the protocol
and port of any type of data and view the lifespan of
a packet, with detailed information about actions taken
on it. See the firewall configuration guide for more
information.

Ping

Verifies the configuration and operation of the ASA
and surrounding communications links, as well as

performs basic testing of other network devices. See
the firewall configuration guide for more information.

Traceroute

Determines the route that packets will take to their
destination. See the firewall configuration guide for
more information.

File Management

Views, moves, copies, and deletes files stored in flash
memory. You can also create a directory in flash
memory. You can also transfer files between various
file systems, including TFTP, flash memory, and your
local PC.
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Tools Menu Item

Description

Check for ASA/ASDM Updates

Upgrades ASA software and ASDM software through
a wizard.

Upgrade Software from Local Computer

Uploads an ASA image, ASDM image, or another
image on your PC to flash memory.

Downgrade Software

Loads an older ASA image than the one you are
currently running.

Backup Configurations

Backs up the ASA configuration, a Cisco Secure
Desktop image, and SSL VPN Client images and
profiles.

Restore Configurations

Restores the ASA configuration, a Cisco Secure
Desktop image, and SSL VPN Client images and
profiles.

System Reload

Restarts the ASDM and reload the saved configuration
into memory.

Administrator’s Alert to Clientless SSL VPN Users

Enables an administrator to send an alert message to
clientless SSL VPN users. See the VPN configuration
guide for more information.

Migrate Network Object Group Members

If you migrate to 8.3 or later, the ASA creates named
network objects to replace inline IP addresses in some
features. In addition to named objects, ASDM
automatically creates non-named objects for any

IP addresses used in the configuration. These
auto-created objects are identified by the |P address
only, do not have a name, and are not present as
named objects in the platform configuration.

When the ASA creates named objects as part of the
migration, the matching non-named ASDM-only
objects are replaced with the named objects. The only
exception are non-named objects in a network object
group. When the ASA creates named objects for IP
addresses that are inside a network object group,
ASDM retains the non-named objects as well, creating
duplicate objects in ASDM. Choose Tools > Migrate
Network Object Group Members to merge these
object.

See Cisco ASA 5500 Migration to Version 8.3 and
Later for more information.

Preferences

Changes the behavior of specified ASDM functions
between sessions.

ASDM Java Console

Shows the Java console.
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Wizards Menu

Wizards Menu .

The Wizards menu lets you run a wizard to configure multiple features.

Wizards Menu Item

Description

Startup Wizard Guides you, step-by-step, through the initial
configuration of the ASA.
VPN Wizards There are separate wizards for a variety of VPN

configurations. See the VPN configuration guide for
more information.

High Availability and Scalability Wizard

Allows you to configure failover: VPN cluster load
balancing, or ASA clustering on the ASA.

Unified Communication Wizard

Enables you to configure unified communication
features, such as an IP phone, on the ASA. See the
firewall configuration guide for more information.

ASDM ldentity Certificate Wizard

When using Java 7 update 51 and later, the ASDM
Launcher requires a trusted certificate. An easy
approach to fulfill the certificate requirements is to
install a self-signed identity certificate. You can use
Java Web Start to launch ASDM until you install a
certificate using this wizard. See
http://www.cisco.com/go/asdm-certificate for more
information.

Packet Capture Wizard

Allows you to configure packet capture on the ASA.
The wizard runs one packet capture on each ingress
and egress interface. After you run the capture, you
can save it on your computer, and then examine and
analyze the capture with a packet analyzer.

Window Menu

The Window menu enables you to move between ASDM windows. The active window appears as the selected

window.

Help Menu

The Help menu provides links to online help, as well as information about ASDM and the ASA.

Help Menu ltems

Description

Help Topics

Opens a new browser window to show the ASDM
online help. If you are managing an ASA FirePOWER
module in ASDM, this item is labeled ASDM Help
Topics.
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Help Menu ltems

Description

ASA FirePOWER Help Topics

Opens a new browser window to show online help
for the ASA FirePOWER module. This item is
available only if you have installed the module and
are managing it in ASDM.

Help for Current Screen

Opens context-sensitive help about the screen you are
viewing. Alternatively, you can also click the ? Help
button in the tool bar.

Release Notes

Opens the most current version of the ASDM release
notes on Cisco.com. The release notes contain the
most current information about ASDM software and
hardware requirements, and the most current
information about changes in the software.

Cisco ASA Series Documentation

Opens a document on Cisco.com that includes links
to all of the available product documentation.

ASDM Assistant

Opens the ASDM Assistant, which lets you search
downloadable content from Cisco.com, with details
about performing certain tasks.

About Cisco Adaptive Security Appliance (ASA)

Displays information about the ASA, including the
software version, hardware set, configuration file
loaded at startup, and software image loaded at startup.
This information is helpful in troubleshooting.

About Cisco ASDM

Displays information about ASDM such as the
software version, hostname, privilege level, operating
system, device type, and Java version.

The Toolbar below the menus provides access to the Home view, Configuration view, and Monitoring view.
It also lets you choose between the system and security contexts in multiple context mode, and provides

navigation and other commonly used features.

Toolbar Button Description

Home Displays the Home pane, which lets you view important information about your

Home pane.

ASA such as the status of your interfaces, the version you are running, licensing
information, and performance. In multiple mode, the system does not have a

Configuration
configure that function.

Configures the ASA. Click a function button in the left Navigation pane to

Monitoring
various elements.

Monitors the ASA. Click a function button in the left Navigation pane to monitor
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Toolbar Button

Description

Save

Saves the running configuration to the startup configuration for write-accessible
contexts only.

The button is replaced by the Deploy button if you have an ASA FirePOWER
module installed on the device and you are configuring it through ASDM.

Deploy

If you have an ASA FirePOWER module installed on the device and you are
configuring it through ASDM, the Deploy button replaces the Save button and
contains the following options:

* Deploy FirePOWER Changes—Saves configuration changes made to
ASA FirePOWER module policies to the module.

+ Save Running Configuration to Flash—Writes a copy of the ASA running
configuration to flash memory. This is equivalent to the Save button for
devices that do not include an ASA FirePOWER module.

Refresh

Refreshes ASDM with the current running configuration, except for graphs in
any of the Monitoring panes.

Back

Returns to the last pane of ASDM that you visited.

Forward

Goes forward to the last pane of ASDM that you visited.

Help

Shows context-sensitive help for the screen that is currently open.

Search

Searches for a feature in ASDM. The Search function looks through the titles of
each pane and presents you with a list of matches, and gives you a hyperlink
directly to that pane. Click Back or Forward to switch quickly between two
different panes that you found.

ASDM Assistant

The ASDM Assistant lets you search and view useful ASDM procedural help about certain tasks. This feature
is available in routed and transparent modes, and in the single and system contexts.

ChooseView > ASDM Assistant > How Do 1? or enter a search request from the Look For field in the menu
bar to access information. Choose How Do 1? from the Find drop-down list to begin the search.

To use the ASDM Assistant, perform the following steps:

Procedure

Step 1 Choose View > ASDM Assistant.

The ASDM Assistant pane appears.

Step 2 Enter the information that you want to find in the Search field, then click Go.

The requested information appears in the Search Results pane.
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Step 3 Click any links that appear in the Search Results and Features areas to obtain more details.

Status Bar

The Status Bar appears at the bottom of the ASDM window. The following table lists the areas shown from

left to right.

Area Description

Status The status of the configuration (for example, “Device
configuration loaded successfully.”)

Failover The status of the failover unit, either active or standby.

User Name The username of the ASDM user. If you logged in
without a username, the username is “admin.”

User Privilege The privilege of the ASDM user.

Commands Ignored by ASDM Click the icon to show a list of commands from your
configuration that ASDM did not process. These
commands will not be removed from the
configuration.

Connection to Device The ASDM connection status to the ASA.

Syslog Connection The syslog connection is up, and the ASA is being
monitored.

SSL Secure The connection to ASDM is secure because it uses
SSL.

Time The time that is set on the ASA.

Connection to Device

ASDM maintains a constant connection to the ASA to maintain up-to-date Monitoring and Home pane data.
This dialog box shows the status of the connection. When you make a configuration change, ASDM opens a
second connection for the duration of the configuration, and then closes it; however, this dialog box does not
represent the second connection.

Device List

The Device List is a dockable pane. You can click one of the three buttons in the header to maximize or restore
this pane, make it a floating pane that you can move, hide it, or close it. This pane is available in the Home,
Configuration, Monitoring, and System views. You can use this pane to switch to another device, and between
the System and contexts; however, that device must run the same version of ASDM that you are currently
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Step 1

Step 2
Step 3
Step 4

Step 5

Common Buttons .

running. To display the pane fully, you must have at least two devices listed. This pane is available in routed
and transparent modes, and in the single, multiple, and system contexts.

To use this pane to connect to another device, perform the following steps:

Procedure

Click Add to add another device to the list.
The Add Device dialog box appears.
Enter the device name or IP address of the device, then click OK.

Click Delete to remove a selected device from the list.
Click Connect to connect to another device.

The Enter Network Password dialog box appears.

Enter your username and password in the applicable fields, then click Login.

Common Buttons

Many ASDM panes include buttons that are listed in the following table. Click the applicable button to
complete the desired task:

Button Description

Apply Sends changes made in ASDM to the ASA and applies
them to the running configuration.

Save Writes a copy of the running configuration to flash
memory.

Reset Discards changes and reverts to the information

displayed before changes were made or the last time
that you clicked Refresh or Apply. After you click
Reset, click Refresh to make sure that information
from the current running configuration appears.

Restore Default Clears the selected settings and returns to the default
settings.

Cancel Discards changes and returns to the previous pane.

Enable Displays read-only statistics for a feature.

Close Closes an open dialog box.

Clear Remove information from a field, or remove a check

from a check box.

Back Returns to the previous pane.
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Button Description
Forward Goes to the next pane.
Help Displays help for the selected pane or dialog box.

Keyboard Shortcuts

You can use the keyboard to navigate the ASDM user interface.

The following table lists the keyboard shortcuts you can use to move across the three main areas of the ASDM

user interface.

Table 2: Keyboard Shortcuts Within the Main Window

To display the Windows/Linux Mac0S

Home Pane Ctrl+H Shift+Command+H
Configuration Pane Ctrl+G Shift+Command+G
Monitoring Pane Ctrl+M Shift+Command+M
Help F1 Command+?

Back Alt+Left Arrow Command+]|
Forward Alt+Rightarrow Command+]
Refresh the display F5 Command+R

Cut Ctrl+X Command+X

Copy Ctrl+C Command+C

Paste Ctrl+V Command+V

Save the configuration Ctrl+S Command+S
Popup menus Shift+F10

Close a secondary window Alt+F4 Command+W

Find Ctrl+F Command+F

Exit Alt+F4 Command+Q

Exit a table or text area

Ctrl_Shift or Ctrl+Shift+Tab

Ctril+Shift or Ctrl+Shift+Tab

The following table lists the keyboard shortcut you can use to navigate within a pane.
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Table 3: Keyboard Shortcuts Within a Pane

To move the focus to the Press

Next field Tab
Previous field Shift+Tab
Next field when the focus is in a table Ctrl+Tab
Previous field when the focus is in a table Shift+Ctrl+Tab
Next tab (when a tab has the focus) Right Arrow
Previous tab (when a tab has the focus) Left Arrow
Next cell in a table Tab
Previous sell in a table Shift+Tab
Next pane (when multiple panes are displayed) F6

Previous pane (when multiple panes are displayed) | Shift+F6

The following table lists the keyboard shortcuts you can use with the Log Viewers.

Table 4: Keyboard Shortcuts for the Log Viewer

To Windows/Linux Mac0S

Pause and Resume Real-Time Log | Ctrl+U Command+
Viewer

Refresh Log Buffer Pane F5 Command+R
Clear Internal Log Buffer Ctrl+Delete Command+Delete
Copy Selected Log Entry Ctrl+C Command+C
Save Log Ctrl+S Command+S
Print Ctrl+P Command+P
Close a secondary window Alt+F4 Command+W

The following table lists the keyboard shortcuts you can use to access menu items.

Table 5: Keyboard Shortcuts to Access Menu Items

To access the Windows/Linux
Menu Bar Alt

Next Menu Right Arrow
Previous Menu Left Arrow
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. Find Function in ASDM Panes

To access the Windows/Linux
Next Menu Option Down Arrow
Previous Menu Option Up Arrow
Selected Menu Option Enter

Find Function in ASDM Panes

Some ASDM panes contain tables with many elements. To make it easier for you to search, highlight, and
then edit a particular entry, several ASDM panes have a find function that allows you to search on objects
within those panes.

To perform a search, you can type a phrase into the Find field to search on all columns within any given pane.
The phrase can contain the wild card characters “*” and “?”. The * matches one or more characters, and ?
matches one character. The up and down arrows to the right of the Find field locate the next (up) or previous
(down) occurrence of the phrase. Check the Match Case check box to find entries with the exact uppercase
and lowercase characters that you enter.

For example, entering B*ton-L* might return the following matches:
Boston-LA, Boston-Lisbon, Boston-London
Entering Bo?ton might return the following matches:

Boston, Bolton

Find Function in Rule Lists

Step 1
Step 2

Step 3

Because ACLs and ACEs and other rules contain many elements of different types, the find function in the
any pane that displays rules allows for a more targeted search than the find function in other panes. This
includes access rules, service policy rules, the ACL Manager, and any other pane that lists ACL rules, and
also the NAT rules.

To find elements within the rule lists, perform the following steps:

Procedure

Click Find.
Choose one of the following options in the Filter field from the drop-down list.

The items you can search on differ depending on the rule type, and correspond to the columns in the table.
Select Query if you want to create a complex search that uses more than one field.

Unless you picked Query, in the second field, choose one of the following options from the drop-down list:

* is—Specifies an exact match to the search string. This is always the option for queries.
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Step 4

Step 5

Step 6
Step 7

Enable Extended Screen Reader Support .

* contains—Specifies a match to any rule that includes, whether exactly or partially, your search string.

In the third field, enter the string you want to find. Click ... to pick an object from a list. If you are using a
query, click Define Query.

If you search for an IP address, you can get matches to addresses that are in a network object or group, so
long as that object or group was created by ASDM. That is, the group name begins with DM_INLINE. The
find feature cannot find IP addresses within user-created objects.

Click Filter to perform the search.

The view is updated to show only those rules that match. The rule numbers are maintained so that you can

see their absolute location within the rule list.

Click Clear to remove the filter and see the complete list again.

When you are finished, click the red X to close the find controls.

Enable Extended Screen Reader Support

Step 1

Step 2
Step 3
Step 4

By default, labels and descriptions are not included in tab order when you press the Tab key to navigate a
pane. Some screen readers, such as JAWS, only read screen objects that have the focus. You can include the
labels and descriptions in the tab order by enabling extended screen reader support.

To enable extended screen reader support, perform the following steps:

Procedure

Choose Tools > Preferences.
The Preferences dialog box appears.
Check the Enable screen reader support check box on the General tab.

Click OK.
Restart ASDM to activate screen reader support.

Organizational Folder

Some folders in the navigation pane for the configuration and monitoring views do not have associated
configuration or monitoring panes. These folders are used to organize related configuration and monitoring
tasks. Clicking these folders displays a list of sub-items in the right Navigation pane. You can click the name
of a sub-item to go to that item.
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Home Pane (Single Mode and Context)

The ASDM Home pane lets you view important information about your ASA. Status information in the Home
pane is updated every ten seconds. This pane usually has two tabs: Device Dashboard and Firewall Dashboard.

If you have hardware or software modules installed on the device, such as IPS, CX, or ASA FirePOWER
modules, there are separate tabs for those modules.

Device Dashboard Tab

The Device Dashboard tab lets you view, at a glance, important information about your ASA, such as the
status of your interfaces, the version you are running, licensing information, and performance.

The following figure shows the elements of the Device Dashboard tab.
Figure 2: Device Dashboard Tab
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Legend

GUI Element Description

1 Device Information Pane, on page 73
2 Interface Status Pane, on page 74

3 VPN Sessions Pane, on page 74

4 Traffic Status Pane, on page 75
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Device Information Pane .

GUI Element Description
5 System Resources Status Pane, on page 74
6 Traffic Status Pane, on page 75

— Device List, on page 66

— Latest ASDM Syslog Messages Pane, on page 75

Device Information Pane
The Device Information pane includes two tabs that show device information: General tab and License tab.
Under the General tab you have access to the Environment Status button, which provides an at-a-glance
view of the system health:
General Tab
This tab shows basic information about the ASA:
» Host name—Shows the hostname of the device.
 ASA version—Lists the version of ASA software that is running on the device.
» ASDM version—Lists the version of ASDM software that is running on the device.
« Firewall mode—Shows the firewall mode in which the device is running.
« Total flash—Displays the total RAM that is currently being used.

 ASA Cluster Role—When you enable clustering, shows the role of this unit, either Master or Slave.

* Device uptime—Shows the time in which the device has been operational since the latest software
upload.

« Context mode—Shows the context mode in which the device is running.
« Total Memory—Shows the DRAM installed on the ASA.

 Environment status—Shows the system health. View hardware statistics by clicking the plus sign (+)
to the right of the Environment Status label in the General tab. You can see how many power supplies
are installed, track the operational status of the fan and power supply modules, and track the temperatures
of the CPUs and the ambient temperature of the system.

In general, the Environment Status button provides an at-a-glance view of the system health. If all
monitored hardware components within the system are operating within normal ranges, the plus sign (+)
button shows OK in green. Conversely, if any one component within the hardware system is operating
outside of normal ranges, the plus sign (+) button turns into a red circle to show Critical status and to
indicate that a hardware component requires immediate attention.

See the hardware guide for your particular device for more information about specific hardware statistics.
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\}

Note Ifyou do not have enough memory to upgrade to the most current release of the ASA, the Memory Insufficient
Warning dialog box appears. Follow the directions that appear in this dialog box to continue using the ASA
and ASDM in a supported manner. Click OK to close this dialog box.

License Tab
This tab shows a subset of licensed features. Click More Licenses to view detailed license information, or to
enter a new activation key; the Configuration > Device Management > Licensing > Activation Key pane
appears.

Cluster Tab

This tab shows the cluster interface mode, as well as the cluster status

Device Information

General  License

Cluster Interface Mode: Spanned EtherChannel

Cluster is not enabled.

Details

Virtual Resources Tab (ASAv)
This tab shows the virtual resources used by the ASAv, including the number of vCPUs, RAM, and whether

the ASAv is over- or under-provisioned.

Interface Status Pane
This pane shows the status of each interface. If you select an interface row, the input and output throughput
in Kbps displays below the table.

VPN Sessions Pane
This pane shows the VPN tunnel status. Click Details to go to the Monitoring > VPN > VPN Statistics >
Sessions pane.

Failover Status Pane
This pane shows the failover status.

Click Configure to start the High Availability and Scalability Wizard. After you have completed the wizard,
the failover configuration status (either Active/Active or Active/Standby) appears.

If failover is configured, click Details to open the Monitoring > Properties > Failover > Status pane.

System Resources Status Pane

This pane shows CPU and memory usage statistics.
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Traffic Status Pane

This pane shows graphs for connections per second for all interfaces and for the traffic throughput of the
lowest security interface.

When your configuration contains multiple lowest security level interfaces, and any one of them is named
“outside,” then that interface is used for the traffic throughput graphs. Otherwise, ASDM picks the first
interface from the alphabetical list of lowest security level interfaces.

Latest ASDM Syslog Messages Pane

This pane shows the most recent system messages generated by the ASA, up to a maximum of 100 messages.
Click Enable Logging to enable logging if it is disabled.

The following figure shows the elements of the Latest ASDM Syslog Messages pane.
Figure 3: Latest ASDM Syslog Messages Pane
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GUI Element Description

1 Drag the divider up or down to resize the pane.

2 Expands the pane. Click the double-square icon to
return the pane to the default size.

3 Makes a floating pane. Click the docked pane icon
to dock the pane.

4 Enables or disables Auto-hide. When Auto-hide is
enabled, move your cursor over the Latest ASDM
Syslog Messages button in the left, bottom corner and
the pane displays. Move your cursor away from the
pane, and it disappears.

5 Closes the pane. Choose View Latest ASDM Syslog
Messages to show the pane.

6 Click the green icon on the right-hand side to continue
updating the display of syslog messages.

7 Click the red icon on the right-hand side To stop
updating the display of syslog messages.
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. Firewall Dashboard Tab

GUI Element Description

8 Click the filters icon on the right-hand side to open
the Logging Filters pane.

* Right-click an event and choose Clear Content to clear the current messages.
* Right-click an event and click Save Content to save the current messages to a file on your PC.
* Right-click an event and choose Copy to copy the current content.

* Right-click an event and choose Color Settings to change the background and foreground colors of
syslog messages according to their severity.

Firewall Dashhoard Tab

The Firewall Dashboard tab lets you view important information about the traffic passing through your ASA.
This dashboard differs depending on whether you are in single context mode or multiple context mode. In
multiple context mode, the Firewall Dashboard is viewable within each context.

The following figure shows some of the elements of the Firewall Dashboard tab.
Figure 4: Firewall Dashboard Tab
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GUI Element Description
1 Traffic Overview Pane, on page 77
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GUI Element Description

2 Top 10 Access Rules Pane, on page 77

3 Top Usage Status Pane, on page 77

(not shown) Top Ten Protected Servers Under SYN Attack Pane,
on page 78

(not shown) Top 200 Hosts Pane, on page 78

(not shown) Top Botnet Traffic Filter Hits Pane, on page 78

Traffic Overview Pane

Enabled by default. If you disable basic threat detection (see the firewall configuration guide), then this area
includes an Enable button that lets you enable basic threat detection. The runtime statistics include the
following information, which is display-only:

* The number of connections and NAT translations.
* The rate of dropped packets per second caused by access list denials and application inspections.

* The rate of dropped packets per second that are identified as part of a scanning attack, or that are
incomplete sessions detected, such as TCP SYN attack detected or no data UDP session attack detected.

Top 10 Access Rules Pane

Enabled by default. If you disable threat detection statistics for access rules (see the firewall configuration
guide), then this area includes an Enable button that lets you enable statistics for access rules.

In the Table view, you can select a rule in the list and right-click the rule to display a popup menu item, Show
Rule. Choose this item to go to the Access Rules table and select that rule in this table.

Top Usage Status Pane
Disabled by default. This pane include the following four tabs:
» Top 10 Services—Threat Detection service
* Top 10 Sources—Threat Detection service
* Top 10 Destinations—Threat Detection service

* Top 10 Users—Identity Firewall service

The first three tabs—Top 10 Services, Top 10 Sources, and Top 10 Destinations—provide statistics for
threat detection services. Each tab includes an Enable button that let you enable each threat detection service.
You can enable them according to the firewall configuration guide.

The Top 10 Services Enable button enables statistics for both ports and protocols (both must be enabled for
the display). The Top 10 Sources and Top 10 Destinations Enable buttons enable statistics for hosts. The
top usage status statistics for hosts (sources and destinations), and ports and protocols are displayed.

The fourth tab for Top 10 Users provides statistics for the Identity Firewall service. The Identity Firewall
service provides access control based on users’ identities. You can configure access rules and security policies
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. Top Ten Protected Servers Under SYN Attack Pane

based on user names and user groups name rather than through source IP addresses. The ASA provides this
service by accessing an IP-user mapping database.

The Top 10 Users tab displays data only when you have configured one of the following features:

* Identity Firewall service configuration, which includes configuring these additional components: Microsoft
Active Directory and Cisco Active Directory (AD) Agent. The Identity Firewall service is enabled using
the user-identity enable command (enabled by default) and the user-accounting statistics command.

* VPN configuration using a RADIUS server for authenticating, authorizing, or accounting VPN users.

Depending on which option you choose, the Top 10 Users tab shows statistics for received EPS packets, sent
EPS packets, and sent attacks for the top 10 users. For each user (displayed as domain\user_name), the tab
displays the average EPS packet, the current EPS packet, the trigger, and total events for that user.

A

Caution  Enabling statistics can affect the ASA performance, depending on the type of statistics enabled. Enabling
statistics for hosts affects performance in a significant way; if you have a high traffic load, you might consider
enabling this type of statistics temporarily. Enabling statistics for ports, however, has a modest effect.

Top Ten Protected Servers Under SYN Attack Pane

Disabled by default. This area includes an Enable button that lets you enable the feature, or you can enable
it according to the firewall configuration guide. Statistics for the top ten protected servers under attack are
displayed.

For the average rate of attack, the ASA samples the data every 30 seconds over the rate interval (by default
30 minutes).

If there is more than one attacker, then “<various>" displays, followed by the last attacker IP address.

Click Detail to view statistics for all servers (up to 1000) instead of just 10 servers. You can also view history
sampling data. The ASA samples the number of attacks 60 times during the rate interval, so for the default
30-minute period, statistics are collected every 60 seconds.

Top 200 Hosts Pane

Disabled by default. Shows the top 200 hosts connected through the ASA. Each entry of a host contains the
IP address of the host and the number of connections initiated by the host, and is updated every 120 seconds.
Enter the hpm topnenable command to enable this display.

Top Botnet Traffic Filter Hits Pane

Disabled by default. This area includes links to configure the Botnet Traffic Filter. Reports of the top ten
botnet sites, ports, and infected hosts provide a snapshot of the data, and may not match the top ten items
since statistics started to be collected. If you right-click an IP address, you can invoke the whois tool to learn
more about the botnet site.

See the Botnet configuration guide for more information.
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Cluster Dashboard Tab .

Cluster Dashboard Tab

When you enable ASA clustering and are connected to the master unit, the Cluster Dashboard tab shows a
summary of cluster membership and resource utilization.

0 Home
_ Cluster Members: 1
Device Mamse Management IF Address Role Version Uptime Environment Status Health Stanus REEC;:"E umlza::nmmmv
cls1 172.23.204.243 MASTER 100.8(0.94) 2d 15h 56m 49s = ' - -
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3001:bOb:6500:-3 1 7 Unknown 1% 294 MB
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* Cluster Members—Shows the names and basic information about the members comprising the cluster
(their management IP address, version, role in the cluster, and so on) and their health status (environment
status, health status, and resource utilization).

N

Note In multiple context mode, if you connect ASDM to the admin context, and then
change to a different context, the management IP address listed does not change
to show the current context management IP addresses; it continues to show the
admin context management IP addresses, including the main cluster IP address
to which ASDM is currently connected.

» System Resource Status—Shows resource utilization (CPU and memory) across the cluster and traffic
graphs, both cluster-wide and per-device.
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« Traffic Status—Each tab has the following graphs.
+ Connections Per Second tab:
Cluster Overall—Shows the connections per second throughout the cluster.
Per-Member Total—Shows the average connections per second for each member.
» Throughput tab:
Cluster Overall—Shows the aggregated egress throughput throughout the cluster.
Per-Member Throughput—Shows the member throughput, one line per member.
« Load Balancing tab:

Per-Member Percentage of Total Traffic—For each member, shows the percentage of total cluster
traffic that the member receives.

Per-Member Locally Processed Traffic—For each member, shows the percentage of traffic that
was processed locally.

« Control Link Usage tab:

Per-Member Receival Capacity Utilization—For each member, shows the usage of the transmittal
capacity.

Per-Member Transmittal Capacity Utilization—For each member, shows the usage of the receival
capacity.

Cluster Firewall Dashbhoard Tab

The Cluster Firewall Dashboard tab shows traffic overview and the “top N” statistics, similar to those shown
in the Firewall Dashboard, but aggregated across the whole cluster.
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Content Security Tab .

= - %

Connection Statistics

4]

04 : )
0807 08,08 08:09 0810 0&:11
M Connections: 1 M NAT Xlates: 0

Dropped Packets Rate

The Dropped Packets Rate feature is disabled
in the Security Appliance.
Please click the button to enable it.

Possible Scan and SYN Attack Rates

The Possible Scan and SYN Attack Rates
feature is disabled in the Security Appliance.
Please click the button to enable it.

| Enable |

Content Security Tab

Top 10 AccessRules  lastupdated:

Interval: | Last 1 hour + Based on: Packet HitsDisplay: Tab

The Top 10 Access Rules feature is disabled in the Security Appli
Please click the button to enable it.

:. “Enable

 TopUsageStatus ~ lastupdated:
Top 10 Services Top 10 Sources L

Interval: Last 1 hour +  Based on: Packet Hits 5 [

The Top 10 Services feature is disabled in the Securi
Please click the button to enable it.

Enable |

The Content Security tab lets you view important information about the Content Security and Control (CSC)
SSM. This pane appears only if CSC software running on the CSC SSM is installed in the ASA.

)

Note If you have not completed the CSC Setup Wizard by choosing Configuration > Trend Micro Content
Security > CSC Setup, you cannot access the panes under Home > Content Security. Instead, a dialog box
appears and lets you access the CSC Setup Wizard directly from this location.

The following figure shows the elements of the Content Security tab.
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. Intrusion Prevention Tab

Figure 5: Content Security Tab
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GUI Element Description
1 CSC SSM Information pane.
2 Threat Summary pane. Shows aggregated data about

threats detected by the CSC SSM, including the
following threat types: Virus, Spyware, URL Filtered
or Blocked, Spam. Blocked, Files Blocked, and
Damage Control Services.

3 System Resources Status pane.

4 Email Scan pane. The graphs display data in
ten-second intervals.

5 Latest CSC Security Events pane.

Intrusion Prevention Tab

The Intrusion Prevention tab lets you view important information about IPS. This tab appears only when
you have an IPS module installed on the ASA.

To connect to the IPS module, perform the following steps:

1. Click the Intrusion Prevention tab.
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Intrusion Prevention Tab .

The Connecting to IPS dialog box appears.

Connecting to IPS...
ASDM will make a new connection to the SSP-1PS module in this ASA system.

ASDM makes a separate connection to the IP address of the management port
on the 55P-IP5 module.

SSP-IPS Management IP Address:  10.89,147.143 " port: (443

Username:

Password:

[ save SSP-IPS login information on local host.

“Password cache is encrypted. Use File > Clear Password cache menu to clear it.

¢ Help y f Cancel . 'rCr;mlinue\'

255100

2. Enter the IP address, port, username and password. The default IP address and port is 192.168.1.2:443.
The default username and password is Cisco and cisco.

3. Check the Save IPS login information on local host check box to save the login information on your local
PC.

4. Click Continue.

See the IPS quick start guide for more information about intrusion prevention.

The following figure shows the elements of the Health Dashboard tab, located on the Intrusion Prevention
tab.

Figure 6: Intrusion Prevention Tah (Health Dashboard)

A AMELL —

b 3 o,
| - N
e .Q'.-. [ S E""' sl B .I CIBCD
LRl L ¥
A ool ) s e P (L E T R T
B dvlAva T dida) ¥ ¥ T i fockdy ) Ak Dnndcard
B i E .
& et
& dal:iiiN P i e e Py b oms ' ke
] 1 v FHOIRT e |
& i BT ™ T v asraila
B i1 ol g ot Tl s | . MIEPY
i =l T Sl Lrpred 00 1) K e ally

S e e AR
Pt 1 oo T8, T | R T
Ll oy 05, IO R 1AM
4 e peinte vy Ml Dherlied
T 03
e ey 20, B T RH T
ok e a1, 208 | 2o L

et S Mot Chcied

L E

E—— =14] Y2 165 4T B

ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8 .




Getting Started with the ASA |
[l AsAcxstatus Tab

Legend

GUI Element Description

1 Sensor Information pane.

2 Sensor Health pane.

3 CPU, Memory, and Load pane.
4 Interface Status pane.

5 Licensing pane.

ASA CX Status Tab

The ASA CX Status tab lets you view important information about the ASA CX module. This tab appears
only when you have an ASA CX module installed on the ASA.

Ay Home
i i ool sl 28 A5 X stavs
|
ﬂj Device Information Last updated: 10:56:39 AM ! Interface Status Last updated: 10:56:39 AM
Model: ASAS585=55P-CX10 Application Name: ASA CX Security Module
Hardware Version: 1.3 Application Status: Up
Serial Number: JAF1543CGRE Application Status Description: Normal Operation
Firmware Version: 2.0(13)0 Application Version: 0.6.1
Software Version: 0.6.1 Data plane Status: Up
MAC Address Range: 70ca.9bf0.1cad to 70ca.9bf0.1cab Status: Up
Connect to the ASA CX application: = hitps: 47.153:44 i

ASA FirePower Status Tabs

The ASA FirePOWER Status tab lets you view information about the module. This includes module
information, such as the model, serial number, and software version, and module status, such as the application
name and status, data plane status, and overall status. If the module is registered to a FireSIGHT Management
Center, you can click the link to open the application and do further analysis and module configuration.

This tab appears only if you have an ASA FirePOWER module installed in the device.

If you are managing the ASA FirePOWER module with ASDM rather than FireSIGHT Management Center,
there are additional tabs:

» ASA FirePOWER Dashboard—The dashboard provides summary information about the software
running on the module, product updates, licensing, system load, disk usage, system time, and interface
status.
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Home Pane (System) .

* ASA FirePOWER Reporting—The reporting page provides Top 10 dashboards for a wide variety of
module statistics, such as web categories, users, sources, and destinations for the traffic passing through

the module.

Home Pane (System)

The ASDM System Home pane lets you view important status information about your ASA. Many of the
details available in the ASDM System Home pane are available elsewhere in ASDM, but this pane shows
at-a-glance how your ASA is running. Status information in the System Home pane is updated every ten

seconds.

The following figure shows the elements of the System Home pane.

Figure 7: System Home Pane
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GUI Element Description
1 System vs. Context selection.
2 Interface Status pane. Choose an interface to view

the total amount of traffic through the interface.
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Getting Started with the ASA |

GUI Element Description

3 Connection Status pane.
4 CPU Status pane.

5 Memory Status pane.

Define ASDM Preferences

Step 1

Step 2

Step 3

You can define the behavior of certain ASDM settings.

To change various settings in ASDM, perform the following steps:

Procedure

Choose Tools > Preferences.

The Preferences dialog box appears, with three tabs: General, Rules Table, and Syslog.

To define your settings, click one of these tabs: the General tab to specify general preferences; the Rules
Table tab to specify preferences for the Rules table; and the Syslog tab to specify the appearance of syslog
messages displayed in the Home pane and to enable the display of a warning message for NetFlow-related
syslog messages.

On the General tab, specify the following:

* Check the Warn that configuration in ASDM is out of sync with the configuration in ASA check
box to be notified when the startup configuration and the running configuration are no longer in sync
with each other.

* Check the Show configuration restriction message to read-only user check box to display the following
message to a read-only user at startup. This option is checked by default.

“You are not allowed to modify the ASA configuration,
because you do not have sufficient privileges.”

* Check the Show configuration restriction message on a slave unit in an ASA cluster check box to
display a configuration restriction message to a user connected to a slave unit.

* Check the Confirm before exiting ASDM check box to display a prompt when you try to close ASDM
to confirm that you want to exit. This option is checked by default.

* Check the Enable screen reader support (requires ASDM restart) check box to enable screen readers
to work. You must restart ASDM to enable this option.

* Check the Warn of insufficient ASA memory when ASDM loads check box to receive notification
when the minimum amount of ASA memory is insufficient to run complete functionality in the ASDM
application. ASDM displays the memory warning in a text banner message at bootup, displays a message
in the title bar text in ASDM, and sends a syslog alert once every 24 hours.

« In the Communications area:
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* Check the Preview commands before sending them to the device check box to view CLI commands
generated by ASDM.

* Check the Enable cumulative (batch) CLI delivery check box to send multiple commands in a
single group to the ASA.

* In the Minimum Configuration Sending Timeout field, enter the minimum amount of time in
seconds for a configuration to send a timeout message. The default is 60 seconds.

* In the Logging area:
* Check the Enable logging to the ASDM Java console check box to configure Java logging.

* Set the severity level by choosing a Logging Level from the drop-down list.

* In the Packet Capture Wizard area, to display captured packets, enter the name of the Network Sniffer
Application or click Browse to find it in the file system.

Step 4 On the Rules Table tab, specify the following:
* Display settings let you change the way rules appear in the Rules table.

* Check the Auto-expand network and service object groups with specified prefix check box to

display the network and service object groups automatically expanded based on the Auto-Expand
Prefix setting.

* Enter the prefix of the network and service object groups to expand automatically when displayed
in the Auto-Expand Prefix field.

* Check the Show members of network and service object groups check box to display members

of network and service object groups and the group name in the Rules table. If the check box is not
checked, only the group name is displayed.

* Enter the number of network and service object groups to display in the Limit Members To field.
When the object group members are displayed, then only the first n members are displayed.

* Check the Show all actions for service policy rules check box to display all actions in the Rules
table. When unchecked, a summary appears.

* Deployment settings let you configure the behavior of the ASA when deploying changes to the Rules
table.

* Check the Issue “clear xlate” command when deploying access lists check box to clear the NAT

table when deploying new access lists. This setting ensures the access lists that are configured on
the ASA are applied to all translated addresses.

* Access Rule Hit Count Settings let you configure the frequency for which the hit counts are updated in

the Access Rules table. Hit counts are applicable for explicit rules only. No hit count will be displayed
for implicit rules in the Access Rules table.

* Check the Update access rule hit counts automatically check box to have the hit counts
automatically updated in the Access Rules table.

* Specify the frequency in seconds in which the hit count column is updated in the Access Rules table.
Valid values are 10 - 86400 seconds.
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Step 5 On the Syslog tab, specify the following:

* In the Syslog Colors area, you can customize the message display by configuring background or
foreground colors for messages at each severity level. The Severity column lists each severity level by
name and number. To change the background color or foreground color for messages at a specified
severity level, click the corresponding column. The Pick a Color dialog box appears. Click one of the
following tabs:

* Choose a color from the palette on the Swatches tab and click OK.
* Specify the H, S, and B settings on the HSB tab, and click OK.
* Specify the Red, Green, and Blue settings on the RGB tab, and click OK.
* Check the Warn to disable redundant syslog messages when NetFlow action is first applied to the

global service policy rule check box in the NetFlow area to enable the display of a warning message
to disable redundant syslog messages.

Step 6 After you have specified settings on these three tabs, click OK to save your settings and close the Preferences
dialog box.

Note Each time that you check or uncheck a preferences setting, the change is saved to the .conf file and
becomes available to all the other ASDM sessions running on the workstation at the time. You must
restart ASDM for all changes to take effect.

Search with the ASDM Assistant

The ASDM Assistant tool lets you search and view useful ASDM procedural help about certain tasks.

Choose View > ASDM Assistant > How Do 1? to access information, or enter a search request from the
Look For field in the menu bar. Choose How Do 1? From the Find drop-down list to begin the search.

To view the ASDM Assistant, perform the following steps:

Procedure

Step 1 Choose View > ASDM Assistant.
The ASDM Assistant pane appears.

Step 2 Enter the information that you want to find in the Search field, and click Go.

The requested information appears in the Search Results pane.

Step 3 Click any links that appear in the Search Results and Features sections to obtain more details.
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Enable History Metrics

The History Metrics pane lets you configure the ASA to keep a history of various statistics, which ASDM
can display on any graph/table. If you do not enable history metrics, you can only monitor statistics in real
time. Enabling history metrics lets you view statistics graphs from the last 10 minutes, 60 minutes, 12 hours,
and 5 days.

To configure history metrics, perform the following steps:

Procedure

Step 1 Choose Configuration > Device Management > Advanced > History Metrics.

The History Metrics pane appears.

Step 2 Check the ASDM History Metrics check box to enable history metrics, then click Apply.

Unsupported Commands

ASDM supports almost all commands available for the ASA, but ASDM ignores some commands in an
existing configuration. Most of these commands can remain in your configuration; see Tools > Show
Commands Ignored by ASDM on Device for more information.

Ignored and View-Only Commands

The following table lists commands that ASDM supports in the configuration when added through the CLI,
but that cannot be added or edited in ASDM. If ASDM ignores the command, it does not appear in the ASDM
GUI at all. If the command is view-only, then it appears in the GUI, but you cannot edit it.

Table 6: List of Unsupported Commands

Unsupported Commands ASDM Behavior

capture Ignored.

coredump Ignored. This can be configured only using the CLI.
crypto engine large-mod-accel Ignored.

dhcp-server (tunnel-group name ASDM only allows one setting for all DHCP servers.

general-attributes)

eject Unsupported.
established Ignored.
failover timeout Ignored.
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Unsupported Commands ASDM Behavior

fips Ignored.

nat-assigned-to-public-ip Ignored.

pager Ignored.

pim accept-register route-map Ignored. You can configure only the list option using ASDM.
service-policy global Ignored if it uses a match access-list class. For example:

access-list myacl extended permit ip any any
class-map mycm
match access-list myacl
policy-map mypm
class mycm
inspect ftp
service-policy mypm global

set metric Ignored.
sysopt nodnsalias Ignored.
sysopt uauth allow-http-cache Ignored.
terminal Ignored.
threat-detection rate Ignored.

Effects of Unsupported Commands

If ASDM loads an existing running configuration and finds other unsupported commands, ASDM operation
is unaffected. Choose Tools > Show Commands Ignored by ASDM on Device to view the unsupported
commands.

Discontinuous Subnet Masks Not Supported

ASDM does not support discontinuous subnet masks such as 255.255.0.255. For example, you cannot use the
following:

ip address inside 192.168.2.1 255.255.0.255

Interactive User Commands Not Supported by the ASDM CLI Tool

The ASDM CLI tool does not support interactive user commands. If you enter a CLI command that requires
interactive confirmation, ASDM prompts you to enter “[yes/no]” but does not recognize your input. ASDM
then times out waiting for your response.

For example:

1. Choose Tools > Command Line Interface.
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Enter the crypto key generate rsa command.
ASDM generates the default 1024-bit RSA key.
Enter the crypto key generate rsa command again.

Instead of regenerating the RSA keys by overwriting the previous one, ASDM displays the following
error:

Do you really want to replace them? [yes/no]:WARNING: You already have
RSA ke0000000000000$A key

Input line must be less than 16 characters in length.

%$Please answer 'yes' or 'no'.
Do you really want to replace them [yes/no]:

$ERROR: Timed out waiting for a response.
ERROR: Failed to create new RSA keys names <Default-RSA-key>

Workaround:

* You can configure most commands that require user interaction by means of the ASDM panes.

* For CLI commands that have a noconfirm option, use this option when entering the CLI command. For
example:

crypto key generate rsa noconfirm
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CHAPTER 4

Licenses: Product Authorization Key Licensing

A license specifies the options that are enabled on a given Cisco ASA. This document describes product
authorization key (PAK) licenses for all physical ASAs. For the ASAv, see Licenses: Smart Software Licensing
(ASAv, ASA on Firepower), on page 143.

» About PAK Licenses, on page 93

* Guidelines for PAK Licenses, on page 104

* Configure PAK Licenses, on page 106

* Configure a Shared License (AnyConnect 3 and Earlier), on page 110
* Supported Feature Licenses Per Model, on page 116

* Monitoring PAK Licenses, on page 132

* History for PAK Licenses, on page 133

About PAK Licenses

A license specifies the options that are enabled on a given ASA. It is represented by an activation key that is
a 160-bit (5 32-bit words or 20 bytes) value. This value encodes the serial number (an 11 character string)
and the enabled features.

Preinstalled License

By default, your ASA ships with a license already installed. This license might be the Base License, to which
you want to add more licenses, or it might already have all of your licenses installed, depending on what you
ordered and what your vendor installed for you.

Related Topics
Monitoring PAK Licenses, on page 132

Permanent License

You can have one permanent activation key installed. The permanent activation key includes all licensed
features in a single key. If you also install time-based licenses, the ASA combines the permanent and time-based
licenses into a running license.

Related Topics
How Permanent and Time-Based Licenses Combine, on page 94
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Time-Based Licenses

In addition to permanent licenses, you can purchase time-based licenses or receive an evaluation license that
has a time-limit. For example, you might buy a time-based AnyConnect Premium license to handle short-term
surges in the number of concurrent SSL VPN users, or you might order a Botnet Traffic Filter time-based
license that is valid for 1 year.

\}

Note The ASA 5506-X and ASA 5506W-X do not support time-based licenses.

Time-Based License Activation Guidelines

* You can install multiple time-based licenses, including multiple licenses for the same feature. However,
only one time-based license per feature can be active at a time. The inactive license remains installed,
and ready for use. For example, if you install a 1000-session AnyConnect Premium license, and a
2500-session AnyConnect Premium license, then only one of these licenses can be active.

* If you activate an evaluation license that has multiple features in the key, then you cannot also activate
another time-based license for one of the included features. For example, if an evaluation license includes
the Botnet Traffic Filter and a 1000-session AnyConnect Premium license, you cannot also activate a
standalone time-based 2500-session AnyConnect Premium license.

How the Time-Based License Timer Works
* The timer for the time-based license starts counting down when you activate it on the ASA.

* If you stop using the time-based license before it times out, then the timer halts. The timer only starts
again when you reactivate the time-based license.

« If the time-based license is active, and you shut down the ASA, then the timer stops counting down. The
time-based license only counts down when the ASA is running. The system clock setting does not affect
the license; only ASA uptime counts towards the license duration.

How Permanent and Time-Based Licenses Combine

When you activate a time-based license, then features from both permanent and time-based licenses combine
to form the running license. How the permanent and time-based licenses combine depends on the type of
license. The following table lists the combination rules for each feature license.

\)

Note Even when the permanent license is used, if the time-based license is active, it continues to count down.
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Table 7: Time-Based License Combination Rules

Stacking Time-Based Licenses .

Time-Based Feature

Combined License Rule

AnyConnect Premium Sessions

The higher value is used, either time-based or
permanent. For example, if the permanent license is
1000 sessions, and the time-based license is 2500
sessions, then 2500 sessions are enabled. Typically,
you will not install a time-based license that has less
capability than the permanent license, but if you do
so, then the permanent license is used.

Unified Communications Proxy Sessions

The time-based license sessions are added to the
permanent sessions, up to the platform limit. For
example, if the permanent license is 2500 sessions,
and the time-based license is 1000 sessions, then 3500
sessions are enabled for as long as the time-based
license is active.

Security Contexts

The time-based license contexts are added to the
permanent contexts, up to the platform limit. For
example, if the permanent license is 10 contexts, and
the time-based license is 20 contexts, then 30 contexts
are enabled for as long as the time-based license is
active.

Botnet Traffic Filter There is no permanent Botnet Traffic Filter license
available; the time-based license is used.
All Others The higher value is used, either time-based or

permanent. For licenses that have a status of enabled
or disabled, then the license with the enabled status
is used. For licenses with numerical tiers, the higher
value is used. Typically, you will not install a
time-based license that has less capability than the
permanent license, but if you do so, then the
permanent license is used.

Related Topics

Monitoring PAK Licenses, on page 132

Stacking Time-Based Licenses

In many cases, you might need to renew your time-based license and have a seamless transition from the old
license to the new one. For features that are only available with a time-based license, it is especially important
that the license not expire before you can apply the new license. The ASA allows you to stack time-based
licenses so that you do not have to worry about the license expiring or about losing time on your licenses

because you installed the new one early.

When you install an identical time-based license as one already installed, then the licenses are combined, and

the duration equals the combined duration.

For example:
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1. You install a 52-week Botnet Traffic Filter license, and use the license for 25 weeks (27 weeks remain).

2. You then purchase another 52-week Botnet Traffic Filter license. When you install the second license,
the licenses combine to have a duration of 79 weeks (52 weeks plus 27 weeks).

Similarly:
1. Youinstall an 8-week 1000-session AnyConnect Premium license, and use it for 2 weeks (6 weeks remain).

2. You then install another 8-week 1000-session license, and the licenses combine to be 1000-sessions for
14 weeks (8 weeks plus 6 weeks).

If the licenses are not identical (for example, a 1000-session AnyConnect Premium license vs. a 2500-session
license), then the licenses are not combined. Because only one time-based license per feature can be active,
only one of the licenses can be active.

Although non-identical licenses do not combine, when the current license expires, the ASA automatically
activates an installed license of the same feature if available.

Related Topics
Activate or Deactivate Keys, on page 109
Time-Based License Expiration, on page 96

Time-Based License Expiration

When the current license for a feature expires, the ASA automatically activates an installed license of the
same feature if available. If there are no other time-based licenses available for the feature, then the permanent
license is used.

If you have more than one additional time-based license installed for a feature, then the ASA uses the first
license it finds; which license is used is not user-configurable and depends on internal operations. If you prefer
to use a different time-based license than the one the ASA activated, then you must manually activate the
license you prefer.

For example, you have a time-based 2500-session AnyConnect Premium license (active), a time-based
1000-session AnyConnect Premium license (inactive), and a permanent 500-session AnyConnect Premium
license. While the 2500-session license expires, the ASA activates the 1000-session license. After the
1000-session license expires, the ASA uses the 500-session permanent license.

Related Topics
Activate or Deactivate Keys, on page 109

License Notes

The following sections include additional information about licenses.

AnyConnect Plus and Apex Licenses

The AnyConnect Plus or Apex license is a multi-use license that you can apply to multiple ASAs, all of which
share a user pool as specified by the license. See https://www.cisco.com/go/license, and assign the PAK
separately to each ASA. When you apply the resulting activation key to an ASA, it toggles on the VPN features
to the maximum allowed, but the actual number of unique users across all ASAs sharing the license should
not exceed the license limit. For more information, see:
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* Cisco AnyConnect Ordering Guide

* AnyConnect Licensing Frequently Asked Questions (FAQ)

N

Note The AnyConnect Apex license is required for multiple context mode. Moreover, in multiple context mode,
this license must be applied to each unit in a failover pair; the license is not aggregated.

Other VPN License
Other VPN sessions include the following VPN types:

* [Psec remote access VPN using IKEv1
* [Psec site-to-site VPN using IKEv1
* [Psec site-to-site VPN using IKEv2

This license is included in the Base license.

Total VPN Sessions Combined, All Types

* Although the maximum VPN sessions add up to more than the maximum VPN AnyConnect and Other
VPN sessions, the combined sessions should not exceed the VPN session limit. If you exceed the maximum
VPN sessions, you can overload the ASA, so be sure to size your network appropriately.

* If you start a clientless SSL VPN session and then start an AnyConnect client session from the portal, 1
session is used in total. However, if you start the AnyConnect client first (from a standalone client, for
example) and then log into the clientless SSL VPN portal, then 2 sessions are used.

VPN Load Balancing
VPN load balancing requires a Strong Encryption (3DES/AES) License.

Legacy VPN Licenses

Refer to the Supplemental end User License Agreement for AnyConnect for all relevant information on
licensing.

N

Note The AnyConnect Apex license is required for multiple context mode; you cannot use the default or legacy
license.

Encryption License

The DES license cannot be disabled. If you have the 3DES license installed, DES is still available. To prevent
the use of DES when you want to only use strong encryption, be sure to configure any relevant commands to
use only strong encryption.
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The Carrier license enables the following inspection features:

» Diameter
* GTP/GPRS
» SCTP

Total TLS Proxy Sessions

Each TLS proxy session for Encrypted Voice Inspection is counted against the TLS license limit.

Other applications that use TLS proxy sessions do not count toward the TLS limit, for example, Mobility
Advantage Proxy (which does not require a license).

Some applications might use multiple sessions for a connection. For example, if you configure a phone with
a primary and backup Cisco Unified Communications Manager, there are 2 TLS proxy connections.

You independently set the TLS proxy limit using the tls-proxy maximum-sessions command or in ASDM,
using the Configuration > Firewall > Unified Communications > TLS Proxy pane. To view the limits of
your model, enter the tls-proxy maximum-sessions ? command. When you apply a TLS proxy license that
is higher than the default TLS proxy limit, the ASA automatically sets the TLS proxy limit to match the
license. The TLS proxy limit takes precedence over the license limit; if you set the TLS proxy limit to be less
than the license, then you cannot use all of the sessions in your license.

Note

For license part numbers ending in “K8” (for example, licenses under 250 users), TLS proxy sessions are
limited to 1000. For license part numbers ending in “K9” (for example, licenses 250 users or larger), the
TLS proxy limit depends on the configuration, up to the model limit. K8 and K9 refer to whether the license
is restricted for export: K8 is unrestricted, and K9 is restricted.

If you clear the configuration (using the clear configure all command, for example), then the TLS proxy
limit is set to the default for your model; if this default is lower than the license limit, then you see an error
message to use the tls-proxy maximum-sessions command to raise the limit again (in ASDM, use the TLS
Proxy pane). If you use failover and enter the write standby command or in ASDM, use File > Save Running
Configuration to Standby Unit on the primary unit to force a configuration synchronization, the clear
configure all command is generated on the secondary unit automatically, so you may see the warning message
on the secondary unit. Because the configuration synchronization restores the TLS proxy limit set on the
primary unit, you can ignore the warning.

You might also use SRTP encryption sessions for your connections:

* For K8 licenses, SRTP sessions are limited to 250.

* For K9 licenses, there is no limit.

Note

Only calls that require encryption/decryption for media are counted toward the SRTP limit; if passthrough is
set for the call, even if both legs are SRTP, they do not count toward the limit.
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VLANSs, Maximum

For an interface to count against the VLAN limit, you must assign a VLAN to it.

Botnet Traffic Filter License

Requires a Strong Encryption (3DES/AES) License to download the dynamic database.

IPS Module License

The IPS module license lets you run the IPS software module on the ASA. You also need the IPS signature
subscription on the IPS side.

See the following guidelines:

* To buy the IPS signature subscription you need to have the ASA with IPS pre-installed (the part number
must include “IPS”, for example ASA5515-IPS-K9); you cannot buy the IPS signature subscription for
a non-IPS part number ASA.

* For failover, you need the IPS signature subscription on both units; this subscription is not shared in
failover, because it is not an ASA license.

* For failover, the IPS signature subscription requires a unique IPS module license per unit. Like other
ASA licenses, the IPS module license is technically shared in the failover cluster license. However,
because of the IPS signature subscription requirements, you must buy a separate IPS module license for
each unit in failover.

Shared AnyConnect Premium Licenses (AnyConnect 3 and Earlier)

\}

Note The shared license feature on the ASA is not supported with AnyConnect 4 and later licensing. AnyConnect
licenses are shared and no longer require a shared server or participant license.

A shared license lets you purchase a large number of AnyConnect Premium sessions and share the sessions
as needed among a group of ASAs by configuring one of the ASAs as a shared licensing server, and the rest
as shared licensing participants.

Failover or ASA Cluster Licenses

With some exceptions, failover and cluster units do not require the same license on each unit. For earlier
versions, see the licensing document for your version.

Failover License Requirements and Exceptions

Failover units do not require the same license on each unit. If you have licenses on both units, they combine
into a single running failover cluster license. There are some exceptions to this rule. See the following table
for precise licensing requirements for failover.
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Model

License Requirement

ASA 5506-X and ASA 5506W-X

* Active/Standby—Security Plus License.

* Active/Active—No Support.

Note Each unit must have the same encryption license.

ASA 5512-X through ASA 5555-X

* ASA 5512-X—Security Plus License.

e Other models—Base License.

Note  Each unit must have the same encryption license.

* In multiple context mode, each unit must have the
the same AnyConnect Apex license.

* Each unit must have the same IPS module license.
You also need the IPS signature subscription on
the IPS side for both units. See the following
guidelines:

* To buy the IPS signature subscription you
need to have the ASA with IPS pre-installed
(the part number must include “IPS”, for
example ASA5525-IPS-K9); you cannot buy
the IPS signature subscription for a non-IPS
part number ASA.

* You need the IPS signature subscription on
both units; this subscription is not shared in
failover, because it is not an ASA license.

* The IPS signature subscription requires a
unique IPS module license per unit. Like
other ASA licenses, the IPS module license
is technically shared in the failover cluster
license. However, because of the IPS
signature subscription requirements, you
must buy a separate IPS module license for
each unit in.

ASAv See Failover Licenses for the ASAv, on page 150.
Firepower 2100 See Failover Licenses for the Firepower 2100, on page 150.
Firepower 4100/9300 See Failover Licenses for the ASA on the Firepower 4100/9300

Chassis, on page 151.
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ASA Cluster License Requirements and Exceptions .

Model

License Requirement

All other models

Base License or Standard License.

Note * Each unit must have the same encryption license.

* In multiple context mode, each unit must have the
the same AnyConnect Apex license.

)

Note A valid permanent key is required; in rare instances, your PAK authentication key can be removed. If your
key consists of all 0’s, then you need to reinstall a valid authentication key before failover can be enabled.

ASA Cluster License Requirements and Exceptions

Cluster units do not require the same license on each unit. Typically, you buy a license only for the control
unit; data units inherit the control unit license. If you have licenses on multiple units, they combine into a

single running ASA cluster license.

There are exceptions to this rule. See the following table for precise licensing requirements for clustering.

Model License Requirement
ASA 5585-X Cluster License, supports up to 16 units.
Note Each unit must have the same encryption license; each
unit must have the same 10 GE I/O/Security Plus
license (ASA 5585-X with SSP-10 and -20).
ASA 5516-X Base license, supports 2 units.
Note Each unit must have the same encryption license.
ASA 5512-X Security Plus license, supports 2 units.

Note Each unit must have the same encryption license.

ASA 5515-X, ASA 5525-X, ASA 5545-X, ASA 5555-X

Base License, supports 2 units.

Note Each unit must have the same encryption license.

Firepower 4100/9300 Chassis

See ASA Cluster Licenses for the ASA on the Firepower
4100/9300 Chassis, on page 152.

All other models

No support.

How Failover or ASA Cluster Licenses Combine

For failover pairs or ASA clusters, the licenses on each unit are combined into a single running cluster license.
If you buy separate licenses for each unit, then the combined license uses the following rules:
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* For licenses that have numerical tiers, such as the number of sessions, the values from each unit’s licenses
are combined up to the platform limit. If all licenses in use are time-based, then the licenses count down
simultaneously.

For example, for failover:

* You have two ASAs with 10 TLS Proxy sessions installed on each; the licenses will be combined
for a total of 20 TLS Proxy sessions.

* You have an ASA 5545-X with 1000 TLS Proxy sessions, and another with 2000 sessions; because
the platform limit is 2000, the combined license allows 2000 TLS Proxy sessions.

* You have two ASA 5545-X ASAs, one with 20 contexts and the other with 10 contexts; the combined
license allows 30 contexts. For Active/Active failover, the contexts are divided between the two

units. One unit can use 18 contexts and the other unit can use 12 contexts, for example, for a total
of 30.

For example, for ASA clustering:

* You have 2 ASA 5516-X ASAs with the default 2 contexts. Because the platform limit is 5, the
combined license allows a maximum of 4 contexts. Therefore, you can configure up to 4 contexts
on the primary unit; each secondary unit will also have 4 contexts through configuration replication.

* You have four ASA 5516-X ASAs, three units with 5 contexts each, and one unit with the default
2 contexts. Because the platform limit is 5, the licenses will be combined for a total of 5 contexts.
Therefore, you can configure up to 5 contexts on the primary unit; each secondary unit will also
have 5 contexts through configuration replication.

* For licenses that have a status of enabled or disabled, then the license with the enabled status is used.

* For time-based licenses that are enabled or disabled (and do not have numerical tiers), the duration is
the combined duration of all licenses. The primary/control unit counts down its license first, and when
it expires, the secondary/data unit(s) start counting down its license, and so on. This rule also applies to
Active/Active failover and ASA clustering, even though all units are actively operating.

For example, if you have 48 weeks left on the Botnet Traffic Filter license on two units, then the combined
duration is 96 weeks.

Related Topics
Monitoring PAK Licenses, on page 132

Loss of Communication Between Failover or ASA Cluster Units

If the units lose communication for more than 30 days, then each unit reverts to the license installed locally.
During the 30-day grace period, the combined running license continues to be used by all units.

If you restore communication during the 30-day grace period, then for time-based licenses, the time elapsed
is subtracted from the primary/control license; if the primary/control license becomes expired, only then does
the secondary/data license start to count down.

If you do not restore communication during the 30-day period, then for time-based licenses, time is subtracted
from all unit licenses, if installed. They are treated as separate licenses and do not benefit from the combined
license. The time elapsed includes the 30-day grace period.

For example:
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1. You have a 52-week Botnet Traffic Filter license installed on two units. The combined running license
allows a total duration of 104 weeks.

2. The units operate as a failover unit/ASA cluster for 10 weeks, leaving 94 weeks on the combined license
(42 weeks on the primary/control, and 52 weeks on the secondary/data).

3. If the units lose communication (for example the primary/control unit fails), the secondary/data unit
continues to use the combined license, and continues to count down from 94 weeks.

4. The time-based license behavior depends on when communication is restored:

» Within 30 days—The time elapsed is subtracted from the primary/control unit license. In this case,
communication is restored after 4 weeks. Therefore, 4 weeks are subtracted from the primary/control
license leaving 90 weeks combined (38 weeks on the primary, and 52 weeks on the secondary).

* After 30 days—The time elapsed is subtracted from both units. In this case, communication is restored
after 6 weeks. Therefore, 6 weeks are subtracted from both the primary/control and secondary/data
licenses, leaving 84 weeks combined (36 weeks on the primary/control, and 46 weeks on the
secondary/data).

Upgrading Failover Pairs

Because failover pairs do not require the same license on both units, you can apply new licenses to each unit
without any downtime. If you apply a permanent license that requires a reload, then you can fail over to the
other unit while you reload. If both units require reloading, then you can reload them separately so that you
have no downtime.

Related Topics
Activate or Deactivate Keys, on page 109

No Payload Encryption Models

You can purchase some models with No Payload Encryption. For export to some countries, payload encryption
cannot be enabled on the Cisco ASA series. The ASA software senses a No Payload Encryption model, and
disables the following features:

* Unified Communications
* VPN
You can still install the Strong Encryption (3DES/AES) license for use with management connections. For

example, you can use ASDM HTTPS/SSL, SSHv2, Telnet and SNMPv3. You can also download the dynamic
database for the Botnet Traffic Filter (which uses SSL).

When you view the license, VPN and Unified Communications licenses will not be listed.

Related Topics
Monitoring PAK Licenses, on page 132

ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8 [JJj



. Licenses FAQ

Getting Started with the ASA |

Licenses FAQ

Can | activate multiple time-based licenses, for example, AnyConnect Premium and Botnet Traffic
Filter?

Yes. You can use one time-based license per feature at a time.

Can | “stack” time-based licenses so that when the time limit runs out, it will automatically use the next
license?

Yes. For identical licenses, the time limit is combined when you install multiple time-based licenses. For
non-identical licenses (for example, a 1000-session AnyConnect Premium license and a 2500-session
license), the ASA automatically activates the next time-based license it finds for the feature.

Can I install a new permanent license while maintaining an active time-based license?
Yes. Activating a permanent license does not affect time-based licenses.

For failover, can | use a shared licensing server as the primary unit, and the shared licensing backup
server as the secondary unit?

No. The secondary unit has the same running license as the primary unit; in the case of the shared licensing
server, they require a server license. The backup server requires a participant license. The backup server
can be in a separate failover pair of two backup servers.

Do I need to buy the same licenses for the secondary unit in a failover pair?

No. Starting with Version 8.3(1), you do not have to have matching licenses on both units. Typically,
you buy a license only for the primary unit; the secondary unit inherits the primary license when it
becomes active. In the case where you also have a separate license on the secondary unit (for example,
if you purchased matching licenses for pre-8.3 software), the licenses are combined into a running failover
cluster license, up to the model limits.

Can | use a time-based or permanent AnyConnect Premium license in addition to a shared AnyConnect
Premium license?

Yes. The shared license is used only after the sessions from the locally installed license (time-based or
permanent) are used up.

A\

Note  On the shared licensing server, the permanent AnyConnect Premium license is not used; you can however

use a time-based license at the same time as the shared licensing server license. In this case, the time-based
license sessions are available for local AnyConnect Premium sessions only; they cannot be added to the
shared licensing pool for use by participants.

Guidelines for PAK Licenses

Context Mode Guidelines

In multiple context mode, apply the activation key in the system execution space.

Failover Guidelines

See Failover or ASA Cluster Licenses, on page 99.
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Model Guidelines

* Smart Licensing is supported on the ASAv only.
» Shared licenses are not supported on the ASAv, ASA 5506-X, ASA 5508-X, and ASA 5516-X.
* The ASA 5506-X and ASA 5506W-X do not support time-based licenses.

Upgrade and Downgrade Guidelines

Your activation key remains compatible if you upgrade to the latest version from any previous version.
However, you might have issues if you want to maintain downgrade capability:

» Downgrading to Version 8.1 or earlie—After you upgrade, if you activate additional feature licenses
that were introduced before 8.2, then the activation key continues to be compatible with earlier versions
if you downgrade. However if you activate feature licenses that were introduced in 8.2 or later, then the
activation key is not backwards compatible. If you have an incompatible license key, then see the following
guidelines:

* [f you previously entered an activation key in an earlier version, then the ASA uses that key (without
any of the new licenses you activated in Version 8.2 or later).

* If you have a new system and do not have an earlier activation key, then you need to request a new
activation key compatible with the earlier version.

» Downgrading to Version 8.2 or earlier—Version 8.3 introduced more robust time-based key usage as
well as failover license changes:

* If you have more than one time-based activation key active, when you downgrade, only the most
recently activated time-based key can be active. Any other keys are made inactive. If the last
time-based license is for a feature introduced in 8.3, then that license still remains the active license
even though it cannot be used in earlier versions. Reenter the permanent key or a valid time-based
key.

* If you have mismatched licenses on a failover pair, then downgrading will disable failover. Even
if the keys are matching, the license used will no longer be a combined license.

* If you have one time-based license installed, but it is for a feature introduced in 8.3, then after you
downgrade, that time-based license remains active. You need to reenter the permanent key to disable
the time-based license.

Additional Guidelines

* The activation key is not stored in your configuration file; it is stored as a hidden file in flash memory.

* The activation key is tied to the serial number of the device. Feature licenses cannot be transferred
between devices (except in the case of a hardware failure). If you have to replace your device due to a
hardware failure, and it is covered by Cisco TAC, contact the Cisco Licensing Team to have your existing
license transferred to the new serial number. The Cisco Licensing Team will ask for the Product
Authorization Key reference number and existing serial number.

* The serial number used for licensing is the one seen on the Activation Key page. This serial number is
different from the chassis serial number printed on the outside of your hardware. The chassis serial
number is used for technical support, but not for licensing.
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* Once purchased, you cannot return a license for a refund or for an upgraded license.

* On a single unit, you cannot add two separate licenses for the same feature together; for example, if you
purchase a 25-session SSL VPN license, and later purchase a 50-session license, you cannot use 75
sessions; you can use a maximum of 50 sessions. (You may be able to purchase a larger license at an
upgrade price, for example from 25 sessions to 75 sessions; this kind of upgrade should be distinguished
from adding two separate licenses together).

+ Although you can activate all license types, some features are incompatible with each other. In the case
of the AnyConnect Essentials license, the license is incompatible with the following licenses: AnyConnect
Premium license, shared AnyConnect Premium license, and Advanced Endpoint Assessment license.
By default, if you install the AnyConnect Essentials license (if it is available for your model), it is used
instead of the above licenses. You can disable the AnyConnect Essentials license in the configuration to
restore use of the other licenses using the Configuration > Remote Access VPN > Network (Client)
Access > Advanced > AnyConnect Essentials pane.

Configure PAK Licenses

This section describes how to obtain an activation key and how to active it. You can also deactivate a key.

Order License PAKs and Obtain an Activation Key

Step 1

To install a license on the ASA, you need Product Authorization Keys, which you can then register with
Cisco.com to obtain an activation key. You can then enter the activation key on the ASA. You need a separate
Product Authorization Key for each feature license. The PAKs are combined to give you a single activation
key. You may have received all of your license PAKSs in the box with your device. The ASA has the Base or
Security Plus license pre-installed, along with the Strong Encryption (3DES/AES) license if you qualify for
its use. If you need to manually request the Strong Encryption license (which is free), see
http://www.cisco.com/go/license.

Before you begin
When you purchase 1 or more licenses for the device, you manage them in the Cisco Smart Software Manager:
https://software.cisco.com/#module/SmartLicensing

If you do not yet have an account, set up a new account. The Smart Software Manager lets you create a master
account for your organization.

Procedure

To purchase additional licenses, see http://www.cisco.com/go/ccw. See the following AnyConnect ordering
guide and FAQ:

* Cisco AnyConnect Ordering Guide

» AnyConnect Licensing Frequently Asked Questions (FAQ)
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Step 2

Step 3

Step 4

Step 5

Step 6

Obtain a Strong Encryption License .

After you order a license, you will then receive an email with a Product Authorization Key (PAK). For the
AnyConnect licenses, you receive a multi-use PAK that you can apply to multiple ASAs that use the same
pool of user sessions. The PAK email can take several days in some cases.

The ASA FirePOWER module uses a separate licensing mechanism from the ASA. See the quick start guide
for your model for more information.

Obtain the serial number for your ASA by choosing Configuration > Device Management > Licensing
> Activation Key (in multiple context mode, view the serial number in the System execution space).

The serial number used for licensing is different from the chassis serial number printed on the outside of your
hardware. The chassis serial number is used for technical support, but not for licensing.

To obtain the activation key, go to the following licensing website:

http://www.cisco.com/go/license

Enter the following information, when prompted:

* Product Authorization Key (if you have multiple keys, enter one of the keys first. You have to enter each
key as a separate process.)

* The serial number of your ASA

* Your e-mail address

An activation key is automatically generated and sent to the e-mail address that you provide. This key includes
all features you have registered so far for permanent licenses. For time-based licenses, each license has a
separate activation key.

If you have additional Product Authorization Keys, repeat the process for each Product Authorization Key.
After you enter all of the Product Authorization Keys, the final activation key provided includes all of the
permanent features you registered.

Install the activation key according to Activate or Deactivate Keys, on page 109.

Obtain a Strong Encryption License

Step 1

Step 2

To use ASDM (and many other features), you need to install the Strong Encryption (3DES/AES) license. If
your ASA did not come with the Strong Encryption license pre-installed, you can request one for free. You
must qualify for a Strong Encryption license based on your country.

Procedure

Obtain the serial number for your ASA by entering the following command:
show version | grep Serial

This serial number is different from the chassis serial number printed on the outside of your hardware. The
chassis serial number is used for technical support, but not for licensing.

See https://www.cisco.com/go/license, and click Get Other Licenses.
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Figure 8: Get Other Licenses
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Step 4 In the Search by Keyword field, enter asa, and select Cisco ASA 3DES/AES L.icense.
Figure 10: Cisco ASA 3DES/AES License
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Product Family Product
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Step 5 Select your Smart Account, Virtual Account, enter the ASA Serial Number, and click Next.
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Activate or Deactivate Keys .

Figure 11: Smart Account, Virtual Account, and Serial Number

Request Crypto, IPS and Other Licenses

| 2. Specify Target and Options

Cisco ASA JDES/AES License

Serial Humber FCH17146HH . a

Step 6 Your Send To email address and End User name are auto-filled; enter additional email addresses if needed.
Check the | Agree check box, and click Submit.

Figure 12: Submit
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| | 3. Review and Submit
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Enter multiple email addresses separaled by commas.Your License Key will be emailed within the hour to the specified email addresses
Send To: Add
End Usar: -
License Request

SerialMumber
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Smart Account SKU Name ity
¥ Cisco Internal ASASS00-ENCR-KS
Step 7 You will then receive an email with the activation key, but you can also download the key right away from

the Manage > Licenses area.
Step 8 Apply the activation key according to Activate or Deactivate Keys, on page 109.

Activate or Deactivate Keys

This section describes how to enter a new activation key, and how to activate and deactivate time-based keys.

Before you begin

« [f you are already in multiple context mode, enter the activation key in the system execution space.

» Some permanent licenses require you to reload the ASA after you activate them. The following table
lists the licenses that require reloading.
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Table 8: Permanent License Reloading Requirements

Model License Action Requiring Reload
All models Downgrading the Encryption license.
Procedure
Step 1 Choose Configuration > Device Management, and then choose the Licensing > Activation Key or

Licensing Activation Key pane, depending on your model.

Step 2 To enter a new activation key, either permanent or time-based, enter the new activation key in the New
Activation Key field.

The key is a five-element hexadecimal string with one space between each element. The leading Ox specifier

is optional; all values are assumed to be hexadecimal. For example:

ASAOxd11b3d48 Oxa80adclOa 0x48e0fdlc 0xb0443480 0x843fc490

You can install one permanent key, and multiple time-based keys. If you enter a new permanent key, it
overwrites the already installed one. If you enter a new time-based key, then it is active by default and displays
in the Time-based License Keys Installed table. The last time-based key that you activate for a given feature
is the active one.

Step 3 To activate or deactivate an installed time-based key, choose the key in the Time-based License Keys Installed
table, and click either Activate or Deactivate.

You can only have one time-based key active for each feature.

Step 4 Click Update Activation Key.

Some permanent licenses require you to reload the ASA after entering the new activation key. You will be
prompted to reload if it is required.

Related Topics
Time-Based Licenses, on page 94

Configure a Shared License (AnyConnect 3 and Earlier)
A\

Note The shared license feature on the ASA is not supported with AnyConnect 4 and later licensing. AnyConnect
licenses are shared and no longer require a shared server or participant license.

This section describes how to configure the shared licensing server and participants.
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About Shared Licenses

A shared license lets you purchase a large number of AnyConnect Premium sessions and share the sessions
as needed among a group of ASAs by configuring one of the ASAs as a shared licensing server, and the rest
as shared licensing participants.

About the Shared Licensing Server and Participants

The following steps describe how shared licenses operate:

1. Decide which ASA should be the shared licensing server, and purchase the shared licensing server license
using that device serial number.

2. Decide which ASAs should be shared licensing participants, including the shared licensing backup server,
and obtain a shared licensing participant license for each device, using each device serial number.

3. (Optional) Designate a second ASA as a shared licensing backup server. You can only specify one backup
server.

\}

Note The shared licensing backup server only needs a participant license.

4. Configure a shared secret on the shared licensing server; any participants with the shared secret can use
the shared license.

5. When you configure the ASA as a participant, it registers with the shared licensing server by sending
information about itself, including the local license and model information.

Note The participant needs to be able to communicate with the server over the IP network; it does not have to be
on the same subnet.

6. The shared licensing server responds with information about how often the participant should poll the
server.

7. When a participant uses up the sessions of the local license, it sends a request to the shared licensing
server for additional sessions in 50-session increments.

8. The shared licensing server responds with a shared license. The total sessions used by a participant cannot
exceed the maximum sessions for the platform model.

\}

Note The shared licensing server can also participate in the shared license pool. It does not need a participant license
as well as the server license to participate.

a. If there are not enough sessions left in the shared license pool for the participant, then the server
responds with as many sessions as available.

b. The participant continues to send refresh messages requesting more sessions until the server can
adequately fulfill the request.
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9. When the load is reduced on a participant, it sends a message to the server to release the shared sessions.

\}

Note The ASA uses SSL between the server and participant to encrypt all communications.

Communication Issues Between Participant and Server
See the following guidelines for communication issues between the participant and server:

» If a participant fails to send a refresh after 3 times the refresh interval, then the server releases the sessions
back into the shared license pool.

« If the participant cannot reach the license server to send the refresh, then the participant can continue to
use the shared license it received from the server for up to 24 hours.

» If the participant is still not able to communicate with a license server after 24 hours, then the participant
releases the shared license, even if it still needs the sessions. The participant leaves existing connections
established, but cannot accept new connections beyond the license limit.

* If a participant reconnects with the server before 24 hours expires, but after the server expired the
participant sessions, then the participant needs to send a new request for the sessions; the server responds
with as many sessions as can be reassigned to that participant.

About the Shared Licensing Backup Server

The shared licensing backup server must register successfully with the main shared licensing server before it
can take on the backup role. When it registers, the main shared licensing server syncs server settings as well
as the shared license information with the backup, including a list of registered participants and the current
license usage. The main server and backup server sync the data at 10 second intervals. After the initial sync,
the backup server can successfully perform backup duties, even after a reload.

When the main server goes down, the backup server takes over server operation. The backup server can operate
for up to 30 continuous days, after which the backup server stops issuing sessions to participants, and existing
sessions time out. Be sure to reinstate the main server within that 30-day period. Critical-level syslog messages
are sent at 15 days, and again at 30 days.

When the main server comes back up, it syncs with the backup server, and then takes over server operation.

When the backup server is not active, it acts as a regular participant of the main shared licensing server.

Note When you first launch the main shared licensing server, the backup server can only operate independently for
5 days. The operational limit increases day-by-day, until 30 days is reached. Also, if the main server later
goes down for any length of time, the backup server operational limit decrements day-by-day. When the main
server comes back up, the backup server starts to increment again day-by-day. For example, if the main server
is down for 20 days, with the backup server active during that time, then the backup server will only have a
10-day limit left over. The backup server “recharges” up to the maximum 30 days after 20 more days as an
inactive backup. This recharging function is implemented to discourage misuse of the shared license.
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Failover and Shared Licenses .

Failover and Shared Licenses

This section describes how shared licenses interact with failover.

Failover and Shared License Servers

This section describes how the main server and backup server interact with failover. Because the shared
licensing server is also performing normal duties as the ASA, including performing functions such as being
a VPN gateway and firewall, then you might need to configure failover for the main and backup shared
licensing servers for increased reliability.

Note

The backup server mechanism is separate from, but compatible with, failover.

Shared licenses are supported only in single context mode, so Active/Active failover is not supported.

For Active/Standby failover, the primary unit acts as the main shared licensing server, and the standby unit
acts as the main shared licensing server after failover. The standby unit does not act as the backup shared
licensing server. Instead, you can have a second pair of units acting as the backup server, if desired.

For example, you have a network with 2 failover pairs. Pair #1 includes the main licensing server. Pair #2
includes the backup server. When the primary unit from Pair #1 goes down, the standby unit immediately
becomes the new main licensing server. The backup server from Pair #2 never gets used. Only if both units
in Pair #1 go down does the backup server in Pair #2 come into use as the shared licensing server. If Pair #1
remains down, and the primary unit in Pair #2 goes down, then the standby unit in Pair #2 comes into use as
the shared licensing server (see the following figure).
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Figure 13: Failover and Shared License Servers
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The standby backup server shares the same operating limits as the primary backup server; if the standby unit
becomes active, it continues counting down where the primary unit left off.

Related Topics

About the Shared Licensing Backup Server, on page 112

Failover and Shared License Participants

For participant pairs, both units register with the shared licensing server using separate participant IDs. The

active unit syncs its participant ID with the standby unit. The standby unit uses this ID to generate a transfer
request when it switches to the active role. This transfer request is used to move the shared sessions from the
previously active unit to the new active unit.

Maximum Number of Participants

The ASA does not limit the number of participants for the shared license; however, a very large shared network
could potentially affect the performance on the licensing server. In this case, you can increase the delay

between participant refreshes, or you can create two shared networks.
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Configure the Shared Licensing Server .

Configure the Shared Licensing Server

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

This section describes how to configure the ASA to be a shared licensing server.

Before you begin

The server must have a shared licensing server key.

Procedure

Choose the Configuration > Device Management > Licenses > Shared SSL VPN Licenses pane.
In the Shared Secret field, enter the shared secret as a string between 4 and 128 ASCII characters.

Any participant with this secret can use the license server.

(Optional) In the TCP IP Port field, enter the port on which the server listens for SSL connections from
participants, between 1 and 65535.

The default is TCP port 50554.

(Optional) In the Refresh interval field, enter the refresh interval between 10 and 300 seconds.

This value is provided to participants to set how often they should communicate with the server. The default
is 30 seconds.

In the Interfaces that serve shared licenses area, check the Shares Licenses check box for any interfaces
on which participants contact the server.

(Optional) To identify a backup server, in the Optional backup shared SSL VPN license server area:
a) In the Backup server IP address field, enter the backup server IP address.
b) In the Primary backup server serial number field, enter the backup server serial number.

¢) Ifthe backup server is part of a failover pair, identify the standby unit serial number in the Secondary
backup server serial number field.

You can only identify 1 backup server and its optional standby unit.

Click Apply.

Configure the Shared Licensing Participant and the Optional Backup Server

Step 1

This section configures a shared licensing participant to communicate with the shared licensing server. This
section also describes how you can optionally configure the participant as the backup server.

Before you begin

The participant must have a shared licensing participant key.

Procedure

Choose the Configuration > Device Management > Licenses > Shared SSL VPN Licenses pane.
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Supported

Step 2
Step 3

Step 4

Step 5

In the Shared Secret field, enter the shared secret as a string between 4 and 128 ASCII characters.

(Optional) In the TCP IP Port field, enter the port on which to communicate with the server using SSL, between
1 and 65535.

The default is TCP port 50554.

(Optional) To identify the participant as the backup server, in the Select backup role of participant area:

a) Click the Backup Server radio button.
b) Check the Shares Licenses check box for any interfaces on which participants contact the backup server.

Click Apply.

Feature Licenses Per Model

This section describes the licenses available for each model as well as important notes about licenses.

Licenses Per Model

N

This section lists the feature licenses available for each model:

Items that are in italics are separate, optional licenses that can replace the Base (or Security Plus, and so on)
license version. You can mix and match optional licenses.

Note

Some features are incompatible with each other. See the individual feature chapters for compatibility
information.

If you have a No Payload Encryption model, then some of the features below are not supported. See No
Payload Encryption Models, on page 103 for a list of unsupported features.

For detailed information about licenses, see License Notes, on page 96.

ASA 5506-X and ASA 5506W-X License Features

The following table shows the licensed features for the ASA 5506-X and ASA 5506W-X.

Licenses | Base License Security Plus License
Firewall Licenses

Botnet | No support No Support

Traffic

Filter

Firewall | 20,000 50,000

Conns,

Concurrent

Carrier |No Support No Support
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ASA 5506H-X License Features .

Licenses

Base License

Security Plus License

Total
TLS
Proxy
Sessions

160

160

VPN Lic

€nses

AnGamet

peers

Disabled Optional AnyConnect Plus or Apex

license: 50 maximum

Disabled Optional AnyConnect Plus or Apex

license: 50 maximum

Other
VPN
Peers

10

50

Total
VPN
Peers,
combined
all types

50

50

VPN
Load
Balancing

No support

No support

General

Licenses

Encryption

Base (DES) Opt. lic.: Strong (3DESAES)

Base (DES) Opt. lic.: Strong (3DESAES)

Failover

No support

Active/Standby

Security
Contexts

No support

No support

Clustering

No Support

No Support

VLAN:S,
Maximum

5

30

ASA 5506H-X License Features
The following table shows the licensed features for the ASA 5506H-X.

Licenses Base License
Firewall Licenses

Botnet Traffic No Support
Filter

Firewall Conns, |50,000
Concurrent
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Licenses

Base License

Carrier

No Support

Total UC Proxy
Sessions

160

VPN Licenses

AnyConnect Plus
or Apex license
(purchased
separately),
maximum
premium peers

50

Total VPN Peers,
combined all

types

50

Other VPN Peers

50

VPN Load
Balancing

Enabled

General Licenses

Encryption Base (DES) Opt. lic.: Strong (3BDESAES)
Failover Active/Standby or Active/Active

Security Contexts | No Support

Clustering No Support

VLAN:S, 30

Maximum

ASA 5508-X License Features

The following table shows the licensed features for the ASA 5508-X.

Licenses

Base License

Firewall Licenses

Botnet Traffic No Support
Filter

Firewall Conns, |100,000
Concurrent

Carrier No Support
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Licenses Base License

Total TLS Proxy | 320
Sessions

VPN Licenses

AnyConnect Disabled Optional AnyConnect Plus or Apex license: 100 maximum
peers

Total VPN Peers, | 100
combined all

types

Other VPN Peers | 100

VPN Load Enabled
Balancing

General Licenses

Encryption Base (DES) Opt. lic.: Strong (3DESAES)
Failover Active/Standby or Active/Active

Security Contexts | 2 Optional licenses: 5
Clustering No Support

VLANS, 50

Maximum

ASA 5512-X License Features
The following table shows the licensed features for the ASA 5512-X.

Licenses | Base License Security Plus License

Firewall Licenses

Botnet | Disabled Optional Time-based license: Available| Disabled Optional Time-based license: Available
Traffic

Filter

Firewall | 100,000 250,000

Conns,

Concurrent

Carrier | No support No Support

Total 2 Optional licenses: 2 Optional licenses:

TLS

Proxy 24 50 100 250 500 24 50 100 250 500
Sessions
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Licenses

Base License

Security Plus License

VPN Lic

enses

AnyComt

peers

Disabled

Optional AnyConnect Plus or Apex
license: 250 maximum

Disabled

Optional AnyConnect Plus or Apex
license: 250 maximum

Other
VPN
Peers

250

250

Total
VPN
Peers,
combined

all types

250

250

VPN
Load
Balancing

No support

Enabled

General

Licenses

Encryption

Base (DES)

Opt. lic.: Strong (3DESAES)

Base (DES)

Opt. lic.: Strong (3DESAES)

Failover

No support

Active/Standby or Active/Active

Security
Contexts

No support

2

Optional licenses:

Clustering

No Support

2

IPS
Module

Disabled

Optional license: Available

Disabled

Optional license: Available

VLAN:S,
Maximum

50

100

ASA 5515-X License Features
The following table shows the licensed features for the ASA 5515-X.

Licenses

Base License

Firewall

Licenses

Botnet
Traffic
Filter

Disabled

Optional Time-based license: Available

Firewall
Conns,
Concunrent

250,000
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ASA 5516-X License Features .

Licenses | Base License

Carrier |No Support

Total 2
TLS
Proxy
Sessions

Optional licenses:

24

50

100

250

500

VPN Licenses

AmyCorat | Disabled

peers

Optional AnyConnect Plus or Apex license: 250 maximum

Other 250
VPN
Peers

Total 250
VPN
Peers,
combined

all types

VPN Enabled
Load
Balancing

General Licenses

Encryption | Base (DES)

Optional license: Srong (3ADESAES)

Failover | Active/Standby or Active/Active

Security |2
Contexts

Optional licenses:

Clustering | 2

IPS Disabled
Module

Optional license: Available

VLAN:S, | 100
Maximum

ASA 5516-X License Features

The following table shows the licensed features for the ASA 5516-X.

Licenses Base License

Firewall Licenses
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Licenses Base License

Botnet Traffic No Support

Filter

Firewall Conns, |250,000

Concurrent

Carrier No Support

Total TLS Proxy | 1000

Sessions

VPN Licenses

AnyConnect Disabled Optional AnyConnect Plus or Apex license: 300 maximum
peers

Other VPN Peers | 300

Total VPN Peers, | 300

combined all

types

VPN Load Enabled

Balancing

General Licenses

Encryption Base (DES) Opt. lic.: Strong (3BDESAES)
Failover Active/Standby or Active/Active

Security Contexts | 2 Optional licenses: 5
Clustering 2

VLAN:S, 150

Maximum

ASA 5525-X License Features
The following table shows the licensed features for the ASA 5525-X.

Licenses

Base License

Firewall Licenses

Botnet
Traffic
Filter

Disabled

Optional Time-based license: Available
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Licenses | Base License

Firewall | 500,000
Conns,
Concuurent

Carrier |Disabled Optional license: Available

Total 2 Optional licenses: 24 50 100 250 500 750 1000
TLS
Proxy
Sessions

VPN Licenses

AmyCorat | Disabled Optional AnyConnect Plus or Apex license: 750 maximum
peers

Other 750
VPN
Peers

Total 750
VPN
Peers,
combined
all types

VPN Enabled
Load
Balancing

General Licenses

Encryption | Base (DES) Optional license: Srong (3DESAES)

Failover | Active/Standby or Active/Active

Security |2 Optional licenses: 5 10 20
Contexts

Clustering | 2

IPS Disabled Optional license: Available
Module

VLAN:S, [ 200
Maximum

ASA 5545-X License Features
The following table shows the licensed features for the ASA 5545-X.
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Licenses | Base License

Firewall Licenses

Botnet | Disabled Optional Time-based license: Available
Traffic
Filter

Firewall | 750,000
Conns,
Concuurent

Carrier |Disabled Optional license: Available

Total 2 Optional licenses: 24 50 100 250 500 750 1000 2000
TLS
Proxy
Sessions

VPN Licenses

AmyComat | Disabled Optional AnyConnect Plus or Apex license: 2500 maximum
peers

Other 2500
VPN
Peers

Total 2500
VPN
Peers,
combined

all types

VPN Enabled
Load
Balancing

General Licenses

Encryption | Base (DES) Optional license: Srong (3ADESAES)

Failover | Active/Standby or Active/Active

Security |2 Optional licenses: 5 10 20 50
Contexts

Clustering | 2

IPS Disabled Optional license: Available
Module

VLAN:S, [ 300
Maximum
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ASA 5555-X License Features
The following table shows the licensed features for the ASA 5555-X.

ASA 5555-X License Features .

Licenses | Base License

Firewall Licenses

Botnet | Disabled Optional Time-based license: Available
Traffic

Filter

Firewall | 1,000,000

Conns,

Concurrent

Carrier |Disabled Optional license: Available

Total 2 Optional licenses:

TLS

Proxy 24 50 100 250 500 750 1000 2000 3000
Sessions

VPN Licenses

AmyCorat | Disabled Optional AnyConnect Plus or Apex license: 5000 maximum
peers

Other 5000

VPN

Peers

Total 5000

VPN

Peers,

combined

all types

VPN Enabled

Load

Balancing

General Licenses

Encryption | Base (DES) Optional license: Strong (3DESAES)
Failover | Active/Standby or Active/Active

Security |2 Optional licenses: 5 10 20 50 100
Contexts

Clustering | 2

IPS Disabled Optional license: Available

Module
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Licenses

Base License

VLAN:S,
Maximum

500

ASA 5585-X with SSP-10 License Features
The following table shows the licensed features for the ASA 5585-X with SSP-10.

You can use two SSPs of the same level in the same chassis. Mixed-level SSPs are not supported (for example,
an SSP-10 with an SSP-20 is not supported). Each SSP acts as an independent device, with separate
configurations and management. You can use the two SSPs as a failover pair if desired.

Licenses

Base and Security Plus Licenses

Firewall

Licenses

Botnet
Traftic
Filter

Disabled

Optional Time-based license: Available

Firewall
Conns,
Concunrent

1,000,000

Carrier

Disabled

Optional license: Available

Total
TLS
Proxy
Sessions

2

Optional

licenses:

24

50 100 250 500 750 1000

2000

3000

VPN Lic

enses

AnyGamat

peers

Disabled

Optional AnyConnect Plus or Apex license: 5000 maximum

Other
VPN
Peers

5000

Total
VPN
Peers,
combined
all types

5000

VPN
Load
Balancing

Enabled

General

Licenses
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ASA 5585-X with SSP-20 License Features .

Licenses | Base and Security Plus Licenses

10 GE |Base License: Disabled; fiber ifcs run at 1 GE Security Plus License: Enabled; fiber ifcs run at 10 GE
/O

Encryption | Base (DES) Optional license: Strong (3DESAES)

Failover | Active/Standby or Active/Active

Security |2 Optional licenses: 5 10 20 50 100

Contexts

Clustering | Disabled Optional license: Available for 16 units

VLANS, | 1024

Maxinum

ASA 5585-X with SSP-20 License Features

\)

The following table shows the licensed features for the ASA 5585-X with SSP-20.

You can use two SSPs of the same level in the same chassis. Mixed-level SSPs are not supported (for example,
an SSP-20 with an SSP-40 is not supported). Each SSP acts as an independent device, with separate
configurations and management. You can use the two SSPs as a failover pair if desired.

Note  With the 10,000-session UC license, the total combined sessions can be 10,000, but the maximum number of
Phone Proxy sessions is 5000.
Licenses | Base and Security Plus Licenses
Firewall Licenses
Botnet | Disabled Optional Time-based license: Available
Traffic
Filter
Firewall | 2,000,000
Conns,
Concurrent
Carrier |Disabled Optional license: Available
Total 2 Optional licenses:
TLS
Proxy 24 50 100 250 500 750 1000 2000 3000 5000 10,000
Sessions
VPN Licenses
AmyCorat | Disabled Optional AnyConnect Plus or Apex license: 10,000 maximum
peers
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. ASA 5585-X with SSP-40 and -60 License Features

Licenses

Base and Security Plus Licenses

Other
VPN
Peers

10,000

Total
VPN
Peers,
combined
all types

10,000

VPN
Load
Balancing

Enabled

General

Licenses

10 GE
/'O

Base License: Disabled; fiber ifcs run at 1 GE Security Plus License: Enabled; fiber ifcs run at 10 GE

Encryption

Base (DES) Optional license: Srong (3DESAES)

Failover

Active/Standby or Active/Active

Security
Contexts

2

Optional licenses: 5 10 20 50 100 250

Clustering

Disabled

Optional license: Available for 16 units

VLANS,
Maximum

1024

ASA 5585-X with SSP-40 and -60 License Features

\}

The following table shows the licensed features for the ASA 5585-X with SSP-40 and -60.

You can use two SSPs of the same level in the same chassis. Mixed-level SSPs are not supported (for example,
an SSP-40 with an SSP-60 is not supported). Each SSP acts as an independent device, with separate
configurations and management. You can use the two SSPs as a failover pair if desired.

Note

With the 10,000-session UC license, the total combined sessions can be 10,000, but the maximum number of
Phone Proxy sessions is 5000.

Licenses

Base License

Firewall

Licenses

Botnet
Traffic
Filter

Disabled

Optional Time-based license: Available
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Licenses | Base License

Firewall | 5585-X with SSP-40: 4,000,000 5585-X with SSP-60: 10,000,000

Conns,

Concurrent

Carrier |Disabled Optional license: Available

Total 2 Optional licenses:

TLS

Proxy 24 50 100 250 500 750 1000 2000 3000 5000 10,000
Sessions

VPN Licenses

AmyComat | Disabled Optional AnyConnect Plus or Apex license: 10,000 maximum
peers

Other 10,000
VPN
Peers

Total 10,000
VPN
Peers,
combined

all types

VPN Enabled
Load
Balancing

General Licenses

10 GE |Enabled; fiber ifcs run at 10 GE
1/0

Encryption | Base (DES) Optional license: Strong (3DESAES)

Failover | Active/Standby or Active/Active

Security |2 Optional licenses: 5 10 20 50 100 250
Contexts

Clustering | Disabled Optional license: Available for 16 units

VLAN:S, | 1024

Maximum

ASASM License Features

The following table shows the licensed features for the ASA Services Module.
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\}

Note  With the 10,000-session UC license, the total combined sessions can be 10,000, but the maximum number of
Phone Proxy sessions is 5000.

Licenses | Base License

Firewall Licenses

Botnet | Disabled Optional Time-based license: Available
Traffic
Filter

Firewall | 10,000,000
Conns,
Concuurent

Carrier |Disabled Optional license: Available

Total 2 Optional licenses:

TLS
Proxy 24 50 100 250 500 750 1000 2000 3000 5000 10,000

Sessions

VPN Licenses

AmGComet | Disabled Optional AnyConnect Plus or Apex license: 10,000 maximum
peers

Other 10,000
VPN
Peers

Total 10,000
VPN
Peers,
combined
all types

VPN Enabled
Load
Balancing

General Licenses

Encryption | Base (DES) Optional license: Strong (3DESAES)
Failover | Active/Standby or Active/Active
Security |2 Optional licenses:
Contexts
5 10 20 50 100 250

Clustering | No support
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Licenses

Base License

VLAN:S,
Maximum

1000

ISA 3000 License Features

The following table shows the licensed features for the ISA 3000.

Licenses | Base License Security Plus License

Firewall Licenses

Botnet | No support No Support

Traffic

Filter

Firewall | 20,000 50,000

Conns,

Concurrent

Carrier | No Support No Support

Total 160 160

TLS

Proxy

Sessions

VPN Licenses

AmyCamat | Disabled Optional AnyConnect Plus or Apex Disabled Optional AnyConnect Plus or Apex
peers license: 25 maximum license: 25 maximum
Other 10 50

VPN

Peers

Total 25 50

VPN

Peers,

combined

all types

VPN No support No support

Load

Balancing

General Licenses

Encryption | Base (DES) Opt. lic.: Strong (SDESAES) Base (DES) Opt. lic.: Strong (SDESAES)
Failover | No support Active/Standby
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. Monitoring PAK Licenses

Licenses | Base License Security Plus License
Security | No support No Support

Contexts

Clustering | No Support No Support

VLAN:S, |5 25

Maximum

Monitoring PAK Licenses

This section describes how to view license information.

Viewing Your Current License

Step 1

Step 2

Step 3

This section describes how to view your current license, and for time-based activation keys, how much time
the license has left.

Before you begin

If you have a No Payload Encryption model, then you view the license, VPN and Unified Communications
licenses will not be listed. See No Payload Encryption Models, on page 103 for more information.

Procedure

To view the running license, which is a combination of the permanent license and any active time-based
licenses, choose the Configuration > Device Management > Licensing > Activation Key pane and view
the Running Licenses area.

In multiple context mode, view the activation key in the System execution space by choosing the Configuration
> Device Management > Activation Key pane.

For a failover pair, the running license shown is the combined license from the primary and secondary units.
See How Failover or ASA Cluster Licenses Combine, on page 101 for more information. For time-based
licenses with numerical values (the duration is not combined), the License Duration column displays the
shortest time-based license from either the primary or secondary unit; when that license expires, the license
duration from the other unit displays.

(Optional) To view time-based license details, such as the features included in the license and the duration,
in the Time-Based License Keys Installed area, choose a license key, and then click Show License Details.

(Optional) For a failover unit, to view the license installed on this unit (and not the combined license from
both primary and secondary units), in the Running Licenses area, click Show information of license specifically
purchased for this device alone.
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Monitoring the Shared License

To monitor the shared license, choose Monitoring > VPN > Clientless SSL VPN > Shared Licenses.

History for PAK Licenses

Feature Name Platform Releases Description

Increased Connections and VLANSs 7.0(5) Increased the following limits:

* ASA5510 Base license connections
from 32000 to 5000; VLANSs from 0
to 10.

* ASA5510 Security Plus license
connections from 64000 to 130000;
VLANS from 10 to 25.

* ASA5520 connections from 130000
to 280000; VLANSs from 25 to 100.

* ASA5540 connections from 280000
to 400000; VLANSs from 100 to 200.

SSL VPN Licenses 7.1(1) SSL VPN licenses were introduced.
Increased SSL VPN Licenses 7.2(1) A 5000-user SSL VPN license was

introduced for the ASA 5550 and above.
Increased interfaces for the Base license on | 7.2(2) For the Base license on the ASA 5510, the
the ASA 5510 maximum number of interfaces was

increased from 3 plus a management
interface to unlimited interfaces.
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Feature Name

Platform Releases

Description

Increased VLANS

7.2(2)

The maximum number of VLANS for the
Security Plus license on the ASA 5505 was
increased from 5 (3 fully functional; 1
failover; one restricted to a backup
interface) to 20 fully functional interfaces.
In addition, the number of trunk ports was
increased from 1 to 8. Now there are 20
fully functional interfaces, you do not need
to use the backup interface command to
cripple a backup ISP interface; you can use
a fully functional interface for it. The
backup interface command is still useful
for an Easy VPN configuration.

VLAN limits were also increased for the
ASA 5510 (from 10 to 50 for the Base
license, and from 25 to 100 for the Security
Plus license), the ASA 5520 (from 100 to
150), the ASA 5550 (from 200 to 250).

Gigabit Ethernet Support for the ASA 5510
Security Plus License

7.2(3)

The ASA 5510 now supports Gigabit
Ethernet (1000 Mbps) for the Ethernet 0/0
and 0/1 ports with the Security Plus license.
In the Base license, they continue to be used
as Fast Ethernet (100 Mbps) ports. Ethernet
0/2, 0/3, and 0/4 remain as Fast Ethernet
ports for both licenses.

Note The interface names remain
Ethernet 0/0 and Ethernet 0/1.
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History for PAK Licenses .

Feature Name

Platform Releases

Description

Advanced Endpoint Assessment License

8.002)

The Advanced Endpoint Assessment license
was introduced. As a condition for the
completion of a Cisco AnyConnect or
clientless SSL VPN connections, the remote
computer scans for a greatly expanded
collection of antivirus and antispyware
applications, firewalls, operating systems,
and associated updates. It also scans for any
registry entries, filenames, and process
names that you specify. It sends the scan
results to the ASA. The ASA uses both the
user login credentials and the computer scan
results to assign a Dynamic Access Policy
(DAP).

With an Advanced Endpoint Assessment
License, you can enhance Host Scan by
configuring an attempt to update
noncompliant computers to meet version
requirements.

Cisco can provide timely updates to the list
of applications and versions that Host Scan
supports in a package that is separate from
Cisco Secure Desktop.

VPN Load Balancing for the ASA 5510

8.0(2)

VPN load balancing is now supported on
the ASA 5510 Security Plus license.

AnyConnect for Mobile License

8.03)

The AnyConnect for Mobile license was
introduced. It lets Windows mobile devices
connect to the ASA using the AnyConnect
client.

Time-based Licenses

8.0(4)/8.1(2)

Support for time-based licenses was
introduced.

Increased VLANSs for the ASA 5580 8.1(2) The number of VLANSs supported on the
ASA 5580 are increased from 100 to 250.
Unified Communications Proxy Sessions | 8.0(4) The UC Proxy sessions license was

license

introduced. Phone Proxy, Presence
Federation Proxy, and Encrypted Voice
Inspection applications use TLS proxy
sessions for their connections. Each TLS
proxy session is counted against the UC
license limit. All of these applications are
licensed under the UC Proxy umbrella, and
can be mixed and matched.

This feature is not available in Version 8.1.
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Feature Name

Platform Releases

Description

Botnet Traffic Filter License

8.2(1)

The Botnet Traffic Filter license was
introduced. The Botnet Traffic Filter
protects against malware network activity
by tracking connections to known bad
domains and IP addresses.

AnyConnect Essentials License

8.2(1)

The AnyConnect Essentials License was
introduced. This license enables
AnyConnect VPN client access to the ASA.
This license does not support browser-based
SSL VPN access or Cisco Secure Desktop.
For these features, activate an AnyConnect
Premium license instead of the AnyConnect
Essentials license.

Note With the AnyConnect Essentials
license, VPN users can use a
Web browser to log in, and
download and start
(WebLaunch) the AnyConnect
client.

The AnyConnect client software offers the
same set of client features, whether it is
enabled by this license or an AnyConnect
Premium license.

The AnyConnect Essentials license cannot
be active at the same time as the following
licenses on a given ASA: AnyConnect
Premium license (all types) or the
Advanced Endpoint Assessment license.
You can, however, run AnyConnect
Essentials and AnyConnect Premium
licenses on different ASAs in the same
network.

By default, the ASA uses the AnyConnect
Essentials license, but you can disable it to
use other licenses by using the
Configuration > Remote Access VPN >
Network (Client) Access > Advanced >
AnyConnect Essentials pane.

SSL VPN license changed to AnyConnect
Premium SSL VPN Edition license

8.2(1)

The SSL VPN license name was changed
to the AnyConnect Premium SSL VPN
Edition license.
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Feature Name

Platform Releases

Description

Shared Licenses for SSL VPN

8.2(1)

Shared licenses for SSL VPN were
introduced. Multiple ASAs can share a pool
of SSL VPN sessions on an as-needed
basis.

Mobility Proxy application no longer
requires Unified Communications Proxy
license

8.2(2)

The Mobility Proxy no longer requires the
UC Proxy license.

10 GE I/O license for the ASA 5585-X with
SSP-20

8.2(3)

We introduced the 10 GE I/O license for
the ASA 5585-X with SSP-20 to enable
10-Gigabit Ethernet speeds for the fiber
ports. The SSP-60 supports 10-Gigabit
Ethernet speeds by default.

Note The ASA 5585-X is not
supported in 8.3(x).

10 GE I/O license for the ASA 5585-X with
SSP-10

8.2(4)

We introduced the 10 GE I/O license for
the ASA 5585-X with SSP-10 to enable
10-Gigabit Ethernet speeds for the fiber
ports. The SSP-40 supports 10-Gigabit
Ethernet speeds by default.

Note The ASA 5585-X is not
supported in 8.3(x).

Non-identical failover licenses

8.3(1)

Failover licenses no longer need to be
identical on each unit. The license used for
both units is the combined license from the
primary and secondary units.

We modified the following screen:
Configuration > Device Management >
Licensing > Activation Key.

Stackable time-based licenses

8.3(1)

Time-based licenses are now stackable. In
many cases, you might need to renew your
time-based license and have a seamless
transition from the old license to the new
one. For features that are only available
with a time-based license, it is especially
important that the license not expire before
you can apply the new license. The ASA
allows you to stack time-based licenses so
that you do not have to worry about the
license expiring or about losing time on
your licenses because you installed the new
one early.

Intercompany Media Engine License

8.3(1)

The IME license was introduced.
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Feature Name

Platform Releases

Description

Multiple time-based licenses active at the
same time

8.3(1)

You can now install multiple time-based
licenses, and have one license per feature
active at a time.

The following screen was modified:
Configuration > Device Management >
Licensing > Activation Key.

Discrete activation and deactivation of
time-based licenses.

8.3(1)

You can now activate or deactivate
time-based licenses using a command.

We modified the following screen:
Configuration > Device Management >
Licensing > Activation Key.

AnyConnect Premium SSL VPN Edition
license changed to AnyConnect Premium
SSL VPN license

8.3(1)

The AnyConnect Premium SSL VPN
Edition license name was changed to the
AnyConnect Premium SSL VPN license.

No Payload Encryption image for export

8.3(2)

If you install the No Payload Encryption
software on the ASA 5505 through 5550,
then you disable Unified Communications,
strong encryption VPN, and strong
encryption management protocols.

Note This special image is only
supported in 8.3(x); for No
Payload Encryption support in
8.4(1) and later, you need to
purchase a special hardware
version of the ASA.

Increased contexts for the ASA 5550, 5580,
and 5585-X

8.4(1)

For the ASA 5550 and ASA 5585-X with
SSP-10, the maximum contexts was
increased from 50 to 100. For the ASA
5580 and 5585-X with SSP-20 and higher,
the maximum was increased from 50 to
250.

Increased VLANS for the ASA 5580 and
5585-X

8.4(1)

For the ASA 5580 and 5585-X, the
maximum VLANSs was increased from 250
to 1024.
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Feature Name

Platform Releases

Description

Increased connections for the ASA 5580
and 5585-X

8.4(1)

We increased the firewall connection limits:

* ASA 5580-20—1,000,000 to
2,000,000.

* ASA 5580-40—2,000,000 to
4,000,000.

« ASA 5585-X with SSP-10: 750,000
to 1,000,000.

* ASA 5585-X with SSP-20: 1,000,000
to 2,000,000.

* ASA 5585-X with SSP-40: 2,000,000
to 4,000,000.

* ASA 5585-X with SSP-60: 2,000,000
to 10,000,000.

AnyConnect Premium SSL VPN license
changed to AnyConnect Premium license

8.4(1)

The AnyConnect Premium SSL VPN
license name was changed to the
AnyConnect Premium license. The license
information display was changed from
“SSL VPN Peers” to “AnyConnect
Premium Peers.”

Increased AnyConnect VPN sessions for
the ASA 5580

8.4(1)

The AnyConnect VPN session limit was
increased from 5,000 to 10,000.

Increased Other VPN sessions for the ASA
5580

8.4(1)

The other VPN session limit was increased
from 5,000 to 10,000.

IPsec remote access VPN using IKEv2

8.4(1)

IPsec remote access VPN using IKEv2 was
added to the AnyConnect Essentials and
AnyConnect Premium licenses.

Note The following limitation exists
in our support for IKEv2 on the
ASA: We currently do not
support duplicate security
associations.

IKEV?2 site-to-site sessions were added to
the Other VPN license (formerly IPsec
VPN). The Other VPN license is included
in the Base license.
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Feature Name

Platform Releases

Description

No Payload Encryption hardware for export

8.4(1)

For models available with No Payload
Encryption (for example, the ASA 5585-X),
the ASA software disables Unified
Communications and VPN features, making
the ASA available for export to certain
countries.

Dual SSPs for SSP-20 and SSP-40

8.4(2)

For SSP-40 and SSP-60, you can use two
SSPs of the same level in the same chassis.
Mixed-level SSPs are not supported (for
example, an SSP-40 with an SSP-60 is not
supported). Each SSP acts as an
independent device, with separate
configurations and management. You can
use the two SSPs as a failover pair if
desired. When using two SSPs in the
chassis, VPN is not supported; note,
however, that VPN has not been disabled.

IPS Module license for the ASA 5512-X
through ASA 5555-X

8.6(1)

The IPS SSP software module on the ASA
5512-X, ASA 5515-X, ASA 5525-X, ASA
5545-X, and ASA 5555-X requires the IPS
module license.

Clustering license for the ASA 5580 and
ASA 5585-X.

9.0(1)

A clustering license was added for the ASA
5580 and ASA 5585-X.

Support for VPN on the ASASM

9.0(1)

The ASASM now supports all VPN
features.

Unified communications support on the
ASASM

9.0(1)

The ASASM now supports all Unified
Communications features.

ASA 5585-X Dual SSP support for the
SSP-10 and SSP-20 (in addition to the
SSP-40 and SSP-60); VPN support for Dual
SSPs

9.0(1)

The ASA 5585-X now supports dual SSPs
using all SSP models (you can use two
SSPs of the same level in the same chassis).
VPN is now supported when using dual
SSPs.

ASA 5500-X support for clustering

9.1(4)

The ASA 5512-X, ASA 5515-X, ASA
5525-X, ASA 5545-X, and ASA 5555-X
now support 2-unit clusters. Clustering for
2 units is enabled by default in the base
license; for the ASA 5512-X, you need the
Security Plus license.

Support for 16 cluster members for the
ASA 5585-X

9.2(1)

The ASA 5585-X now supports 16-unit
clusters.
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Feature Name Platform Releases Description
ASAv4 and ASAv30 Standard and 9.2(1) The ASAv was introduced with a simple
Premium model licenses introduced licensing scheme: ASAv4 and ASAv30

permanent licenses in Standard or Premium
levels. No add-on licenses are available.
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CHAPTER 5

Licenses: Smart Software Licensing (ASAv, ASA
on Firepower)

Cisco Smart Software Licensing lets you purchase and manage a pool of licenses centrally. Unlike product
authorization key (PAK) licenses, smart licenses are not tied to a specific serial number. You can easily deploy
or retire ASAs without having to manage each unit’s license key. Smart Software Licensing also lets you see
your license usage and needs at a glance.

Note  Smart Software Licensing is only supported on the ASAv and ASA Firepower chassis. Other models use PAK
licenses. See About PAK Licenses, on page 93.

For more information about Smart Licensing features and behaviors per platform, see Smart Enabled Product
Families.

» About Smart Software Licensing, on page 143

* Prerequisites for Smart Software Licensing, on page 154

* Guidelines for Smart Software Licensing, on page 157

* Defaults for Smart Software Licensing, on page 157

* ASAv: Configure Smart Software Licensing, on page 158

* Firepower 2100: Configure Smart Software Licensing, on page 165
* Firepower 4100/9300: Configure Smart Software Licensing, on page 175
* Licenses Per Model, on page 178

* Monitoring Smart Software Licensing, on page 183

* Smart Software Manager Communication, on page 184

* History for Smart Software Licensing, on page 186

About Smart Software Licensing

This section describes how Smart Software Licensing works.

Smart Software Licensing for the ASA on the Firepower 4100/9300 Chassis

For the ASA on the Firepower 4100/9300 chassis, Smart Software Licensing configuration is split between
the Firepower 4100/9300 chassis supervisor and the ASA.
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. Smart Software Manager and Accounts

* Firepower 4100/9300 chassis—Configure all Smart Software Licensing infrastructure on the chassis,
including parameters for communicating with the License Authority. The Firepower 4100/9300 chassis
itself does not require any licenses to operate.

N

Note Inter-chassis clustering requires that you enable the same Smart Licensing method
on each chassis in the cluster.

» ASA Application—Configure all license entitlements in the ASA.

Smart Software Manager and Accounts

When you purchase 1 or more licenses for the device, you manage them in the Cisco Smart Software Manager:
https://software.cisco.com/#module/SmartLicensing

The Smart Software Manager lets you create a master account for your organization.

Note

If you do not yet have an account, click the link to set up a new account. The Smart Software Manager lets
you create a master account for your organization.

By default, your licenses are assigned to the Default Virtual Account under your master account. As the
account administrator, you can optionally create additional virtual accounts; for example, you can create
accounts for regions, departments, or subsidiaries. Multiple virtual accounts let you more easily manage large
numbers of licenses and devices.

Offline Management

If your devices do not have internet access, and cannot register with the License Authority, you can configure
offline licensing.

Permanent License Reservation

If your devices cannot access the internet for security reasons, you can optionally request permanent licenses
for each ASA. Permanent licenses do not require periodic access to the License Authority. Like PAK licenses,
you will purchase a license and install the license key for the ASA. Unlike a PAK license, you obtain and
manage the licenses with the Smart Software Manager. You can easily switch between regular smart licensing
mode and permanent license reservation mode.

ASAv Permanent License Reservation

You can obtain a model-specific license that enables all features: Standard tier; maximum throughput for your
model; Strong Encryption (3DES/AES) license if your account qualifies; and AnyConnect client capabilities
enabled to the platform maximum, contingent on your purchase of an AnyConnect license that enables the

right to use AnyConnect (see AnyConnect Plus, AnyConnect Apex, And VPN Only Licenses, on page 147).

* ASAvS
+ ASAv10
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* ASAv30
* ASAvV50

You must choose the model level that you want to use during ASAv deployment. That model level determines
the license you request. If you later want to change the model level of a unit, you will have to return the current
license and request a new license at the correct model level. To change the model of an already deployed
ASAv, from the hypervisor you can change the vCPUs and DRAM settings to match the new model
requirements; see the ASAv quick start guide for these values.

If you stop using a license, you must return the license by generating a return code on the ASAv, and then
entering that code into the Smart Software Manager. Make sure you follow the return process correctly so
you do not pay for unused licenses.

Permanent license reservation is not supported for the Azure hypervisor.
Firepower 2100 Permanent License Reservation

You can obtain a license that enables all features: Standard tier; maximum Security Contexts; Strong Encryption
(3DES/AES) license if your account qualifies; and AnyConnect client capabilities enabled to the platform
maximum, contingent on your purchase of an AnyConnect license that enables the right to use AnyConnect
(see AnyConnect Plus, AnyConnect Apex, And VPN Only Licenses, on page 147) You also need to request
the entitlements in the ASA configuration so that the ASA allows their use.

If you stop using a license, you must return the license by generating a return code on the ASA, and then
entering that code into the Smart Software Manager. Make sure you follow the return process correctly so
you do not pay for unused licenses.

Firepower 4100/9300 chassis Permanent License Reservation

You can obtain a license that enables all features: Standard tier; maximum Security Contexts; Carrier license;
Strong Encryption (3DES/AES) license if your account qualifies; and AnyConnect client capabilities enabled
to the platform maximum, contingent on your purchase of an AnyConnect license that enables the right to
use AnyConnect (see AnyConnect Plus, AnyConnect Apex, And VPN Only Licenses, on page 147). The
license is managed on the Firepower 4100/9300 chassis, but you also need to request the entitlements in the
ASA configuration so that the ASA allows their use.

If you stop using a license, you must return the license by generating a return code on the Firepower 4100/9300
chassis, and then entering that code into the Smart Software Manager. Make sure you follow the return process
correctly so you do not pay for unused licenses.

Satellite Server (Smart Software Manager On-Prem)

If your devices cannot access the internet for security reasons, you can optionally install a local Smart Software
Manager satellite (also known as On-Prem) server as a virtual machine (VM). The satellite provides a subset
of Smart Software Manager functionality, and allows you to provide essential licensing services for all your
local devices. Only the satellite needs to connect periodically to the main License Authority to sync your
license usage. You can sync on a schedule or you can sync manually.

You can perform the following functions on the satellite server:

* Activate or register a license
* View your company's licenses

* Transfer licenses between company entities

For more information, see Smart Software Manager satellite.
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. Licenses and Devices Managed per Virtual Account

Licenses and Devices Managed per Virtual Account

Licenses and devices are managed per virtual account: only that virtual account’s devices can use the licenses
assigned to the account. If you need additional licenses, you can transfer an unused license from another
virtual account. You can also transfer devices between virtual accounts.

For the ASA on the Firepower 4100/9300 chassis—Only the chassis registers as a device, while the ASA
applications in the chassis request their own licenses. For example, for a Firepower 9300 chassis with 3 security
modules, the chassis counts as one device, but the modules use 3 separate licenses.

Evaluation License

\}

ASAv

The ASAv does not support an evaluation mode. Before the ASAv registers with the Licensing Authority, it
operates in a severely rate-limited state.

Firepower 2100

Before the Firepower 2100 registers with the Licensing Authority, it operates for 90 days (total usage) in
evaluation mode. Only default entitlements are enabled. When this period ends, the Firepower 2100 becomes
out-of-compliance.

Note

\}

You cannot receive an evaluation license for Strong Encryption (3DES/AES); you must register with the
License Authority to receive the export-compliance token that enables the Strong Encryption (3DES/AES)
license.

Firepower 4100/9300 Chassis
The Firepower 4100/9300 chassis supports two types of evaluation license:

* Chassis-level evaluation mode—Before the Firepower 4100/9300 chassis registers with the Licensing
Authority, it operates for 90 days (total usage) in evaluation mode. The ASA cannot request specific
entitlements in this mode; only default entitlements are enabled. When this period ends, the Firepower
4100/9300 chassis becomes out-of-compliance.

* Entitlement-based evaluation mode—A fter the Firepower 4100/9300 chassis registers with the Licensing
Authority, you can obtain time-based evaluation licenses that can be assigned to the ASA. In the ASA,
you request entitlements as usual. When the time-based license expires, you need to either renew the
time-based license or obtain a permanent license.

Note

You cannot receive an evaluation license for Strong Encryption (3DES/AES); you must register with the
License Authority and obtain a permanent license to receive the export-compliance token that enables the
Strong Encryption (3DES/AES) license.
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About Licenses by Type

The following sections include additional information about licenses by type.

AnyConnect Plus, AnyConnect Apex, And VPN Only Licenses

The AnyConnect Plus, AnyConnect Apex, or VPN Only license is a multi-use license that you can apply to
multiple ASAs, all of which share a user pool as specified by the license. Devices that use Smart Licensing
do not require any AnyConnect license to be physically applied to the actual platform. The same licenses must
still be purchased, and you must still link the Contract number to your Cisco.com ID for SW Center access
and technical support. For more information, see:

* Cisco AnyConnect Ordering Guide
» AnyConnect Licensing Frequently Asked Questions (FAQ)

Other VPN License
Other VPN sessions include the following VPN types:

* [Psec remote access VPN using IKEv1
* [Psec site-to-site VPN using IKEv1
* [Psec site-to-site VPN using IKEv2

This license is included in the Base license.

Total VPN Sessions Combined, All Types

* Although the maximum VPN sessions add up to more than the maximum VPN AnyConnect and Other
VPN sessions, the combined sessions should not exceed the VPN session limit. If you exceed the maximum
VPN sessions, you can overload the ASA, so be sure to size your network appropriately.

* If you start a clientless SSL VPN session and then start an AnyConnect client session from the portal, 1
session is used in total. However, if you start the AnyConnect client first (from a standalone client, for
example) and then log into the clientless SSL VPN portal, then 2 sessions are used.

Encryption License

Strong Encryption: ASAv

Strong Encryption (3DES/AES) is available for management connections before you connect to the License
Authority or Satellite server, so you can launch ASDM and connect to the License Authority. For
through-the-box traffic, throughput is severely limited until you connect to the License Authority and obtain
the Strong Encryption license.

When you request the registration token for the ASAv from your Smart Software Licensing account, check
the Allow export-controlled functionality on the products registered with this token check box so that
the Strong Encryption (3DES/AES) license is applied (your account must be qualified for its use). If the ASAv
becomes out-of-compliance later, as long as the export compliance token was successfully applied, the ASAv
will retain the license and not revert to the rate-limited state. The license is removed if you re-register the
ASAv, and export compliance is disabled, or if you restore the ASAv to factory default settings.
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If you initially register the ASAv without strong encryption and later add strong encryption, then you must
reload the ASAv for the new license to take effect.

For permanent license reservation licenses, the Strong Encryption (3DES/AES) license is enabled if your
account qualifies for its use.

For pre-2.3.0 Satellite server versions, you must manually request the Strong Encryption license in the ASA
configuration (the export compliance token is not supported); in this case, if the ASAv becomes
out-of-compliance, throughput is severely limited.

Strong Encryption: Firepower 2100

Strong Encryption (3DES/AES) is available for management connections before you connect to the License
Authority or Satellite server so you can launch ASDM. Note that ASDM access is only available on
management-only interfaces with the default encryption. Through the box traffic is not allowed until you
connect and obtain the Strong Encryption license.

When you request the registration token for the ASA from your Smart Software Licensing account, check the
Allow export-controlled functionality on the products registered with this token check box so that the
Strong Encryption (3DES/AES) license is applied (your account must be qualified for its use). If the ASA
becomes out-of-compliance later, as long as the export compliance token was successfully applied, the ASA
will continue to allow through the box traffic. Even if you re-register the ASA, and export compliance is
disabled, the license remains enabled. The license is removed if you restore the ASA to factory default settings.

If you initially register the ASA without strong encryption and later add strong encryption, then you must
reload the ASA for the new license to take effect.

For permanent license reservation licenses, the Strong Encryption (3DES/AES) license is enabled if your
account qualifies for its use.

For pre-2.3.0 Satellite server versions, you must manually request the Strong Encryption license in the ASA
configuration (the export compliance token is not supported); in this case, if the ASA becomes
out-of-compliance, through-traffic will not be allowed.

Strong Encryption: Firepower 4100/9300 Chassis

When the ASA is deployed as a logical device, you can launch ASDM immediately. Through the box traffic
is not allowed until you connect and obtain the Strong Encryption license.

When you request the registration token for the Firepower chassis from your Smart Software Licensing
account, check the Allow export-controlled functionality on the products registered with this token check
box so that the Strong Encryption (3DES/AES) license is applied (your account must be qualified for its use).

Ifthe ASA becomes out-of-compliance later, as long as the export compliance token was successfully applied,
the ASA will continue to allow through the box traffic. The license is removed if you re-register the chassis,
and export compliance is disabled, or if you restore the chassis to factory default settings.

If you initially register the chassis without strong encryption and later add strong encryption, then you must
reload the ASA application for the new license to take effect.

For permanent license reservation licenses, the Strong Encryption (3DES/AES) license is enabled if your
account qualifies for its use.

For pre-2.3.0 Satellite server versions that do not support the export-compliance token: You must manually
request the Strong Encryption license in the ASA configuration using the CLI because ASDM requires 3DES.
If the ASA becomes out-of-compliance, neither management traffic nor through-traffic requiring this license
will be allowed.
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Carrier License

Carrier License .

DES: All Models

The DES license cannot be disabled. If you have the 3DES license installed, DES is still available. To prevent
the use of DES when you want to only use strong encryption, be sure to configure any relevant commands to
use only strong encryption.

The Carrier license enables the following inspection features:

» Diameter
* GTP/GPRS
» SCTP

Total TLS Proxy Sessions

Each TLS proxy session for Encrypted Voice Inspection is counted against the TLS license limit.

Other applications that use TLS proxy sessions do not count toward the TLS limit, for example, Mobility
Advantage Proxy (which does not require a license).

Some applications might use multiple sessions for a connection. For example, if you configure a phone with
a primary and backup Cisco Unified Communications Manager, there are 2 TLS proxy connections.

You independently set the TLS proxy limit using the tls-proxy maximum-sessions command or in ASDM,
using the Configuration > Firewall > Unified Communications > TLS Proxy pane. To view the limits of
your model, enter the tls-proxy maximum-sessions ? command. When you apply a TLS proxy license that
is higher than the default TLS proxy limit, the ASA automatically sets the TLS proxy limit to match the
license. The TLS proxy limit takes precedence over the license limit; if you set the TLS proxy limit to be less
than the license, then you cannot use all of the sessions in your license.

Note

For license part numbers ending in “K8” (for example, licenses under 250 users), TLS proxy sessions are
limited to 1000. For license part numbers ending in “K9” (for example, licenses 250 users or larger), the
TLS proxy limit depends on the configuration, up to the model limit. K8 and K9 refer to whether the license
is restricted for export: K8 is unrestricted, and K9 is restricted.

If you clear the configuration (using the clear configure all command, for example), then the TLS proxy
limit is set to the default for your model; if this default is lower than the license limit, then you see an error
message to use the tls-proxy maximum-sessions command to raise the limit again (in ASDM, use the TLS
Proxy pane). If you use failover and enter the write standby command or in ASDM, use File > Save Running
Configuration to Standby Unit on the primary unit to force a configuration synchronization, the clear
configure all command is generated on the secondary unit automatically, so you may see the warning message
on the secondary unit. Because the configuration synchronization restores the TLS proxy limit set on the
primary unit, you can ignore the warning.

You might also use SRTP encryption sessions for your connections:

* For K8 licenses, SRTP sessions are limited to 250.

* For K9 licenses, there is no limit.
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. VLANs, Maximum

\}

Note  Only calls that require encryption/decryption for media are counted toward the SRTP limit; if passthrough is
set for the call, even if both legs are SRTP, they do not count toward the limit.

VLANs, Maximum

For an interface to count against the VLAN limit, you must assign a VLAN to it.

Botnet Traffic Filter License
Requires a Strong Encryption (3DES/AES) License to download the dynamic database.

Failover or ASA Cluster Licenses

Failover Licenses for the ASAv

The standby unit requires the same model license as the primary unit.

Failover Licenses for the Firepower 2100
Regular or Satellite Smart Licensing

Only the active unit requests licenses from the server. Licenses are aggregated into a single failover license
that is shared by the failover pair. There is no extra cost for secondary units.

After you enable failover for Active/Standby failover, you can only configure smart licensing on the active
unit. For Active/Active failover, you can only configure smart licensing on the unit with failover group 1 as
active. The configuration is replicated to the standby unit, but the standby unit does not use the configuration;
it remains in a cached state. The aggregated license is also cached on the standby unit to be used if it becomes
the active unit in the future.

Note Each ASA must have the same encryption license when forming a failover pair. When you register an ASA
to the smart licensing server, the Strong Encryption license is automatically enabled for qualified customers
when you apply the registration token. Because of this requirement, you have two choices for licensing when
you use the Strong Encryption token with failover:

* Before you enable failover, register both units to the smart licensing server. In this case, both units will
have strong encryption. Then, after you enable failover, continue configuring license entitlements on the
active unit. If you enable encryption for the failover link, it will use AES/3DES (strong encryption).

* Before you register the active unit to the smart licensing server, enable failover. In this case, both units
will not yet have strong encryption. Then configure license entitlements and register the active unit to
the smart licensing server; both units will get strong encryption from the aggregated license. Note that
if you enabled encryption on the failover link, it will use DES (weak encryption) because the failover
link was established before the units gained strong encryption. You must reload both units to use
AES/3DES on the link. If you only reload one unit, then that unit will try to use AES/3DES while the
original unit uses DES, which will result in both units becoming active (split brain).
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Each add-on license type is managed as follows:

* Standard—Although only the active unit requests this license from the server, the standby unit has the
Standard license enabled by default; it does not need to register with the server to use it.

» Context—Only the active unit requests this license. However, the Standard license includes 2 contexts
by default and is present on both units. The value from each unit’s Standard license plus the value of the
Context license on the active unit are combined up to the platform limit. For example:

* The Standard license includes 2 contexts; for two Firepower 2130 units, these licenses add up to 4
contexts. You configure a 30-Context license on the active unit in an Active/Standby pair. Therefore,
the aggregated failover license includes 34 contexts. However, because the platform limit for one
unit is 30, the combined license allows a maximum of 30 contexts only. In this case, you might only
configure the active Context license to be 25 contexts.

The Standard license includes 2 contexts; for two Firepower 2130 units, these licenses add up to 4
contexts. You configure a 10-Context license on the primary unit in an Active/Active pair. Therefore,
the aggregated failover license includes 14 contexts. One unit can use 9 contexts and the other unit
can use 5 contexts, for example, for a total of 14. Because the platform limit for one unit is 30, the
combined license allows a maximum of 30 contexts; the 14 contexts are within the limit.

* Strong Encryption (3DES/AES) (for a pre-2.3.0 Cisco Smart Software Manager satellite deployment
when you cannot use the strong encryption token, or for tracking purposes)—Only the active unit requests
this license, and both units can use it due to license aggregation.

After a failover, the new active unit continues to use the aggregated license. It uses the cached license
configuration to re-request the entitlement from the server. When the old active unit rejoins the pair as a
standby unit, it releases the license entitlement. Before the standby unit releases the entitlement, the new active
unit's license might be in a non-compliant state if there are no available licenses in the account. The failover
pair can use the aggregated license for 30 days, but if it is still non-compliant after the grace period, you will
not be able to make configuration changes to features requiring special licenses (i.e. add an extra context);
operation is otherwise unaffected. The new active unit sends an entitlement authorization renewal request
every 35 seconds until the license is compliant. If you disband the failover pair, then the active unit releases
the entitlements, and both units retain the licensing configuration in a cached state. To re-activate licensing,
you need to clear the configuration on each unit, and re-configure it.

Permanent License Reservation

For permanent license reservation, you must purchase separate licenses for each chassis and enable the licenses
before you configure failover.

Failover Licenses for the ASA on the Firepower 4100/9300 Chassis
Regular or Satellite Smart Licensing

Both Firepower 4100/9300 chassis must be registered with the License Authority or satellite server before
you configure failover. There is no extra cost for secondary units.

The Strong Encryption license is automatically enabled for qualified customers when you apply the registration
token. When using the token, each chassis must have the same encryption license. For the optional Strong
Encryption (3DES/AES) feature license enabled in the ASA configuration, see below.

After you enable failover, for the ASA license configuration for Active/Standby failover, you can only configure
smart licensing on the active unit. For Active/Active failover, you can only configure smart licensing on the
unit with failover group 1 as active. The configuration is replicated to the standby unit, but the standby unit

does not use the configuration; it remains in a cached state. Only the active unit requests the licenses from
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. ASA Cluster Licenses for the ASA on the Firepower 4100/9300 Chassis

the server. The licenses are aggregated into a single failover license that is shared by the failover pair, and
this aggregated license is also cached on the standby unit to be used if it becomes the active unit in the future.
Each license type is managed as follows:

* Standard—Although only the active unit requests this license from the server, the standby unit has the
Standard license enabled by default; it does not need to register with the server to use it.

*» Context—Only the active unit requests this license. However, the Standard license includes 10 contexts
by default and is present on both units. The value from each unit’s Standard license plus the value of the
Context license on the active unit are combined up to the platform limit. For example:

* The Standard license includes 10 contexts; for 2 units, these licenses add up to 20 contexts. You
configure a 250-Context license on the active unit in an Active/Standby pair. Therefore, the
aggregated failover license includes 270 contexts. However, because the platform limit for one unit
is 250, the combined license allows a maximum of 250 contexts only. In this case, you should only
configure the active Context license to be 230 contexts.

* The Standard license includes 10 contexts; for 2 units, these licenses add up to 20 contexts. You
configure a 10-Context license on the primary unit in an Active/Active pair. Therefore, the aggregated
failover license includes 30 contexts. One unit can use 17 contexts and the other unit can use 13
contexts, for example, for a total of 30. Because the platform limit for one unit is 250, the combined
license allows a maximum of 250 contexts; the 30 contexts are within the limit.

* Carrier—Only the active requests this license, and both units can use it due to license aggregation.

* Strong Encryption (3DES) (for a pre-2.3.0 Cisco Smart Software Manager satellite deployment when
you cannot use the strong encryption token, or for tracking purposes)—Only the active unit requests this
license, and both units can use it due to license aggregation.

After a failover, the new active unit continues to use the aggregated license. It uses the cached license
configuration to re-request the entitlement from the server. When the old active unit rejoins the pair as a
standby unit, it releases the license entitlement. Before the standby unit releases the entitlement, the new active
unit's license might be in a non-compliant state if there are no available licenses in the account. The failover
pair can use the aggregated license for 30 days, but if it is still non-compliant after the grace period, you will
not be able to make configuration changes to features requiring special licenses; operation is otherwise
unaffected. The new active unit sends an entitlement authorization renewal request every 35 seconds until the
license is compliant. If you disband the failover pair, then the active unit releases the entitlements, and both
units retain the licensing configuration in a cached state. To re-activate licensing, you need to clear the
configuration on each unit, and re-configure it.

Permanent License Reservation

For permanent license reservation, you must purchase separate licenses for each chassis and enable the licenses
before you configure failover.

ASA Cluster Licenses for the ASA on the Firepower 4100/9300 Chassis

The clustering feature itself does not require any licenses. To use Strong Encryption and other optional licenses,
each Firepower 4100/9300 chassis must be registered with the License Authority or satellite server. There is
no extra cost for data units. For permanent license reservation, you must purchase separate licenses for each
chassis.

The Strong Encryption license is automatically enabled for qualified customers when you apply the registration
token. When using the token, each chassis must have the same encryption license. For the optional Strong
Encryption (3DES/AES) feature license enabled in the ASA configuration, see below.
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In the ASA license configuration, you can only configure smart licensing on the control unit. The configuration
is replicated to the data units, but for some licenses, they do not use the configuration; it remains in a cached
state, and only the control unit requests the license. The licenses are aggregated into a single cluster license
that is shared by the cluster units, and this aggregated license is also cached on the data units to be used if one
of them becomes the control unit in the future. Each license type is managed as follows:

* Standard—Only the control unit requests the Standard license from the server. Because the data units
have the Standard license enabled by default, they do not need to register with the server to use it.

* Context—Only the control unit requests the Context license from the server. The Standard license includes
10 contexts by default and is present on all cluster members. The value from each unit’s Standard license
plus the value of the Context license on the control unit are combined up to the platform limit in an
aggregated cluster license. For example:

* You have 6 Firepower 9300 modules in the cluster. The Standard license includes 10 contexts; for
6 units, these licenses add up to 60 contexts. You configure an additional 20-Context license on the
control unit. Therefore, the aggregated cluster license includes 80 contexts. Because the platform
limit for one module is 250, the combined license allows a maximum of 250 contexts; the 80 contexts
are within the limit. Therefore, you can configure up to 80 contexts on the control unit; each data
unit will also have 80 contexts through configuration replication.

* You have 3 Firepower 4110 units in the cluster. The Standard license includes 10 contexts; for 3
units, these licenses add up to 30 contexts. You configure an additional 250-Context license on the
control unit. Therefore, the aggregated cluster license includes 280 contexts. Because the platform
limit for one unit is 250, the combined license allows a maximum of 250 contexts; the 280 contexts
are over the limit. Therefore, you can only configure up to 250 contexts on the control unit; each
data unit will also have 250 contexts through configuration replication. In this case, you should only
configure the control unit Context license to be 220 contexts.

* Carrier—Required for Distributed S2S VPN. This license is a per-unit entitlement, and each unit requests
its own license from the server. This license configuration is replicated to the data units.

* Strong Encryption (3DES) (for pre-2.3.0 Cisco Smart Software Manager satellite deployment, or for
tracking purposes)—This license is a per-unit entitlement, and each unit requests its own license from
the server.

If a new control unit is elected, the new control unit continues to use the aggregated license. It also uses the
cached license configuration to re-request the control unit license. When the old control unit rejoins the cluster
as a data unit, it releases the control unit license entitlement. Before the data unit releases the license, the
control unit's license might be in a non-compliant state if there are no available licenses in the account. The
retained license is valid for 30 days, but if it is still non-compliant after the grace period, you will not be able
to make configuration changes to features requiring special licenses; operation is otherwise unaffected. The
new active unit sends an entitlement authorization renewal request every 12 hours until the license is compliant.
You should refrain from making configuration changes until the license requests are completely processed.
If a unit leaves the cluster, the cached control configuration is removed, while the per-unit entitlements are
retained. In particular, you would need to re-request the Context license on non-cluster units.
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Prerequisites for Smart Software Licensing

Regular and Satellite Smart License Prerequisites

ASAv, Firepower 2100
* Ensure internet access, or HTTP proxy access, or satellite server access from the device.
* Configure a DNS server so the device can resolve the name of the License Authority.
* Set the clock for the device. On the Firepower 2100, you set the clock in FXOS.

* Create a master account on the Cisco Smart Software Manager:
https://software.cisco.com/#module/SmartLicensing

If you do not yet have an account, click the link to set up a new account. The Smart Software Manager
lets you create a master account for your organization.

Firepower 4100/9300

Configure the Smart Software Licensing infrastructure on the Firepower 4100/9300 chassis before you
configure the ASA licensing entitlements.

Permanent License Reservation Prerequisites

* Create a master account on the Cisco Smart Software Manager:
https://software.cisco.com/#module/SmartLicensing

If you do not yet have an account, click the link to set up a new account. The Smart Software Manager
lets you create a master account for your organization. Even though the ASA does need internet
connectivity to the Smart Licensing server for permanent license reservation, the Smart Software Manager
is used to manage your permanent licenses.

* Obtain support for permanent license reservation from the licensing team. You must provide a justification
for using permanent license reservation. If your account is not approved, then you cannot purchase and
apply permanent licenses.

* Purchase special permanent licenses (see License PIDs, on page 155). If you do not have the correct
license in your account, then when you try to reserve a license on the ASA, you will see an error message
similar to: "The licenses cannot be reserved because the Virtual Account does not contain a sufficient
surplus of the following perpetual licenses: 1 - Firepower 4100 ASA PERM UNIV(perpetual)."

* The permanent license includes all available features, including the Strong Encryption (3DES/AES)
license if your account qualifies. AnyConnect client capabilities are also enabled to the platform maximum,
contingent on your purchase of an AnyConnect license that enables the right to use AnyConnect (see
AnyConnect Plus, AnyConnect Apex, And VPN Only Licenses, on page 147).

* ASAv: Permanent license reservation is not supported for the Azure hypervisor and ASAv100.
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License PIDs

When you bought your device from Cisco or a reseller, your licenses should have been linked to your Smart
Software License account. However, if you need to add licenses yourself, use the Find Products and Solutions
search field on the Cisco Commerce Workspace. Search for the following license Product IDs (PIDs).

Figure 14: License Search

Find Products and Solutions

L-FPRZK-ASASC-10=

Search by Product Family | Search for Solutions

ASAv PIDs
ASAv Regular and Satellite Smart Licensing PIDs:
* ASAv5—L-ASAV5S-K9=
* ASAv10—L-ASAV10S-K9=
* ASAv30—L-ASAV30S-K9=
* ASAv50—L-ASAVS50S-K9=

ASAv Permanent License Reservation PIDs:

The permanent license includes all available features, including the Strong Encryption (3DES/AES) license
if your account qualifies. AnyConnect client capabilities are also enabled to the platform maximum, contingent
on your purchase of an AnyConnect license that enables the right to use AnyConnect (see AnyConnect Plus,
AnyConnect Apex, And VPN Only Licenses, on page 147).

* ASAv5—L-ASAV5SR-K9=

* ASAvI0—L-ASAVI10SR-K9=
* ASAv30—L-ASAV30SR-K9=
* ASAV50—L-ASAVS50SR-K9=

Firepower 2100 PIDs
Firepower 2100 Regular and Satellite Smart Licensing PIDs:

» Standard license—L-FPR2100-ASA=. The Standard license is free, but you still need to add it to your
Smart Software Licensing account.

* 5 context license—L-FPR2K-ASASC-5=. Context licenses are additive; buy multiple licenses to meet
your needs.

* 10 context license—L-FPR2K-ASASC-10=. Context licenses are additive; buy multiple licenses to meet
your needs.
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* Strong Encryption (3DES/AES) license—L-FPR2K-ENC-K9=. This license is free. Although this license
is not generally rquired (for example, ASAs that use older Satellite Server versions (pre-2.3.0) require
this license), you should still add it to your account for tracking purposes.

Firepower 2100 Permanent License Reservation PID:

The permanent license includes all available features, including the Strong Encryption (3DES/AES) license
if your account qualifies. AnyConnect client capabilities are also enabled to the platform maximum, contingent
on your purchase of an AnyConnect license that enables the right to use AnyConnect (see AnyConnect Plus,
AnyConnect Apex, And VPN Only Licenses, on page 147).

* L-FPR2K-ASA-BPU=

Firepower 4100 PIDs
Firepower 4100 Regular and Satellite Smart Licensing PIDs:

* Standard license—L-FPR4100-ASA=. The Standard license is free, but you still need to add it to your
Smart Software Licensing account.

* 10 context license—L-FPR4K-ASASC-10=. Context licenses are additive; buy multiple licenses to meet
your needs.

* 230 context license—L-FPR4K-ASASC-230=. Context licenses are additive; buy multiple licenses to
meet your needs.

* 250 context license—L-FPR4K-ASASC-250=. Context licenses are additive; buy multiple licenses to
meet your needs.

* Carrier (Diameter, GTP/GPRS, SCTP)—L-FPR4K-ASA-CAR=
* Strong Encryption (3DES/AES) license—L-FPR4K-ENC-K9=. This license is free. Although this license

is not generally rquired (for example, ASAs that use older Satellite Server versions (pre-2.3.0) require
this license), you should still add it to your account for tracking purposes.

Firepower 4100 Permanent License Reservation PID:

The permanent license includes all available features, including the Strong Encryption (3DES/AES) license
if your account qualifies. AnyConnect client capabilities are also enabled to the platform maximum, contingent
on your purchase of an AnyConnect license that enables the right to use AnyConnect (see AnyConnect Plus,
AnyConnect Apex, And VPN Only Licenses, on page 147).

» L-FPR4K-ASA-BPU=

Firepower 9300 PIDs
Firepower 9300 Regular and Satellite Smart Licensing PIDs:

* Standard license—L-F9K-ASA=. The Standard license is free, but you still need to add it to your Smart
Software Licensing account.

* 10 context license—L-FIK-ASA-SC-10=. Context licenses are additive; buy multiple licenses to meet
your needs.

* Carrier (Diameter, GTP/GPRS, SCTP)—L-F9K-ASA-CAR=
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» Strong Encryption (3DES/AES) license—L-FIK-ASA-ENCR-K9=. This license is free. Although this
license is not generally rquired (for example, ASAs that use older Satellite Server versions (pre-2.3.0)
require this license), you should still add it to your account for tracking purposes.

Firepower 9300 Permanent License Reservation PIDs:

The permanent license includes all available features, including the Strong Encryption (3DES/AES) license
if your account qualifies. AnyConnect client capabilities are also enabled to the platform maximum, contingent
on your purchase of an AnyConnect license that enables the right to use AnyConnect (see AnyConnect Plus,
AnyConnect Apex, And VPN Only Licenses, on page 147).

* L-FPR9K-ASA-BPU=

Guidelines for Smart Software Licensing

* Only Smart Software Licensing is supported. For older software on the ASAv, if you upgrade an existing
PAK-licensed ASAv, then the previously installed activation key will be ignored, but retained on the
device. If you downgrade the ASAv, the activation key will be reinstated.

* For permanent license reservation, you must return the license before you decommission the device. If
you do not officially return the license, the license remains in a used state and cannot be reused for a new
device.

* Because the Cisco Transport Gateway uses a certificate with a non-compliant country code, you cannot
use HTTPS when using the ASA in conjunction with that product. You must use HTTP with Cisco
Transport Gateway.

Defaults for Smart Software Licensing

ASAv

* The ASAv default configuration includes a Smart Call Home profile called “License” that specifies the
URL for the Licensing Authority.

* When you deploy the ASAv, you set the feature tier and throughput level. Only the standard level is
available at this time. For permanent license reservation, you do not need to set these parameters. When
you enable permanent license reservation, these commands are removed from the configuration.

* Also during deployment, you can optionally configure an HTTP proxy.

Firepower 2100

The Firepower 2100 default configuration includes a Smart Call Home profile called “License” that specifies
the URL for the Licensing Authority.

ASA on the Firepower 4100/9300 Chassis

There is no default configuration. You must manually enable the standard license tier and other optional
licenses.
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. ASAv: Configure Smart Software Licensing

ASAv: Configure Smart Software Licensing

Step 1
Step 2
Step 3

This section describes how to configure Smart Software Licensing for the ASAv. Choose one of the following
methods:

Procedure

ASAv: Configure Regular Smart Software Licensing, on page 158.
ASAv: Configure Satellite Smart Software Licensing, on page 161.

ASAv: Configure Permanent License Reservation, on page 162.

ASAv: Configure Regular Smart Software Licensing

\}

When you deploy the ASAv, you can pre-configure the device and include a registration token so it registers
with the License Authority and enables Smart Software Licensing. If you need to change your HTTP proxy
server, license entitlement, or register the ASAv (for example, if you did not include the ID token in the Day0
configuration), perform this task.

Note

Step 1

You may have pre-configured the HTTP proxy and license entitlements when you deployed your ASAv. You
may also have included the registration token with your Day0 configuration when you deployed the ASAv;
if so, you do not need to re-register using this procedure.

Procedure

In the Smart Software Manager (Cisco Smart Software Manager), request and copy a registration token for
the virtual account to which you want to add this device.

a) Click Inventory.

Figure 15: Inventory

Cisco Software Cenfral > Smart Software Licensing

Smart Software Licensing

License Conversion Reports Email Motification Satellites Activity

b) On the General tab, click New Token.
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Figure 16: New Token

General Licenses Product Instances Event Log

Virtual Account
Description:

Default Virtual Account: No

Product Instance Registration Tokens
he registration tokens below can be used to register new product instances to this virtual account

Token Expiration Date Description

NWU1MzY 1MzEtZ]NmOS00MjF..8  2018-Jul-06 14:20:13 (in 354 days) FTD-5506

¢) Onthe Create Registration Token dialog box enter the following settings, and then click Create Token
* Description

+ Expire After—Cisco recommends 30 days.

« Allow export-controlled functionaility on the products registered with this token—Enables the
export-compliance flag.

Figure 17: Create Registration Token

Create Registration Token

This dialog will generate the token required to register your product instances with your Smart Account
\irtual Account:

Description:

= Expire After:

30 Days

Enter the value between T and 365 but Cisco recommends a maximum of 30 days.
Allow export-controlled functionality on the products registered with this token @@

Create Token Cancel

The token is added to your inventory.

d) Click the arrow icon to the right of the token to open the Token dialog box so you can copy the token ID
to your clipboard. Keep this token ready for later in the procedure when you need to register the ASA.
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Figure 18: View Token

General Licenses Product Instances Event Log

Virtual Account
Description:

Default Virtual Account: No

Product Instance Registration Tokens

The registration tokens below can be used to register new product instances to this virtual account
New Token...
Token Expiration Date Description Export-Controlled
M\M3Z]\hYTI[ZGQ4OSDOY\k2L@ 2017-Aug-16 19:41:53 (in 30 days) ASAFP 21101 Allowed

Figure 19: Copy Token

Token 0 X

MjM3ZjInYTIZGQ40500Yk2LTgzMGIMThmZTUyY]ky
NmVALTETMDISMTIT %60AMTMxMzh8YzdQdmgzMjA2V
mFJN2dYQjISQWRhOEdscDU4cWISNFNWRUtsa2wz %
NAMDANSTN%AINANA

Press ctrl + ¢ o copy selected text to clipboard.

Step 2 (Optional) Specify the HTTP Proxy URL.

Getting Started with the ASA |

Created By Actions

Actions ~

If your network uses an HTTP proxy for Internet access, you must configure the proxy address for Smart

Software Licensing. This proxy is also used for Smart Call Home in general.

a) Choose Configuration > Device Management > Smart Call-Home.
b) Check Enable HTTP Proxy.

c) Enter the proxy IP address and port in the Proxy server and Proxy port fields. For example, enter port

443 for an HTTPS server.
d) Click Apply.

Step 3 Configure the license entitlements.

a) Choose Configuration > Device Management > Licensing > Smart Licensing.

b) Check Enable Smart license configuration.
¢) From the Feature Tier drop-down menu, choose Standard.

Only the standard tier is available.

d) From the Throughput Level drop-down menu, choose 100M, 1G, 2G, 10G.

Note Do not check the Enable strong-encryption protocol check box. This setting is only for

pre-2.3.0 satellite servers.

e) Click Apply.
Step 4 Register the ASAv with the License Authority.

a) Choose Configuration > Device Management > Licensing > Smart Licensing.

b) Click Register.
c) Enter the registration token in the 1D Token field.
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d) (Optional) Click the Force registration checkbox to register an ASAv that is already registered, but that
might be out of sync with the License Authority.

For example, use Force registration if the ASAv was accidentally removed from the Smart Software
Manager.

e) Click Register.

The ASAv attempts to register with the License Authority and request authorization for the configured
license entitlements.

ASAv: Configure Satellite Smart Software Licensing

This procedure applies for an ASAv using a satellite Smart Software Licensing server.

Before you begin

Download the Smart Software Manager satellite OVA file from Cisco.com and install and configure it on a
VMwareESXi server. For more information, see Smart Software Manager satellite.

Procedure

Step 1 Request a registration token on the satellite server.
Step 2 (Optional) In ASDM, specify the HTTP Proxy URL.

If your network uses an HTTP proxy for Internet access, you must configure the proxy address for Smart
Software Licensing. This proxy is also used for Smart Call Home in general.

a) Choose Configuration > Device Management > Smart Call-Home.

b) Check Enable HTTP Proxy.

¢) Enter the proxy IP address and port in the Proxy server and Proxy port fields. For example, enter port
443 for an HTTPS server.

d) Click Apply.
Step 3 Change the license server URL to go to the satellite server.
a) Choose Configuration > Device Management > Smart Call-Home.
b) Inthe Configure Subscription Profiles area, edit the License profile.
¢) Inthe Deliver Subscriptions Using HTTP transport area, select the Subscribers URL, and click Edit.
d) Change the Subscribers URL to the following value, and click OK:

https://satellite ip_address/Transportgateway/services/DeviceRequestHandler
e) Click OK, and then click Apply.

Step 4 Register the ASA with the License Authority.
a) Choose Configuration > Device Management > Licensing > Smart Licensing.
b) Click Register.
c) Enter the registration token in the ID Token field.

d) (Optional) Click the Force registration checkbox to register an ASA that is already registered, but that
might be out of sync with the License Authority.
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. ASAv: Configure Permanent License Reservation

For example, use Force registration if the ASA was accidentally removed from the Smart Software
Manager.

e) Click Register.

The ASA registers with the License Authority and requests authorization for the configured license
entitlements. The License Authority also applies the Strong Encryption (3DES/AES) license if your
account allows. Choose Monitoring > Properties > Smart License to check the license status.

ASAv: Configure Permanent License Reservation

Step 1
Step 2

You can assign a permanent license to an ASAv. This section also describes how to return a license if you
retire the ASAv or change model tiers and need a new license.

Procedure

Install the ASAv Permanent License, on page 162
(Optional) (Optional) Return the ASAv Permanent License, on page 164

Install the ASAv Permanent License

\}

For ASAvs that do not have Internet access, you can request a permanent license from the Smart Software
Manager.

Note

\)

For permanent license reservation, you must return the license before you decommission the ASAv. If you
do not officially return the license, the license remains in a used state and cannot be reused for a new ASAv.
See (Optional) Return the ASAv Permanent License, on page 164.

Note

If you clear your configuration after you install the permanent license (for example using write erase), then
you only need to reenable permanent license reservation using the license smart reservation command
without any arguments as shown in step 1; you do not need to complete the rest of this procedure.

Before you begin

* Purchase permanent licenses so they are available in the Smart Software Manager. Not all accounts are
approved for permanent license reservation. Make sure you have approval from Cisco for this feature
before you attempt to configure it.

* You must request a permanent license after the ASAv starts up; you cannot install a permanent license
as part of the Day 0 configuration.
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Step 1

Step 2

Step 3

Step 4

Install the ASAv Permanent License .

Procedure

At the ASAv CLI, enable permanent license reservation:
license smart reservation

Example:

ciscoasa (config)# license smart reservation
ciscoasa (config)#

The following commands are removed:

license smart
feature tier standard
throughput level {100M | 1G | 2G | 10G}

To use regular smart licensing, use the Nno form of this command, and re-enter the above commands. Other
Smart Call Home configuration remains intact but unused, so you do not need to re-enter those commands.

Request the license code to enter in the Smart Software Manager:
license smart reservation request universal

Example:

ciscoasa# license smart reservation request universal

Enter this request code in the Cisco Smart Software Manager portal:
ABP:ASAv, S: 9AUSET6UQHD{A8ug5/1jRDaSp3w8uGlfeQ{53C13E

ciscoasa#

You must choose the model level (ASAvS5/ASAv10/ASAv30/ASAv50/ASAv100) that you want to use during
ASAv deployment. That model level determines the license you request. If you later want to change the model
level of a unit, you will have to return the current license and request a new license at the correct model level.
To change the model of an already deployed ASAv, from the hypervisor you can change the vCPUs and
DRAM settings to match the new model requirements; see the ASAv quick start guide for these values. To
view your current model, use the show vm command.

If you re-enter this command, then the same code is displayed, even after a reload. If you have not yet entered
this code into the Smart Software Manager and want to cancel the request, enter:

license smart reservation cancel

If you disable permanent license reservation, then any pending requests are canceled. If you already entered
the code into the Smart Software Manager, then you must complete this procedure to apply the license to the
ASAv, after which point you can return the license if desired. See (Optional) Return the ASAv Permanent
License, on page 164.

Go to the Smart Software Manager Inventory screen, and click the Licenses tab:
https://software.cisco.com/#SmartLicensing-Inventory

The Licenses tab displays all existing licenses related to your account, both regular and permanent.

Click License Reservation, and type the ASAv code into the box. Click Reserve License.
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. (Optional) Return the ASAv Permanent License

Step 5

The Smart Software Manager generates an authorization code. You can download the code or copy it to the
clipboard. At this point, the license is now in use according to the Smart Software Manager.

If you do not see the License Reservation button, then your account is not authorized for permanent license
reservation. In this case, you should disable permanent license reservation and re-enter the regular smart
license commands.

On the ASAv, enter the authorization code:
license smart reservation install code

Example:

ciscoasa# license smart reservation install AAu3431rGRS00Ig5HQ12vpzg{MEYCIQCBwWS
ciscoasa#

Your ASAv is now fully licensed.

(Optional) Return the ASAv Permanent License

Step 1

Step 2

If you no longer need a permanent license (for example, you are retiring an ASAv or changing its model level
so it needs a new license), you must officially return the license to the Smart Software Manager using this
procedure. If you do not follow all steps, then the license stays in a used state and cannot easily be freed up
for use elsewhere.

Procedure

On the ASAv, generate a return code:
license smart reservation return

Example:

ciscoasa# license smart reservation return
Enter this return code in the Cisco Smart Software Manager portal:
Au3431rGRS00Ig5HQ12vpcg{uXiTRfVrp7M/zDpirLwYCagq8oSv60yZJuFDVBS2Q1iQ=

The ASAv immediately becomes unlicensed and moves to the Evaluation state. If you need to view this code
again, re-enter this command. Note that if you request a new permanent license (license smart reservation
request universal) or change the ASAv model level (by powering down and changing the vCPUs/RAM),
then you cannot re-display this code. Be sure to capture the code to complete the return.

View the ASAv universal device identifier (UDI) so you can find this ASAv instance in the Smart Software
Manager:

show license udi

Example:
ciscoasa# show license udi

UDI: PID:ASAv,SN:9AHV3KJBEKE
ciscoasa#
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Step 3

Step 4

(Optional) Deregister the ASAv (Regular and Satellite) .

Go to the Smart Software Manager Inventory screen, and click the Product Instances tab:
https://software.cisco.com/#SmartLicensing-Inventory

The Product Instances tab displays all licensed products by the UDI.

Find the ASAv you want to unlicense, choose Actions > Remove, and type the ASAv return code into the
box. Click Remove Product Instance.

The permanent license is returned to the available pool.

(Optional) Deregister the ASAv (Regular and Satellite)

Step 1
Step 2

Deregistering the ASAv removes the ASAv from your account. All license entitlements and certificates on
the ASAv are removed. You might want to deregister to free up a license for a new ASAv. Alternatively, you
can remove the ASAv from the Smart Software Manager.

Procedure

Choose Configuration > Device Management > Licensing > Smart Licensing.
Click Unregister.

The ASAv then reloads.

(Optional) Renew the ASAv ID Certificate or License Entitlement (Regular and

Satellite)

Step 1
Step 2
Step 3

By default, the ID certificate is automatically renewed every 6 months, and the license entitlement is renewed
every 30 days. You might want to manually renew the registration for either of these items if you have a
limited window for Internet access, or if you make any licensing changes in the Smart Software Manager, for
example.

Procedure
Choose Configuration > Device Management > Licensing > Smart Licensing.

To renew the ID certificate, click Renew ID Certificate.
To renew the license entitlement, click Renew Authorization.

Firepower 2100: Configure Smart Software Licensing

This section describes how to configure Smart Software Licensing for the Firepower 2100. Choose one of
the following methods:
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Procedure

Step 1 Firepower 2100: Configure Regular Smart Software Licensing, on page 166.

You can also (Optional) Deregister the Firepower 2100 (Regular and Satellite), on page 174 or (Optional)
Renew the Firepower 2100 ID Certificate or License Entitlement (Regular and Satellite), on page 174.

Step 2 Firepower 2100: Configure Satellite Smart Software Licensing, on page 169.

You can also (Optional) Deregister the Firepower 2100 (Regular and Satellite), on page 174 or (Optional)
Renew the Firepower 2100 ID Certificate or License Entitlement (Regular and Satellite), on page 174.

Step 3 Firepower 2100: Configure Permanent License Reservation, on page 171.

Firepower 2100: Configure Regular Smart Software Licensing

This procedure applies for an ASA using the License Authority.

Procedure

Step 1 In the Smart Software Manager (Cisco Smart Software Manager), request and copy a registration token for
the virtual account to which you want to add this device.

a) Click Inventory.

Figure 20: Inventory

Cisco Software Cenfral > Smart Software Licensing

Smart Software Licensing

Alerts Inventory License Conversion Reports Email Motification Satellites Activity

b) On the General tab, click New Token.
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Figure 21: New Token

General Licenses Product Instances Event Log

Virtual Account
Description:

Default Virtual Account: No

Product Instance Registration Tokens
he registration tokens below can be used to register new product instances to this virtual account

Token Expiration Date Description

NWU1MzY 1MzEtZ]NmOS00MjF..8  2018-Jul-06 14:20:13 (in 354 days) FTD-5506

¢) Onthe Create Registration Token dialog box enter the following settings, and then click Create Token
* Description

+ Expire After—Cisco recommends 30 days.

« Allow export-controlled functionaility on the products registered with this token—Enables the
export-compliance flag.

Figure 22: Create Registration Token

Create Registration Token

This dialog will generate the token required to register your product instances with your Smart Account
\irtual Account:

Description:

= Expire After:

30 Days

Enter the value between T and 365 but Cisco recommends a maximum of 30 days.
Allow export-controlled functionality on the products registered with this token @@

Create Token Cancel

The token is added to your inventory.

d) Click the arrow icon to the right of the token to open the Token dialog box so you can copy the token ID
to your clipboard. Keep this token ready for later in the procedure when you need to register the ASA.
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Firepower 2100: Configure Regular Smart Software Licensing

Figure 23: View Token

General Licenses Product Instances Event Log

Virtual Account
Description:

Default Virtual Account: No

Product Instance Registration Tokens

The registration tokens below can be used to register new product instances to this virtual account
New Token...
Token Expiration Date Description Export-Controlled
M\M3Z]\hYTI[ZGQ4OSDOY\k2L@ 2017-Aug-16 19:41:53 (in 30 days) ASAFP 21101 Allowed

Figure 24: Copy Token

Token 0 X

MjM3ZjInYTIZGQ40500Yk2LTgzMGIMThmZTUyY]ky
NmVALTETMDISMTIT %60AMTMxMzh8YzdQdmgzMjA2V
mFJN2dYQjISQWRhOEdscDU4cWISNFNWRUtsa2wz %
NAMDANSTN%AINANA

Press ctrl + ¢ o copy selected text to clipboard.

Step 2 (Optional) In ASDM, specify the HTTP Proxy URL.

Created By Actions

Actions ~

If your network uses an HTTP proxy for Internet access, you must configure the proxy address for Smart

Software Licensing. This proxy is also used for Smart Call Home in general.

a) Choose Configuration > Device Management > Smart Call-Home.
b) Check Enable HTTP Proxy.

c) Enter the proxy IP address and port in the Proxy server and Proxy port fields. For example, enter port

443 for an HTTPS server.
d) Click Apply.

Step 3 Configure the license entitlements.

a) Choose Configuration > Device Management > Licensing > Smart Licensing.

b) Check Enable Smart license configuration.
¢) From the Feature Tier drop-down menu, choose Standard.

Only the standard tier is available. A tier license is a prerequisite for adding other feature licenses.

d) (Optional) For the Context license, enter the number of contexts.

By default, the ASA supports 2 contexts, so you should request the number of contexts you want minus

the 2 default contexts. The maximum number of contexts depends on your model:
* Firepower 2110—25 contexts
* Firepower 2120—25 contexts
* Firepower 2130—30 contexts

* Firepower 2140—40 contexts
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Step 4

Firepower 2100: Configure Satellite Smart Software Licensing .

For example, to use the maximum of 25 contexts on the Firepower 2110, enter 23 for the number of
contexts; this value is added to the default of 2.

e) (Optional) The Enable strong-encryption protocol is generally not required; for example, ASAs that
use older Satellite Server versions (pre-2.3.0) require this license, but you can check this box if you know
you need to, or if you want to track usage of this license in your account.

f) Click Apply.

Register the ASA with the License Authority.

a) Choose Configuration > Device Management > Licensing > Smart Licensing.
b) Click Register.

¢) Enter the registration token in the ID Token field.

d) (Optional) Click the Force registration checkbox to register an ASA that is already registered, but that
might be out of sync with the License Authority.

For example, use Force registration if the ASA was accidentally removed from the Smart Software
Manager.

e) Click Register.

The ASA registers with the License Authority and requests authorization for the configured license
entitlements. The License Authority also applies the Strong Encryption (3DES/AES) license if your
account allows. Choose Monitoring > Properties > Smart License to check the license status.

Firepower 2100: Configure Satellite Smart Software Licensing

Step 1
Step 2

Step 3

This procedure applies for an ASA using a satellite Smart Software Licensing server.

Before you begin

Download the Smart Software Manager satellite OVA file from Cisco.com and install and configure it on a
VMwareESXi server. For more information, see Smart Software Manager satellite.

Procedure

Request a registration token on the satellite server.
(Optional) In ASDM, specify the HTTP Proxy URL.

If your network uses an HTTP proxy for Internet access, you must configure the proxy address for Smart
Software Licensing. This proxy is also used for Smart Call Home in general.

a) Choose Configuration > Device Management > Smart Call-Home.

b) Check Enable HTTP Proxy.

c) Enter the proxy IP address and port in the Proxy server and Proxy port fields. For example, enter port
443 for an HTTPS server.

d) Click Apply.

Change the license server URL to go to the satellite server.
a) Choose Configuration > Device Management > Smart Call-Home.
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. Firepower 2100: Configure Satellite Smart Software Licensing

Step 4

Step 5

b)

¢)
d)

e)

In the Configure Subscription Profiles area, edit the License profile.
In the Deliver Subscriptions Using HTTP transport area, select the Subscribers URL, and click Edit.
Change the Subscribers URL to the following value, and click OK:

https://satellite_ip_address/Transportgateway/services/DeviceRequestHandler
Click OK, and then click Apply.

Configure the license entitlements.

a)
b)

<)

d)

f)

Choose Configuration > Device Management > Licensing > Smart Licensing.
Check Enable Smart license configuration.
From the Feature Tier drop-down menu, choose Standard.

Only the standard tier is available. A tier license is a prerequisite for adding other feature licenses.
(Optional) For the Context license, enter the number of contexts.

By default, the ASA supports 2 contexts, so you should request the number of contexts you want minus
the 2 default contexts. The maximum number of contexts depends on your model:

* Firepower 2110—25 contexts
* Firepower 2120—25 contexts
* Firepower 2130—30 contexts

* Firepower 2140—40 contexts

For example, to use the maximum of 25 contexts on the Firepower 2110, enter 23 for the number of
contexts; this value is added to the default of 2.

(Optional) The Enable strong-encryption protocol is generally not required; for example, ASAs that
use older Satellite Server versions (pre-2.3.0) require this license, but you can check this box if you know
you need to, or if you want to track usage of this license in your account.

Click Apply.

Register the ASA with the License Authority.

a)
b)
¢)
d)

Choose Configuration > Device Management > Licensing > Smart Licensing.
Click Register.
Enter the registration token in the 1D Token field.

(Optional) Click the Force registration checkbox to register an ASA that is already registered, but that
might be out of sync with the License Authority.

For example, use Force registration if the ASA was accidentally removed from the Smart Software
Manager.

Click Register.

The ASA registers with the License Authority and requests authorization for the configured license
entitlements. The License Authority also applies the Strong Encryption (3DES/AES) license if your
account allows. Choose Monitoring > Properties > Smart License to check the license status.
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Firepower 2100: Configure Permanent License Reservation .

Firepower 2100: Configure Permanent License Reservation

Step 1
Step 2

You can assign a permanent license to a Firepower 2100. This section also describes how to return a license
if you retire the ASA.

Procedure

Install the Firepower 2100 Permanent License, on page 171.

(Optional) (Optional) Return the Firepower 2100 Permanent License, on page 173.

Install the Firepower 2100 Permanent License

\}

For ASAs that do not have internet access, you can request a permanent license from the Smart Software
Manager. The permanent license enables all features: Standard tier with maximum Security Contexts.

Note

Step 1

Step 2

For permanent license reservation, you must return the license before you decommission the ASA. If you do
not officially return the license, the license remains in a used state and cannot be reused for a new ASA. See
(Optional) Return the Firepower 2100 Permanent License, on page 173.

Before you begin

Purchase permanent licenses so they are available in the Smart Software Manager. Not all accounts are
approved for permanent license reservation. Make sure you have approval from Cisco for this feature before
you attempt to configure it.

Procedure

At the ASA CLI, enable permanent license reservation:
license smart reservation

Example:

ciscoasa (config)# license smart reservation
ciscoasa (config)#

Request the license code to enter in the Smart Software Manager:
license smart reservation request universal

Example:
ciscoasa# license smart reservation request universal
Enter this request code in the Cisco Smart Software Manager portal:

BB-ZFPR-2140:JAD200802RR-AzKmHcc71-2A
ciscoasa#
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. Install the Firepower 2100 Permanent License

Step 3

Step 4

Step 5

Step 6

If you re-enter this command, then the same code is displayed, even after a reload. If you have not yet entered
this code into the Smart Software Manager and want to cancel the request, enter:

license smart reservation cancel

If you disable permanent license reservation, then any pending requests are canceled. If you already entered
the code into the Smart Software Manager, then you must complete this procedure to apply the license to the
ASA, after which point you can return the license if desired. See (Optional) Return the Firepower 2100
Permanent License, on page 173.

Go to the Smart Software Manager Inventory screen, and click the Licenses tab:
https://software.cisco.com/#SmartLicensing-Inventory

The Licenses tab displays all existing licenses related to your account, both regular and permanent.

Click License Reservation, and type the ASA code into the box. Click Reserve License.

The Smart Software Manager generates an authorization code. You can download the code or copy it to the
clipboard. At this point, the license is now in use according to the Smart Software Manager.

If you do not see the License Reservation button, then your account is not authorized for permanent license
reservation. In this case, you should disable permanent license reservation and re-enter the regular smart
license commands.

On the ASA, enter the authorization code:
license smart reservation install code

Example:

ciscoasa# license smart reservation install AAu3431rGRS00Ig5HQ12vpzg{MEYCIQCBwWS
ciscoasa#

Request license entitlements on the ASA.
You need to request the entitlements in the ASA configuration so that the ASA allows their use.
a) Enter license smart configuration mode:

license smart

Example:

ciscoasa(config)# license smart

ciscoasa (config-smart-1lic) #
b) Set the feature tier:

feature tier standard

Only the standard tier is available. A tier license is a prerequisite for adding other feature licenses.
¢) Request the security context license.

feature context number

By default, the ASA supports 2 contexts, so you should request the number of contexts you want minus
the 2 default contexts. The maximum number of contexts depends on your model:
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(Optional) Return the Firepower 2100 Permanent License .

* Firepower 2110—25 contexts
* Firepower 2120—25 contexts
* Firepower 2130—30 contexts

* Firepower 2140—40 contexts
For example, to use the maximum of 25 contexts on the Firepower 2110, enter 23 for the number of
contexts; this value is added to the default of 2.

Example:

ciscoasa (config-smart-lic)# feature context 18

d) (Optional) The Strong Encryption (3DES/AES) license is generally not required; for example, ASAs that
use older Satellite Server versions (pre-2.3.0) require this license, but you can enable this feature if you
know you need to, or if you want to track usage of this license in your account.

feature strong-encryption

Example:

ciscoasa(config-smart-lic)# feature strong-encryption

(Optional) Return the Firepower 2100 Permanent License

Step 1

Step 2

If you no longer need a permanent license (for example, you are retiring an ASA), you must officially return
the license to the Smart Software Manager using this procedure. If you do not follow all steps, then the license
stays in a used state and cannot easily be freed up for use elsewhere.

Procedure

On the ASA, generate a return code:
license smart reservation return

Example:

ciscoasa# license smart reservation return
Enter this return code in the Cisco Smart Software Manager portal:
Au3431rGRS00Ig5HQ12vpcg{uXiTRfVrp7M/zDpirLlwYCagq8oSv60yZJuFDVBS2Q1iQ=

The ASA immediately becomes unlicensed and moves to the Evaluation state. If you need to view this code
again, re-enter this command. Note that if you request a new permanent license (license smart reservation
request universal), then you cannot re-display this code. Be sure to capture the code to complete the return.

View the ASA universal device identifier (UDI) so you can find this ASA instance in the Smart Software
Manager:

show license udi
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. (Optional) Deregister the Firepower 2100 (Regular and Satellite)

Step 3

Step 4

Example:

ciscoasa# show license udi
UDI: PID:FPR-2140,SN:JAD200802RR
ciscoasa#

Go to the Smart Software Manager Inventory screen, and click the Product Instances tab:
https://software.cisco.com/#SmartLicensing-Inventory

The Product Instances tab displays all licensed products by the UDI.

Find the ASA you want to unlicense, choose Actions > Remove, and type the ASA return code into the box.
Click Remove Product Instance.

The permanent license is returned to the available pool.

(Optional) Deregister the Firepower 2100 (Regular and Satellite)

Step 1
Step 2

Deregistering the ASA removes the ASA from your account. All license entitlements and certificates on the
ASA are removed. You might want to deregister to free up a license for a new ASA. Alternatively, you can
remove the ASA from the Smart Software Manager.

Procedure

Choose Configuration > Device Management > Licensing > Smart Licensing.
Click Unregister.

(Optional) Renew the Firepower 2100 ID Certificate or License Entitlement
(Regular and Satellite)

Step 1
Step 2
Step 3

By default, the ID certificate is automatically renewed every 6 months, and the license entitlement is renewed
every 30 days. You might want to manually renew the registration for either of these items if you have a
limited window for internet access, or if you make any licensing changes in the Smart Software Manager, for
example.

Procedure

Choose Configuration > Device Management > Licensing > Smart Licensing.
To renew the ID certificate, click Renew ID Certificate.
To renew the license entitlement, click Renew Authorization.
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Firepower 4100/9300: Configure Smart Software Licensing .

Firepower 4100/9300: Configure Smart Software Licensing

Step 1

Step 2

This section describes how to configure Smart Software Licensing for the Firepower 4100/9300 chassis.

Procedure

Firepower 4100/9300: Configure Pre-2.3.0 Satellite Smart Software Licensing, on page 175.For a chassis using
a pre-2.3.0 satellite server, you must initally configure ASA licensing at the CLI; see the FXOS configuration
guide to pre-configure license communication.

Firepower 4100/9300: Configure Smart Software Licensing, on page 177

Firepower 4100/9300: Configure Pre-2.3.0 Satellite Smart Software Licensing

\}

For a chassis using a pre-2.3.0 satellite server, you must initally configure ASA licensing at the CLI; see the
FXOS configuration guide to pre-configure license communication.

Note

Step 1

For pre-2.3.0 Smart Software Manager satellite users: The Strong Encryption (3DES/AES) license is not
enabled by default so you cannot use ASDM to configure your ASA until you request the Strong Encryption
license using the ASA CLI. Other strong encryption features are also not available until you do so, including
VPN.

Before you begin

For an ASA cluster, you need to access the control unit for configuration. Check the Firepower Chassis
Manager to see which unit is the control unit. You can also check from the ASA CLI, as shown in this
procedure.

Procedure

Connect to the Firepower 4100/9300 chassis CLI (console or SSH), and then session to the ASA:

connect module slot console
connect asa

Example:

Firepower> connect module 1 console
Firepower-modulel> connect asa

asa>

The next time you connect to the ASA console, you go directly to the ASA; you do not need to enter connect
asa again.
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. Firepower 4100/9300: Configure Pre-2.3.0 Satellite Smart Software Licensing

Step 2

Step 3

Step 4

For an ASA cluster, you only need to access the control unit for license configuration and other configuration.
Typically, the control unit is in slot 1, so you should connect to that module first.

At the ASA CLI, enter global configuration mode. By default, the enable password is blank.

enable
configure terminal

Example:

asa> enable

Password:

asa# configure terminal
asa (config) #

If required, for an ASA cluster confirm that this unit is the control unit:
show cluster info

Example:

asa (config)# show cluster info
Cluster stbu: On
This is "unit-1-1" in state SLAVE
ID : O
Version : 9.5(2)
Serial No.: P3000000025
CCL IP : 127.2.1.1
CCL MAC : 000b.fcf8.cl192
Last join : 17:08:59 UTC Sep 26 2015
Last leave: N/A
Other members in the cluster:
Unit "unit-1-2" in state SLAVE
ID : 1
Version : 9.5(2)
Serial No.: P3000000001
CCL IP : 127.2.1.2
CCL MAC : 000b.fcf8.cl62
Last join : 19:13:11 UTC Sep 23 2015
Last leave: N/A
Unit "unit-1-3" in state MASTER
ID : 2
Version : 9.5(2)
Serial No.: JABO815R0OJY
CCL IP : 127.2.1.3
CCL MAC : 000f.f775.541e
Last join : 19:13:20 UTC Sep 23 2015
Last leave: N/A

If a different unit is the control unit, exit the connection and connect to the correct unit. See below for
information about exiting the connection.

Enter license smart configuration mode:
license smart

Example:

ciscoasa(config)# license smart
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Step 5

Step 6

Step 7

Firepower 4100/9300: Configure Smart Software Licensing .

ciscoasa(config-smart-lic)#

Set the feature tier:
feature tier standard

Only the standard tier is available. A tier license is a prerequisite for adding other feature licenses. You must
have sufficient tier licenses in your account. Otherwise, you cannot configure any other feature licenses or
any features that require licenses.

Request one or more of the following features:
* Carrier (GTP/GPRS, Diameter, and SCTP inspection)
feature carrier
* Security Contexts
feature context <1-248>
For Permanent License Reservation, you can specify the maximum contexts (248).
* Strong Encryption (3DES/AES)

feature strong-encryption

To exit the ASA console, enter ~ at the prompt to exit to the Telnet application. Enter quit to exit back to the
supervisor CLI.

Firepower 4100/9300: Configure Smart Software Licensing

\}

This procedure applies for a chassis using the License Authority, for post-2.3.0 Satellite server users, or for
Permanent License Reservation; see the FXOS configuration guide to pre-configure licensing communication.
For pre-2.3.0 Satellite servers, you must initially configure licensing at the CLI. Satellite server Version 2.3.0
and later supports the Strong Encryption (3DES/AES) export-compliance token, so you can run ASDM before
you request other license entitlements.

For Permanent License Reservation, the license enables all features: Standard tier with maximum Security
Contexts and the Carrier license. However, for the ASA to "know" to use these features, you need to enable
them on the ASA.

Note

For pre-2.3.0 satellite server users, see Firepower 4100/9300: Configure Pre-2.3.0 Satellite Smart Software
Licensing, on page 175 to configure licensing at the CLI.

Before you begin

For an ASA cluster, you need to access the primary unit for configuration. Check the Firepower Chassis
Manager to see which unit is the primary.
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Step 2

Step 3
Step 4
Step 5

Step 6
Step 7
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Procedure

In ASDM, choose Configuration > Device Management > Licensing > Smart Licensing.
From the Feature Tier drop-down menu, choose Standard.

Only the standard tier is available. A tier license is a prerequisite for adding other feature licenses. You must
have sufficient tier licenses in your account. Otherwise, you cannot configure any other feature licenses or
any features that require licenses.

For pre-2.3.0 satellite server users only: Do not disable the Strong Encryption license; it is required for
ASDM access.

(Optional) Check Carrier.

(Optional) From the Context drop-down menu, choose the number of contexts you want.
For Permanent License Reservation, you can specify the maximum contexts (248).

Click Apply.

Quit ASDM and relaunch it.

When you change licenses, you need to relaunch ASDM to show updated screens.

Licenses Per Model

ASAv

This section lists the license entitlements available for the ASAv and Firepower 4100/9300 chassis ASA
security module.

The following table shows the licensed features for the ASAv series.

Licenses Standard License

Firewall Licenses

Botnet Traffic Filter Enabled

Firewall Conns, Concurrent ASAv5: 50,000
ASAv10: 100,000
ASAv30: 500,000
ASAv50: 2,000,000

Carrier Enabled
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asav i}

Licenses

Standard License

Total TLS Proxy Sessions

ASAvS5: 500
ASAv10: 500
ASAv30: 1000
ASAv50: 10,000

VPN Licenses

AnyConnect peers Unlicensed Optional AnyConnect Plusor Apex
license, Maximums:
ASAV5: 50
ASAV10: 250
ASAV30: 750
ASAvV50: 10,000

Other VPN Peers ASAvS5: 50

ASAv10: 250

ASAv30: 1000
ASAv50: 10,000

Total VPN Peers, combined all
types

ASAvS: 50
ASAv10: 250
ASAv30: 1000
ASAv50: 10,000

General Licenses

Throughput Level ASAvS: 100 Mbps
ASAv10: 1 Gbps
ASAv30: 2 Gbps
ASAv50: 10 Gbps
Encryption Base (DES) or Strong (3DES/AES), depending on the account's export
compliance setting
Failover Active/Standby
Security Contexts No support
Clustering No support
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Licenses

Standard License

VLANSs, Maximum

ASAVS: 25
ASAv10: 50
ASAv30: 200
ASAv50: 1024

RAM, vCPUs

ASAvS5: 1 GB, 1 vCPU

(Optional) ASAv5: 1.5 GB, 1 vCPU (9.8(2) and later). You may want
to assign more memory if your ASAvS experiences memory exhaustion.

ASAv10: 2 GB, 1 vCPU
ASAv30: 8 GB, 4 vCPUs
ASAv50: 16 GB, 8 vCPUs

Firepower 2100 Series

The following table shows the licensed features for the Firepower 2100 series.

Licenses

Standard License

Firewall Licenses

Botnet Traffic Filter

No Support.

Firewall Conns, Concurrent

Firepower 2110: 1,000,000
Firepower 2120: 1,500,000
Firepower 2130: 2,000,000
Firepower 2140: 3,000,000

Carrier

No support. Although SCTP inspection maps are not supported, SCTP
stateful inspection using ACLs is supported.

Total TLS Proxy Sessions

Firepower 2110: 4,000
Firepower 2120: 8,000
Firepower 2130: 8,000
Firepower 2140: 10,000

VPN Licenses
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Licenses Standard License
AnyConnect peers Unlicensed Optional AnyConnect Plusor Apex
license, Maximums:
Firepower 2110: 1,500
Firepower 2120: 3,500
Firepower 2130: 7,500
Firepower 2140: 10,000
Other VPN Peers Firepower 2110: 1,500

Firepower 2120: 3,500
Firepower 2130: 7,500
Firepower 2140: 10,000

Total VPN Peers, combined all Firepower 2110: 1,500
types Firepower 2120: 3,500
Firepower 2130: 7,500
Firepower 2140: 10,000

General Licenses

Encryption Base (DES) or Strong (3DES/AES), depending on the account's export
compliance setting

Security Contexts 2 Optional License, Maximumsin
incrementsof 5 or 10:

Firepower 2110: 25
Firepower 2120: 25
Firepower 2130: 30
Firepower 2140: 40

Clustering No support.

VLANSs, Maximum 1024

Firepower 4100 Series ASA Application

The following table shows the licensed features for the Firepower 4100 series ASA application.

Licenses Standard License

Firewall Licenses

Botnet Traffic Filter No Support.
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Licenses Standard License

Firewall Conns, Concurrent Firepower 4110: 10,000,000
Firepower 4120: 15,000,000
Firepower 4140: 25,000,000
Firepower 4150: 35,000,000

Carrier Disabled Optional License: Carrier

Total TLS Proxy Sessions Firepower 4110: 10,000
All others: 15,000

VPN Licenses

AnyConnect peers Unlicensed Optional AnyConnect Plusor Apex
license:

Firepower 4110: 10,000
All others; 20,000

Other VPN Peers Firepower 4110: 10,000
All others: 20,000

Total VPN Peers, combined all Firepower 4110: 10,000
types All others: 20,000

General Licenses

Encryption Base (DES) or Strong (3DES/AES), depending on the account's export
compliance setting

Security Contexts 10 Optional License: Maximum of 250,
in increments of 10

Clustering Enabled

VLANSs, Maximum 1024

Firepower 9300 ASA Application

The following table shows the licensed features for the Firepower 9300 ASA application.

Licenses Standard License

Firewall Licenses

Botnet Traffic Filter No Support.
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Licenses Standard License

Firewall Conns, Concurrent Firepower 9300 SM-44: 60,000,000, up to 70,000,000 for a chassis with
3 modules
Firepower 9300 SM-36: 60,000,000, up to 70,000,000 for a chassis with
3 modules
Firepower 9300 SM-24: 55,000,000, up to 70,000,000 for a chassis with
3 modules

Carrier Disabled Optional License: Carrier

Total TLS Proxy Sessions 15,000

VPN Licenses

AnyConnect peers Unlicensed Optional AnyConnect Plusor Apex
license: 20,000 maximum

Other VPN Peers 20,000

Total VPN Peers, combined all 20,000
types

General Licenses

Encryption Base (DES) or Strong (3DES/AES), depending on the account's export
compliance setting

Security Contexts 10 Optional License: Maximumof 250,
in increments of 10

Clustering Enabled

VLANS, Maximum 1024

Monitoring Smart Software Licensing

You can monitor the license features, status, and certificate, as well as enable debug messages.

Viewing Your Current License

See the followingscreen for viewing your license:

« Configuration > Device Management > Licensing > Smart Licensing pane and view the Effective
Running Licenses area.

Viewing Smart License Status

See the following commands for viewing license status:
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» Monitoring > Properties > Smart License

Displays the state of Smart Software Licensing, Smart Agent version, UDI information, Smart Agent
state, global compliance status, the entitlements status, licensing certificate information, and scheduled
Smart Agent tasks.

Viewing the UDI

See the following command to view the universal product identifier (UDI):
show license udi

The following example shows the UDI for the ASAv:

ciscoasa# show license udi

UDI: PID:ASAv,SN:9AHV3KJBEKE
ciscoasa#

Smart Software Manager Communication

This section describes how your device communicates with the Smart Software Manager.

Device Registration and Tokens

\}

For each virtual account, you can create a registration token. This token is valid for 30 days by default. Enter
this token ID plus entitlement levels when you deploy each device, or when you register an existing device.
You can create a new token if an existing token is expired.

Note

Firepower 4100/9300 chassis—Device registration is configured in the chassis, not on the ASA logical device.

At startup after deployment, or after you manually configure these parameters on an existing device, the device
registers with the Cisco License Authority. When the device registers with the token, the License Authority

issues an ID certificate for communication between the device and the License Authority. This certificate is

valid for 1 year, although it will be renewed every 6 months.

Periodic Communication with the License Authority

The device communicates with the License Authority every 30 days. If you make changes in the Smart Software
Manager, you can refresh the authorization on the device so the change takes place immediately. Or you can
wait for the device to communicate as scheduled.

You can optionally configure an HTTP proxy.

ASAv

The ASAv must have internet access either directly or through an HTTP proxy at least every 90 days. Normal
license communication occurs every 30 days, but with the grace period, your device will stay compliant for
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up to 90 days without calling home. After the grace period, you should contact the Licensing Authority, or
your ASAv will be out-of-compliance.

Firepower 2100

The Firepower 2100 must have internet access either directly or through an HTTP proxy at least every 90
days. Normal license communication occurs every 30 days, but with the grace period, your device will operate
for up to 90 days without calling home. After the grace period, you must contact the Licensing Authority, or
you will not be able to make configuration changes to features requiring special licenses; operation is otherwise
unaffected.

Firepower 4100/9300

The Firepower 4100/9300 must have internet access either directly or through an HTTP proxy at least every
90 days. Normal license communication occurs every 30 days, but with the grace period, your device will
operate for up to 90 days without calling home. After the grace period, you must contact the Licensing
Authority, or you will not be able to make configuration changes to features requiring special licenses; operation
is otherwise unaffected.

Out-of-Compliance State

The device can become out of compliance in the following situations:

* Over-utilization—When the device uses unavailable licenses.
* License expiration—When a time-based license expires.

* Lack of communication—When the device cannot reach the Licensing Authority for re-authorization.

To verify whether your account is in, or approaching, an Out-of-Compliance state, you must compare the
entitlements currently in use by your device against those in your Smart Account.

In an out-of-compliance state, the device might be limited, depending on the model:

» ASAv—The ASAv is not affected.

* Firepower 2100—You will not be able to make configuration changes to features requiring special
licenses, but operation is otherwise unaffected. For example, existing contexts over the Standard license
limit can continue to run, and you can modify their configuration, but you will not be able to add a new
context. If you do not have sufficient Standard licenses when you first register, you cannot configure
any licensed features, including strong encryption features.

* Firepower 4100/9300—You will not be able to make configuration changes to features requiring special
licenses, but operation is otherwise unaffected. For example, existing contexts over the Standard license
limit can continue to run, and you can modify their configuration, but you will not be able to add a new
context. If you do not have sufficient Standard licenses when you first register, you cannot configure
any licensed features, including strong encryption features.

Smart Call Home Infrastructure

By default, a Smart Call Home profile exists in the configuration that specifies the URL for the Licensing
Authority. You cannot remove this profile. Note that the only configurable option for the License profile is
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. Smart License Certificate Management

the destination address URL for the License Authority. Unless directed by Cisco TAC, you should not change
the License Authority URL.

Note

For the Firepower 4100/9300 chassis, Smart Call Home for licensing is configured in the Firepower 4100/9300
chassis supervisor, not on the ASA.

You cannot disable Smart Call Home for Smart Software Licensing. For example, even if you disable Smart
Call Home using the no service call-home command, Smart Software Licensing is not disabled.

Other Smart Call Home functions are not turned on unless you specifically configure them.

Smart License Certificate Management

The ASA automatically creates a trustpoint containing the certificate of the CA that issued the Smart Call
Home server certificate. To avoid service interruption if the issuing hierarchy of the server certificate changes,
configure the Automatic Import area of the Configuration > Remote Access VPN > Certificate
Management > Trusted Certificate Pool > Edit Trusted Certificate Pool Policy screen to enable the
automatic update of the trustpool bundle at periodic intervals.

The server certificate received from a Smart License Server must contain "ServAuth" in the Extended Key
Usage field. This check will be done on non self-signed certificates only; self-signed certificates do not provide
any value in this field.

History for Smart Software Licensing

Feature Name Platform Description

Releases
Licensing changes for failover pairs on the | 9.7(1) Only the active unit requests the license entitlements. Previously, both
Firepower 4100/9300 chassis units requested license entitlements. Supported with FXOS 2.1.1.
Permanent License Reservation for the 9.6(2) Due to an update to the Smart Agent (to 1.6.4), the request and
ASAv Short String enhancement authorization codes now use shorter strings.

We did not modify any screens.

Satellite Server support for the ASAv 9.6(2) If your devices cannot access the internet for security reasons, you can

optionally install a local Smart Software Manager satellite server as a
virtual machine (VM).

We did not modify any screens.
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History for Smart Software Licensing .

Feature Name

Platform
Releases

Description

Permanent License Reservation for the
ASA on the Firepower 4100/9300 chassis

9.6(2)

For highly secure environments where communication with the Cisco
Smart Software Manager is not allowed, you can request a permanent
license for the ASA on the Firepower 9300 and Firepower 4100. All
available license entitlements are included in the permanent license,
including the Standard Tier, Strong Encryption (if qualified), Security
Contexts, and Carrier licenses. Requires FXOS 2.0.1.

All configuration is performed on the Firepower 4100/9300 chassis; no
configuration is required on the ASA.

Permanent License Reservation for the
ASAv

9.5(2.200)
9.6(2)

For highly secure environments where communication with the Cisco
Smart Software Manager is not allowed, you can request a permanent
license for the ASAv. In 9.6(2), we also added support for this feature
for the ASAv on Amazon Web Services. This feature is not supported
for Microsoft Azure.

We introduced the following commands: license smart reservation,
license smart reservation cancel, license smart reservation install,
license smart reservation request universal, license smart reservation
return

No ASDM support.

Smart Agent Upgrade to v1.6

9.5(2.200)
9.6(2)

The smart agent was upgraded from Version 1.1 to Version 1.6. This
upgrade supports permanent license reservation and also supports setting
the Strong Encryption (3DES/AES) license entitlement according to the
permission set in your license account.

Note If you downgrade from Version 9.5(2.200), the ASAv does
not retain the licensing registration state. You need to
re-register with the Configuration > Device Management >
Licensing > Smart Licensing page with the Force
registration option; obtain the ID token from the Smart
Software Manager.

We did not change any screens.

Strong Encryption (3DES) license
automatically applied for the ASA on the
Firepower 9300

9.5(2.1)

For regular Cisco Smart Software Manager users, the Strong Encryption
license is automatically enabled for qualified customers when you apply
the registration token on the Firepower 9300.

Note If you are using the Smart Software Manager satellite
deployment, to use ASDM and other strong encryption
features, after you deploy the ASA you must enable the Strong
Encryption (3DES) license using the ASA CLI.

This feature requires FXOS 1.1.3.

We modified the following screen: Configuration > Device
Management > Licensing > Smart License

ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8 [JJj



. History for Smart Software Licensing

Getting Started with the ASA |

Feature Name

Platform
Releases

Description

Validation of the Smart Call Home/Smart
Licensing certificate if the issuing hierarchy
of the server certificate changes

9.5(2)

Smart licensing uses the Smart Call Home infrastructure. When the ASA
first configures Smart Call Home anonymous reporting in the background,
it automatically creates a trustpoint containing the certificate of the CA
that issued the Smart Call Home server certificate. The ASA now supports
validation of the certificate if the issuing hierarchy of the server certificate
changes; you can enable the automatic update of the trustpool bundle at
periodic intervals.

We modified the following screen: Configuration > Remote Access
VPN > Certificate Management > Trusted Certificate Pool > Edit
Trusted Certificate Pool Policy

New Carrier license

9.5(2)

The new Carrier license replaces the existing GTP/GPRS license, and
also includes support for SCTP and Diameter inspection. For the ASA
on the Firepower 9300, the feature mobile-sp command will
automatically migrate to the feature carrier command.

We modified the following screen: Configuration > Device
Management > Licensing > Smart License

Cisco Smart Software Licensing for the
ASA on the Firepower 9300

9.4(1.150)

We introduced Smart Software Licensing for the ASA on the Firepower
9300.

We modified the following screen: Configuration > Device
Management > Licensing > Smart License

Cisco Smart Software Licensing for the
ASAv

9.3(2)

Smart Software Licensing lets you purchase and manage a pool of
licenses. Unlike PAK licenses, smart licenses are not tied to a specific
serial number. You can easily deploy or retire ASAvs without having to
manage each unit’s license key. Smart Software Licensing also lets you
see your license usage and needs at a glance.

We introduced or modified the following screens:

Configuration > Device Management > Licensing > Smart License
Configuration > Device Management > Smart Call-Home Monitoring
> Properties > Smart License
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CHAPTER 6

Logical Devices for the Firepower 4100/9300

The Firepower 4100/9300 is a flexible security platform on which you can install one or more logical devices.
This chapter describes basic interface configuration and how to add a standalone or High Availability logical
device using the Firepower Chassis Manager. To add a clustered logical device, see ASA Cluster for the
Firepower 4100/9300 Chassis, on page 407. To use the FXOS CLI, see the FXOS CLI configuration guide.
For more advanced FXOS procedures and troubleshooting, see the FXOS configuration guide.

* About Firepower Interfaces, on page 189

* About Logical Devices, on page 190

* Requirements and Prerequisites for Hardware and Software Combinations, on page 191
* Guidelines and Limitations for Logical Devices, on page 192

* Configure Interfaces, on page 193

* Configure Logical Devices, on page 196

* History for Logical Devices, on page 202

About Firepower Interfaces

The Firepower 4100/9300 chassis supports physical interfaces and EtherChannel (port-channel) interfaces.
EtherChannel interfaces can include up to 16 member interfaces of the same type.

Chassis Management Interface

The chassis management interface is used for management of the FXOS Chassis by SSH or Firepower Chassis
Manager. This interface appears at the top of the Interfaces tabas MGMT, and you can only enable or disable
this interface on the Interfaces tab. This interface is separate from the mgmt-type interface that you assign
to the logical devices for application management.

To configure parameters for this interface, you must configure them from the CLI. To view information about
this interface in the FXOS CLI, connect to local management and show the management port:

Firepower # connect local-mgmt
Firepower(local-mgmt) # show mgmt-port

Note that the chassis management interface remains up even if the physical cable or SFP module are unplugged,
or if the mgmt-port shut command is performed.
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\}

Note The chassis management interface does not support jumbo frames.

Interface Types

Each interface can be one of the following types:

 Data—Use for regular data. Data interfaces cannot be shared between logical devices, and logical devices
cannot communicate over the backplane to other logical devices. For traffic on Data interfaces, all traffic
must exit the chassis on one interface and return on another interface to reach another logical device.

» Mgmt—Use to manage application instances. These interfaces can be shared by one or more logical
devices to access external hosts; logical devices cannot communicate over this interface with other logical
devices that share the interface. You can only assign one management interface per logical device. For
ASA: You can later enable management from a data interface; but you must assign a Management
interface to the logical device even if you don't intend to use it after you enable data management. For
information about the separate chassis management interface, see Chassis Management Interface, on
page 189.

* Firepower-eventing—Use as a secondary management interface for FTD devices.

* Cluster—Use as the cluster control link for a clustered logical device. By default, the cluster control link
is automatically created on Port-channel 48. The Cluster type is only supported on EtherChannel interfaces.

FXOS Interfaces vs. Application Interfaces

The Firepower 4100/9300 manages the basic Ethernet settings of physical interfaces and EtherChannel
(port-channel) interfaces. Within the application, you configure higher level settings. For example, you can
only create EtherChannels in FXOS; but you can assign an IP address to the EtherChannel within the application.

The following sections describe the interaction between FXOS and the application for interfaces.

VLAN Subinterfaces

For all logical devices, you can create VLAN subinterfaces within the application.

Independent Interface States in the Chassis and in the Application

You can administratively enable and disable interfaces in both the chassis and in the application. For an
interface to be operational, the interface must be enabled in both operating systems. Because the interface
state is controlled independently, you may have a mismatch between the chassis and application.

About Logical Devices

A logical device lets you run one application instance (either ASA or Firepower Threat Defense) and also one
optional decorator application (Radware DefensePro) to form a service chain.

When you add a logical device, you also define the application instance type and version, assign interfaces,
and configure bootstrap settings that are pushed to the application configuration.
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\}

Note For the Firepower 9300, you must install the same application instance type (ASA or FTD) on all modules
in the chassis; different types are not supported at this time. Note that modules can run different versions of
an application instance type.

Standalone and Clustered Logical Devices

You can add the following logical device types:

« Standalone—A standalone logical device operates as a standalone unit or as a unit in a High Availability
pair.

* Cluster—A clustered logical device lets you group multiple units together, providing all the convenience
of a single device (management, integration into a network) while achieving the increased throughput
and redundancy of multiple devices. Multiple module devices, like the Firepower 9300, support
intra-chassis clustering. For the Firepower 9300, all three modules must participate in the cluster.

Requirements and Prerequisites for Hardware and Software
Combinations

The Firepower 4100/9300 supports multiple models, security modules, application types, and high availability
and scalability features. See the following requirements for allowed combinations.

Firepower 9300 Requirements

The Firepower 9300 includes 3 security module slots and multiple types of security modules. See the following
requirements:

* Security Module Types—All modules in the Firepower 9300 must be the same type.

* Clustering—All security modules in the cluster, whether it is intra-chassis or inter-chassis, must be the
same type. You can have different quantities of installed security modules in each chassis, although all
modules present in the chassis must belong to the cluster including any empty slots. For example, you
can install 2 SM-36s in chassis 1, and 3 SM-36s in chassis 2.

* High Availability—High Availability is only supported between same-type modules on the Firepower
9300.

* ASA and FTD application types— You can only install one application type on the chassis, ASA or FTD.

* ASA or FTD versions—You can run different versions of an application instance type on separate
modules. For example, you can install FTD 6.3 on module 1, FTD 6.4 on module 2, and FTD 6.5 on
module 3.

Firepower 4100 Requirements
The Firepower 4100 comes in multiple models. See the following requirements:

* Clustering—All chassis in the cluster must be the same model.
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* High Availability—High Availability is only supported between same-type models.

* ASA and FTD application types—The Firepower 4100 can only run a single application type.

Guidelines and Limitations for Logical Devices

See the following sections for guidelines and limitations.

Guidelines and Limitations for Firepower Interfaces

Default MAC Addresses
Default MAC address assignments depend on the type of interface.

* Physical interfaces—The physical interface uses the burned-in MAC address.

* EtherChannels—For an EtherChannel, all interfaces that are part of the channel group share the same
MAC address. This feature makes the EtherChannel transparent to network applications and users,
because they only see the one logical connection; they have no knowledge of the individual links. The
port-channel interface uses a unique MAC address from a pool; interface membership does not affect
the MAC address.

General Guidelines and Limitations

Firewall Mode
You can set the firewall mode to routed or transparent in the bootstrap configuration for the FTD. For the
ASA, you can change the firewall mode to transparent after you deploy. See Change the ASA to Transparent
Firewall Mode, on page 199.
High Availability

* Configure high availability within the application configuration.

* You can use any data interfaces as the failover and state links.

Context Mode

* Enable multiple context mode in the ASA after you deploy.

Requirements and Prerequisites for High Availability

* The two units in a High Availability Failover configuration must:
* Be on a separate chassis; intra-chassis High Availability for the Firepower 9300 is not supported.
* Be the same model.

* Have the same interfaces assigned to the High Availability logical devices.
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Configure Interfaces .

* Have the same number and types of interfaces. All interfaces must be preconfigured in FXOS
identically before you enable High Availability.

* For High Availability system requirements, see Failover System Requirements, on page 272.

Configure Interfaces

\}

By default, physical interfaces are disabled. You can enable interfaces, add EtherChannels, and edit interface
properties.

Note

If you remove an interface in FXOS (for example, if you remove a network module, remove an EtherChannel,
or reassign an interface to an EtherChannel), then the ASA configuration retains the original commands so
that you can make any necessary adjustments; removing an interface from the configuration can have wide
effects. You can manually remove the old interface configuration in the ASA OS.

Enable or Disable an Interface

Step 1

Step 2

Step 3

You can change the Admin State of each interface to be enabled or disabled. By default, physical interfaces
are disabled.

Procedure

Choose Interfaces to open the Interfaces page.
The Interfaces page shows a visual representation of the currently installed interfaces at the top of the page

and provides a listing of the installed interfaces in the table below.

To enable the interface, click the disabled Slider disabled (C2¥3) so that it changes to the enabled Slider
enabled (¥1),

Click Yes to confirm the change. The corresponding interface in the visual representation changes from gray
to green.

To disable the interface, click the enabled Slider enabled (€#1) so that it changes to the disabled Slider
disabled (C15),

Click Yes to confirm the change. The corresponding interface in the visual representation changes from green
to gray.

Configure a Physical Interface

You can physically enable and disable interfaces, as well as set the interface speed and duplex. To use an
interface, it must be physically enabled in FXOS and logically enabled in the application.
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. Add an EtherChannel (Port Channel)

Step 1

Step 2
Step 3

Step 4

Step 5
Step 6
Step 7
Step 8

Before you begin

* Interfaces that are already a member of an EtherChannel cannot be modified individually. Be sure to
configure settings before you add it to the EtherChannel.

Procedure

Choose Interfaces to open the Interfaces page.

The All Interfaces page shows a visual representation of the currently installed interfaces at the top of the
page and provides a listing of the installed interfaces in the table below.

Click Edit in the row for the interface you want to edit to open the Edit Interface dialog box.

To enable the interface, check the Enable check box. To disable the interface, uncheck the Enable check
box.

Choose the interface Type:
See Interface Types, on page 190 for details about interface type usage.

» Data
* Mgmt

» Cluster—Do not choose the Cluster type; by default, the cluster control link is automatically created
on Port-channel 48.

(Optional) Choose the speed of the interface from the Speed drop-down list.

(Optional) If your interface supports Auto Negotiation, click the Yes or No radio button.
(Optional) Choose the duplex of the interface from the Duplex drop-down list.

Click OK.

Add an EtherChannel (Port Channel)

An EtherChannel (also known as a port channel) can include up to 16 member interfaces of the same media
type and capacity, and must be set to the same speed and duplex. The media type can be either RJ-45 or SFP;
SFPs of different types (copper and fiber) can be mixed. You cannot mix interface capacities (for example
1GB and 10GB interfaces) by setting the speed to be lower on the larger-capacity interface. The Link
Aggregation Control Protocol (LACP) aggregates interfaces by exchanging the Link Aggregation Control
Protocol Data Units (LACPDUs) between two network devices.

The Firepower 4100/9300 chassis only supports EtherChannels in Active LACP mode so that each member
interface sends and receives LACP updates. An active EtherChannel can establish connectivity with either
an active or a passive EtherChannel. You should use the active mode unless you need to minimize the amount
of LACP traffic.

LACP coordinates the automatic addition and deletion of links to the EtherChannel without user intervention.
It also handles misconfigurations and checks that both ends of member interfaces are connected to the correct
channel group.
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Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Add an EtherChannel (Port Channel) .

When the Firepower 4100/9300 chassis creates an EtherChannel, the EtherChannel stays in a Suspended
state until you assign it to a logical device, even if the physical link is up. The EtherChannel will be brought
out of this Suspended state in the following situations:

* The EtherChannel is added as a data or management interface for a standalone logical device

* The EtherChannel is added as a management interface or cluster control link for a logical device that is
part of a cluster

* The EtherChannel is added as a data interface for a logical device that is part of a cluster and at least one

unit has joined the cluster

Note that the EtherChannel does not come up until you assign it to a logical device. If the EtherChannel is
removed from the logical device or the logical device is deleted, the EtherChannel will revert to a Suspended
state.

Procedure

Choose Interfaces to open the Interfaces page.

The All Interfaces page shows a visual representation of the currently installed interfaces at the top of the
page and provides a listing of the installed interfaces in the table below.

Click Add Port Channel above the interfaces table to open the Add Port Channel dialog box.
Enter an ID for the port channel in the Port Channel ID field. Valid values are between 1 and 47.

Port-channel 48 is reserved for the cluster control link when you deploy a clustered logical device. If you do
not want to use Port-channel 48 for the cluster control link, you can delete it and configure a Cluster type
EtherChannel with a different ID. You can only add one Cluster type EtherChannel. For intra-chassis clustering,
do not assign any interfaces to the Cluster EtherChannel.

To enable the port channel, check the Enable check box. To disable the port channel, uncheck the Enable
check box.

Choose the interface Type:
See Interface Types, on page 190 for details about interface type usage.

» Data
* Mgmt

e Cluster

Set the required Admin Speed for the member interfaces from the drop-down list.

If you add a member interface that is not at the specified speed, it will not successfully join the port channel.

Set the required Admin Duplex for the member interfaces, Full Duplex or Half Duplex.

If you add a member interface that is configured with the specified duplex, it will not successfully join the
port channel.

To add an interface to the port channel, select the interface in the Available Interface list and click Add
Interface to move the interface to the Member ID list.
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You can add up to 16 member interfaces of the same media type and capacity. The member interfaces must
be set to the same speed and duplex, and must match the speed and duplex that you configured for this port
channel. The media type can be either RJ-45 or SFP; SFPs of different types (copper and fiber) can be mixed.
You cannot mix interface capacities (for example 1GB and 10GB interfaces) by setting the speed to be lower
on the larger-capacity interface.

Tip You can add multiple interfaces at one time. To select multiple individual interfaces, click on the
desired interfaces while holding down the Ctrl key. To select a range of interfaces, select the first
interface in the range, and then, while holding down the Shift key, click to select the last interface
in the range.

Step 9 To remove an interface from the port channel, click the Delete button to the right of the interface in the Member
ID list.

Step 10 Click OK.

Configure Logical Devices

Add a standalone logical device or a High Availability pair on the Firepower 4100/9300 chassis.

For clustering, see #unique 290.

Add a Standalone ASA

Standalone logical devices work either alone or in a High Availability pair. On the Firepower 9300 with
multiple security modules, you can deploy either a cluster or standalone devices. The cluster must use all
modules, so you cannot mix and match a 2-module cluster plus a single standalone device, for example.

You can deploy a routed firewall mode ASA from the Firepower 4100/9300 chassis. To change the ASA to
transparent firewall mode, complete this procedure, and then see Change the ASA to Transparent Firewall
Mode, on page 199.

For multiple context mode, you must first deploy the logical device, and then enable multiple context mode
in the ASA application.

Before you begin

» Download the application image you want to use for the logical device from Cisco.com, and then upload
that image to the Firepower 4100/9300 chassis.

N

Note For the Firepower 9300, you must install the same application instance type (ASA
or FTD) on all modules in the chassis; different types are not supported at this
time. Note that modules can run different versions of an application instance type.

+ Configure a management interface to use with the logical device. The management interface is required.
Note that this management interface is not the same as the chassis management port that is used only for
chassis management (and that appears at the top of the Interfaces tab as MGMT).

* Gather the following information:
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Step 1
Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

Add a Standalone ASA [J|]

* Interface IDs for this device
* Management interface IP address and network mask

* Gateway IP address

Procedure

Choose Logical Devices.
Click Add Device, and set the following parameters:
a) Provide a Device Name.

This name is used by the chassis supervisor to configure management settings and to assign interfaces; it
is not the device name used in the application configuration.

b) For the Template, choose Cisco: Adaptive Security Appliance.
¢) Choose the Image Version.

d) For the Usage, click the Standalone radio button.

e) Click OK.

You see the Provisioning - device name window.

Expand the Data Ports area, and click each port that you want to assign to the device.

You can only assign data interfaces that you previously enabled on the Interfaces page. You will later enable
and configure these interfaces on the ASA, including setting the IP addresses.

Click the device icon in the center of the screen.

A dialog box appears where you can configure initial bootstrap settings. These settings are meant for initial
deployment only, or for disaster recovery. For normal operation, you can later change most values in the
application CLI configuration.

On the General Information page, complete the following:

a) (For the Firepower 9300) Under Security Module Selection click the security module that you want to
use for this logical device.

b) Choose the Management Interface.

This interface is used to manage the logical device. This interface is separate from the chassis management
port.

¢) Choose the management interface Address Type: IPv4 only, IPv6 only, or IPv4 and IPVv6.
d) Configure the Management IP address.

Set a unique IP address for this interface.

e) Enter a Network Mask or Prefix Length.
f) Enter a Network Gateway address.

Click the Settings tab.

Enter and confirm a Password for the admin user.
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. Add a High Availability Pair

Step 8
Step 9

Step 10

The pre-configured ASA admin user/password is useful for password recovery; if you have FXOS access,
you can reset the admin user password if you forget it.

Click OK to close the configuration dialog box.
Click Save.

The chassis deploys the logical device by downloading the specified software version and pushing the bootstrap
configuration and management interface settings to the application instance. Check the Logical Devices page
for the status of the new logical device. When the logical device shows its Status as online, you can start
configuring the security policy in the application.

System Tools Help

& Refresh | | (&) Add Device

B7% (40 of 46) Cores Available

&P |l 8
Status
@ online (_L;:' #* (455

See the ASA configuration guide to start configuring your security policy.

Add a High Availability Pair

Step 1
Step 2

Step 3
Step 4

ASA High Availability (also known as failover) is configured within the application, not in FXOS. However,
to prepare your chassis for high availability, see the following steps.

Before you begin

See Failover System Requirements, on page 272.

Procedure

Allocate the same interfaces to each logical device.

Allocate 1 or 2 data interfaces for the failover and state link(s).

These interfaces exchange high availability traffic between the 2 chassis. We recommend that you use a 10
GB data interface for a combined failover and state link. If you have available interfaces, you can use separate
failover and state links; the state link requires the most bandwidth. You cannot use the management-type
interface for the failover or state link. We recommend that you use a switch between the chassis, with no other
device on the same network segment as the failover interfaces.

Enable High Availability on the logical devices. See Failover for High Availability, on page 271.

If you need to make interface changes after you enable High Availability, perform the changes on the standby
unit first, and then perform the changes on the active unit.
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Note For the ASA, if you remove an interface in FXOS (for example, if you remove a network module,
remove an EtherChannel, or reassign an interface to an EtherChannel), then the ASA configuration
retains the original commands so that you can make any necessary adjustments; removing an interface
from the configuration can have wide effects. You can manually remove the old interface
configuration in the ASA OS.

Change the ASA to Transparent Firewall Mode

You can only deploy a routed firewall mode ASA from the Firepower 4100/9300 chassis. To change the ASA
to transparent firewall mode, complete the initial deployment, and then change the firewall mode within the
ASA CLI For standalone ASAs, because changing the firewall mode erases the configuration, you must then
redeploy the configuration from the Firepower 4100/9300 chassis to regain the bootstrap configuration. The
ASA then remains in transparent mode with a working bootstrap configuration. For clustered ASAs, the
configuration is not erased, so you do not need to redeploy the bootstrap configuration from FXOS.

Procedure

Step 1 Connect to the ASA console according to Connect to the Console of the Application, on page 201. For a cluster,
connect to the primary unit. For a failover pair, connect to the active unit.

Step 2 Enter configuration mode:
enable

configure terminal

By default, the enable password is blank.

Step 3 Set the firewall mode to transparent:

firewall transparent

Step 4 Save the configuration:
write memory
For a cluster or failover pair, this configuration is replicated to secondary units:
asa(config)# firewall transparent
asa(config)# write memory

Building configuration...
Cryptochecksum: 9f831dfb 60dffa8c 1d939884 74735b69

3791 bytes copied in 0.160 secs

[OK]

asa (config) #

Beginning configuration replication to unit-1-2

End Configuration Replication to data unit.

asa (config) #

Step 5 On the Firepower Chassis Manager Logical Devices page, click the Edit icon to edit the ASA.
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. Change an Interface on an ASA Logical Device

Step 6

Step 7

The Provisioning page appears.

Click the device icon to edit the bootstrap configuration. Change any value in your configuration, and click
OK.

You must change the value of at least one field, for example, the Password field.

You see a warning about changing the bootstrap configuration; click Yes.

Click Save to redeploy the configuration to the ASA. For an inter-chassis cluster or for a failover pair, repeat
steps 5 through 7 to redeploy the bootstrap configuration on each chassis.

Wait several minutes for the chassis/security modules to reload, and for the ASA to become operational again.
The ASA now has an operational bootstrap configuration, but remains in transparent mode.

Change an Interface on an ASA Logical Device

You can allocate, unallocate, or replace a management interface on an ASA logical device. ASDM discovers
the new interfaces automatically.

Adding a new interface, or deleting an unused interface has minimal impact on the ASA configuration.
However, if you remove an allocated interface in FXOS (for example, if you remove a network module,
remove an EtherChannel, or reassign an allocated interface to an EtherChannel), and the interface is used in
your security policy, removal will impact the ASA configuration. In this case, the ASA configuration retains
the original commands so that you can make any necessary adjustments. You can manually remove the old
interface configuration in the ASA OS.

Note

You can edit the membership of an allocated EtherChannel without impacting the logical device.

Before you begin

* Configure your interfaces and add any EtherChannels according to Configure a Physical Interface, on
page 193 and Add an EtherChannel (Port Channel), on page 194.

* If you want to add an already-allocated interface to an EtherChannel (for example, all interfaces are
allocated by default to a cluster), you need to unallocate the interface from the logical device first, then
add the interface to the EtherChannel. For a new EtherChannel, you can then allocate the EtherChannel
to the device.

* If you want to replace the management interface with a management EtherChannel, then you need to
create the EtherChannel with at least 1 unallocated data member interface, and then replace the current
management interface with the EtherChannel. After the ASA reloads (management interface changes
cause a reload), you can add the (now unallocated) management interface to the EtherChannel as well.

* For clustering or failover, make sure you add or remove the interface on all units. We recommend that
you make the interface changes on the data/standby unit(s) first, and then on the control/active unit. New
interfaces are added in an administratively down state, so they do not affect interface monitoring.
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Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Connect to the Console of the Application .

Procedure

In the Firepower Chassis Manager, choose Logical Devices.
Click the Edit icon at the top right to edit the logical device.
Unallocate a data interface by de-selecting the interface in the Data Ports area.
Allocate a new data interface by selecting the interface in the Data Ports area.

Replace the management interface:
For this type of interface, the device reloads after you save your changes.

a) Click the device icon in the center of the page.

b) On the General/Cluster Information tab, choose the new Management Interface from the drop-down
list.

¢) Click OK.
Click Save.

Connect to the Console of the Application

Step 1

Step 2

Use the following procedure to connect to the console of the application.

Procedure

Connect to the module CLI.
connect module slot_number console

To connect to the security engine of a device that does not support multiple security modules, always use 1
as the slot_number.

Example:

Firepower# connect module 1 console
Telnet escape character is '~'.
Trying 127.5.1.1...

Connected to 127.5.1.1.

Escape character is '~'.

CISCO Serial Over LAN:
Close Network Connection to Exit

Firepower-modulel>

Connect to the application console.
connect asa

Example:

Firepower-modulel> connect asa
Connecting to asa(asal) console... hit Ctrl + A + D to return to bootCLI
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asa>

Step 3 Exit the application console to the FXOS module CLI.

* ASA—Enter Ctrl-a, d

Step 4 Return to the supervisor level of the FXOS CLI.

a) Enter ~

You exit to the Telnet application.

b) To exit the Telnet application, enter:

telnet>quit

History for Logical Devices

Getting Started with the ASA |

Feature

Version

Details

Inter-site clustering improvement for the
ASA on the Firepower 4100/9300 chassis

9.7(1)

You can now configure the site ID for each
Firepower 4100/9300 chassis when you
deploy the ASA cluster. Previously, you
had to configure the site ID within the ASA
application; this new feature eases initial
deployment. Note that you can no longer
set the site ID within the ASA
configuration. Also, for best compatibility
with inter-site clustering, we recommend
that you upgrade to ASA 9.7(1) and FXOS
2.1.1, which includes several improvements
to stability and performance.

We modified the following screen:
Configuration > Device Management >
High Availability and Scalability > ASA
Cluster > Cluster Configuration

Support for the Firepower 4100 series

9.6(1)

With FXOS 1.1.4, the ASA supports
inter-chassis clustering on the Firepower
4100 series.

We did not modify any screens.

Inter-chassis clustering for 6 modules, and
inter-site clustering for the Firepower 9300
ASA application

9.5(2.1)

With FXOS 1.1.3, you can now enable
inter-chassis, and by extension inter-site
clustering. You can include up to 6 modules
in up to 6 chassis.

We did not modify any screens.
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Feature

Version

Details

Intra-chassis ASA Clustering for the
Firepower 9300

9.4(1.150)

You can cluster up to 3 security modules
within the Firepower 9300 chassis. All
modules in the chassis must belong to the
cluster.

We introduced the following screen:
Configuration > Device Management >
High Availability and Scalability > ASA
Cluster Replication
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CHAPTER 7

Transparent or Routed Firewall Mode

This chapter describes how to set the firewall mode to routed or transparent, as well as how the firewall works
in each firewall mode.

You can set the firewall mode independently for each context in multiple context mode.

* About the Firewall Mode, on page 205

* Default Settings, on page 214

* Guidelines for Firewall Mode, on page 214

* Set the Firewall Mode (Single Mode), on page 215
» Examples for Firewall Mode, on page 216

* History for the Firewall Mode, on page 227

About the Firewall Mode

The ASA supports two firewall modes: Routed Firewall mode and Transparent Firewall mode.

About Routed Firewall Mode

In routed mode, the ASA is considered to be a router hop in the network. Each interface that you want to route
between is on a different subnet. You can share Layer 3 interfaces between contexts.

With Integrated Routing and Bridging, you can use a "bridge group" where you group together multiple
interfaces on a network, and the ASA uses bridging techniques to pass traffic between the interfaces. Each
bridge group includes a Bridge Virtual Interface (BVI) to which you assign an IP address on the network.
The ASA routes between BVIs and regular routed interfaces. If you do not need multiple context mode or
clustering or EtherChannel or redundant or VNI member interfaces, you might consider using routed mode
instead of transparent mode. In routed mode, you can have one or more isolated bridge groups like in transparent
mode, but also have normal routed interfaces as well for a mixed deployment.

About Transparent Firewall Mode

Traditionally, a firewall is a routed hop and acts as a default gateway for hosts that connect to one of its
screened subnets. A transparent firewall, on the other hand, is a Layer 2 firewall that acts like a “bump in the
wire,” or a “stealth firewall,” and is not seen as a router hop to connected devices. However, like any other
firewall, access control between interfaces is controlled, and all of the usual firewall checks are in place.
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Layer 2 connectivity is achieved by using a "bridge group" where you group together the inside and outside
interfaces for a network, and the ASA uses bridging techniques to pass traffic between the interfaces. Each
bridge group includes a Bridge Virtual Interface (BVI) to which you assign an IP address on the network.
You can have multiple bridge groups for multiple networks. In transparent mode, these bridge groups cannot
communicate with each other.

Using the Transparent Firewall in Your Network

The ASA connects the same network between its interfaces. Because the firewall is not a routed hop, you can
easily introduce a transparent firewall into an existing network.

The following figure shows a typical transparent firewall network where the outside devices are on the same
subnet as the inside devices. The inside router and hosts appear to be directly connected to the outside router.

Figure 25: Transparent Firewall Network
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Management Interface

In addition to each Bridge Virtual Interface (BVI) IP address, you can add a separate Management Slot/port
interface that is not part of any bridge group, and that allows only management traffic to the ASA. For more
information, see Management Interface, on page 464.

Passing Traffic For Routed-Mode Features

For features that are not directly supported on the transparent firewall, you can allow traffic to pass through
so that upstream and downstream routers can support the functionality. For example, by using an access rule,
you can allow DHCP traffic (instead of the unsupported DHCP relay feature) or multicast traffic such as that
created by IP/TV. You can also establish routing protocol adjacencies through a transparent firewall; you can
allow OSPF, RIP, EIGRP, or BGP traffic through based on an access rule. Likewise, protocols like HSRP or
VRRP can pass through the ASA.
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About Bridge Groups

A bridge group is a group of interfaces that the ASA bridges instead of routes. Bridge groups are supported
in both transparent and routed firewall mode. Like any other firewall interfaces, access control between
interfaces is controlled, and all of the usual firewall checks are in place.

Bridge Virtual Interface (BVI)

Each bridge group includes a Bridge Virtual Interface (BVI). The ASA uses the BVI IP address as the source
address for packets originating from the bridge group. The BVI IP address must be on the same subnet as the
bridge group member interfaces. The BVI does not support traffic on secondary networks; only traffic on the
same network as the BVI IP address is supported.

In transparent mode: Only bridge group member interfaces are named and can be used with interface-based
features.

In routed mode: The BVI acts as the gateway between the bridge group and other routed interfaces. To route
between bridge groups/routed interfaces, you must name the BVI. For some interface-based features, you can
use the BVI itself:

* Access rules—You can configure access rules for both bridge group member interfaces and for the BVI;
for inbound rules, the member interface is checked first. For outbound rules, the BVI is checked first.

* DHCPv4 server—Only the BVI supports the DHCPv4 server configuration.

« Static routes—You can configure static routes for the BVI; you cannot configure static routes for the
member interfaces.

* Syslog server and other traffic sourced from the ASA—When specifying a syslog server (or SNMP
server, or other service where the traffic is sourced from the ASA), you can specify either the BVI or a
member interface.

If you do not name the BVI in routed mode, then the ASA does not route bridge group traffic. This configuration
replicates transparent firewall mode for the bridge group. If you do not need multiple context mode or clustering
or EtherChannel or redundant or VNI member interfaces, you might consider using routed mode instead. In
routed mode, you can have one or more isolated bridge groups like in transparent mode, but also have normal
routed interfaces as well for a mixed deployment.

Bridge Groups in Transparent Firewall Mode

Bridge group traffic is isolated from other bridge groups; traffic is not routed to another bridge group within
the ASA, and traffic must exit the ASA before it is routed by an external router back to another bridge group
in the ASA. Although the bridging functions are separate for each bridge group, many other functions are
shared between all bridge groups. For example, all bridge groups share a syslog server or AAA server
configuration. For complete security policy separation, use security contexts with one bridge group in each
context.

You can include multiple interfaces per bridge group. See Guidelines for Firewall Mode, on page 214 for the
exact number of bridge groups and interfaces supported. If you use more than 2 interfaces per bridge group,
you can control communication between multiple segments on the same network, and not just between inside
and outside. For example, if you have three inside segments that you do not want to communicate with each
other, you can put each segment on a separate interface, and only allow them to communicate with the outside
interface. Or you can customize the access rules between interfaces to allow only as much access as desired.

The following figure shows two networks connected to the ASA, which has two bridge groups.
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Figure 26: Transparent Firewall Network with Two Bridge Groups

Bridge Groups in Routed Firewall Mode

Bridge group traffic can be routed to other bridge groups or routed interfaces. You can choose to isolate bridge
group traffic by not assigning a name to the BVI interface for the bridge group. If you name the BVI, then
the BVI participates in routing like any other regular interface.

One use for a bridge group in routed mode is to use extra interfaces on the ASA instead of an external switch.
For example, the default configuration for some devices include an outside interface as a regular interface,
and then all other interfaces assigned to the inside bridge group. Because the purpose of this bridge group is
to replace an external switch, you need to configure an access policy so all bridge group interfaces can freely
communicate. For example, as in the default configuration, set all the interfaces to the same security level,
and then enable same-security interface communication; no access rule is required.
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Figure 27: Routed Firewall Network with an Inside Bridge Group and an Outside Routed Interface
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Passing Traffic Not Allowed in Routed Mode

In routed mode, some types of traffic cannot pass through the ASA even if you allow it in an access rule. The
bridge group, however, can allow almost any traffic through using either an access rule (for IP traffic) or an
EtherType rule (for non-IP traffic):

* [P traffic—In routed firewall mode, broadcast and multicast traffic is blocked even if you allow it in an
access rule, including unsupported dynamic routing protocols and DHCP (unless you configure DHCP
relay). Within a bridge group, you can allow this traffic with an access rule.

* Non-IP traffic—AppleTalk, IPX, BPDUs, and MPLS, for example, can be configured to go through
using an EtherType rule.

)

Note The bridge group does not pass CDP packets packets, or any packets that do not have a valid EtherType greater
than or equal to 0x600. An exception is made for BPDUs and IS-IS, which are supported.

Allowing Layer 3 Traffic

* Unicast [Pv4 and IPv6 traffic is allowed through the bridge group automatically from a higher security
interface to a lower security interface, without an access rule.

* For Layer 3 traffic traveling from a low to a high security interface, an access rule is required on the low
security interface.

* ARPs are allowed through the bridge group in both directions without an access rule. ARP traffic can
be controlled by ARP inspection.
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* [Pv6 neighbor discovery and router solicitation packets can be passed using access rules.

* Broadcast and multicast traffic can be passed using access rules.

Allowed MAC Addresses

The following destination MAC addresses are allowed through the bridge group if allowed by your access
policy (see Allowing Layer 3 Traffic, on page 209). Any MAC address not on this list is dropped.

» TRUE broadcast destination MAC address equal to FFFF.FFFF.FFFF

* [Pv4 multicast MAC addresses from 0100.5E00.0000 to 0100.5EFE.FFFF

* [Pv6 multicast MAC addresses from 3333.0000.0000 to 3333 .FFFF.FFFF

* BPDU multicast address equal to 0100.0CCC.CCCD

* AppleTalk multicast MAC addresses from 0900.0700.0000 to 0900.07FF.FFFF

BPDU Handling

To prevent loops using the Spanning Tree Protocol, BPDUs are passed by default. To block BPDUs, you need
to configure an EtherType rule to deny them. You can also block BPDUs on the external switches. For example,
you can block BPDUs on the switch if members of the same bridge group are connected to switch ports in
different VLANS. In this case, BPDUs from one VLAN will be visible in the other VLAN, which can cause
Spanning Tree Root Bridge election process problems.

If you are using failover, you might want to block BPDUs to prevent the switch port from going into a blocking
state when the topology changes. See Bridge Group Requirements for Failover, on page 284 for more
information.

MAC Address vs. Route Lookups

For traffic within a bridge group, the outgoing interface of a packet is determined by performing a destination
MAC address lookup instead of a route lookup.

Route lookups, however, are necessary for the following situations:

» Traffic originating on the ASA—Add a default/static route on the ASA for traffic destined for a remote
network where a syslog server, for example, is located.

* Voice over IP (VoIP) and TFTP traffic with inspection enabled, and the endpoint is at least one hop
away—Add a static route on the ASA for traffic destined for the remote endpoint so that secondary
connections are successful. The ASA creates a temporary "pinhole" in the access control policy to allow
the secondary connection; and because the connection might use a different set of IP addresses than the
primary connection, the ASA needs to perform a route lookup to install the pinhole on the correct interface.

Affected applications include:
« CTIQBE
* GTP
+ H.323
* MGCP
* RTSP
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* SIP
+ Skinny (SCCP)
* SQL*Net
* SunRPC
* TFTP
* Traffic at least one hop away for which the ASA performs NAT—Configure a static route on the ASA

for traffic destined for the remote network. You also need a static route on the upstream router for traffic
destined for the mapped addresses to be sent to the ASA.

This routing requirement is also true for embedded IP addresses for VoIP and DNS with inspection and
NAT enabled, and the embedded IP addresses are at least one hop away. The ASA needs to identify the
correct egress interface so it can perform the translation.

Figure 28: NAT Example: NAT within a Bridge Group
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Unsupported Features for Bridge Groups in Transparent Mode

The following table lists the features are not supported in bridge groups in transparent mode.

Table 9: Unsupported Features in Transparent Mode

Feature

Description

Dynamic DNS

DHCPv6 stateless server

Only the DHCPv4 server is supported on bridge group
member interfaces.

DHCEP relay

The transparent firewall can act as a DHCPv4 server,
but it does not support DHCP relay. DHCP relay is
not required because you can allow DHCP traffic to
pass through using two access rules: one that allows
DCHP requests from the inside interface to the
outside, and one that allows the replies from the server
in the other direction.

Dynamic routing protocols

You can, however, add static routes for traffic
originating on the ASA for bridge group member
interfaces. You can also allow dynamic routing
protocols through the ASA using an access rule.

Multicast IP routing

You can allow multicast traffic through the ASA by
allowing it in an access rule.

QoS

VPN termination for through traffic

The transparent firewall supports site-to-site VPN
tunnels for management connections only on bridge
group member interfaces. It does not terminate VPN
connections for traffic through the ASA. You can pass
VPN traffic through the ASA using an access rule,
but it does not terminate non-management
connections. Clientless SSL VPN is also not
supported.

Unified Communications

Unsupported Features for Bridge Groups in Routed Mode

The following table lists the features are not supported in bridge groups in routed mode.
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Table 10: Unsupported Features in Routed Mode

Feature Description

EtherChannel or VNI member interfaces Only physical interfaces, redundant interfaces, and
subinterfaces are supported as bridge group member
interfaces.

Management interfaces are also not supported.

Clustering Bridge groups are not supported in clustering.
Dynamic DNS —

DHCPv6 stateless server Only the DHCPv4 server is supported on BVIs.
DHCEP relay The routed firewall can act as a DHCPv4 server, but

it does not support DHCP relay on BVIs or bridge
group member interfaces.

Dynamic routing protocols You can, however, add static routes for BVIs. You
can also allow dynamic routing protocols through the
ASA using an access rule. Non-bridge group interfaces
support dynamic routing.

Multicast IP routing You can allow multicast traffic through the ASA by
allowing it in an access rule. Non-bridge group
interfaces support multicast routing.

Multiple Context Mode Bridge groups are not supported in multiple context
mode.

QoS Non-bridge group interfaces support QoS.

VPN termination for through traffic You cannot terminate a VPN connection on the BVI.

Non-bridge group interfaces support VPN.

Bridge group member interfaces support site-to-site
VPN tunnels for management connections only. It
does not terminate VPN connections for traffic
through the ASA. You can pass VPN traffic through
the bridge group using an access rule, but it does not
terminate non-management connections. Clientless
SSL VPN is also not supported.

Unified Communications Non-bridge group interfaces support Unified
Communications.
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Default Settings

Default Mode

The default mode is routed mode.

Bridge Group Defaults
By default, all ARP packets are passed within the bridge group.

Guidelines for Firewall Mode

Context Mode Guidelines

Set the firewall mode per context.

Model Guidelines
* For the ASAVS50, bridge groups are not supported in either transparent or routed mode.

* For the Firepower 2100 series, bridge groups are not supported in routed mode.

Bridge Group Guidelines (Transparent and Routed Mode)

* You can create up to 250 bridge groups, with 64 interfaces per bridge group.
* Each directly-connected network must be on the same subnet.

» The ASA does not support traffic on secondary networks; only traffic on the same network as the BVI
IP address is supported.

* An IP address for the BVI is required for each bridge group for to-the-device and from-the-device
management traffic, as well as for data traffic to pass through the ASA. For IPv4 traffic, specify an [Pv4
address. For IPv6 traffic, specify an IPv6 address.

* You can only configure [Pv6 addresses manually.

» The BVI IP address must be on the same subnet as the connected network. You cannot set the subnet to
a host subnet (255.255.255.255).

* Management interfaces are not supported as bridge group members.
* In transparent mode, you must use at least 1 bridge group; data interfaces must belong to a bridge group.

* In transparent mode, do not specify the BVI IP address as the default gateway for connected devices;
devices need to specify the router on the other side of the ASA as the default gateway.

* In transparent mode, the default route, which is required to provide a return path for management traffic,
is only applied to management traffic from one bridge group network. This is because the default route
specifies an interface in the bridge group as well as the router IP address on the bridge group network,
and you can only define one default route. If you have management traffic from more than one bridge
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group network, you need to specify a regular static route that identifies the network from which you
expect management traffic.

* In transparent mode, PPPoE is not supported for the Management interface.
* In routed mode, to route between bridge groups and other routed interfaces, you must name the BVI.

* In routed mode, ASA-defined EtherChannel and VNI interfaces are not supported as bridge group
members. EtherChannels on the Firepower 4100/9300 can be bridge group members.

* Bidirectional Forwarding Detection (BFD) echo packets are not allowed through the ASA when using
bridge group members. If there are two neighbors on either side of the ASA running BFD, then the ASA
will drop BFD echo packets because they have the same source and destination IP address and appear
to be part of a LAND attack.

Additional Guidelines and Limitations

* When you change firewall modes, the ASA clears the running configuration because many commands
are not supported for both modes. The startup configuration remains unchanged. If you reload without
saving, then the startup configuration is loaded, and the mode reverts back to the original setting. See
Set the Firewall Mode (Single Mode), on page 215 for information about backing up your configuration
file.

* If you download a text configuration to the ASA that changes the mode with the firewall transparent
command, be sure to put the command at the top of the configuration; the ASA changes the mode as
soon as it reads the command and then continues reading the configuration you downloaded. If the
command appears later in the configuration, the ASA clears all the preceding lines in the configuration.

Set the Firewall Mode (Single Mode)

This section describes how to change the firewall mode using the CLI. For single mode and for the currently
connected context in multiple mode (typically the admin context), you cannot change the mode in ASDM.
For other multiple mode contexts, you can set the mode in ASDM for each context; see Configure a Security
Context, on page 258.

\}

Note We recommend that you set the firewall mode before you perform any other configuration because changing
the firewall mode clears the running configuration.

Before you begin

When you change modes, the ASA clears the running configuration (see Guidelines for Firewall Mode, on
page 214 for more information).

* If you already have a populated configuration, be sure to back up your configuration before changing
the mode; you can use this backup for reference when creating your new configuration.

* Use the CLI at the console port to change the mode. If you use any other type of session, including the
ASDM Command Line Interface tool or SSH, you will be disconnected when the configuration is cleared,
and you will have to reconnect to the ASA using the console port in any case.
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* Set the mode within the context.

\}

Note To set the firewall mode to transparent and also configure ASDM management access after the configuration
is cleared, see Configure ASDM Access, on page 29.

Procedure

Set the firewall mode to transparent:
firewall transparent

Example:

ciscoasa(config)# firewall transparent

To change the mode to routed, enter the no firewall transparent command.

Note You are not prompted to confirm the firewall mode change; the change occurs immediately.

Examples for Firewall Mode

This section includes examples of how traffic moves through the ASA in the routed and transparent firewall
mode.

How Data Moves Through the ASA in Routed Firewall Mode

The following sections describe how data moves through the ASA in routed firewall mode in multiple scenarios.

An Inside User Visits a Web Server

The following figure shows an inside user accessing an outside web server.
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Figure 29: Inside to Outside
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The following steps describe how data moves through the ASA:

1.
2.

The user on the inside network requests a web page from www.example.com.

The ASA receives the packet and because it is a new session, it verifies that the packet is allowed according
to the terms of the security policy.

For multiple context mode, the ASA first classifies the packet to a context.

The ASA translates the real address (10.1.2.27) to the mapped address 209.165.201.10, which is on the
outside interface subnet.

The mapped address could be on any subnet, but routing is simplified when it is on the outside interface
subnet.

The ASA then records that a session is established and forwards the packet from the outside interface.

When www.example.com responds to the request, the packet goes through the ASA, and because the
session is already established, the packet bypasses the many lookups associated with a new connection.
The ASA performs NAT by untranslating the global destination address to the local user address, 10.1.2.27.

The ASA forwards the packet to the inside user.

An Outside User Visits a Web Server on the DMZ

The following figure shows an outside user accessing the DMZ web server.
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Figure 30: Outside to DMZ
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The following steps describe how data moves through the ASA:

1. A user on the outside network requests a web page from the DMZ web server using the mapped address
0f 209.165.201.3, which is on the outside interface subnet.

2. The ASA receives the packet and untranslates the mapped address to the real address 10.1.1.3.

3. Because it is a new session, the ASA verifies that the packet is allowed according to the terms of the
security policy.

For multiple context mode, the ASA first classifies the packet to a context.
4. The ASA then adds a session entry to the fast path and forwards the packet from the DMZ interface.

5. When the DMZ web server responds to the request, the packet goes through the ASA and because the
session is already established, the packet bypasses the many lookups associated with a new connection.
The ASA performs NAT by translating the real address to 209.165.201.3.

6. The ASA forwards the packet to the outside user.

An Inside User Visits a Web Server on the DMZ

The following figure shows an inside user accessing the DMZ web server.
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An Outside User Attempts to Access an Inside Host .

The following steps describe how data moves through the ASA:

1. A user on the inside network requests a web page from the DMZ web server using the destination address

of 10.1.1.3.

2. The ASA receives the packet and because it is a new session, the ASA verifies that the packet is allowed

according to the terms of the security policy.

For multiple context mode, the ASA first classifies the packet to a context.

3. The ASA then records that a session is established and forwards the packet out of the DMZ interface.

4. When the DMZ web server responds to the request, the packet goes through the fast path, which lets the
packet bypass the many lookups associated with a new connection.

5. The ASA forwards the packet to the inside user.

An Qutside User Attempts to Access an Inside Host

The following figure shows an outside user attempting to access the inside network.
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Figure 32: Outside to Inside
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The following steps describe how data moves through the ASA:
1. A useron the outside network attempts to reach an inside host (assuming the host has a routable IP address).

If the inside network uses private addresses, no outside user can reach the inside network without NAT.
The outside user might attempt to reach an inside user by using an existing NAT session.

2. The ASA receives the packet and because it is a new session, it verifies if the packet is allowed according
to the security policy.

3. The packet is denied, and the ASA drops the packet and logs the connection attempt.

If the outside user is attempting to attack the inside network, the ASA employs many technologies to
determine if a packet is valid for an already established session.

A DMZ User Attempts to Access an Inside Host

The following figure shows a user in the DMZ attempting to access the inside network.
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Figure 33: DMZ to Inside
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The following steps describe how data moves through the ASA:

1. A user on the DMZ network attempts to reach an inside host. Because the DMZ does not have to route
the traffic on the Internet, the private addressing scheme does not prevent routing.

2. The ASA receives the packet and because it is a new session, it verifies if the packet is allowed according
to the security policy.

The packet is denied, and the ASA drops the packet and logs the connection attempt.

How Data Moves Through the Transparent Firewall

The following figure shows a typical transparent firewall implementation with an inside network that contains
apublic web server. The ASA has an access rule so that the inside users can access Internet resources. Another
access rule lets the outside users access only the web server on the inside network.
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. An Inside User Visits a Web Server

Figure 34: Typical Transparent Firewall Data Path
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The following sections describe how data moves through the ASA.

An Inside User Visits a Web Server

The following figure shows an inside user accessing an outside web server.
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An Inside User Visits a Web Server Using NAT .

Figure 35: Inside to Outside

wWwWw.examp le.com

HiE

Internet
208165201 .2

Management [P
2089.165.201.6

i

k:

209.165.201.3 i

The following steps describe how data moves through the ASA:

1.
2.

The user on the inside network requests a web page from www.example.com.

The ASA receives the packet and adds the source MAC address to the MAC address table, if required.
Because it is a new session, it verifies that the packet is allowed according to the terms of the security

policy.
For multiple context mode, the ASA first classifies the packet to a context.

The ASA records that a session is established.

If the destination MAC address is in its table, the ASA forwards the packet out of the outside interface.
The destination MAC address is that of the upstream router, 209.165.201.2.

If the destination MAC address is not in the ASA table, it attempts to discover the MAC address by sending
an ARP request or a ping. The first packet is dropped.

The web server responds to the request; because the session is already established, the packet bypasses
the many lookups associated with a new connection.

The ASA forwards the packet to the inside user.

An Inside User Visits a Web Server Using NAT

The following figure shows an inside user accessing an outside web server.
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. An Inside User Visits a Web Server Using NAT

Figure 36: Inside to Outside with NAT
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The following steps describe how data moves through the ASA:

1.
2.

The user on the inside network requests a web page from www.example.com.

The ASA receives the packet and adds the source MAC address to the MAC address table, if required.
Because it is a new session, it verifies that the packet is allowed according to the terms of the security

policy.
For multiple context mode, the ASA first classifies the packet according to a unique interface.

The ASA translates the real address (10.1.2.27) to the mapped address 209.165.201.10.

Because the mapped address is not on the same network as the outside interface, then be sure the upstream
router has a static route to the mapped network that points to the ASA.

The ASA then records that a session is established and forwards the packet from the outside interface.

If the destination MAC address is in its table, the ASA forwards the packet out of the outside interface.
The destination MAC address is that of the upstream router, 10.1.2.1.

If the destination MAC address is not in the ASA table, then it attempts to discover the MAC address by
sending an ARP request and a ping. The first packet is dropped.

The web server responds to the request; because the session is already established, the packet bypasses
the many lookups associated with a new connection.

The ASA performs NAT by untranslating the mapped address to the real address, 10.1.2.27.
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An Outside User Visits a Web Server on the Inside Network

The following figure shows an outside user accessing the inside web server.

Figure 37: Outside to Inside
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The following steps describe how data moves through the ASA:

1. A user on the outside network requests a web page from the inside web server.

2. The ASA receives the packet and adds the source MAC address to the MAC address table, if required.
Because it is a new session, it verifies that the packet is allowed according to the terms of the security
policy.

For multiple context mode, the ASA first classifies the packet to a context.
3. The ASA records that a session is established.

4. If the destination MAC address is in its table, the ASA forwards the packet out of the inside interface.
The destination MAC address is that of the downstream router, 209.165.201.1.

If the destination MAC address is not in the ASA table, then it attempts to discover the MAC address by
sending an ARP request and a ping. The first packet is dropped.

5. The web server responds to the request; because the session is already established, the packet bypasses
the many lookups associated with a new connection.
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6. The ASA forwards the packet to the outside user.

An Outside User Attempts to Access an Inside Host

Getting Started with the ASA |

The following figure shows an outside user attempting to access a host on the inside network.

Figure 38: Outside to Inside
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The following steps describe how data moves through the ASA:

1. A user on the outside network attempts to reach an inside host.

2. The ASA receives the packet and adds the source MAC address to the MAC address table, if required.
Because it is a new session, it verifies if the packet is allowed according to the terms of the security policy.

For multiple context mode, the ASA first classifies the packet to a context.

3. The packet is denied because there is no access rule permitting the outside host, and the ASA drops the

packet.

4. If the outside user is attempting to attack the inside network, the ASA employs many technologies to

determine if a packet is valid for an already established session.
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History for the Firewall Mode

Table 11: Feature History for Firewall Mode

History for the Firewall Mode .

Feature Name Platform Releases

Feature Information

Transparent Firewall Mode 7.0(1)

A transparent firewall is a Layer 2 firewall
that acts like a “bump in the wire,” or a
“stealth firewall,” and is not seen as a router
hop to connected devices.

We introduced the following commands:
firewall transparent, show firewall.

You cannot set the firewall mode in ASDM;
you must use the command-line interface.

Transparent firewall bridge groups 8.4(1)

If you do not want the overhead of security
contexts, or want to maximize your use of
security contexts, you can group interfaces
together in a bridge group, and then
configure multiple bridge groups, one for
each network. Bridge group traffic is
isolated from other bridge groups. You can
configure up to 8 bridge groups in single
mode or per context in multiple mode, with
4 interfaces maximum per bridge group.

Note Although you can configure
multiple bridge groups on the
ASA 5505, the restriction of 2
data interfaces in transparent
mode on the ASA 5505 means
you can only effectively use 1
bridge group.

We modified or introduced the following
screens:

Configuration > Device Setup > Interface
Settings > Interfaces Configuration >
Device Setup > Interface Settings >
Interfaces > Add/Edit Bridge Group
Interface Configuration > Device Setup >
Interface Settings > Interfaces > Add/Edit
Interface
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Feature Name

Platform Releases

Feature Information

Mixed firewall mode support in multiple
context mode

8.5(1)/9.0(1)

You can set the firewall mode
independently for each security context in
multiple context mode, so some can run in
transparent mode while others run in routed
mode.

We modified the following command:
firewall transparent.

For single mode, you cannot set the firewall
mode in ASDM; you must use the
command-line interface.

For multiple mode, we modified the
following screen: Configuration > Context
Management > Security Contexts.

Transparent mode bridge group maximum
increased to 250

9.3(1)

The bridge group maximum was increased
from 8 to 250 bridge groups. You can
configure up to 250 bridge groups in single
mode or per context in multiple mode, with
4 interfaces maximum per bridge group.

We modified the following screens:

Configuration > Device Setup > Interface
Settings > Interfaces Configuration >
Device Setup > Interface Settings >
Interfaces > Add/Edit Bridge Group
Interface Configuration > Device Setup >
Interface Settings > Interfaces > Add/Edit
Interface

Transparent mode maximum interfaces per
bridge group increased to 64

9.6(2)

The maximum interfaces per bridge group
was increased from 4 to 64.

We did not modify any screens.
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Feature Name

Platform Releases

Feature Information

Integrated Routing and Bridging

9.7(1)

Integrated Routing and Bridging provides
the ability to route between a bridge group
and a routed interface. A bridge group is a
group of interfaces that the ASA bridges
instead of routes. The ASA is not a true
bridge in that the ASA continues to act as
a firewall: access control between interfaces
is controlled, and all of the usual firewall
checks are in place. Previously, you could
only configure bridge groups in transparent
firewall mode, where you cannot route
between bridge groups. This feature lets
you configure bridge groups in routed
firewall mode, and to route between bridge
groups and between a bridge group and a
routed interface. The bridge group
participates in routing by using a Bridge
Virtual Interface (BVI) to act as a gateway
for the bridge group. Integrated Routing
and Bridging provides an alternative to
using an external Layer 2 switch if you have
extra interfaces on the ASA to assign to the
bridge group. In routed mode, the BVI can
be a named interface and can participate
separately from member interfaces in some
features, such as access rules and DHCP
server.

The following features that are supported
in transparent mode are not supported in
routed mode: multiple context mode, ASA
clustering. The following features are also
not supported on BVIs: dynamic routing
and multicast routing.

We modified the following screens:

Configuration > Device Setup > Interface
Settings > Interfaces

Configuration > Device Setup >
Routing > Static Routes

Configuration > Device Management >
DHCP > DHCP Server

Configuration > Firewall > Access Rules

Configuration > Firewall > EtherType
Rules
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CHAPTER 8

Startup Wizard

This chapter describes the ASDM Startup Wizard, which guides you through the initial configuration of the
Cisco ASA and helps you define basic settings.

* Access the Startup Wizard, on page 231

* Guidelines for the Startup Wizard, on page 231
* Startup Wizard Screens, on page 231

* History for the Startup Wizard, on page 234

Access the Startup Wizard

To access the Startup Wizard, choose one of the following options:

» Wizards > Startup Wizard.

» Configuration > Device Setup > Startup Wizard, then click Launch Startup Wizard.

Guidelines for the Startup Wizard

Context Mode Guidelines

The Startup Wizard is not supported in the system context.

Startup Wizard Screens

The actual sequence of screens is determined by your specified configuration selections. Each screen is
available for all modes or models unless otherwise noted.

Starting Point or Welcome

* Click the Modify existing configuration radio button to change the existing configuration.

* Click the Reset configuration to factory defaults radio button to set the configuration to the factory
default values.
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* Check the Configure the IP address of the management interface check box to configure the IP
address and subnet mask of the Management 0/0 interface to be different from the default value
(192.168.1.1).

A\

Note If you reset the configuration to factory defaults, you cannot undo these changes
by clicking Cancel or by closing this screen.

In multiple context mode, this screen does not include any parameters.

Basic Configuration

Set the hostname, domain name, and enable password in this screen.

Interface Screens

The interface screens depend on the mode and model selected.

Outside Interface Configuration (Routed Mode)
* Configure the IP address of the outside interface (the interface with the lowest security level).

* Configure the IPv6 address.
Outside Interface Configuration - PPPoE (Routed Mode, Single Mode)
Configure the PPPoE settings for the outside interface.

Management IP Address Configuration (Transparent Mode)

For IPv4, a management IP address is required for each bridge group for both management traffic and for
traffic to pass through the ASA. This screen sets the IP address for BVI 1.

Other Interfaces Configuration

Configure parameters for other interfaces.

Static Routes

Configure static routes.

DHCP Server

Configure the DHCP server.

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8



| Getting Started with the ASA
Address Translation (NAT/PAT) .

Address Translation (NAT/PAT)

Configures NAT or PAT for inside addresses (the interface with the highest security level) when accessing
the outside (the interface with the lowest security level). See the firewall configuration guide for more
information.

Administrative Access
* Configure ASDM, Telnet, or SSH access.

* Check the Enable HTTP server for HTTPS/ASDM access check box to enable a secure connection
to an HTTP server to access ASDM.

* Check the Enable ASDM history metrics check box.

IPS Basic Configuration

In single context mode, use the Startup Wizard in ASDM to configure basic IPS network configuration. These
settings are saved to the IPS configuration, not the ASA configuration. See the IPS quick start guide for more
information.

ASA CX Basic Configuration (ASA 5585-X)

You can use the Startup Wizard in ASDM to configure the ASA CX management address and Auth Proxy
Port. These settings are saved to the ASA CX configuration, not the ASA configuration. You will also need
to set additional network settings at the ASA CX CLI. See the ASA CX quick start guide for information
about this screen.

ASA FirePOWER Basic Configuration

You can use the Startup Wizard in ASDM to configure the ASA FirePOWER management address information
and accept the end user license agreement (EULA). These settings are saved to the ASA FirePOWER
configuration, not the ASA configuration. You will also need to configure some settings in the ASA
FirePOWER CLI. For more information, see the chapter on the ASA FirePOWER module in the firewall
configuration guide.

Time Zone and Clock Configuration

Configure the clock parameters.

Auto Update Server (Single Mode)

Follow these guidelines to configure an Auto-Update Server:

» Configure an auto update server by checking the Enable Auto Update Server for ASA check box.

* Check the Enable Signature and Engine Updates from Cisco.com check box if you have an IPS
module. Set the following additional parameters:

ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8 [JJj



Getting Started with the ASA |
. Startup Wizard Summary

* Enter your Cisco.com username and password, then confirm the password.

* Enter the start time in hh:mm:ss format, using a 24-hour clock.

Startup Wizard Summary
This screen summarizes all of the configuration settings that you have made for the ASA.
* Click Back to change any of the settings in previous screens.
* Choose one of the following:

* If you ran the Startup Wizard directly from a browser, when you click Finish, the configuration
settings that you created through the wizard are sent to the ASA and saved in flash memory
automatically.

* If you ran the Startup Wizard from within ASDM, you must explicitly save the configuration in
flash memory by choosing File > Save Running Configuration to Flash.

History for the Startup Wizard

Table 12: History for the Startup Wizard

Feature Name Platform Releases Description

Startup Wizard 7.0(1) This wizard was introduced.

We introduced the Wizards > Startup
Wizard screen.

ASA IPS Configuration 8.4(1) For the ASA IPS module, the IPS Basic
Configuration screen was added to the
startup wizard. Signature updates for the
IPS module were also added to the Auto
Update screen. The Time Zone and Clock
Configuration screen was added to ensure
the clock is set on the ASA; the IPS module
gets its clock from the ASA.

We introduced or modified the following
screens:

Wizards > Startup Wizard > IPS Basic
Configuration

Wizards > Startup Wizard > Auto
Update

Wizards > Startup Wizard > Time Zone
and Clock Configuration
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Feature Name Platform Releases Description

ASA CX Configuration 9.1(1) For the ASA CX module, the ASA CX
Basic Configuration screen was added to
the startup wizard.

We introduced the following screens:

Wizards > Startup Wizard > ASA CX
Basic Configuration

ASA FirePOWER Configuration 9.2(2.4) For the ASA FirePOWER module, the ASA
FirePOWER Basic Configuration screen
was added to the startup wizard.

We introduced the following screens:

Wizards > Startup Wizard > ASA
FirePOWER Basic Configuration

ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8 [JJj



Getting Started with the ASA |
. History for the Startup Wizard

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8



==
¢ l——-—l —
I 148 L e A A R T i

e ———

PART I I

High Availability and Scalability

* Multiple Context Mode, on page 239

* Failover for High Availability, on page 271

* ASA Cluster, on page 317

* ASA Cluster for the Firepower 4100/9300 Chassis, on page 407






CHAPTER 9

Multiple Context Mode

This chapter describes how to configure multiple security contexts on the Cisco ASA.

* About Security Contexts, on page 239

* Licensing for Multiple Context Mode, on page 249

* Prerequisites for Multiple Context Mode, on page 251

* Guidelines for Multiple Context Mode, on page 251

* Defaults for Multiple Context Mode, on page 252

* Configure Multiple Contexts, on page 252

» Change Between Contexts and the System Execution Space, on page 261
* Manage Security Contexts, on page 261

* Monitoring Security Contexts, on page 265

* History for Multiple Context Mode, on page 267

About Security Contexts

You can partition a single ASA into multiple virtual devices, known as security contexts. Each context acts
as an independent device, with its own security policy, interfaces, and administrators. Multiple contexts are
similar to having multiple standalone devices. For unsupported features in multiple context mode, see Guidelines
for Multiple Context Mode, on page 251.

This section provides an overview of security contexts.

Common Uses for Security Contexts

You might want to use multiple security contexts in the following situations:

* You are a service provider and want to sell security services to many customers. By enabling multiple
security contexts on the ASA, you can implement a cost-effective, space-saving solution that keeps all
customer traffic separate and secure, and also eases configuration.

* You are a large enterprise or a college campus and want to keep departments completely separate.
* You are an enterprise that wants to provide distinct security policies to different departments.

* You have any network that requires more than one ASA.
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Context Configuration Files

This section describes how the ASA implements multiple context mode configurations.

Context Configurations

For each context, the ASA includes a configuration that identifies the security policy, interfaces, and all the
options you can configure on a standalone device. You can store context configurations in flash memory, or
you can download them from a TFTP, FTP, or HTTP(S) server.

System Configuration

The system administrator adds and manages contexts by configuring each context configuration location,
allocated interfaces, and other context operating parameters in the system configuration, which, like a single
mode configuration, is the startup configuration. The system configuration identifies basic settings for the
ASA. The system configuration does not include any network interfaces or network settings for itself; rather,
when the system needs to access network resources (such as downloading the contexts from the server), it
uses one of the contexts that is designated as the admin context. The system configuration does include a
specialized failover interface for failover traffic only.

Admin Context Configuration

The admin context is just like any other context, except that when a user logs in to the admin context, then
that user has system administrator rights and can access the system and all other contexts. The admin context
is not restricted in any way, and can be used as a regular context. However, because logging into the admin
context grants you administrator privileges over all contexts, you might need to restrict access to the admin
context to appropriate users. The admin context must reside on flash memory, and not remotely.

If your system is already in multiple context mode, or if you convert from single mode, the admin context is
created automatically as a file on the internal flash memory called admin.cfg. This context is named “admin.”
If you do not want to use admin.cfg as the admin context, you can change the admin context.

How the ASA Classifies Packets

Each packet that enters the ASA must be classified, so that the ASA can determine to which context to send
a packet.

N

Note Ifthe destination MAC address is a multicast or broadcast MAC address, the packet is duplicated and delivered
to each context.

Valid Classifier Criteria

This section describes the criteria used by the classifier.

)

Note For management traffic destined for an interface, the interface IP address is used for classification.

The routing table is not used for packet classification.
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Unique Interfaces

If only one context is associated with the ingress interface, the ASA classifies the packet into that context. In
transparent firewall mode, unique interfaces for contexts are required, so this method is used to classify packets
at all times.

Unique MAC Addresses

If multiple contexts share an interface, then the classifier uses unique MAC addresses assigned to the interface
in each context. An upstream router cannot route directly to a context without unique MAC addresses. You
can enable auto-generation of MAC addresses. You can also set the MAC addresses manually when you
configure each interface.

NAT Configuration

If you do not enable use of unique MAC addresses, then the ASA uses the mapped addresses in your NAT
configuration to classify packets. We recommend using MAC addresses instead of NAT, so that traffic
classification can occur regardless of the completeness of the NAT configuration.

Classification Examples

The following figure shows multiple contexts sharing an outside interface. The classifier assigns the packet
to Context B because Context B includes the MAC address to which the router sends the packet.

Figure 39: Packet Classification with a Shared Interface Using MAC Addresses
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Note that all new incoming traffic must be classified, even from inside networks. The following figure shows
a host on the Context B inside network accessing the Internet. The classifier assigns the packet to Context B
because the ingress interface is Gigabit Ethernet 0/1.3, which is assigned to Context B.

Figure 40: Incoming Traffic from Inside Networks
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For transparent firewalls, you must use unique interfaces. The following figure shows a packet destined to a
host on the Context B inside network from the Internet. The classifier assigns the packet to Context B because
the ingress interface is Gigabit Ethernet 1/0.3, which is assigned to Context B.
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Figure 41: Transparent Firewall Contexts
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Cascading Security Contexts

Placing a context directly in front of another context is called cascading contexts; the outside interface of one
context is the same interface as the inside interface of another context. You might want to cascade contexts
if you want to simplify the configuration of some contexts by configuring shared parameters in the top context.

\}

Note Cascading contexts requires unique MAC addresses for each context interface. Because of the limitations of
classifying packets on shared interfaces without MAC addresses, we do not recommend using cascading
contexts without unique MAC addresses.

The following figure shows a gateway context with two contexts behind the gateway.
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Figure 42: Cascading Contexts
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Management Access to Security Contexts

The ASA provides system administrator access in multiple context mode as well as access for individual
context administrators.
System Administrator Access

You can access the ASA as a system administrator in two ways:
* Access the ASA console.

From the console, you access the system execution space, which means that any commands you enter
affect only the system configuration or the running of the system (for run-time commands).

* Access the admin context using Telnet, SSH, or ASDM.

As the system administrator, you can access all contexts.

The system execution space does not support any AAA commands, but you can configure its own enable
password, as well as usernames in the local database to provide individual logins.

Context Administrator Access

You can access a context using Telnet, SSH, or ASDM. If you log in to a non-admin context, you can only
access the configuration for that context. You can provide individual logins to the context.

Management Interface Usage

The Management interface is a separate interface just for management traffic.
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About Resource Management .

In routed firewall mode, you can share the Management interface across all contexts.

In transparent firewall mode, the Management interface is special. In addition to the maximum allowed
through-traffic interfaces, you can also use the Management interface as a separate management-only interface.
However, in multiple context mode, you cannot share any interfaces across transparent contexts. You can
instead use subinterfaces of the Management interface, and assign one to each context. However, only Firepower
models and the ASA 5585-X allow subinterfaces on the Management interface. For ASA models other than
the ASA 5585-X, you must use a data interface or a subinterface of a data interface, and add it to a bridge
group within the context.

For the Firepower 4100/9300 chassis transparent context, neither the Management interface nor subinterface
retains its special status. In this case, you must treat it as a data interface, and add it to a bridge group. (Note
that in single context mode, the Management interface does retain its special status.)

Another consideration about transparent mode: when you enable multiple context mode, all configured
interfaces are automatically assigned to the Admin context. For example, if your default configuration includes
the Management interface, then that interface will be assigned to the Admin context. One option is to leave
the main interface allocated to the Admin context and manage it using the native VLAN, and then use
subinterfaces to manage each context. Keep in mind that if you make the Admin context transparent, its IP
address will be removed; you have to assign it to a bridge group and assign the IP address to the BVI.

About Resource Management

By default, all security contexts have unlimited access to the resources of the ASA, except where maximum
limits per context are enforced; the only exception is VPN resources, which are disabled by default. If you
find that one or more contexts use too many resources, and they cause other contexts to be denied connections,
for example, then you can configure resource management to limit the use of resources per context. For VPN
resources, you must configure resource management to allow any VPN tunnels.

Resource Classes

Resource Limits

The ASA manages resources by assigning contexts to resource classes. Each context uses the resource limits
set by the class. To use the settings of a class, assign the context to the class when you define the context. All
contexts belong to the default class if they are not assigned to another class; you do not have to actively assign
a context to default. You can only assign a context to one resource class. The exception to this rule is that
limits that are undefined in the member class are inherited from the default class; so in effect, a context could
be a member of default plus another class.

You can set the limit for individual resources as a percentage (if there is a hard system limit) or as an absolute
value.

For most resources, the ASA does not set aside a portion of the resources for each context assigned to the
class; rather, the ASA sets the maximum limit for a context. If you oversubscribe resources, or allow some
resources to be unlimited, a few contexts can “use up” those resources, potentially affecting service to other
contexts. The exception is VPN resource types, which you cannot oversubscribe, so the resources assigned
to each context are guaranteed. To accommodate temporary bursts of VPN sessions beyond the amount
assigned, the ASA supports a “burst” VPN resource type, which is equal to the remaining unassigned VPN
sessions. The burst sessions can be oversubscribed, and are available to contexts on a first-come, first-served
basis.
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All contexts belong to the default class if they are not assigned to another class; you do not have to actively
assign a context to the default class.

If a context belongs to a class other than the default class, those class settings always override the default class
settings. However, if the other class has any settings that are not defined, then the member context uses the
default class for those limits. For example, if you create a class with a 2 percent limit for all concurrent
connections, but no other limits, then all other limits are inherited from the default class. Conversely, if you
create a class with a limit for all resources, the class uses no settings from the default class.

For most resources, the default class provides unlimited access to resources for all contexts, except for the
following limits:

* Telnet sessions—>5 sessions. (The maximum per context.)

* SSH sessions—>5 sessions. (The maximum per context.)

* ASDM sessions—32 sessions. (The maximum per context.)

* [Psec sessions—>5 sessions. (The maximum per context.)

* MAC addresses—65,535 entries. (The maximum for the system.)

» AnyConnect peers—0 sessions. (You must manually configure the class to allow any AnyConnect peers.)

* VPN site-to-site tunnels—0 sessions. (You must manually configure the class to allow any VPN sessions.)

The following figure shows the relationship between the default class and other classes. Contexts A and C
belong to classes with some limits set; other limits are inherited from the default class. Context B inherits no
limits from default because all limits are set in its class, the Gold class. Context D was not assigned to a class,
and is by default a member of the default class.

Figure 43: Resource Classes
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Use Oversubscribed Resources

You can oversubscribe the ASA by assigning more than 100 percent of a resource across all contexts (with
the exception of non-burst VPN resources). For example, you can set the Bronze class to limit connections
to 20 percent per context, and then assign 10 contexts to the class for a total of 200 percent. If contexts
concurrently use more than the system limit, then each context gets less than the 20 percent you intended.

Figure 44: Resource Oversubscription
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Use Unlimited Resources

The ASA lets you assign unlimited access to one or more resources in a class, instead of a percentage or
absolute number. When a resource is unlimited, contexts can use as much of the resource as the system has
available. For example, Context A, B, and C are in the Silver Class, which limits each class member to 1
percent of the connections, for a total of 3 percent; but the three contexts are currently only using 2 percent
combined. Gold Class has unlimited access to connections. The contexts in the Gold Class can use more than
the 97 percent of “unassigned” connections; they can also use the 1 percent of connections not currently in
use by Context A, B, and C, even if that means that Context A, B, and C are unable to reach their 3 percent
combined limit. Setting unlimited access is similar to oversubscribing the ASA, except that you have less
control over how much you oversubscribe the system.

Figure 45: Unlimited Resources
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About MAC Addresses

\}

You can manually assign MAC addresses to override the default. For multiple context mode, you can
automatically generate unique MAC addresses (for all interfaces assigned to a context).

Note

You might want to assign unique MAC addresses to subinterfaces defined on the ASA, because they use the
same burned-in MAC address of the parent interface. For example, your service provider might perform access
control based on the MAC address. Also, because IPv6 link-local addresses are generated based on the MAC
address, assigning unique MAC addresses to subinterfaces allows for unique IPv6 link-local addresses, which
can avoid traffic disruption in certain instances on the ASA.

MAC Addresses in Multiple Context Mode

The MAC address is used to classify packets within a context. If you share an interface, but do not have unique
MAC addresses for the interface in each context, then other classification methods are attempted that might
not provide full coverage.

To allow contexts to share interfaces, you should enable auto-generation of virtual MAC addresses to each
shared context interface. On the ASASM only, auto-generation is enabled by default in multiple context mode.

Automatic MAC Addresses

In multiple context mode, auto-generation assigns unique MAC addresses to all interfaces assigned to a
context.

If you manually assign a MAC address and also enable auto-generation, then the manually assigned MAC
address is used. If you later remove the manual MAC address, the auto-generated address is used, if enabled.

In the rare circumstance that the generated MAC address conflicts with another private MAC address in your
network, you can manually set the MAC address for the interface.

Because auto-generated addresses (when using a prefix) start with A2, you cannot start manual MAC addresses
with A2 if you also want to use auto-generation.

The ASA generates the MAC address using the following format:
A2XX.Yyz2z.7222

Where xx.yy is a user-defined prefix or an autogenerated prefix based on the last two bytes of the interface
MAC address, and zz.zzzz is an internal counter generated by the ASA. For the standby MAC address, the
address is identical except that the internal counter is increased by 1.

For an example of how the prefix is used, if you set a prefix of 77, then the ASA converts 77 into the
hexadecimal value 004D (yyxx). When used in the MAC address, the prefix is reversed (Xxyy) to match the
ASA native form:

A24D.00zz.zzzz
For a prefix of 1009 (03F1), the MAC address is:
A2F1.03zzzzzz
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Note

VPN Support

The MAC address format without a prefix is a legacy version. See the mac-address auto command in the
command reference for more information about the legacy format.

For VPN resources, you must configure resource management to allow any VPN tunnels.
You can use site-to-site VPN in multiple context mode.

For remote access VPN, you must use AnyConnect 3.x and later for SSL VPN only; there is no IKEv2 support.
You can customize flash storage per context for AnyConnect images and customizations, as well as using
shared flash memory across all contexts. For unsupported features, see Guidelines for Multiple Context Mode,
on page 251. For a detailed list of supported VPN features per ASA release, see History for Multiple Context
Mode, on page 267.

Note

The AnyConnect Apex license is required for multiple context mode; you cannot use the default or legacy
license.

Licensing for Multiple Context Mode

Model License Requirement
ASA 5506-X No support.
ASA 5508-X Security Plus License: 2 contexts.
Optional license: 5 contexts.
ASA 5512-X * Base License: No support.
* Security Plus License: 2 contexts.
Optional license: 5 contexts.
ASA 5515-X Base License: 2 contexts.
Optional license: 5 contexts.
ASA 5516-X Security Plus License: 2 contexts.
Optional license: 5 contexts.
ASA 5525-X Base License: 2 contexts.
Optional licenses: 5, 10, or 20 contexts.
ASA 5545-X Base License: 2 contexts.

Optional licenses: 5, 10, 20, or 50 contexts.
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Model

License Requirement

ASA 5555-X

Base License: 2 contexts.

Optional licenses: 5, 10, 20, 50, or 100 contexts.

ASA 5585-X with SSP-10

Base License: 2 contexts.

Optional licenses: 5, 10, 20, 50, or 100 contexts.

ASA 5585-X with SSP-20, -40, and -60

Base License: 2 contexts.

Optional licenses: 5, 10, 20, 50, 100, or 250 contexts.

ASASM

Base License: 2 contexts.

Optional licenses: 5, 10, 20, 50, 100, or 250 contexts.

Firepower 2100

Base License: 2 contexts.

Optional License, Maximums in increments of 5 or 10:
Firepower 2110: 25

Firepower 2120: 25

Firepower 2130: 30

Firepower 2140: 40

Firepower 4100

Base License: 10 contexts.

Optional licenses: up to 250 contexts, in increments of 10.

Firepower 9300

Base License: 10 contexts.

Optional licenses: up to 250 contexts, in increments of 10.

ISA 3000

No support.

ASAv

No support.

Note Ifthe Admin context only contains management-only interfaces, and does not include any data interfaces for
through traffic, then it does not count against the limit.

\}

Note The AnyConnect Apex license is required for multiple context mode; you cannot use the default or legacy

license.
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Prerequisites for Multiple Context Mode

After you are in multiple context mode, connect tothe admin context to access the system configuration. You
cannot configure the system from a non-admin context. By default, after you enable multiple context mode,
you can connect to the admin context by using the default management IP address.

Guidelines for Multiple Context Mode

Failover

Active/Active mode failover is only supported in multiple context mode.

IPv6

Cross-context IPv6 routing is not supported.

Unsupported Features
Multiple context mode does not support the following features:

* RIP

* OSPFv3. (OSPFv2 is supported.)
* Multicast routing

* Threat Detection

* Unified Communications

* QoS

» Static route tracking

Multiple context mode does not currently support the following features for remote access VPN:

* Clientless SSL VPN

* AnyConnect 2.x and earlier
» IKEv2

» IKEvl

* WebLaunch

* VLAN Mapping

* HostScan

* VPN load balancing

* Customization

« L2TP
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. Defaults for Multiple Context Mode

Additional Guidelines

* The context mode (single or multiple) is not stored in the configuration file, even though it does endure
reboots. If you need to copy your configuration to another device, set the mode on the new device to
match.

* If you store context configurations in the root directory of flash memory, on some models you might run
out of room in that directory, even though there is available memory. In this case, create a subdirectory
for your configuration files. Background: some models, such as the ASA 5585-X, use the FAT 16 file
system for internal flash memory, and if you do not use 8.3-compliant short names, or use uppercase
characters, then fewer than 512 files and folders can be stored because the file system uses up slots to
store long file names (see http://support.microsoft.com/kb/120138/en-us).

Defaults for Multiple Context Mode

* By default, the ASA is in single context mode.

* See Default Class, on page 246.

Configure Multiple Contexts

Step 1
Step 2

Step 3

Step 4
Step 5
Step 6

Procedure

Enable or Disable Multiple Context Mode, on page 253.

(Optional) Configure a Class for Resource Management, on page 255.
Note For VPN support, you must configure VPN resources in a resource class; the default class does not
allow VPN.
Configure interfaces in the system execution space.
* ASA 5500-X—Basic Interface Configuration, on page 463.
* Firepower 2100—See the getting started guide.
* Firepower 4100/9300—Logical Devices for the Firepower 4100/9300, on page 189
* ASASM—ASASM quick start guide.

Configure a Security Context, on page 258.
(Optional) Assign MAC Addresses to Context Interfaces Automatically, on page 260.

Complete interface configuration in the context. See Routed and Transparent Mode Interfaces, on page 507.
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Enable or Disable Multiple Context Mode

Your ASA might already be configured for multiple security contexts depending on how you ordered it from
Cisco. If you need to convert from single mode to multiple mode, follow the procedures in this section.

ASDM supports changing modes from single to multiple mode if you use the High Availability and Scalability
Wizard and you enable Active/Active failover. See Failover for High Availability, on page 271 for more
information. If you do not want to use Active/Active failover or want to change back to single mode, you
must change modes using the CLI; because changing modes requires confirmation, you cannot use the
Command Line Interface tool. This section describes changing modes at the CLI.

Enable Multiple Context Mode

When you convert from single mode to multiple mode, the ASA converts the running configuration into two
files: a new startup configuration that comprises the system configuration, and admin.cfg that comprises the
admin context (in the root directory of the internal flash memory). The original running configuration is saved
as old_running.cfg (in the root directory of the internal flash memory). The original startup configuration is
not saved. The ASA automatically adds an entry for the admin context to the system configuration with the
name “admin.”

Before you begin

Back up your startup configuration if it differs from the running configuration. When you convert from single
mode to multiple mode, the ASA converts the running configuration into two files. The original startup
configuration is not saved. See Manage Files, on page 930.

Procedure

Change to multiple context mode.

mode multiple

Example:

You are prompted to change the mode and convert the configuration, and then the system reloads.

Note You will have to regenerate the RSA key pair in the Admin context before you can reestablish an
SSH connection. From the console, enter the crypto key generate rsa modulus command. See
Configure SSH Access, on page 889 for more information.

Example:

ciscoasa(config)# mode multiple

WARNING: This command will change the behavior of the device
WARNING: This command will initiate a Reboot

Proceed with change mode? [confirm]

Convert the system configuration? [confirm]

|
The old running configuration file will be written to flash
Converting the configuration - this may take several minutes for a large configuration

The admin context configuration will be written to flash

The new running configuration file was written to flash
Security context mode: multiple
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ciscoasa (config) #

* Kk Kk

*** ——-- START GRACEFUL SHUTDOWN ---

* Kk Kk

*** Message to all terminals:
* Kk Kk

b change mode

Shutting down isakmp

Shutting down webvpn

Shutting down License Controller
Shutting down File system

* Kk Kk

*** ——— SHUTDOWN NOW ---

* Kk Kk

*** Message to all terminals:
* Kk Kk

bl change mode

Restore Single Context Mode

To copy the old running configuration to the startup configuration and to change the mode to single mode,
perform the following steps.

Before you begin

Perform this procedure in the system execution space.

Procedure

Step 1 Copy the backup version of your original running configuration to the current startup configuration:
copy disk0:old_running.cfg startup-config

Example:

ciscoasa(config)# copy disk0O:old running.cfg startup-config

Step 2 Set the mode to single mode:
mode single

Example:

ciscoasa(config) # mode single

You are prompted to reboot the ASA.
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Configure a Class for Resource Management

To configure a class in the system configuration, perform the following steps. You can change the value of a
particular resource limit by reentering the command with a new value.

Before you begin

* Perform this procedure in the system execution space.

* The following table lists the resource types and the limits.

A

Note

If the System Limit is N/A, then you cannot set a percentage of the resource
because there is no hard system limit for the resource.

Table 13: Resource Names and Limits

Minimum and
Maximum Number

Resource Name | Rate or Concurrent | per Context System Limit Description

ASDM Sessions | Concurrent 1 minimum 200 ASDM management sessions.

ASDM sessions use two HTTPS
connections: one for monitoring that is
always present, and one for making
configuration changes that is present
only when you make changes. For
example, the system limit of 200 ASDM
sessions represents a limit of

400 HTTPS sessions.

32 maximum

Connections

Conns/sec

Concurrent or Rate

N/A

Concurrent connections: See
Supported Feature Licenses
Per Model, on page 116 for
the connection limit available
for your model.

Rate: N/A

TCP or UDP connections between any
two hosts, including connections
between one host and multiple other
hosts.

Note Syslog messages are
generated for whichever
limit is lower, xlates or
conns. For example, if you
set the xlates limit to 7 and
the conns to 9, then the ASA
only generates syslog
message 321001 (“Resource
'xlates' limit of 7 reached for
context 'ctx1”’) and not
321002 (“Resource 'conn
rate' limit of 5 reached for
context 'ctx1"™’).

Hosts

Concurrent

N/A

N/A

Hosts that can connect through the ASA.
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Minimum and
Maximum Number

Resource Name | Rate or Concurrent | per Context System Limit Description

Inspects/sec Rate N/A N/A Application inspections per second.

MAC Entries Concurrent N/A 65,535 For transparent firewall mode, the

number of MAC addresses allowed in
the MAC address table.

Routes Concurrent N/A N/A Dynamic routes.

AnyConnect Burst | Concurrent N/A The AnyConnect Premium | The number of AnyConnect sessions
Peers for your model minus | allowed beyond the amount assigned to
the sum of the sessions a context with AnyConnect. For
assigned to all contexts for |example, if your model supports 5000
AnyConnect. peers, and you assign 4000 peers across

all contexts with AnyConnect, then the
remaining 1000 sessions are available
for AnyConnect Burst. Unlike
AnyConnect, which guarantees the
sessions to the context, AnyConnect
Burst can be oversubscribed; the burst
pool is available to all contexts on a
first-come, first-served basis.

AnyConnect Concurrent N/A See Supported Feature AnyConnect peers. You cannot
Licenses Per Model, on page | oversubscribe this resource; all context
116 for the AnyConnect assignments combined cannot exceed
Premium Peers available for | the model limit. The peers you assign
your model. for this resource are guaranteed to the

context.

Other VPN Burst | Concurrent N/A The Other VPN session The number of site-to-site VPN sessions

amount for your model minus
the sum of the sessions
assigned to all contexts for
Other VPN.

allowed beyond the amount assigned to
a context with Other VPN. For example,
if your model supports 5000 sessions,
and you assign 4000 sessions across all
contexts with Other VPN, then the
remaining 1000 sessions are available
for Other VPN Burst. Unlike Other
VPN, which guarantees the sessions to
the context, Other VPN Burst can be
oversubscribed; the burst pool is
available to all contexts on a first-come,
first-served basis.
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Minimum and
Maximum Number
Resource Name | Rate or Concurrent | per Context System Limit Description
Other VPN Concurrent N/A See Supported Feature Site-to-site VPN sessions. You cannot
Licenses Per Model, on page | oversubscribe this resource; all context
116 for the Other VPN assignments combined cannot exceed
sessions available for your |the model limit. The sessions you assign
model. for this resource are guaranteed to the
context.
IKEv1 SAs In Concurrent N/A A percentage of the Other | Incoming IKEv1 SA negotiations, as a
Negotiation (percentage only) VPN sessions assigned to this | percentage of the context Other VPN
context. See the Other VPN | limit.
resources to assign sessions
to the context.
SSH Concurrent I minimum 100 SSH sessions.
5 maximum
Storage MB The maximum The maximum depends on | Storage limit of context directory in
depends on your | your specified flash memory | MB.
specified flash drive
memory drive
Syslogs/sec Rate N/A N/A Syslog messages per second.
Telnet Concurrent 1 minimum 100 Telnet sessions.
5 maximum
Xlates Concurrent N/A N/A Network address translations.
Procedure
Step 1 If you are not already in the System configuration mode, in the Device List pane, double-click System under
the active device IP address.
Step 2 Choose Configuration > Context Management > Resource Class, and click Add.
The Add Resource Class dialog box appears.
Step 3 Enter a class name up to 20 characters in length, in the Resource Class field.
Step 4 In the Count Limited Resources area, set the concurrent limits for resources,.
See the preceding table for a description of each resource type.
For resources that do not have a system limit, you cannot set the percentage; you can only set an absolute
value. If you do not set a limit, the limit is inherited from the default class. If the default class does not set a
limit, then the resource is unlimited, or the system limit if available. For most resources, 0 sets the limit to
unlimited. For VPN types, 0 sets the limit none.
Step 5 In the Rate Limited Resources area, set the rate limit for resources.
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. Configure a Security Context

Step 6

See the preceding table for a description of each resource type.

If you do not set a limit, the limit is inherited from the default class. If the default class does not set a limit,
then it is unlimited by default. 0 sets the limit to unlimited.

Click OK.

Configure a Security Context

Step 1

Step 2

Step 3

Step 4

The security context definition in the system configuration identifies the context name, configuration file
URL, interfaces that a context can use, and other settings.

Before you begin
* Perform this procedure in the system execution space.

* Configure interfaces. For transparent mode contexts, you cannot share interfaces between contexts, so
you might want to use subinterfaces. To plan for Management interface usage, see Management Interface
Usage, on page 244.

* ASA 5500-X—Basic Interface Configuration, on page 463.

* Firepower 2100—See the getting started guide.

* Firepower 4100/9300—Logical Devices for the Firepower 4100/9300, on page 189
* ASASM—ASASM quick start guide.

Procedure

If you are not already in the System configuration mode, in the Device List pane, double-click System under
the active device IP address.

Choose Configuration > Context Management > Security Contexts, and click Add.

The Add Context dialog box appears.

In the Security Context field, enter the context name as a string up to 32 characters long.

This name is case sensitive, so you can have two contexts named “customerA” and “CustomerA,” for example.
“System” or “Null” (in upper or lower case letters) are reserved names, and cannot be used.

In the Interface Allocation area, click the Add button to assign an interface to the context.
a) From the Interfaces > Physical Interface drop-down list, choose an interface.

You can assign the main interface, in which case you leave the subinterface ID blank, or you can assign
a subinterface or a range of subinterfaces associated with this interface. In transparent firewall mode, only
interfaces that have not been allocated to other contexts are shown. If the main interface was already
assigned to another context, then you must choose a subinterface.

b) (Optional) In the Interfaces > Subinterface Range drop-down list, choose a subinterface ID.

For a range of subinterface IDs, choose the ending ID in the second drop-down list, if available.
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Step 5

Step 6

Step 7

Step 8
Step 9

Step 10

Step 11
Step 12

Configure a Security Context .

In transparent firewall mode, only subinterfaces that have not been allocated to other contexts are shown.

¢) (Optional) In the Aliased Names area, check Use Aliased Name in Context to set an aliased name for
this interface to be used in the context configuration instead of the interface ID.

« In the Name field, set the aliased name.

An aliased name must start with a letter, end with a letter, and have as interior characters only letters,
digits, or an underscore. This field lets you specify a name that ends with a letter or underscore; to
add an optional digit after the name, set the digit in the Range field.

* (Optional) In the Range field, set the numeric suffix for the aliased name.

If you have a range of subinterfaces, you can enter a range of digits to be appended to the name.

d) (Optional)Check Show Hardware Properties in Context to enable context users to see physical interface
properties even if you set an aliased name.
e) Click OK to return to the Add Context dialog box.

(Optional) In the IPS Sensor Allocation area, assign a sensor to the context if you use IPS virtual sensors.

For detailed information about IPS and virtual sensors, see the IPS quick start guide.

(Optional) In the Resource Assignment area, choose a class name from the Resource Class drop-down list
to assign this context to a resource class.

You can add or edit a resource class directly from this area.

From the Config URL drop-down list, choose a file system type. In the field, identify the URL for the context
configuration location.

For example, the combined URL for FTP has the following format:

ftp://server.example.com/configs/admin.cfg

(Optional) Click Login to set the username and password for external file systems.

(Optional) From the Failover Group drop-down list, choose the group name to set the failover group for
Active/Active failover.

(Optional) For Cloud Web Security, click Enable to enable Web Security inspection in this context. To
override the license set in the system configuration, enter a license in the License field.

(Optional) In the Description field, add a description.

(Optional) In the Storage URL Assignment area, you can allow each context to use flash memory to store
VPN packages, such as AnyConnect, as well as providing storage for AnyConnect and clientless SSL VPN
portal customizations. For example, if you are using multiple context mode to configure an AnyConnect
profile with Dynamic Access Policies, you must plan for context specific private and shared storage. Each
context can use a private storage space as well as a shared read-only storage space. Note: Make sure the target
directory is already present on the specified disk using Tools > File Management.

a) Check the Configure private storage assignment check box, and from the Select drop-down list, choose
the private storage directory. You can specify one private storage space per context. You can
read/write/delete from this directory within the context (as well as from the system execution space).
Under the specified path, the ASA creates a sub-directory named after the context. For example, for
contextA if you specify disk1:/private-storage for the path, then the ASA creates a sub-directory for this
context at disk1:/private-storage/contextA/. You can also optionally name the path within the context
by entering a name in the is mapped to field so that the file system is not exposed to context administrators.
For example, if you specify the mapped name as context, then from within the context, this directory is
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called context:. To control how much disk space is allowed per context, see Configure a Class for Resource
Management, on page 255.

b) Check the Configure shared storage assignment check box, and from the Select drop-down list, choose
the shared storage directory. You can specify one read-only shared storage space per context, but you
can create multiple shared directories. To reduce duplication of common large files that can be shared
among all contexts, such as AnyConnect packages, you can use the shared storage space. The ASA does
not create context sub-directories for this storage space because it is a shared space for multiple contexts.
Only the system execution space can write and delete from the shared directory.

Step 13 Click OK to return to the Security Contexts pane.
Step 14 (Optional) Select the context, and click Change Firewall Mode to set the firewall mode to transparent.

If this is a new context, there is no configuration to erase. Click Change Mode to change to transparent
firewall mode.

If this is an existing context, then be sure to back up the configuration before you change the mode.

Note You cannot change the mode of the currently connected context in ASDM (typically the admin
context); see Set the Firewall Mode (Single Mode), on page 215 to set the mode at the command
line.

Step 15 (Optional) To customize auto-generation of MAC addresses, see Assign MAC Addresses to Context Interfaces
Automatically, on page 260.

Step 16 (Optional) Check the Specify the maximum number of TLS Proxy sessions that the ASA needs to support
check box, to specify the maximum TLS Proxy sessions for the device. For more information about TLS
proxy, see the firewall configuration guide.

Assign MAC Addresses to Context Interfaces Automatically

This section describes how to configure auto-generation of MAC addresses. The MAC address is used to
classify packets within a context.

Before you begin

* When you configure a name for the interface in a context, the new MAC address is generated immediately.
If you enable this feature after you configure context interfaces, then MAC addresses are generated for
all interfaces immediately after you enable it. If you disable this feature, the MAC address for each
interface reverts to the default MAC address. For example, subinterfaces of GigabitEthernet 0/1 revert
to using the MAC address of GigabitEthernet 0/1.

* In the rare circumstance that the generated MAC address conflicts with another private MAC address in

your network, you can manually set the MAC address for the interface within the context.

Procedure

Step 1 If you are not already in the System configuration mode, in the Device List pane, double-click System under
the active device IP address.
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Step 2

Step 3

Change Between Contexts and the System Execution Space .

Choose Configuration > Context Management > Security Contexts, and check Mac-Address auto. If
you do not enter a prefix, then the ASA autogenerates the prefix based on the last two bytes of the interface
(ASA 5500-X) or backplane (ASASM) MAC address.

(Optional) Check the Prefix check box, and in the field, enter a decimal value between 0 and 65535.

This prefix is converted to a four-digit hexadecimal number, and used as part of the MAC address.

Change Between Contexts and the System Execution Space

Step 1
Step 2

If you log in to the system execution space (or the admin context), you can change between contexts and
perform configuration and monitoring tasks within each context. The running configuration that you edit in
a configuration mode depends on your location. When you are in the system execution space, the running
configuration consists only of the system configuration; when you are in a context, the running configuration
consists only of that context.

Procedure

In the Device List pane, double-click System under the active device IP address, to configure the System.

In the Device List pane, double-click the context name under the active device IP address, to configure a
context.

Manage Security Contexts

This section describes how to manage security contexts.

Remove a Security Context

)

You cannot remove the current admin context.

Note

Step 1

If you use failover, there is a delay between when you remove the context on the active unit and when the
context is removed on the standby unit.

Before you begin

Perform this procedure in the system execution space.

Procedure

If you are not already in the System configuration mode, in the Device List pane, double-click System under
the active device IP address.
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Step 2
Step 3

Step 4

Step 5

Choose Configuration > Context Management > Security Contexts.
Select the context you want to delete, and click Delete.

The Delete Context dialog box appears.

If you might want to re-add this context later, and want to keep the configuration file for future use, uncheck
the Also delete config URL file from the disk check box.

If you want to delete the configuration file, then leave the check box checked.

Click Yes.

Change the Admin Context

The system configuration does not include any network interfaces or network settings for itself; rather, when
the system needs to access network resources (such as downloading the contexts from the server), it uses one
of the contexts that is designated as the admin context.

The admin context is just like any other context, except that when a user logs in to the admin context, then
that user has system administrator rights and can access the system and all other contexts. The admin context
is not restricted in any way, and can be used as a regular context. However, because logging into the admin
context grants you administrator privileges over all contexts, you might need to restrict access to the admin
context to appropriate users.

Note

Step 1

Step 2

Step 3

Step 4

For ASDM, you cannot change the admin context within ASDM because your ASDM session would disconnect.
You can perform this procedure using the Command Line Interface tool noting that you will have to reconnect
to the new admin context.

Before you begin

* You can set any context to be the admin context, as long as the configuration file is stored in the internal
flash memory.

* Perform this procedure in the system execution space.

Procedure

If you are not already in the System configuration mode, in the Device List pane, double-click System under
the active device IP address.

Choose Tools > Command Line Interface.

The Command Line Interface dialog box appears.

Enter the following command:

admin-context context_name

Click Send.
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Any remote management sessions, such as Telnet, SSH, or HTTPS (ASDM)), that are connected to the admin
context are terminated. You must reconnect to the new admin context.

Note A few system configuration commands, including ntp server, identify an interface name that belongs
to the admin context. If you change the admin context, and that interface name does not exist in the
new admin context, be sure to update any system commands that refer to the interface.

Change the Security Context URL

This section describes how to change the context URL.

Before you begin

* You cannot change the security context URL without reloading the configuration from the new URL.
The ASA merges the new configuration with the current running configuration.

* Reentering the same URL also merges the saved configuration with the running configuration.
* A merge adds any new commands from the new configuration to the running configuration.
* If the configurations are the same, no changes occur.

* If commands conflict or if commands affect the running of the context, then the effect of the merge
depends on the command. You might get errors, or you might have unexpected results. If the running
configuration is blank (for example, if the server was unavailable and the configuration was never
downloaded), then the new configuration is used.

* If you do not want to merge the configurations, you can clear the running configuration, which disrupts
any communications through the context, and then reload the configuration from the new URL.

* Perform this procedure in the system execution space.

Procedure

Step 1 If you are not already in the System configuration mode, in the Device List pane, double-click System under
the active device IP address.

Step 2 Choose Configuration > Context Management > Security Contexts.

Step 3 Select the context you want to edit, and click Edit.

The Edit Context dialog box appears.

Step 4 Enter a new URL in the Config URL field, and click OK.

The system immediately loads the context so that it is running.
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Reload a Security Context

You can reload the context in two ways:
* Clear the running configuration and then import the startup configuration.
This action clears most attributes associated with the context, such as connections and NAT tables.
* Remove the context from the system configuration.

This action clears additional attributes, such as memory allocation, which might be useful for
troubleshooting. However, to add the context back to the system requires you to respecify the URL and
interfaces.

Reload by Clearing the Configuration

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Procedure

In the Device List pane, double-click the context name under the active device IP address.
Choose Tools > Command Line Interface.

The Command Line Interface dialog box appears.
Enter the following command:

clear configure all

Click Send.

The context configuration is cleared.

Choose Tools > Command Line Interface again.
The Command Line Interface dialog box appears.
Enter the following command:

copy startup-config running-config

Click Send.

The ASA reloads the configuration. The ASA copies the configuration from the URL specified in the system
configuration. You cannot change the URL from within a context.

Reload by Removing and Re-adding the Context

Step 1

To reload the context by removing the context and then re-adding it, perform the steps.

Procedure

Remove a Security Context, on page 261. Be sure to uncheck the Also delete config URL file from the disk
check box.
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Step 2 Configure a Security Context, on page 258

Monitoring Security Contexts

This section describes how to view and monitor context information.

Monitor Context Resource Usage

Procedure

Step 1 If you are not already in the System mode, in the Device List pane, double-click System under the active
device IP address.

Step 2 Click the Monitoring button on the toolbar.
Step 3 Click Context Resource Usage.

Click each resource type to view the resource usage for all contexts:
» ASDM/Telnet/SSH—Shows the usage of ASDM, Telnet, and SSH connections.
* Context—Shows the name of each context.

For each access method, see the following usage statistics:
* Existing Connections (#)—Shows the number of existing connections.

« Existing Connections (%)—Shows the connections used by this context as a percentage of the total
number of connections used by all contexts.

* Peak Connections (#)—Shows the peak number of connections since the statistics were last cleared,
either using the clear resource usage command or because the device rebooted.

* Routes—Shows the usage of dynamic routes.
* Context—Shows the name of each context.
* Existing Connections (#)—Shows the number of existing connections.

« Existing Connections (%)—Shows the connections used by this context as a percentage of the total
number of connections used by all contexts.

* Peak Connections (#)—Shows the peak number of connections since the statistics were last cleared,
either using the clear resource usage command or because the device rebooted.

« Xlates—Shows the usage of network address translations.

* Context—Shows the name of each context.
* Xlates (#)—Shows the number of current xlates.

* Xlates (%)—Shows the xlates used by this context as a percentage of the total number of xlates
used by all contexts.
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* Peak (#)—Shows the peak number of xlates since the statistics were last cleared, either using the
clear resource usage command or because the device rebooted.

* NATs—Shows the number of NAT rules.
* Context—Shows the name of each context.
* NATs (#)—Shows the current number of NAT rules.

* NATs (%)—Shows the NAT rules used by this context as a percentage of the total number of NAT
rules used by all contexts.

* Peak NATs (#)—Shows the peak number of NAT rules since the statistics were last cleared, either
using the clear resource usage command or because the device rebooted.

* Syslogs—Shows the rate of system log messages.

* Context—Shows the name of each context.
* Syslog Rate (#/sec)—Shows the current rate of system log messages.

* Syslog Rate (%)—Shows the system log messages generated by this context as a percentage of the
total number of system log messages generated by all contexts.

* Peak Syslog Rate (#/sec)—Shows the peak rate of system log messages since the statistics were
last cleared, either using the clear resource usage command or because the device rebooted.

* VPN—Shows the usage of VPN site-to-site tunnels.

* Context—Shows the name of each context.
* VPN Connections—Shows usage of guaranteed VPN sessions.

* VPN Burst Connections—Shows usage of burst VPN sessions.

* Existing (#)—Shows the number of existing tunnels.

* Peak (#)—Shows the peak number of tunnels since the statistics were last cleared, either using
the clear resource usage command or because the device rebooted.

Step 4 Click Refresh to refresh the view.

View Assigned MAC Addresses

You can view auto-generated MAC addresses within the system configuration or within the context.

View MAC Addresses in the System Configuration

This section describes how to view MAC addresses in the system configuration.
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Step 1

Step 2

View MAC Addresses Within a Context .

Before you begin

If you manually assign a MAC address to an interface, but also have auto-generation enabled, the auto-generated
address continues to show in the configuration even though the manual MAC address is the one that is in use.
If you later remove the manual MAC address, the auto-generated one shown will be used.

Procedure

If you are not already in the System configuration mode, in the Device List pane, double-click System under
the active device IP address.

Choose Configuration > Context Management > Security Contexts, and view the Primary MAC and
Secondary MAC columns.

View MAC Addresses Within a Context

Step 1

Step 2

This section describes how to view MAC addresses within a context.

Procedure

If you are not already in the System configuration mode, in the Device List pane, double-click System under
the active device IP address.

Choose Configuration > Interfaces, and view the MAC Address address column.

This table shows the MAC address in use; if you manually assign a MAC address and also have auto-generation
enabled, then you can only view the unused auto-generated address from within the system configuration.

History for Multiple Context Mode

Table 14: History for Multiple Context Mode

Feature Name

Plafom | Feature Information

Multiple security contexts 7.0(1) | Multiple context mode was introduced.

We introduced the following screens: Configuration > Context Management.

Automatic MAC address assignment | 7.2(1) | Automatic assignment of MAC address to context interfaces was introduced.

We modified the following screen: Configuration > Context Management > Security
Contexts.

Resource management 7.2(1) | Resource management was introduced.

We introduced the following screen: Configuration > Context Management > Resource
Management.

ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8 [JJj



. History for Multiple Context Mode

High Availability and Scalability |

Feature Name

Feature Information

Virtual sensors for IPS

8.02)

The AIP SSM running IPS software Version 6.0 and above can run multiple virtual
sensors, which means you can configure multiple security policies on the AIP SSM.
You can assign each context or single mode ASA to one or more virtual sensors, or
you can assign multiple security contexts to the same virtual sensor.

We modified the following screen: Configuration > Context Management > Security
Contexts.

Automatic MAC address assignment
enhancements

The MAC address format was changed to use a prefix, to use a fixed starting value
(A2), and to use a different scheme for the primary and secondary unit MAC addresses
in a failover pair. The MAC addresses are also now persistent across reloads. The
command parser now checks if auto-generation is enabled; if you want to also
manually assign a MAC address, you cannot start the manual MAC address with A2.

We modified the following screen: Configuration > Context Management > Security
Contexts.

Maximum contexts increased for the
ASA 5550 and 5580

8.4(1)

The maximum security contexts for the ASA 5550 was increased from 50 to 100.
The maximum for the ASA 5580 was increased from 50 to 250.

Automatic MAC address assignment
enabled by default

8.5(1)

Automatic MAC address assignment is now enabled by default.

We modified the following screen: Configuration > Context Management > Security
Contexts.

Automatic generation of a MAC
address prefix

8.6(1)

In multiple context mode, the ASA now converts the automatic MAC address
generation configuration to use a default prefix. The ASA auto-generates the prefix
based on the last two bytes of the interface (ASA 5500-X) or backplane (ASASM)
MAC address. This conversion happens automatically when you reload, or if you
reenable MAC address generation. The prefix method of generation provides many
benefits, including a better guarantee of unique MAC addresses on a segment. If you
want to change the prefix, you can reconfigure the feature with a custom prefix. The
legacy method of MAC address generation is no longer available.

Note To maintain hitless upgrade for failover pairs, the ASA does not convert
the MAC address method in an existing configuration upon a reload if
failover is enabled. However, we strongly recommend that you manually
change to the prefix method of generation when using failover, especially
for the ASASM. Without the prefix method, ASASMs installed in different
slot numbers experience a MAC address change upon failover, and can
experience traffic interruption. After upgrading, to use the prefix method
of MAC address generation, reenable MAC address generation to use the
default prefix.

We modified the following screen: Configuration > Context Management > Security
Contexts

Automatic MAC address assignment
disabled by default on all models
except for the ASASM

9.0(1)

Automatic MAC address assignment is now disabled by default except for the
ASASM.

We modified the following screen: Configuration > Context Management > Security
Contexts.
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Feature Name Plaform | Feature Information
Releases
Dynamic routing in Security Contexts | 9.0(1) | EIGRP and OSPFv2 dynamic routing protocols are now supported in multiple context
mode. OSPFv3, RIP, and multicast routing are not supported.
New resource type for routing table |9.0(1) | A new resource type, routes, was created to set the maximum number of routing table
entries entries in each context.
We modified the following screen: Configuration > Context Management > Resource
Class > Add Resource Class
Site-to-Site VPN in multiple context |9.0(1) | Site-to-site VPN tunnels are now supported in multiple context mode.
mode
New resource type for site-to-site 9.0(1) | New resource types, vpn other and vpn burst other, were created to set the maximum
VPN tunnels number of site-to-site VPN tunnels in each context.
We modified the following screen: Configuration > Context Management > Resource
Class > Add Resource Class
New resource type for IKEvl SA 9.1(2) | New resource type, ikev1 in-negotiation, was created to set the maximum percentage
negotiations of IKEv1 SA negotiations in each context to prevent overwhelming the CPU and
crypto engines. Under certain conditions (large certificates, CRL checking), you
might want to restrict this resource.
We modified the following screen: Configuration > Context Management > Resource
Class > Add Resource Class
Support for Remote Access VPN in |9.5(2) | You can now use the following remote access features in multiple context mode:
Itipl
multiple context mode » AnyConnect 3.x and later (SSL VPN only; no IKEv2 support)
* Centralized AnyConnect image configuration
* AnyConnect image upgrade
* Context Resource Management for AnyConnect connections
Note The AnyConnect Apex license is required for multiple context mode; you
cannot use the default or legacy license.
We modified the following screen: Configuration > Context Management >
Resource Class > Add Resource Class
Pre-fill/Username-from-cert feature |9.6(2) | AnyConnect SSL support is extended, allowing pre-fill/'username-from-certificate

for multiple context mode

feature CLIs, previously available only in single mode, to be enabled in multiple
context mode as well.

We did not modify any screens.
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Feature Name Plaform | Feature Information
Releases
Flash Virtualization for Remote 9.6(2) | Remote access VPN in multiple context mode now supports flash virtualization. Each
Access VPN context can have a private storage space and a shared storage place based on the total
flash that is available:
* Private storage—Store files associated only with that user and specific to the
content that you want for that user.
* Shared storage—Upload files to this space and have it accessible to any user
context for read/write access once you enable it.
We modified the following screens: Configuration > Context Management >
Resource Class > Add Resource Class
Configuration > Context Management > Security Contexts
AnyConnect client profiles supported | 9.6(2) | AnyConnect client profiles are supported in multi-context devices. To add a new
in multi-context devices profile using ASDM, you must have the AnyConnect Secure Mobility Client release
4.2.00748 or 4.3.03013 and later.
Stateful failover for AnyConnect 9.6(2) | Stateful failover is now supported for AnyConnect connections in multiple context
connections in multiple context mode mode.
We did not modify any screens.
Remote Access VPN Dynamic Access | 9.6(2) | You can now configure DAP per context in multiple context mode.
Policy (DAP) is supported in multiple We did not modify any screens.
context mode
Remote Access VPN CoA (Change |9.6(2) | You can now configure CoA per context in multiple context mode.
of Al.lthorlzatlon) is supported in We did not modify any screens.
multiple context mode
Remote Access VPN localization is | 9.6(2) | Localization is supported globally. There is only one set of localization files that are

supported in multiple context mode

shared across different contexts.

We did not modify any screens.
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Failover for High Availability

This chapter describes how to configure Active/Standby or Active/Active failover to accomplish high availability
of the Cisco ASA.

* About Failover, on page 271

* Licensing for Failover, on page 295

* Guidelines for Failover, on page 297

* Defaults for Failover, on page 298

* Configure Active/Standby Failover, on page 299

* Configure Active/Active Failover, on page 300

* Configure Optional Failover Parameters, on page 301
* Manage Failover, on page 307

* Monitoring Failover, on page 311

* History for Failover, on page 313

About Failover

Configuring failover requires two identical ASAs connected to each other through a dedicated failover link
and, optionally, a state link. The health of the active units and interfaces is monitored to determine whether
they meet the specific failover conditions. If those conditions are met, failover occurs.

Failover Modes

The ASA supports two failover modes, Active/Active failover and Active/Standby failover. Each failover
mode has its own method for determining and performing failover.

* In Active/Standby failover, one device functions as the Active unit and passes traffic. The second device,
designated as the Standby unit, does not actively pass traffic. When a failover occurs, the Active unit
fails over to the Standby unit, which then becomes Active. You can use Active/Standby failover for
ASAs in single or multiple context mode.

* In an Active/Active failover configuration, both ASAs can pass network traffic. Active/Active failover
is only available to ASAs in multiple context mode. In Active/Active failover, you divide the security
contexts on the ASA into 2 failover groups. A failover group is simply a logical group of one or more
security contexts. One group is assigned to be Active on the primary ASA, and the other group is assigned
to be active on the Secondary ASA. When a failover occurs, it occurs at the failover group level.
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Both failover modes support stateful or stateless failover.

Failover System Requirements

This section describes the hardware, software, and license requirements for ASAs in a Failover configuration.

Hardware Requirements
The two units in a Failover configuration must:

* Be the same model.

* Have the same number and types of interfaces.

For the Firepower 2100 and Firepower 4100/9300 chassis, all interfaces must be preconfigured in FXOS
identically before you enable Failover. If you change the interfaces after you enable Failover, make the
interface changes in FXOS on the Standby unit, and then make the same changes on the Active unit. If
you remove an interface in FXOS (for example, if you remove a network module, remove an EtherChannel,
or reassign an interface to an EtherChannel), then the ASA configuration retains the original commands
so that you can make any necessary adjustments; removing an interface from the configuration can have
wide effects. You can manually remove the old interface configuration in the ASA OS.

* Have the same modules installed (if any).

* Have the same RAM installed.
If you are using units with different flash memory sizes in your Failover configuration, make sure the unit
with the smaller flash memory has enough space to accommodate the software image files and the configuration

files. If it does not, configuration synchronization from the unit with the larger flash memory to the unit with
the smaller flash memory will fail.

Software Requirements
The two units in a Failover configuration must:
* Be in the same context mode (single or multiple).
* For single mode: Be in the same firewall mode (routed or transparent).
In multiple context mode, the firewall mode is set at the context-level, and you can use mixed modes.

* Have the same major (first number) and minor (second number) software version. However, you can
temporarily use different versions of the software during an upgrade process; for example, you can
upgrade one unit from Version 8.3(1) to Version 8.3(2) and have failover remain active. We recommend
upgrading both units to the same version to ensure long-term compatibility.

* Have the same AnyConnect images. If the failover pair has mismatched images when a hitless upgrade
is performed, then the clientless SSL VPN connection terminates in the final reboot step of the upgrade
process, the database shows an orphaned session, and the IP pool shows that the IP address assigned to
the client is “in use.”

* Be in the same FIPS mode.

* (Firepower 4100/9300) Have the same flow offload mode, either both enabled or both disabled.
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License Requirements .

License Requirements

The two units in a failover configuration do not need to have identical licenses; the licenses combine to make
a failover cluster license.

Failover and Stateful Failover Links

A

The failover link and the optional stateful failover link are dedicated connections between the two units. Cisco
recommends to use the same interface between two devices in a failover link or a stateful failover link. For
example, in a failover link, if you have used eth0 in device 1, use the same interface (eth0) in device 2 as well.

Caution

Failover Link

Failover Link Data

All information sent over the failover and state links is sent in clear text unless you secure the communication
with an [Psec tunnel or a failover key. If the ASA is used to terminate VPN tunnels, this information includes
any usernames, passwords and preshared keys used for establishing the tunnels. Transmitting this sensitive
data in clear text could pose a significant security risk. We recommend securing the failover communication
with an IPsec tunnel or a failover key if you are using the ASA to terminate VPN tunnels.

The two units in a failover pair constantly communicate over a failover link to determine the operating status
of each unit.

The following information is communicated over the failover link:

* The unit state (active or standby)
* Hello messages (keep-alives)

* Network link status

* MAC address exchange

* Configuration replication and synchronization

Interface for the Failover Link

You can use an unused data interface (physical, subinterface, redundant, or EtherChannel) as the failover link;
however, you cannot specify an interface that is currently configured with a name. The failover link interface
is not configured as a normal networking interface; it exists for failover communication only. This interface
can only be used for the failover link (and also for the state link). For most models, you cannot use a
management interface for failover unless explicitly described below.

The ASA does not support sharing interfaces between user data and the failover link. You also cannot use
separate subinterfaces on the same parent for the failover link and for data.

See the following guidelines for the failover link:

* 5506-X through 5555-X—You cannot use the Management interface as the failover link; you must use
a data interface. The only exception is for the 5506H-X, where you can use the management interface
as the failover link.
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* 5506H-X—You canuse the Management 1/1 interface as the failover link. If you configure it for failover,
you must reload the device for the change to take effect. In this case, you cannot also use the ASA
Firepower module, because it requires the Management interface for management purposes.

* 5585-X—Do not use the Management 0/0 interface, even though it can be used as a data interface. It
does not support the necessary performance for this use.

* Firepower 4100/9300—We recommend that you use a 10 GB data interface for the combined failover
and state link. You cannot use the management-type interface for the failover link.

+ All other models—1 GB interface is large enough for a combined failover and state link.

For a redundant interface used as the failover link, see the following benefits for added redundancy:
* When a failover unit boots up, it alternates between the member interfaces to detect an active unit.

« If a failover unit stops receiving keepalive messages from its peer on one of the member interfaces, it
switches to the other member interface.

The alternation frequency is equal to the unit hold time (the failover polltime unit command).

Note If you have a large configuration and a low unit hold time, alternating between the member interfaces can
prevent the secondary unit from joining/re-joining. In this case, disable one of the member interfaces until
after the secondary unit joins.

For an EtherChannel used as the failover link, to prevent out-of-order packets, only one interface in the
EtherChannel is used. If that interface fails, then the next interface in the EtherChannel is used. You cannot
alter the EtherChannel configuration while it is in use as a failover link.

Connecting the Failover Link

Connect the failover link in one of the following two ways:

* Using a switch, with no other device on the same network segment (broadcast domain or VLAN) as the
failover interfaces of the ASA.

« Using an Ethernet cable to connect the units directly, without the need for an external switch.

If you do not use a switch between the units, if the interface fails, the link is brought down on both peers. This
condition may hamper troubleshooting efforts because you cannot easily determine which unit has the failed
interface and caused the link to come down.

The ASA supports Auto-MDI/MDIX on its copper Ethernet ports, so you can either use a crossover cable or
a straight-through cable. If you use a straight-through cable, the interface automatically detects the cable and
swaps one of the transmit/receive pairs to MDIX.

Stateful Failover Link

To use Stateful Failover, you must configure a Stateful Failover link (also known as the state link) to pass
connection state information.
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Shared with the Failover Link

Dedicated Interface

Sharing a failover link is the best way to conserve interfaces. However, you must consider a dedicated interface
for the state link and failover link, if you have a large configuration and a high traffic network.

You can use a dedicated data interface (physical, redundant, or EtherChannel) for the state link. See Interface
for the Failover Link, on page 273 for requirements for a dedicated state link, and Connecting the Failover
Link, on page 274 for information about connecting the state link as well.

For optimum performance when using long distance failover, the latency for the state link should be less than
10 milliseconds and no more than 250 milliseconds. If latency is more than 10 milliseconds, some performance
degradation occurs due to retransmission of failover messages.

Avoiding Interrupted Failover and Data Links

We recommend that failover links and data interfaces travel through different paths to decrease the chance
that all interfaces fail at the same time. If the failover link is down, the ASA can use the data interfaces to
determine if a failover is required. Subsequently, the failover operation is suspended until the health of the
failover link is restored.

See the following connection scenarios to design a resilient failover network.

Scenario —Not Recommended

If a single switch or a set of switches are used to connect both failover and data interfaces between two ASAs,
then when a switch or inter-switch-link is down, both ASAs become active. Therefore, the following two
connection methods shown in the following figures are NOT recommended.

Figure 46: Connecting with a Single Switch—Not Recommended

~ outside ~_outside
Failover link ‘ __Failover link Secondary
inside inside
Figure 47: Connecting with a Double-Switch—Not Recommended
outside Swnch 1 SW|tch 2 outside

Primary Failover link __ISL__ P Failover link Secondary
. inside , inside

Scenario 2—Recommended

Primary

We recommend that failover links NOT use the same switch as the data interfaces. Instead, use a different
switch or use a direct cable to connect the failover link, as shown in the following figures.
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Figure 48: Connecting with a Different Switch
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Figure 49: Connecting with a Cable
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Scenario 3—Recommended

If the ASA data interfaces are connected to more than one set of switches, then a failover link can be connected
to one of the switches, preferably the switch on the secure (inside) side of network, as shown in the following
figure.

Figure 50: Connecting with a Secure Switch
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Scenario 4—Recommended

The most reliable failover configurations use a redundant interface on the failover link, as shown in the
following figures.
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Figure 51: Connecting with Redundant Interfaces
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Figure 52: Connecting with Inter-switch Links
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MAC Addresses and IP Addresses in Failover

When you configure your interfaces, you can specify an active IP address and a standby IP address on the
same network. Generally, when a failover occurs, the new active unit takes over the active IP addresses and
MAC addresses. Because network devices see no change in the MAC to IP address pairing, no ARP entries
change or time out anywhere on the network.
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Note

Although recommended, the standby address is not required. Without a standby IP address, the active unit
cannot perform network tests to check the standby interface health; it can only track the link state. You also
cannot connect to the standby unit on that interface for management purposes.

The IP address and MAC address for the state link do not change at failover.

Active/Standby IP Addresses and MAC Addresses
For Active/Standby Failover, see the following for IP address and MAC address usage during a failover event:

1. The active unit always uses the primary unit's [P addresses and MAC addresses.

2. When the active unit fails over, the standby unit assumes the IP addresses and MAC addresses of the
failed unit and begins passing traffic.

3. When the failed unit comes back online, it is now in a standby state and takes over the standby IP addresses
and MAC addresses.

However, if the secondary unit boots without detecting the primary unit, then the secondary unit becomes the
active unit and uses its own MAC addresses, because it does not know the primary unit MAC addresses. When
the primary unit becomes available, the secondary (active) unit changes the MAC addresses to those of the
primary unit, which can cause an interruption in your network traffic. Similarly, if you swap out the primary
unit with new hardware, a new MAC address is used.

Virtual MAC addresses guard against this disruption, because the active MAC addresses are known to the
secondary unit at startup, and remain the same in the case of new primary unit hardware. If you do not configure
virtual MAC addresses, you might need to clear the ARP tables on connected routers to restore traffic flow.
The ASA does not send gratuitous ARPs for static NAT addresses when the MAC address changes, so
connected routers do not learn of the MAC address change for these addresses.

Active/Active IP Addresses and MAC Addresses
For Active/Active failover, see the following for IP address and MAC address usage during a failover event:

1. The primary unit autogenerates active and standby MAC addresses for all interfaces in failover group 1
and 2 contexts. You can also manually configure the MAC addresses if necessary, for example, if there
are MAC address conflicts.

2. Each unit uses the active IP addresses and MAC addresses for its active failover group, and the standby
addresses for its standby failover group. For example, the primary unit is active for failover group 1, so
it uses the active addresses for contexts in failover group 1. It is standby for the contexts in failover group
2, where it uses the standby addresses.

3. When a unit fails over, the other unit assumes the active IP addresses and MAC addresses of the failed
failover group and begins passing traffic.

4. When the failed unit comes back online, and you enabled the preempt option, it resumes the failover
group.

Virtual MAC Addresses

The ASA has multiple methods to configure virtual MAC addresses. We recommend using only one method.
If you set the MAC address using multiple methods, the MAC address used depends on many variables, and
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might not be predictable. Manual methods include the interface mode mac-address command, the failover
mac address command, and for Active/Active failover, the failover group mode mac address command, in
addition to autogeneration methods described below.

In multiple context mode, you can configure the ASA to generate virtual active and standby MAC addresses
automatically for shared interfaces, and these assignments are synced to the secondary unit (see the mac-address
auto command). For non-shared interfaces, you can manually set the MAC addresses for Active/Standby
mode (Active/Active mode autogenerates MAC addresses for all interfaces).

For Active/Active failover, virtual MAC addresses are always used, either with default values or with values
you can set per interface.

Intra- and Inter-Chassis Module Placement for the ASA Services Module

You can place the primary and secondary ASASMs within the same switch or in two separate switches.

Intra-Chassis Failover

If you install the secondary ASASM in the same switch as the primary ASASM, you protect against
module-level failure.

Even though both ASASMs are assigned the same VLANS, only the active module takes part in networking.
The standby module does not pass any traffic.

The following figure shows a typical intra-switch configuration.

Figure 53: Intra-Switch Failover
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Inter-Chassis Failover

To protect against switch-level failure, you can install the secondary ASASM in a separate switch. The ASASM
does not coordinate failover directly with the switch, but it works harmoniously with the switch failover
operation. See the switch documentation to configure failover for the switch.

For the best reliability of failover communications between ASASMs, we recommend that you configure an
EtherChannel trunk port between the two switches to carry the failover and state VLANS.

For other VLANSs, you must ensure that both switches have access to all firewall VLANS, and that monitored
VLANS can successfully pass hello packets between both switches.

The following figure shows a typical switch and ASASM redundancy configuration. The trunk between the
two switches carries the failover ASASM VLANs (VLANs 10 and 11).

Note ASASM failover is independent of the switch failover operation; however, ASASM works in any switch
failover scenario.

Figure 54: Normal Operation
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If the primary ASASM fails, then the secondary ASASM becomes active and successfully passes the firewall
VLAN:S.
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Figure 55: ASASM Failure
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Inter-Chassis Failover .

If the entire switch fails, as well as the ASASM (such as in a power failure), then both the switch and the

ASASM fail over to their secondary units.

ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8 .



. Stateless and Stateful Failover

Figure 56: Switch Failure
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Stateless and Stateful Failover

The ASA supports two types of failover, stateless and stateful for both the Active/Standby and Active/Active

modes.

\}
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Note

Some configuration elements for clientless SSL VPN (such as bookmarks and customization) use the VPN

failover subsystem, which is part of Stateful Failover. You must use Stateful Failover to synchronize these
elements between the members of the failover pair. Stateless failover is not recommended for clientless SSL

VPN.

Stateless Failover

When a failover occurs, all active connections are dropped. Clients need to reestablish connections when the
new active unit takes over.
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Note

Stateful Failover

Supported Features

Some configuration elements for clientless SSL VPN (such as bookmarks and customization) use the VPN
failover subsystem, which is part of Stateful Failover. You must use Stateful Failover to synchronize these
elements between the members of the failover pair. Stateless (regular) failover is not recommended for clientless
SSL VPN.

When Stateful Failover is enabled, the active unit continually passes per-connection state information to the
standby unit, or in Active/Active failover, between the active and standby failover groups. After a failover
occurs, the same connection information is available at the new active unit. Supported end-user applications
are not required to reconnect to keep the same communication session.

For Stateful Failover, the following state information is passed to the standby ASA:
* NAT translation table.

* TCP and UDP connections and states. Other types of IP protocols, and ICMP, are not parsed by the active
unit, because they get established on the new active unit when a new packet arrives.

» The HTTP connection table (unless you enable HTTP replication).

» The HTTP connection states (if HTTP replication is enabled)—By default, the ASA does not replicate
HTTP session information when Stateful Failover is enabled. We suggest that you enable HTTP replication.

* SCTP connection states. However, SCTP inspection stateful failover is best effort. During failover, if
any SACK packets are lost, the new active unit will drop all other out of order packets in the queue until
the missing packet is received.

» The ARP table

* The Layer 2 bridge table (for bridge groups)
* The ISAKMP and IPsec SA table

» GTP PDP connection database

» SIP signaling sessions and pin holes.

* ICMP connection state—ICMP connection replication is enabled only if the respective interface is
assigned to an asymmetric routing group.

» Static and dynamic routing tables—Stateful Failover participates in dynamic routing protocols, like OSPF
and EIGRP, so routes that are learned through dynamic routing protocols on the active unit are maintained
in a Routing Information Base (RIB) table on the standby unit. Upon a failover event, packets travel
normally with minimal disruption to traffic because the active secondary unit initially has rules that
mirror the primary unit. Immediately after failover, the re-convergence timer starts on the newly active
unit. Then the epoch number for the RIB table increments. During re-convergence, OSPF and EIGRP
routes become updated with a new epoch number. Once the timer is expired, stale route entries (determined
by the epoch number) are removed from the table. The RIB then contains the newest routing protocol
forwarding information on the newly active unit.
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Note Routes are synchronized only for link-up or link-down events on an active unit.
If the link goes up or down on the standby unit, dynamic routes sent from the
active unit may be lost. This is normal, expected behavior.

* DHCP Server—DHCP address leases are not replicated. However, a DHCP server configured on an
interface will send a ping to make sure an address is not being used before granting the address to a
DHCEP client, so there is no impact to the service. State information is not relevant for DHCP relay or
DDNS.

* Cisco IP SoftPhone sessions—If a failover occurs during an active Cisco IP SoftPhone session, the call
remains active because the call session state information is replicated to the standby unit. When the call
is terminated, the IP SoftPhone client loses connection with the Cisco Call Manager. This connection
loss occurs because there is no session information for the CTIQBE hangup message on the standby unit.
When the IP SoftPhone client does not receive a response back from the Call Manager within a certain
time period, it considers the Call Manager unreachable and unregisters itself.

* RA VPN—Remote access VPN end users do not have to reauthenticate or reconnect the VPN session
after a failover. However, applications operating over the VPN connection could lose packets during the
failover process and not recover from the packet loss.

Unsupported Features
For Stateful Failover, the following state information is not passed to the standby ASA:

* The user authentication (uauth) table

* TCP state bypass connections

* Multicast routing.

* State information for modules, such as the ASA FirePOWER module.

» Selected clientless SSL VPN features:

* Smart Tunnels

* Port Forwarding

* Plugins

* Java Applets

* [Pv6 clientless or Anyconnect sessions

« Citrix authentication (Citrix users must reauthenticate after failover)

Bridge Group Requirements for Failover

There are special considerations for failover when using bridge groups.
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Bridge Group Requirements for Appliances, ASAv

When the active unit fails over to the standby unit, the connected switch port running Spanning Tree Protocol
(STP) can go into a blocking state for 30 to 50 seconds when it senses the topology change. To avoid traffic
loss while the port is in a blocking state, you can configure one of the following workarounds depending on
the switch port mode:

» Access mode—Enable the STP PortFast feature on the switch:

interface interface id
spanning-tree portfast

The PortFast feature immediately transitions the port into STP forwarding mode upon linkup. The port
still participates in STP. So if the port is to be a part of the loop, the port eventually transitions into STP
blocking mode.

* Trunk mode—Block BPDUs on the ASA on a bridge group's member interfaces with an EtherType
access rule.

access-list id ethertype deny bpdu
access-group id in interface namel
access-group id in interface name?2

Blocking BPDUs disables STP on the switch. Be sure not to have any loops involving the ASA in your
network layout.

If neither of the above options are possible, then you can use one of the following less desirable workarounds
that impacts failover functionality or STP stability:

* Disable interface monitoring.

* Increase interface holdtime to a high value that will allow STP to converge before the ASAs fail over.

* Decrease STP timers to allow STP to converge faster than the interface holdtime.

Bridge Group Requirements for the ASA Services Module

To avoid loops when you use failover with bridge groups, you should allow BPDUs to pass (the default), and
you must use switch software that supports BPDU forwarding.

Loops can occur if both modules are active at the same time, such as when both modules are discovering each
other’s presence, or due to a bad failover link. Because the ASASMs bridge packets between the same two
VLAN:S, loops can occur when packets between bridge group member interfaces get endlessly replicated by
both ASASMs. The spanning tree protocol can break such loops if there is a timely exchange of BPDUs. To
break the loop, BPDUs sent between VLAN 200 and VLAN 201 need to be bridged.
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Figure 57: Bridge Group Loop
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Failover Health Monitoring

The ASA monitors each unit for overall health and for interface health. This section includes information
about how the ASA performs tests to determine the state of each unit.

Unit Health Monitoring

The ASA determines the health of the other unit by monitoring the failover link with hello messages. When
aunit does not receive three consecutive hello messages on the failover link, the unit sends LANTEST messages
on each data interface, including the failover link, to validate whether or not the peer is responsive. For the

Firepower 9300 and 4100 series, you can enable Bidirectional Forwarding Detection (BFD) monitoring, which
is more reliable than hello messages. The action that the ASA takes depends on the response from the other

unit. See the following possible actions:

« If the ASA receives a response on the failover link, then it does not fail over.

« I[f the ASA does not receive a response on the failover link, but it does receive a response on a data
interface, then the unit does not failover. The failover link is marked as failed. You should restore the
failover link as soon as possible because the unit cannot fail over to the standby while the failover link
is down.

* If the ASA does not receive a response on any interface, then the standby unit switches to active mode
and classifies the other unit as failed.

Interface Monitoring

You can monitor up to 1025 interfaces (in multiple context mode, divided between all contexts). You should
monitor important interfaces. For example in multiple context mode, you might configure one context to
monitor a shared interface: because the interface is shared, all contexts benefit from the monitoring.
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When a unit does not receive hello messages on a monitored interface for 15 seconds (the default), it runs
interface tests. (To change the period, see Configuration > Device Management > High Availability and
Scalability > Failover > Criteria > Failover Poll Times.) If one of the interface tests fails for an interface,
but this same interface on the other unit continues to successfully pass traffic, then the interface is considered
to be failed, and the ASA stops running tests.

If the threshold you define for the number of failed interfaces is met (see Configuration > Device
Management > High Availability and Scalability > Failover > Criteria > Interface Policy), and the
active unit has more failed interfaces than the standby unit, then a failover occurs. If an interface fails on both
units, then both interfaces go into the “Unknown” state and do not count towards the failover limit defined
by failover interface policy.

An interface becomes operational again if it receives any traffic. A failed ASA returns to standby mode if the
interface failure threshold is no longer met.

If you have an ASA FirePOWER module, then the ASA also monitors the health of the module over the
backplane interface. Failure of the module is considered a unit failure and will trigger failover. This setting
is configurable.

If an interface has IPv4 and IPv6 addresses configured on it, the ASA uses the IPv4 addresses to perform the
health monitoring. If an interface has only IPv6 addresses configured on it, then the ASA uses IPv6 neighbor
discovery instead of ARP to perform the health monitoring tests. For the broadcast ping test, the ASA uses
the IPv6 all nodes address (FE02::1).

Interface Tests

Note

If a failed unit does not recover and you believe it should not be failed, you can reset the state by entering the
failover reset command. If the failover condition persists, however, the unit will fail again.

The ASA uses the following interface tests. The duration of each test is approximately 1.5 seconds by default,
or 1/16 of the failover interface holdtime(see Configuration > Device Management > High Availability
and Scalability > Failover > Criteria > Failover Poll Times).

1. Link Up/Down test—A test of the interface status. If the Link Up/Down test indicates that the interface
is down, then the ASA considers it failed, and testing stops. If the status is Up, then the ASA performs
the Network Activity test.

2. Network Activity test—A received network activity test. At the start of the test, each unit clears its received
packet count for its interfaces. As soon as a unit receives any eligible packets during the test, then the
interface is considered operational. If both units receive traffic, then testing stops. If one unit receives
traffic and the other unit does not, then the interface on the unit that does not receive traffic is considered
failed, and testing stops. If neither unit receives traffic, then the ASA starts the ARP test.

3. ARP test—A test for successful ARP replies. Each unit sends a single ARP request for the IP address in
the most recent entry in its ARP table. If the unit receives an ARP reply or other network traffic during
the test, then the interface is considered operational. If the unit does not receive an ARP reply, then the
ASA sends a single ARP request for the IP address in the next entry in the ARP table. If the unit receives
an ARP reply or other network traffic during the test, then the interface is considered operational. If both
units receive traffic, then testing stops. If one unit receives traffic, and the other unit does not, then the
interface on the unit that does not receive traffic is considered failed, and testing stops. If neither unit
receives traffic, then the ASA starts the Broadcast Ping test.
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4. Broadcast Ping test—A test for successful ping replies. Each unit sends a broadcast ping, and then counts
all received packets. If the unit receives any packets during the test, then the interface is considered
operational. If both units receive traffic, then testing stops. If one unit receives traffic, and the other unit
does not, then the interface on the unit that does not receive traffic is considered failed, and testing stops.
If neither unit receives traffic, then testing starts over again with the ARP test. If both units continue to
receive no traffic from the ARP and Broadcast Ping tests, then these tests will continue running in

perpetuity.

Interface Status

Monitored interfaces can have the following status:

» Unknown—Initial status. This status can also mean the status cannot be determined.

» Normal—The interface is receiving traffic.

* Testing—Hello messages are not heard on the interface for five poll times.

* Link Down—The interface or VLAN is administratively down.

* No Link—The physical link for the interface is down.

* Failed—No traffic is received on the interface, yet traffic is heard on the peer interface.

Failover Times

The following events trigger failover in a Firepower high availability pair:

* More than 50% of the Snort instances on the active unit are down.

» Disk space on the active unit is more than 90% full.

» The no failover active command is run on the active unit or the failover active command is run on the
standby unit.

* The active unit has more failed interfaces than the standby unit.

* Interface failure on the active device exceeds the threshold configured.

By default, failure of a single interface causes failover. You can change the default value by configuring
a threshold for the number of interfaces or a percentage of monitored interfaces that must fail for the
failover to occur. If the threshold breaches on the active device, failover occurs. If the threshold breaches

on the standby device, the unit moves to Fail state.

To change the default failover criteria, enter the following command in global configuration mode:

Table 15:

Command

Purpose

hostname

failover interface-policy num [%]

(config)# failover

interface-policy 20%

Changes the default failover criteria.

When specifying a specific number of interfaces,
the num argument can be from 1 to 250.

When specifying a percentage of interfaces, the
num argument can be from 1 to 100.
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Table 16: ASA

If you manually fail over using the CLI or ASDM, or you reload the ASA, the failover starts immediately and
is not subject to the timers listed below.

Failover Condition

Minimum Default Maximum

Active unit loses power, 800 milliseconds 15 seconds 45 seconds

hardware goes down, or the
software reloads or crashes.
When any of these occur, the
monitored interfaces or failover
link do not receives any hello

message.

Active unit main board interface | 500 milliseconds 5 seconds 15 seconds

link down.

Active unit 4GE module 2 seconds 5 seconds 15 seconds

interface link down.

Active unit FirePOWER module | 2 seconds 2 seconds 2 seconds

fails.

Active unit interface up, but 5 seconds 25 seconds 75 seconds

connection problem causes

interface testing.

Configuration Synchronization

Failover includes various types of configuration synchronization.

Running Configuration Replication

Running configuration replication occurs when any one or both of the devices in the failover pair boot.
In Active/Standby failover, configurations are always synchronized from the active unit to the standby unit.

In Active/Active failover, whichever unit boots second obtains the running configuration from the unit that
boots first, regardless of the primary or secondary designation of the booting unit. After both units are up,
commands entered in the system execution space are replicated from the unit on which failover group 1 is in
the active state.

When the standby/second unit completes its initial startup, it clears its running configuration (except for the
failover commands needed to communicate with the active unit), and the active unit sends its entire
configuration to the standby/second unit. When the replication starts, the ASA console on the active unit
displays the message “Beginning configuration replication: Sending to mate,” and when it is complete, the
ASA displays the message “End Configuration Replication to mate.” Depending on the size of the configuration,
replication can take from a few seconds to several minutes.
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On the unit receiving the configuration, the configuration exists only in running memory. You should save
the configuration to flash memory. For example, in Active/Active failover, enter the write memory all
command in the system execution space on the unit that has failover group 1 in the active state. The command
is replicated to the peer unit, which proceeds to write its configuration to flash memory.

Note

N

During replication, commands entered on the unit sending the configuration may not replicate properly to the
peer unit, and commands entered on the unit receiving the configuration may be overwritten by the configuration
being received. Avoid entering commands on either unit in the failover pair during the configuration replication
process.

Note

File Replication

The crypto ca server command and related subcommands are not supported with failover; you must remove
them using the no crypto ca server command.

Configuration syncing does not replicate the following files and configuration components, so you must copy
these files manually so they match:

» AnyConnect images
* CSD images
» AnyConnect profiles

The ASA uses a cached file for the AnyConnect client profile stored in cache:/stc/profiles, and not the
file stored in the flash file system. To replicate the AnyConnect client profile to the standby unit, perform
one of the following:

* Enter the write standby command on the active unit.
* Reapply the profile on the active unit.

* Reload the standby unit.

* Local Certificate Authorities (CAs)
* ASA images
* ASDM images

Command Replication

After startup, commands that you enter on the active unit are immediately replicated on the standby unit.You
do not have to save the active configuration to flash memory to replicate the commands.

In Active/Active failover,changes entered in the system execution space are replicated from the unit on which
failover group 1 is in the active state.

Failure to enter the changes on the appropriate unit for command replication to occur causes the configurations
to be out of synchronization. Those changes may be lost the next time the initial configuration synchronization
occurs.
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The following commands are replicated to the standby ASA:
* All configuration commands except for mode, firewall, and failover lan unit
* copy running-config startup-config
* delete
» mkdir
* rename
« rmdir

* write memory

The following commands are not replicated to the standby ASA:
« All forms of the copy command except for copy running-config startup-config
* All forms of the write command except for write memory
« debug
« failover lan unit
« firewall
* show

- terminal pager and pager

About Active/Standby Failover

Active/Standby failover lets you use a standby ASA to take over the functionality of a failed unit. When the
active unit fails, the standby unit becomes the active unit.

)

Note For multiple context mode, the ASA can fail over the entire unit (including all contexts) but cannot fail over
individual contexts separately.

Primary/Secondary Roles and Active/Standby Status

The main differences between the two units in a failover pair are related to which unit is active and which
unit is standby, namely which IP addresses to use and which unit actively passes traffic.

However, a few differences exist between the units based on which unit is primary (as specified in the
configuration) and which unit is secondary:

* The primary unit always becomes the active unit if both units start up at the same time (and are of equal
operational health).

* The primary unit MAC addresses are always coupled with the active IP addresses. The exception to this
rule occurs when the secondary unit becomes active and cannot obtain the primary unit MAC addresses
over the failover link. In this case, the secondary unit MAC addresses are used.
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Active Unit Determination at Startup

The active unit is determined by the following:

Failover Events

High Availability and Scalability |

* If a unit boots and detects a peer already running as active, it becomes the standby unit.

* If a unit boots and does not detect a peer, it becomes the active unit.

* I[f both units boot simultaneously, then the primary unit becomes the active unit, and the secondary unit
becomes the standby unit.

In Active/Standby failover, failover occurs on a unit basis. Even on systems running in multiple context mode,

you cannot fail over individual or groups of contexts.

The following table shows the failover action for each failure event. For each failure event, the table shows
the failover policy (failover or no failover), the action taken by the active unit, the action taken by the standby
unit, and any special notes about the failover condition and actions.

Table 17: Failover Events

Failure Event

Policy

Active Unit Action

Standby Unit Action

Notes

Active unit failed (power
or hardware)

Failover

n/a

Become active

Mark active as failed

No hello messages are
received on any
monitored interface or the
failover link.

Formerly active unit No failover Become standby No action None.

recovers

Standby unit failed No failover Mark standby as failed |n/a When the standby unit is

(power or hardware) marked as failed, then the
active unit does not
attempt to fail over, even
if the interface failure
threshold is surpassed.

Failover link failed No failover Mark failover link as Mark failover link as You should restore the

during operation failed failed failover link as soon as

possible because the unit
cannot fail over to the
standby unit while the
failover link is down.

Failover link failed at
startup

No failover

Become active

Mark failover link as
failed

Become active

Mark failover link as
failed

If the failover link is
down at startup, both
units become active.

State link failed

No failover

No action

No action

State information
becomes out of date, and
sessions are terminated if
a failover occurs.
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Failure Event Policy Active Unit Action Standby Unit Action Notes

Interface failure on active | Failover Mark active as failed Become active None.

unit above threshold

Interface failure on No failover No action Mark standby as failed | When the standby unit is

standby unit above
threshold

marked as failed, then the
active unit does not
attempt to fail over even
if the interface failure
threshold is surpassed.

About Active/Active Failover

This section describes Active/Active failover.

Active/Active Failover Overview

In an Active/Active failover configuration, both ASAs can pass network traffic. Active/Active failover is only
available to ASAs in multiple context mode. In Active/Active failover, you divide the security contexts on
the ASA into a maximum of 2 failover groups.

A failover group is simply a logical group of one or more security contexts. You can assign failover group to
be active on the primary ASA, and failover group 2 to be active on the secondary ASA. When a failover
occurs, it occurs at the failover group level. For example, depending on interface failure patterns, it is possible
for failover group 1 to fail over to the secondary ASA, and subsequently failover group 2 to fail over to the
primary ASA. This event could occur if the interfaces in failover group 1 are down on the primary ASA but
up on the secondary ASA, while the interfaces in failover group 2 are down on the secondary ASA but up on
the primary ASA.

The admin context is always a member of failover group 1. Any unassigned security contexts are also members
of failover group 1 by default. If you want Active/Active failover, but are otherwise uninterested in multiple
contexts, the simplest configuration would be to add one additional context and assign it to failover group 2.

When configuring Active/Active failover, make sure that the combined traffic for both units is within the
capacity of each unit.

Note

You can assign both failover groups to one ASA if desired, but then you are not taking advantage of having
two active ASAs.

Primary/Secondary Roles and Active/Standby Status for a Failover Group

As in Active/Standby failover, one unit in an Active/Active failover pair is designated the primary unit, and
the other unit the secondary unit. Unlike Active/Standby failover, this designation does not indicate which
unit becomes active when both units start simultaneously. Instead, the primary/secondary designation does
two things:
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* The primary unit provides the running configuration to the pair when they boot simultaneously.

* Each failover group in the configuration is configured with a primary or secondary unit preference. When
used with preemption, this preference ensures that the failover group runs on the correct unit after it starts
up. Without preemption, both groups run on the first unit to boot up.

Active Unit Determination for Failover Groups at Startup

The unit on which a failover group becomes active is determined as follows:

* When a unit boots while the peer unit is not available, both failover groups become active on the unit.

* When a unit boots while the peer unit is active (with both failover groups in the active state), the failover
groups remain in the active state on the active unit regardless of the primary or secondary preference of
the failover group until one of the following occurs:

* A failover occurs.
* A failover is manually forced.

* A preemption for the failover group is configured, which causes the failover group to automatically
become active on the preferred unit when the unit becomes available.

Failover Events

In an Active/Active failover configuration, failover occurs on a failover group basis, not a system basis. For
example, if you designate both failover groups as Active on the primary unit, and failover group 1 fails, then
failover group 2 remains Active on the primary unit while failover group 1 becomes active on the secondary
unit.

Because a failover group can contain multiple contexts, and each context can contain multiple interfaces, it
is possible for all interfaces in a single context to fail without causing the associated failover group to fail.

The following table shows the failover action for each failure event. For each failure event, the policy (whether
or not failover occurs), actions for the active failover group, and actions for the standby failover group are

given.

Table 18: Failover Events

Failure Event Policy Active Group Action Standby Group Action | Notes

A unit experiences a Failover Become standby Become active When a unit in a failover

ft fail . . . ir fail ti

powerorsottware fatiure Mark as failed Mark active as failed palr 1al’s, any active
failover groups on that
unit are marked as failed
and become active on the
peer unit.

Interface failure on active | Failover Mark active group as Become active None.

failover group above failed

threshold
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Failure Event Policy Active Group Action Standby Group Action | Notes

Interface failure on No failover No action Mark standby group as | When the standby

standby failover group failed failover group is marked

above threshold as failed, the active
failover group does not
attempt to fail over, even
if the interface failure
threshold is surpassed.

Formerly active failover | No failover No action No action Unless failover group

group recovers

preemption is configured,
the failover groups
remain active on their
current unit.

Failover link failed at No failover Become active

startup

Become active

If the failover link is
down at startup, both
failover groups on both
units become active.

State link failed No failover No action

No action

State information
becomes out of date, and
sessions are terminated if
a failover occurs.

Failover link failed No failover n/a

during operation

n/a

Each unit marks the
failover link as failed.
You should restore the
failover link as soon as
possible because the unit
cannot fail over to the
standby unit while the
failover link is down.

Licensing for Failover

Failover units do not require the same license on each unit. If you have licenses on both units, they combine
into a single running failover cluster license. There are some exceptions to this rule. See the following table

for precise licensing requirements for failover.

Model

License Requirement

ASA 5506-X and ASA 5506W-X

Note

* Active/Active—No Support.

* Active/Standby—Security Plus License.

Each unit must have the same encryption license.
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Model

License Requirement

ASA 5512-X through ASA 5555-X

* ASA 5512-X—Security Plus License.

e Other models—Base License.

Note * Each unit must have the same encryption license.

* In multiple context mode, each unit must have the
the same AnyConnect Apex license.

* Each unit must have the same IPS module license.
You also need the IPS signature subscription on
the IPS side for both units. See the following
guidelines:

* To buy the IPS signature subscription you
need to have the ASA with IPS pre-installed
(the part number must include “IPS”, for
example ASA5525-1PS-K9); you cannot buy
the IPS signature subscription for a non-1PS
part number ASA.

You need the IPS signature subscription on
both units; this subscription is not shared in
failover, because it is not an ASA license.

The IPS signature subscription requires a
unique IPS module license per unit. Like
other ASA licenses, the IPS module license
is technically shared in the failover cluster
license. However, because of the IPS
signature subscription requirements, you
must buy a separate IPS module license for
each unit in.

ASAv See Failover Licenses for the ASAv, on page 150.

Firepower 2100 See Failover Licenses for the Firepower 2100, on page 150.

Firepower 4100/9300 See Failover Licenses for the ASA on the Firepower 4100/9300
Chassis, on page 151.

All other models Base License or Standard License.

Note * Each unit must have the same encryption license.

* In multiple context mode, each unit must have the
the same AnyConnect Apex license.
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Note A valid permanent key is required; in rare instances, your PAK authentication key can be removed. If your
key consists of all 0’s, then you need to reinstall a valid authentication key before failover can be enabled.

Guidelines for Failover

Context Mode

* Active/Active mode is supported only in multiple context mode.

* For multiple context mode, perform all steps in the system execution space unless otherwise noted.

Model Support

» ASA 5506 W-X—You must disable interface monitoring for the internal GigabitEthernet 1/9 interface.
These interfaces will not be able to communicate to perform the default interface monitoring checks,
resulting in a switch from active to standby and back again because of expected interface communication
failures.

* Firepower 9300—We recommend that you use inter-chassis Failover for the best redundancy.

» The ASAv on public cloud networks such as Microsoft Azure and Amazon Web Services are not supported
with regular Failover because Layer 2 connectivity is required.

* The ASA FirePOWER module does not support failover directly; when the ASA fails over, any existing
ASA FirePOWER flows are transferred to the new ASA. The ASA FirePOWER module in the new ASA
begins inspecting the traffic from that point forward; old inspection states are not transferred.

You are responsible for maintaining consistent policies on the ASA FirePOWER modules in the
high-availability ASA pair to ensure consistent failover behavior.

A\

Note Create the failover pair before you configure the ASA FirePOWER modules. If
the modules are already configured on both devices, clear the interface
configuration on the standby device before creating the failover pair. From the
CLI on the standby device, enter the clear configure interface command.

ASAv Failover for High Availability

When creating a failover pair with the ASAv, it is necessary to add the data interfaces to each ASAv in the
same order. If the exact same interfaces are added to each ASAv, but in different order, errors may be presented
at the ASAv Console. Failover functionality may also be affected

Additional Guidelines

* When the active unit fails over to the standby unit, the connected switch port running Spanning Tree
Protocol (STP) can go into a blocking state for 30 to 50 seconds when it senses the topology change. To
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avoid traffic loss while the port is in a blocking state, you can enable the STP PortFast feature on the
switch:

interface interface id spanning-tree portfast

This workaround applies to switches connected to both routed mode and bridge group interfaces. The
PortFast feature immediately transitions the port into STP forwarding mode upon linkup. The port still
participates in STP. So if the port is to be a part of the loop, the port eventually transitions into STP
blocking mode.

* You cannot enable failover if a local CA server is configured. Remove the CA configuration using the
no crypto ca server command.

* Configuring port security on the switches connected to the ASA failover pair can cause communication
problems when a failover event occurs. This problem occurs when a secure MAC address configured or
learned on one secure port moves to another secure port, a violation is flagged by the switch port security
feature.

* You can monitor up to 1025 interfaces on a unit, across all contexts.

* For Active/Standby Failover and a VPN IPsec tunnel, you cannot monitor both the active and standby
units using SNMP over the VPN tunnel. The standby unit does not have an active VPN tunnel, and will
drop traffic destined for the NMS. You can instead use SNMPv3 with encryption so the IPsec tunnel is
not required.

* For Active/Active failover, no two interfaces in the same context should be configured in the same ASR
group.

* For Active/Active failover, you can define a maximum of two failover groups.

* For Active/Active failover, when removing failover groups, you must remove failover group 1 last.
Failover group1 always contains the admin context. Any context not assigned to a failover group defaults
to failover group 1. You cannot remove a failover group that has contexts explicitly assigned to it.

» Immediately after failover, the source address of syslog messages will be the failover interface address
for a few seconds.

» When using SNMPv3 with failover, if you replace a failover unit, then SNMPv3 users are not replicated
to the new unit. You must re-add the SNMPv3 users to the active unit to force the users to replicate to
the new unit; or you can add the users directly on the new unit. Reconfigure each user by entering the
snmp-server user username group-name v3 command on the active unit or directly to the standby unit
with the priv-password option and auth-password option in their unencrypted forms.

Defaults for Failover

By default, the failover policy consists of the following:
* No HTTP replication in Stateful Failover.
* A single interface failure causes failover.
* The interface poll time is 5 seconds.
* The interface hold time is 25 seconds.

* The unit poll time is 1 second.
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 The unit hold time is 15 seconds.

* Virtual MAC addresses are disabled in multiple context mode, except for the ASASM, where they are
enabled by default.

* Monitoring on all physical interfaces, or for the ASASM, all VLAN interfaces.

Configure Active/Standby Failover

To configure Active/Standby failover, configure basic failover settings on both the primary and secondary
units. All other configuration occurs only on the primary unit, and is then synched to the secondary unit.

The High Availability and Scalability Wizard guides you through a step-by-step process of creating an
Active/Standby failover configuration.

Procedure

Step 1 Choose Wizards > High Availability and Scalability. See select wizard guidelines in the following steps.

Step 2 On the Failover Peer Connectivity and Compatibility screen, enter the IP address of the peer unit. This
address must be an interface that has ASDM access enabled on it.

By default, the peer address is assigned to be the standby address for the ASDM management interface.
Step 3 On the LAN Link Configuration screen:

* Interface—The interface can be a data physical interface, subinterface, redundant interface, or
EtherChannel interface ID. On the ASASM, the interface is a VLAN ID. For the ASA 5506H-X only,
you can specify the Management 1/1 interface as the failover link. If you do so, you must save the
configuration, and then reload the device. You then cannot use this interface for failover and also use
the ASA Firepower module; the module requires the interface for management, and you can only use it
for one function. For the Firepower 4100/9300, you can use any data-type interface.

* Active IP Address—This IP address should be on an unused subnet. This subnet can be 31-bits
(255.255.255.254) with only two IP addresses. 169.254.0.0/16 and £d00:0:0:*::/64 are internally used
subnets, and you cannot use them for the failover or state links.

» Standby IP Address—This IP address must be on the same network as the active IP address.

* (Optional) Communications Encryption—Encrypt communications on the failover link. Note: Instead
of a Secret Key, we recommend using an IPsec preshared key, which you can configure after you exit
the wizard (see Modify the Failover Setup, on page 307).

Step 4 On the State Link Configuration screen, if you choose another interface for Stateful Failover:

» Active IP Address—This IP address should be on an unused subnet, different from the failover link.
This subnet can be 31-bits (255.255.255.254) with only two IP addresses. 169.254.0.0/16 and
£d00:0:0:*::/64 are internally used subnets, and you cannot use them for the failover or state links.

« Standby IP Address—This IP address must be on the same network as the active IP address.

Step 5 After you click Finish, the wizard shows the Waiting for Config Sync screen.
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After the specified time period is over, the wizard sends the failover configuration to the secondary unit, and
you see an information screen showing that failover configuration is complete.

* If you do not know if failover is already enabled on the secondary unit, then wait for the specified period.
« If you know failover is already enabled, click Skip configuring peer.

* If you know the secondary unit is not yet failover-enabled, click Stop waiting xx more seconds, and the
failover bootstrap configuration is sent to the secondary unit immediately.

Configure Active/Active Failover

Step 1
Step 2

Step 3

Step 4

Step 5

This section tells how to configure Active/Active failover.

The High Availability and Scalability Wizard guides you through a step-by-step process of creating an
Active/Active failover configuration.

Procedure

Choose Wizards > High Availability and Scalability. See select wizard guidelines in the following steps.

In the Failover Peer Connectivity and Compatibility Check screen, the peer IP address must be an interface
that has ASDM access enabled on it.

By default, the peer address is assigned to be the standby address for the interface to which ASDM is connected.

In the Security Context Configuration screen, if you converted to multiple context mode as part of the
wizard, you will only see the admin context. You can add other contexts after you exit the wizard.

On the LAN Link Configuration screen:

* Interface—The interface can be a data physical interface, subinterface, redundant interface, or
EtherChannel interface ID. On the ASASM, the interface ID is a VLAN ID. For the ASA 5506H-X only,
you can specify the Management 1/1 interface as the failover link. If you do so, you must save the
configuration, and then reload the device. You then cannot use this interface for failover and also use
the ASA Firepower module; the module requires the interface for management, and you can only use it
for one function. For the Firepower 4100/9300, you can use any data-type interface.

* Active IP Address—This IP address should be on an unused subnet. This subnet can be 31-bits
(255.255.255.254) with only two IP addresses. 169.254.0.0/16 and fd00:0:0:*::/64 are internally used
subnets, and you cannot use them for the failover or state links.

« Standby IP Address—This IP address must be on the same network as the active IP address.

* (Optional) Communications Encryption—Encrypt communications on the failover link. Note: Instead
of a Secret Key, we recommend using an IPsec preshared key, which you can configure after you exit
the wizard (see Modify the Failover Setup, on page 307).

On the State Link Configuration screen, if you choose another interface for Stateful Failover:
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* Active IP Address—This IP address should be on an unused subnet, different from the failover link.
This subnet can be 31-bits (255.255.255.254) with only two IP addresses. 169.254.0.0/16 and
£d00:0:0:*::/64 are internally used subnets, and you cannot use them for the failover or state links.

« Standby IP Address—This IP address must be on the same network as the active IP address.

Step 6 After you click Finish, the wizard shows the Waiting for Config Sync screen.

After the specified time period is over, the wizard sends the failover configuration to the secondary unit, and
you see an information screen showing that failover configuration is complete.

* If you do not know if failover is already enabled on the secondary unit, then wait for the specified period.
« If you know failover is already enabled, click Skip configuring peer.

» If you know the secondary unit is not yet failover-enabled, click Stop waiting xx more seconds, and the
failover bootstrap configuration is sent to the secondary unit immediately.

Configure Optional Failover Parameters

You can customize failover settings as desired.

Configure Failover Criteria and Other Settings

See Defaults for Failover, on page 298 for the default settings for many parameters that you can change in this
section. For Active/Active mode, you set most criteria per failover group. This section includes enabling
HTTP replication per failover group for Active/Active mode; to configure HTTP replication for Active/Standby
mode, see Modify the Failover Setup, on page 307.

Before you begin

* Configure these settings in the system execution space in multiple context mode.

* For Bidirectional Forwarding Detection (BFD) for unit health monitoring, see the following limitations:
* Firepower 9300 and 4100 only.
* Active/Standby only.

* Routed mode only

Procedure
Step 1 Choose Configuration > Device Management > High Availability and Scalability > Failover.
Step 2 Disable the ability to make any configuration changes directly on the standby unit or context: on the Setup

tab check the Disable configuration changes on the standby unit check box.

By default, configurations on the standby unit/context are allowed with a warning message.
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Step 3

Step 4
Step 5

Step 6
Step 7

Step 8

Step 9

Under BFD Health Check, click Manage to define a BFD template to be used for failover health detection.
The regular unit monitoring can cause false alarms when CPU usage is high. The BFD method is distributed,
so high CPU does not affect its operation.

The Configuration > Device Setup > Routing > BFD > Template page opens. Click Add to create a single
hop template; multi-hop is not supported. For the interval settings, you can specify milliseconds; microseconds
are not supported. For template details, see Create the BFD Template, on page 681.

Click the Criteria tab.

Configure the unit poll times:
In the Failover Poll Times area:

* Unit Failover—The amount of time between hello messages among units. The range is between 1 and
15 seconds or between 200 and 999 milliseconds.

* Unit Hold Time—Sets the time during which a unit must receive a hello message on the failover link,
or else the unit begins the testing process for peer failure. The range is between land 45 seconds or
between 800 and 999 milliseconds. You cannot enter a value that is less than 3 times the polltime.

Note Other settings on this pane apply only to Active/Standby mode. In Active/Active mode, you must
configure the rest of the parameters per failover group.

(Active/Active mode only) Click the Active/Active tab, then choose a failover group and click Edit.

(Active/Active mode only) Change the preferred role of the failover group when used with preemption: click
either Primary or Secondary.

If you used the wizard, failover group 1 is assigned to the primary unit, and failover group 2 is assigned to
the secondary unit. If you want a non-standard configuration, you can specify different unit preferences if
desired. These settings are only used in conjunction with the preempt setting. Both failover groups become
active on the unit that boots first (even if it seems like they boot simultaneously, one unit becomes active
first), despite the primary or secondary setting for the group.

(Active/Active mode only) Configure failover group preemption: check the Preempt after booting with
optional delay of check box.

Both failover groups become active on the unit that boots first (even if it seems like they boot simultaneously,
one unit becomes active first), despite the primary or secondary setting for the group.

You can enter an optional delay value, which specifies the number of seconds the failover group remains
active on the current unit before automatically becoming active on the designated unit. Valid values are from
1 to 1200.

If you manually fail over, the Peempt option is ignored.

Note If Stateful Failover is enabled, the preemption is delayed until the connections are replicated from
the unit on which the failover group is currently active.

Configure the Interface Policy:

» Number of failed interfaces that triggers failover—Define a specific number of interfaces that must
fail to trigger failover, from 1 to 250. When the number of failed monitored interfaces exceeds the value
you specify, the ASA fails over.
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* Percentage of failed interfaces that triggers failover—Define a percentage of configured interfaces
that must fail to trigger failover. When the number of failed monitored interfaces exceeds the percentage
you set, the ASA fails over.

Note Do not use the Use system failover interface policy option. You can only set the policy per group
at this time.

Step 10 (Active/Standby mode) Configure interface poll times:
In the Failover Poll Time area:

» Monitored Interfaces—Specifies the interface polltime: how long to wait between sending hello packets
to the peer. The range is between land 15 seconds or 500 to 999 milliseconds. The default is 5 seconds.

» Link State—By default, each ASA in a failover pair checks the link state of its interfaces every 500
msec. You can customize the polltime; for example, if you set the polltime to 300 msec, the ASA can
detect an interface failure and trigger failover faster. The range is between 300 and 799 milliseconds.

* Interface Hold Time—Sets the time (as a calculation) between the last-received hello message from
the peer unit and the commencement of interface tests to determine the health of the interface. It also
sets the duration of each interface test as holdtime/16. Valid values are from 5 to 75 seconds. The default
is 5 times the polltime. You cannot enter a holdtime value that is less than five times the polltime.

To calculate the time before starting interface tests (y):

a. x=(holdtime/polltime)/2, rounded to the nearest integer. (.4 and down rounds down; .5 and up rounds
up.)

b. y=x*polltime
For example, if you use the default holdtime of 25 and polltime of 5, then y = 15 seconds.

For Active/Active mode, configure interface poll times on the Add/Edit Failover Group dialog box.

Step 11 (Active/Active mode only) Enable HTTP replication: check the Enable HTTP replication check box.
See Modify the Failover Setup, on page 307 section for the session replication rate.

Note Because of a delay when deleting HTTP flows from the standby unit when using failover, the show
conn count output might show different numbers on the active unit vs. the standby unit; if you wait
several seconds and re-issue the command, you will see the same count on both units.

Step 12 Configure virtual MAC addresses:
* Active/Standby mode—click the MAC Addresses tab, and click Add.
The Add/Edit Interface MAC Address dialog box appears.

» Active/Active mode—Go to the bottom of the Active/Active tab.

You can also set the MAC address using other methods, but we recommend using only one method. If you
set the MAC address using multiple methods, the MAC address used depends on many variables, and might
not be predictable.

a) Choose an interface from the Physical Interface drop-down list.
b) In the Active MAC Address field, type the new MAC address for the active interface.
¢) Inthe Standby MAC Address field, type the new MAC address for the standby interface.
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Step 13

d) Click OK. (Active/Active mode only) Click OK again.
Click Apply.

Configure Interface Monitoring and Standby Addresses

Step 1

Step 2

By default, monitoring is enabled on all physical interfaces, or for the ASASM, all VLAN interfaces, and on
any hardware or software modules installed on the ASA, such as the ASA FirePOWER module.

You might want to exclude interfaces attached to less critical networks from affecting your failover policy.
You can monitor up to 1025 interfaces on a unit (across all contexts in multiple context mode).

If you did not configure the standby IP addresses in the wizard, you can configure them manually.

Before you begin

In multiple context mode, configure interfaces within each context.

Procedure

In single mode, choose Configuration > Device Management > High Availability > Failover >
Interfaces.

In multiple context mode, within a context choose Configuration > Device Management > Failover >
Interfaces

Criteria  MAC Addresses

Define interface standby IP addresses and monitoring status. Double-click on a standby address or
click on a monitoring checkbox to edit it. Press the Tab or Enter key after editing an address.

Subnet Mask/
Prefix Length

255.255.252.0

Interface Name Name Active IP Address

Standby IP Address  Monitored
[ I El 10.86.118.12

[10.86.118.13| -3
GigabitEthernet0/4 ccl
Manage mentd /0 mgmt @

370108

A list of configured interfaces appears as well as any installed hardware or software modules, such as the
ASA FirePOWER module. The Monitored column displays whether or not an interface is monitored as part
of your failover criteria. If it is monitored, a check appears in the Monitored check box.

If you do not want a hardware or software module failure to trigger failover, you can disable module monitoring.
Note that for the ASA 5585-X, if you disable monitoring of the service module, you may also want to disable
monitoring of the interfaces on the module, which are monitored separately.

The IP address for each interface appears in the Active IP Address column. If configured, the standby IP
address for the interface appears in the Standby IP Address column. The failover link and state link do not
display IP address; you cannot change those addresses from this tab.

To disable monitoring of a listed interface, uncheck the Monitored check box for the interface.
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Step 3
Step 4

Step 5

Configure Support for Asymmetrically Routed Packets (Active/Active Mode) .

To enable monitoring of a listed interface, check the Monitored check box for the interface.

For each interface that does not have a standby IP address, double-click the Standby IP Address field and
enter an [P address into the field.

If you use a 31-bit subnet mask for point-to-point connections, do not configure a standby IP address.

Click Apply.

Configure Support for Asymmetrically Routed Packets (Active/Active Mode)

\}

When running in Active/Active failover, a unit might receive a return packet for a connection that originated
through its peer unit. Because the ASA that receives the packet does not have any connection information for
the packet, the packet is dropped. This drop most commonly occurs when the two ASAs in an Active/Active
failover pair are connected to different service providers and the outbound connection does not use a NAT
address.

You can prevent the return packets from being dropped by allowing asymmetrically routed packets. To do
s0, you assign the similar interfaces on each ASA to the same ASR group. For example, both ASAs connect
to the inside network on the inside interface, but connect to separate ISPs on the outside interface. On the
primary unit, assign the active context outside interface to ASR group 1; on the secondary unit, assign the
active context outside interface to the same ASR group 1. When the primary unit outside interface receives
a packet for which it has no session information, it checks the session information for the other interfaces in
standby contexts that are in the same group; in this case, ASR group 1. If it does not find a match, the packet
is dropped. If it finds a match, then one of the following actions occurs:

» If the incoming traffic originated on a peer unit, some or all of the layer 2 header is rewritten and the
packet is redirected to the other unit. This redirection continues as long as the session is active.

* If the incoming traffic originated on a different interface on the same unit, some or all of the layer 2
header is rewritten and the packet is reinjected into the stream.

Note

This feature does not provide asymmetric routing; it restores asymmetrically routed packets to the correct
interface.

The following figure shows an example of an asymmetrically routed packet.
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Figure 58: ASR Example
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1. An outbound session passes through the ASA with the active SecAppA context. It exits interface outside
ISP-A (192.168.1.1).

2. Because of asymmetric routing configured somewhere upstream, the return traffic comes back through
the interface outsideISP-B (192.168.2.2) on the ASA with the active SecAppB context.

3. Normally the return traffic would be dropped because there is no session information for the traffic on
interface 192.168.2.2. However, the interface is configured as part of ASR group 1. The unit looks for
the session on any other interface configured with the same ASR group ID.

4. The session information is found on interface outsideISP-A (192.168.1.2), which is in the standby state
on the unit with SecAppB. Stateful Failover replicated the session information from SecAppA to SecAppB.

5. Instead of being dropped, the layer 2 header is rewritten with information for interface 192.168.1.1 and
the traffic is redirected out of the interface 192.168.1.2, where it can then return through the interface on
the unit from which it originated (192.168.1.1 on SecAppA). This forwarding continues as needed until
the session ends.

Before you begin

« Stateful Failover—Passes state information for sessions on interfaces in the active failover group to the
standby failover group.

* Replication HTTP—HTTP session state information is not passed to the standby failover group, and
therefore is not present on the standby interface. For the ASA to be able to re-route asymmetrically routed
HTTP packets, you need to replicate the HTTP state information.

* Perform this procedure within each active context on the primary and secondary units.

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8



| High Availability and Scalability

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6
Step 7

Manage Failover .

* You cannot configure both ASR groups and traffic zones within a context. If you configure a zone in a
context, none of the context interfaces can be part of an ASR group.

Procedure

On the primary unit active context, choose Configuration > Device Setup > Routing > ASR Groups.

For the interface that receives asymmetrically routed packets, choose an ASR Group ID from the drop-down
list.

Click Apply to save your changes to the running configuration.

Connect ASDM to the secondary unit, and choose the active context similar to the primary unit context.
Choose Configuration > Device Setup > Routing > ASR Groups.

For the similar interface on this unit, choose the same ASR Group ID.

Click Apply to save your changes to the running configuration.

Manage Failover

This section describes how to manage Failover units after you enable Failover, including how to change the
Failover setup and how to force failover from one unit to another.

Modify the Failover Setup

Step 1

Step 2

If you do not use the wizard, or want to change a setting, you can configure the failover setup manually. This
section also includes the following options that are not included in the wizard, so you must configure them
manually:

* [Psec preshared key for encrypting failover traffic
* HTTP replication rate
* HTTP replication (Active/Standby mode)

Before you begin

In multiple context mode, perform this procedure in the System execution space.

Procedure

In single mode, choose Configuration > Device Management > High Availability and Scalability >
Failover > Setup.

In multiple context mode, choose Configuration > Device Management > Failover > Setup in the System
execution space.

Check the Enable Failover check box.
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Note Failover is not actually enabled until you apply your changes to the device.

Step 3 To encrypt communications on the failover and state links, use one of the following options:

* IPsec Preshared Key (preferred)—The preshared key is used by IKEv2 to establish IPsec LAN-to-LAN
tunnels on the failover links between the failover units. Note: failover LAN-to-LAN tunnels do not count
against the IPsec (Other VPN) license.

* Secret Key—Enter the secret key used to encrypt failover communication. If you leave this field blank,
failover communication, including any passwords or keys in the configuration that are sent during
command replication, will be in clear text.

Use 32 hexadecimal character key—To use a 32-hexadecimal key for the secret key, check this check
box.

Step 4 In the LAN Failover area, set the following parameters for the failover link:

« Interface—Choose the interface to use for the failover link. Failover requires a dedicated interface,
however you can share the interface with Stateful Failover.

Only unconfigured interfaces or subinterfaces are displayed in this list and can be selected as the failover
link. Once you specify an interface as the failover link, you cannot edit that interface in the Configuration >
Interfaces pane.

+ Logical Name—Specify the logical name of the interface used for failover communication, such as
“failover”. This name is informational.

« Active IP—Specify the active IP address for the interface. The IP address can be either an IPv4 or an
IPv6 address. This IP address should be on an unused subnet.

» Standby IP—Specify the standby IP address for the interface, on the same subnet as the active IP address.
* Subnet Mask—Specify the subnet mask.

* Preferred Role—Select Primary or Secondary to specify whether the preferred role for this ASA is
as the primary or secondary unit.

Step 5 (Optional) Configure the state link by doing the following:

« Interface—Choose the interface to use for the state link. You can choose an unconfigured interface or
subinterface, the failover link, or the --Use Named-- option.

Note We recommend that you use two separate, dedicated interfaces for the failover link and the
state link.
If you choose an unconfigured interface or subinterface, you must supply the Active IP, Subnet Mask,

Logical Name, and Standby IP for the interface.

If you choose the failover link, you do not need to specify the Active IP, Subnet Mask, Logical Name,
and Standby IP values; the values specified for the failover link are used.

If you choose the --Use Named-- option, the Logical Name field becomes a drop-down list of named
interfaces. Choose the interface from this list. The Active IP, Subnet Mask/Prefix Length, and Standby
IP values do not need to be specified. The values specified for the interface are used.

* Logical Name—Specify the logical name of the interface used for state communication, such as “state”.
This name is informational.
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* Active IP—Specify the active IP address for the interface. The IP address can be either an IPv4 or an
IPv6 address. This IP address should be on an unused subnet, different from the failover link.

» Standby IP—Specify the standby IP address for the interface, on the same subnet as the active IP address.
* Subnet Mask—Specify the subnet mask.

* (Optional, Active/Standby only) Enable HTTP Replication—This option enables Stateful Failover to
copy active HTTP sessions to the standby firewall. If you do not allow HTTP replication, then HTTP
connections are disconnected in the event of a failover. In Active/Active mode, set the HTTP replication
per failover group.

Note Because of a delay when deleting HTTP flows from the standby unit when using failover, the
show conn count output might show different numbers on the active unit vs. the standby unit;
if you wait several seconds and re-issue the command, you will see the same count on both
units.

Step 6 In the Replication area, set the session replication rate in connections per second. The minimum and maximum
rates are determined by your model. The default is the maximum rate. To use the default, check the Use
Default check box.

Step 7 Click Apply.

The configuration is saved to the device.

Step 8 If you are enabling failover, you see a dialog box to configure the failover peer.

* Click No if you want to connect to the failover peer later and configure the matching settings manually.

* Click Yes to let ASDM automatically configure the relevant failover settings on the failover peer. Provide
the peer IP address in the Peer IP Address field.

Force Failover

To force the standby unit to become active, perform the following procedure.

Before you begin

In multiple context mode, perform this procedure in the System execution space.

Procedure

Step 1 To force failover at the unit level:

a) Choose the screen depending on your context mode:

* In single context mode choose Monitoring > Properties > Failover > Status.

* In multiple context mode, in the System choose Monitoring > Failover > System.

b) Click one of the following buttons:
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 Click Make Active to make the unit this unit.

* Click Make Standby to make the other unit the active unit.

Step 2 (Active/Active mode only) To force failover at the failover group level:

a) In the System choose Monitoring > Failover > Failover Group #, where # is the number of the failover
group you want to control.
b) Click one of the following buttons

* Click Make Active to make the failover group active on this unit.

* Click Make Standby to make the failover group active on the other unit.

Disable Failover

Disabling failover on one or both units causes the active and standby state of each unit to be maintained until
you reload. For an Active/Active failover pair, the failover groups remain in the active state on whichever
unit they are active, no matter which unit they are configured to prefer.

See the following characteristics when you disable failover:

* The standby unit/context remains in standby mode so that both units do not start passing traffic (this is
called a pseudo-standby state).

* The standby unit/context continues to use its standby IP addresses even though it is no longer connected
to an active unit/context.

* The standby unit/context continues to listen for a connection on the failover link. If failover is re-enabled
on the active unit/context, then the standby unit/context resumes ordinary standby status after
re-synchronizing the rest of its configuration.

* Do not enable failover manually on the standby unit to make it active; instead see Force Failover, on
page 309. If you enable failover on the standby unit, you will see a MAC address conflict that can disrupt
IPv6 traffic.

* To truly disable failover, save the no failover configuration to the startup configuration, and then reload.

Before you begin

In multiple context mode, perform this procedure in the system execution space.

Procedure

Step 1 In single mode, choose Configuration > Device Management > High Availability and Scalability >
Failover > Setup.

In multiple context mode, choose Configuration > Device Management > Failover > Setup in the System
execution space.

Step 2 Uncheck the Enable Failover check box.
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Step 3
Step 4

Restore a Failed Unit .

Click Apply.
To completely disable failover, save the configuration and reload:

a) Click the Save button.
b) Choose Tools > System Reload and reload the ASA.

Restore a Failed Unit

Step 1

Step 2

To restore a failed unit to an unfailed state, perform the following procedure.

Before you begin

In multiple context mode, perform this procedure in the System execution space.

Procedure

To restore failover at the unit level:

a) Choose the screen depending on your context mode:

* In single context mode choose Monitoring > Properties > Failover > Status.

* In multiple context mode, in the System choose Monitoring > Failover > System.

b) Click Reset Failover.

(Active/Active mode only) To reset failover at the failover group level:

a) In the System choose Monitoring > Failover > Failover Group #, where # is the number of the failover
group you want to control.

b) Click Reset Failover.

Re-Sync the Configuration

Replicated commands are stored in the running configuration. To save replicated commands to the flash
memory on the standby unit, choose File > Save Running Configuration to Flash.

Monitoring Failover

This section lets you monitor the Failover status.

Failover Messages

When a failover occurs, both ASAs send out system messages.
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Failover Syslog Messages

The ASA issues a number of syslog messages related to failover at priority level 2, which indicates a critical
condition. To view these messages, see the syslog messages guide. The ranges of message IDs associated
with failover are: 101xxx, 102xxx, 103xxx, 104xxx, 105xxx, 210xxX%, 311xx%, 709x%X, 727xx%. For example,
105032 and 105043 indicate a problem with the failover link.

)

Note During failover, the ASA logically shuts down and then brings up interfaces, generating syslog messages
411001 and 411002. This is normal activity.

Failover Debug Messages

To see debug messages, enter the debug fover command. See the command reference for more information.

N

Note Because debugging output is assigned high priority in the CPU process, it can drastically affect system
performance. For this reason, use the debug fover commands only to troubleshoot specific problems or during
troubleshooting sessions with Cisco TAC.

SNMP Failover Traps

To receive SNMP syslog traps for failover, configure the SNMP agent to send SNMP traps to SNMP
management stations, define a syslog host, and compile the Cisco syslog MIB into your SNMP management
station.

Monitoring Failover Status

)

Note  After a failover event, you should either re-launch ASDM or switch to another device in the Devices pane
and then come back to the original ASA to continue monitoring the device. This action is necessary because
the monitoring connection is not re-established when ASDM is disconnected from and then reconnected to
the device.

Choose Monitoring > Properties > Failover to monitor Active/Standby failover.

Use the following screens in the Monitoring > Properties > Failover area to monitor Active/Active failover.

System

The System pane displays the failover state of the system. You can also control the failover state of the system
by:

* Toggling the active/standby state of the device.
* Resetting a failed device.

* Reloading the standby unit.
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Failover Group 1 and Failover Group 2 .

Fields

Failover state of the system—Display only. Displays the failover state of the ASA. The information shown
is the same output you would receive from the show failover command. Refer to the command reference for
more information about the displayed output.

The following actions are available on the System pane:

» Make Active—Click this button to make the ASA the active unit in an active/standby configuration. In

an active/active configuration, clicking this button causes both failover groups to become active on the
ASA.

» Make Standby—Click this button to make the ASA the standby unit in an active/standby pair. In an
active/active configuration, clicking this button causes both failover groups to go to the standby state on
the ASA.

* Reset Failover—Click this button to reset a system from the failed state to the standby state. You cannot
reset a system to the active state. Clicking this button on the active unit resets the standby unit.

* Reload Standby—Click this button to force the standby unit to reload.

* Refresh—Click this button to refresh the status information in the Failover state of the system field.

Failover Group 1 and Failover Group 2

History for

The Failover Group 1 and Failover Group 2 panes display the failover state of the selected group.You can
also control the failover state of the group by toggling the active/standby state of the group or by resetting a
failed group.

Fields

Failover state of Group[X]—Display only. Displays the failover state of the selected failover group. The
information shown is the same as the output you would receive from the show failover group command.

You can perform the following actions from this pane:
» Make Active—Click this button to make the failover group active unit on the ASA.
» Make Standby—Click this button to force the failover group into the standby state on the ASA.

* Reset Failover—Click this button to reset a system from the failed state to the standby state. You cannot
reset a system to the active state. Clicking this button on the active unit resets the standby unit.

* Refresh—Click this button to refresh the status information in the Failover state of the system field.

Failover

Feature Name Releases Feature Information
Active/Standby failover 7.0(1) This feature was introduced.
Active/Active failover 7.0(1) This feature was introduced.
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Feature Name

Releases

Feature Information

Support for a hex value for the failover key

7.0(4)

You can now specify a hex value for
failover link encryption.

We modified the following screen:
Configuration > Device Management >
High Availability > Failover > Setup.

Support for the master passphrase for the
failover key

8.3(1)

The failover key now supports the master

passphrase, which encrypts the shared key
in the running and startup configuration. If
you are copying the shared secret from one
ASA to another, for example from the more
system:running-config command, you can
successfully copy and paste the encrypted
shared key.

Note The failover key shared secret
shows as ***** in show
running-config output; this
obscured key is not copyable.

There were no ASDM changes.

IPv6 support for failover added.

8.2(2)

We modified the following screens:

Configuration > Device Management >
High Availability > Failover > Setup

Configuration > Device Management >
High Availability > Failover > Interfaces

Change to failover group unit preference
during "simultaneous" bootup.

9.0(1)

Earlier software versions allowed
“simultaneous” boot up so that the failover
groups did not require the preempt
command to become active on the preferred
unit. However, this functionality has now
changed so that both failover groups
become active on the first unit to boot up.

Support for IPsec LAN-to-LAN tunnels to
encrypt failover and state link
communications

9.1(2)

Instead of using the proprietary encryption
for the failover key, you can now use an
IPsec LAN-to-LAN tunnel for failover and
state link encryption.

Note Failover LAN-to-LAN tunnels
do not count against the IPsec
(Other VPN) license.

We modified the following screen:
Configuration > Device Management >
High Availability > Failover > Setup.
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Feature Name

Releases

Feature Information

Disable health monitoring of a hardware
module

9.3(1)

By default, the ASA monitors the health of
an installed hardware module such as the
ASA FirePOWER module. If you do not
want a hardware module failure to trigger
failover, you can disable module
monitoring.

We modified the following screen:
Configuration > Device Management >
High Availability and Scalability >
Failover > Interfaces.

Lock configuration changes on the standby
unit or standby context in a failover pair

9.3(2)

You can now lock configuration changes
on the standby unit (Active/Standby
failover) or the standby context
(Active/Active failover) so you cannot
make changes on the standby unit outside
normal configuration syncing.

We modified the following screen:
Configuration > Device Management >
High Availability and Scalability >
Failover > Setup.

Enable use of the Management 1/1 interface
as the failover link on the ASA 5506H

9.5(1)

On the ASA 5506H only, you can now
configure the Management 1/1 interface as
the failover link. This feature lets you use
all other interfaces on the device as data
interfaces. Note that if you use this feature,
you cannot use the ASA Firepower module,
which requires the Management 1/1
interface to remain as a regular management
interface.

We modified the following screen:
Configuration > Device Management >
High Availability and Scalability >
Failover > Setup

Carrier Grade NAT enhancements now
supported in failover and ASA clustering

9.5(2)

For carrier-grade or large-scale PAT, you
can allocate a block of ports for each host,
rather than have NAT allocate one port
translation at a time (see RFC 6888). This
feature is now supported in failover and
ASA cluster deployments.

We did not modify any screens.
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Feature Name

Releases

Feature Information

Improved sync time for dynamic ACLs
from AnyConnect when using
Active/Standby failover

9.6(2)

When you use AnyConnect on a failover
pair, then the sync time for the associated
dynamic ACLs (dACLs) to the standby unit
is now improved. Previously, with large
dACLs, the sync time could take hours
during which time the standby unit is busy
syncing instead of providing high
availability backup.

We did not modify any screens.

Stateful failover for AnyConnect
connections in multiple context mode

9.6(2)

Stateful failover is now supported for
AnyConnect connections in multiple
context mode.

We did not modify any screens.

Interface link state monitoring polling for
failover now configurable for faster
detection

9.7(1)

By default, each ASA in a failover pair
checks the link state of its interfaces every
500 msec. You can now configure the
polling interval, between 300 msec and 799
msec; for example, if you set the polltime
to 300 msec, the ASA can detect an
interface failure and trigger failover faster.

We modified the following screen:
Configuration > Device Management >
High Availability and Scalability >
Failover > Criteria

Bidirectional Forwarding Detection (BFD)
support for Active/Standby failover health
monitoring on the Firepower 9300 and 4100

9.7(1)

You can enable Bidirectional Forwarding
Detection (BFD) for the failover health
check between two units of an
Active/Standby pair on the Firepower 9300
and 4100. Using BFD for the health check
is more reliable than the default health
check method and uses less CPU.

We modified the following screen:
Configuration > Device Management >
High Availability and Scalability >
Failover > Setup
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ASA Cluster

Clustering lets you group multiple ASAs together as a single logical device. A cluster provides all the
convenience of a single device (management, integration into a network) while achieving the increased
throughput and redundancy of multiple devices.

\}

Note Some features are not supported when using clustering. See Unsupported Features with Clustering, on page
387.

» About ASA Clustering, on page 317

* Licenses for ASA Clustering, on page 321

* Requirements and Prerequisites for ASA Clustering, on page 321
* Guidelines for ASA Clustering, on page 323

* Configure ASA Clustering, on page 328

* Manage Cluster Members, on page 359

* Monitoring the ASA Cluster, on page 365

» Examples for ASA Clustering, on page 367

* Reference for Clustering, on page 387

* History for ASA Clustering, on page 402

About ASA Clustering

This section describes the clustering architecture and how it works.

How the ASA Cluster Fits into Your Network

The cluster consists of multiple ASAs acting as a single unit. To act as a cluster, the ASAs need the following
infrastructure:

» Isolated, high-speed backplane network for intra-cluster communication, known as the cluster control
link.

» Management access to each ASA for configuration and monitoring.
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When you place the cluster in your network, the upstream and downstream routers need to be able to
load-balance the data coming to and from the cluster using one of the following methods:

* Spanned EtherChannel (Recommended)—Interfaces on multiple members of the cluster are grouped
into a single EtherChannel; the EtherChannel performs load balancing between units.

* Policy-Based Routing (Routed firewall mode only)—The upstream and downstream routers perform
load balancing between units using route maps and ACLs.

* Equal-Cost Multi-Path Routing (Routed firewall mode only)—The upstream and downstream routers
perform load balancing between units using equal cost static or dynamic routes.

Cluster Members

Cluster members work together to accomplish the sharing of the security policy and traffic flows. This section
describes the nature of each member role.

Bootstrap Configuration

On each device, you configure a minimal bootstrap configuration including the cluster name, cluster control
link interface, and other cluster settings. The first unit on which you enable clustering typically becomes the
control unit. When you enable clustering on subsequent units, they join the cluster as data units.

Control and Data Unit Roles

One member of the cluster is the control unit. The control unit is determined by the priority setting in the
bootstrap configuration; the priority is set between 1 and 100, where 1 is the highest priority. All other members
are data units. Typically, when you first create a cluster, the first unit you add becomes the control unit simply
because it is the only unit in the cluster so far.

You must perform all configuration (aside from the bootstrap configuration) on the control unit only; the
configuration is then replicated to the data units. In the case of physical assets, such as interfaces, the
configuration of the control unit is mirrored on all data units. For example, if you configure GigabitEthernet
0/1 as the inside interface and GigabitEthernet 0/0 as the outside interface, then these interfaces are also used
on the data units as inside and outside interfaces.

Some features do not scale in a cluster, and the control unit handles all traffic for those features.

Cluster Interfaces

You can configure data interfaces as either Spanned EtherChannels or as Individual interfaces. All data
interfaces in the cluster must be one type only. See About Cluster Interfaces, on page 329 for more information.

Cluster Control Link

Each unit must dedicate at least one hardware interface as the cluster control link. See About the Cluster
Control Link, on page 329 for more information.
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Configuration Replication

All units in the cluster share a single configuration. You can only make configuration changes on the control
unit, and changes are automatically synced to all other units in the cluster.

ASA Cluster Management

One of the benefits of using ASA clustering is the ease of management. This section describes how to manage
the cluster.

Management Network

We recommend connecting all units to a single management network. This network is separate from the cluster
control link.

Management Interface

For the management interface, we recommend using one of the dedicated management interfaces. You can
configure the management interfaces as Individual interfaces (for both routed and transparent modes) or as a
Spanned EtherChannel interface.

We recommend using Individual interfaces for management, even if you use Spanned EtherChannels for your
data interfaces. Individual interfaces let you connect directly to each unit if necessary, while a Spanned
EtherChannel interface only allows remote connection to the current control unit.

Note If you use Spanned EtherChannel interface mode, and configure the management interface as an Individual
interface, you cannot enable dynamic routing for the management interface. You must use a static route.

For an Individual interface, the Main cluster IP address is a fixed address for the cluster that always belongs
to the current control unit. For each interface, you also configure a range of addresses so that each unit,
including the current control unit, can use a Local address from the range. The Main cluster IP address provides
consistent management access to an address; when a control unit changes, the Main cluster IP address moves
to the new control unit, so management of the cluster continues seamlessly. The Local IP address is used for
routing, and is also useful for troubleshooting.

For example, you can manage the cluster by connecting to the Main cluster IP address, which is always
attached to the current control unit. To manage an individual member, you can connect to the Local IP address.

For outbound management traffic such as TFTP or syslog, each unit, including the control unit, uses the Local
IP address to connect to the server.

For a Spanned EtherChannel interface, you can only configure one IP address, and that IP address is always
attached to the control unit. You cannot connect directly to a data unit using the EtherChannel interface; we
recommend configuring the management interface as an Individual interface so that you can connect to each
unit. Note that you can use a device-local EtherChannel for management.

Control Unit Management Vs. Data Unit Management

All management and monitoring can take place on the control unit. From the control unit, you can check
runtime statistics, resource usage, or other monitoring information of all units. You can also issue a command
to all units in the cluster, and replicate the console messages from data units to the control unit.
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You can monitor data units directly if desired. Although also available from the control unit, you can perform
file management on data units (including backing up the configuration and updating images). The following
functions are not available from the control unit:

* Monitoring per-unit cluster-specific statistics.

* Syslog monitoring per unit (except for syslogs sent to the console when console replication is enabled).
* SNMP
* NetFlow

RSA Key Replication

When you create an RSA key on the control unit, the key is replicated to all data units. If you have an SSH
session to the Main cluster IP address, you will be disconnected if the control unit fails. The new control unit
uses the same key for SSH connections, so that you do not need to update the cached SSH host key when you
reconnect to the new control unit.

ASDM Connection Certificate IP Address Mismatch

By default, a self-signed certificate is used for the ASDM connection based on the Local IP address. If you
connect to the Main cluster IP address using ASDM, then a warning message about a mismatched IP address
might appear because the certificate uses the Local IP address, and not the Main cluster IP address. You can
ignore the message and establish the ASDM connection. However, to avoid this type of warning, you can
enroll a certificate that contains the Main cluster IP address and all the Local IP addresses from the IP address
pool. You can then use this certificate for each cluster member. See https://www.cisco.com/c/en/us/td/docs/
security/asdm/identity-cert/cert-install.html for more information.

Inter-Site Clustering

For inter-site installations, you can take advantage of ASA clustering as long as you follow the recommended
guidelines.

You can configure each cluster chassis to belong to a separate site ID.

Site IDs work with site-specific MAC addresses and IP addresses. Packets egressing the cluster use a
site-specific MAC address and IP address, while packets received by the cluster use a global MAC address
and IP address. This feature prevents the switches from learning the same global MAC address from both
sites on two different ports, which causes MAC flapping; instead, they only learn the site MAC address.
Site-specific MAC addresses and IP address are supported for routed mode using Spanned EtherChannels
only.

Site IDs are also used to enable flow mobility using LISP inspection, director localization to improve
performance and reduce round-trip time latency for inter-site clustering for data centers.

See the following sections for more information about inter-site clustering:
» Sizing the Data Center Interconnect—Requirements and Prerequisites for ASA Clustering, on page 321
* Inter-Site Guidelines—Guidelines for ASA Clustering, on page 323
* Configure Cluster Flow Mobility—Configure Cluster Flow Mobility, on page 356

* Enable Director Localization—Configure Basic ASA Cluster Parameters, on page 352
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* Inter-Site Examples—Examples for Inter-Site Clustering, on page 383

Licenses for ASA Clustering

Cluster units do not require the same license on each unit. Typically, you buy a license only for the control
unit; data units inherit the control unit license. If you have licenses on multiple units, they combine into a
single running ASA cluster license.

There are exceptions to this rule. See the following table for precise licensing requirements for clustering.

Model License Requirement
ASA 5585-X Cluster License, supports up to 16 units.
Note Each unit must have the same encryption license; each

unit must have the same 10 GE 1/0/Security Plus
license (ASA 5585-X with SSP-10 and -20).

ASA 5516-X Base license, supports 2 units.

Note Each unit must have the same encryption license.
ASA 5512-X Security Plus license, supports 2 units.

Note Each unit must have the same encryption license.
ASA 5515-X, ASA 5525-X, ASA 5545-X, ASA 5555-X Base License, supports 2 units.

Note Each unit must have the same encryption license.
Firepower 4100/9300 Chassis See ASA Cluster Licenses for the ASA on the Firepower

4100/9300 Chassis, on page 152.

All other models No support.

Requirements and Prerequisites for ASA Clustering

Model Requirements
* ASA 5516-X—Maximum 2 units
* ASA 5512-X, 5515-X, 5525-X, 5545-X, and 5555-X—Maximum 2 units
* ASA 5585-X—Maximum 16 units

For the ASA 5585-X with SSP-10 and SSP-20, which include two Ten Gigabit Ethernet interfaces, we
recommend using one interface for the cluster control link, and the other for data (you can use subinterfaces
for data). Although this setup does not accommodate redundancy for the cluster control link, it does
satisfy the need to size the cluster control link to match the size of the data interfaces.
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* ASA FirePOWER module—The ASA FirePOWER module does not support clustering directly, but you
can use these modules in a cluster. You are responsible for maintaining consistent policies on the ASA
FirePOWER modules in the cluster.

N

Note Create the cluster before you configure the ASA FirePOWER modules. If the
modules are already configured on the data units, clear the interface configuration
on the devices before adding them to the cluster. From the CLI, enter the clear
configure interface command.

ASA Hardware and Software Requirements
All units in a cluster:

* Must be the same model with the same DRAM. You do not have to have the same amount of flash
memory.

» Must run the identical software except at the time of an image upgrade. Hitless upgrade is supported.
* Must be in the same security context mode, single or multiple.
* (Single context mode) Must be in the same firewall mode, routed or transparent.

* New cluster members must use the same SSL encryption setting (the ssl encryption command) as the
control unit for initial cluster control link communication before configuration replication.

* Must have the same cluster, encryption and, for the ASA 5585-X, 10 GE 1/O licenses.

Switch Requirements
* Be sure to complete the switch configuration before you configure clustering on the ASAs.

* For a list of supported switches, see Cisco ASA Compatibility.

ASA Requirements
* Provide each unit with a unique IP address before you join them to the management network.

* See the Getting Started chapter for more information about connecting to the ASA and setting the
management [P address.

* Except for the IP address used by the control unit (typically the first unit you add to the cluster),
these management IP addresses are for temporary use only.

* After a data unit joins the cluster, its management interface configuration is replaced by the one
replicated from the control unit.

* To use jumbo frames on the cluster control link (recommended), you must enable Jumbo Frame
Reservation before you enable clustering.
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Sizing the Data Center Interconnect for Inter-Site Clustering

You should reserve bandwidth on the data center interconnect (DCI) for cluster control link traffic equivalent
to the following calculation:

# of cluster members per site

2

X cluster control link size per member

If the number of members differs at each site, use the larger number for your calculation. The minimum
bandwidth for the DCI should not be less than the size of the cluster control link for one member.

For example:
 For 4 members at 2 sites:

* 4 cluster members total
« 2 members at each site

* 5 Gbps cluster control link per member

Reserved DCI bandwidth = 5 Gbps (2/2 x 5 Gbps).
» For 6 members at 3 sites, the size increases:
* 6 cluster members total
* 3 members at site 1, 2 members at site 2, and 1 member at site 3

* 10 Gbps cluster control link per member

Reserved DCI bandwidth = 15 Gbps (3/2 x 10 Gbps).

» For 2 members at 2 sites:

« 2 cluster members total
* 1 member at each site

* 10 Gbps cluster control link per member

Reserved DCI bandwidth = 10 Gbps (1/2 x 10 Gbps = 5 Gbps; but the minimum bandwidth should not
be less than the size of the cluster control link (10 Gbps)).

Other Requirements

We recommend using a terminal server to access all cluster member unit console ports. For initial setup, and
ongoing management (for example, when a unit goes down), a terminal server is useful for remote management.

Guidelines for ASA Clustering

Context Mode

The mode must match on each member unit.
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Firewall Mode

For single mode, the firewall mode must match on all units.

Failover

Failover is not supported with clustering.

IPv6

The cluster control link is only supported using IPv4.

Switches

» Make sure connected switches match the MTU for both cluster data interfaces and the cluster control
link interface. You should configure the cluster control link interface MTU to be at least 100 bytes higher
than the data interface MTU, so make sure to configure the cluster control link connecting switch
appropriately. Because the cluster control link traffic includes data packet forwarding, the cluster control
link needs to accommodate the entire size of a data packet plus cluster traffic overhead.

* For Cisco IOS XR systems, if you want to set a non-default MTU, set the 10S interface MTU to be 14
bytes higher than the cluster device MTU. Otherwise, OSPF adjacency peering attempts may fail unless
the mtu-ignore option is used. Note that the cluster device MTU should match the IOS |Pv4 MTU. This
adjustment is not required for Cisco Catalyst and Cisco Nexus switches.

* On the switch(es) for the cluster control link interfaces, you can optionally enable Spanning Tree PortFast
on the switch ports connected to the cluster unit to speed up the join process for new units.

* On the switch, we recommend that you use one of the following EtherChannel load-balancing algorithms:
source-dest-ip or source-dest-ip-port (see the Cisco Nexus OS and Cisco IOS port-channel load-balance
command). Do not use a vlan keyword in the load-balance algorithm because it can cause unevenly
distributed traffic to the devices in a cluster. Do not change the load-balancing algorithm from the default
on the cluster device.

* If you change the load-balancing algorithm of the EtherChannel on the switch, the EtherChannel interface
on the switch temporarily stops forwarding traffic, and the Spanning Tree Protocol restarts. There will
be a delay before traffic starts flowing again.

* Some switches do not support dynamic port priority with LACP (active and standby links). You can
disable dynamic port priority to provide better compatibility with Spanned EtherChannels.

* Switches on the cluster control link path should not verify the L4 checksum. Redirected traffic over the
cluster control link does not have a correct L4 checksum. Switches that verify the L4 checksum could
cause traffic to be dropped.

* Port-channel bundling downtime should not exceed the configured keepalive interval.

* On Supervisor 2T EtherChannels, the default hash distribution algorithm is adaptive. To avoid asymmetric
traffic in a VSS design, change the hash algorithm on the port-channel connected to the cluster device
to fixed:

router(config)# port-channel id hash-distribution fixed

Do not change the algorithm globally; you may want to take advantage of the adaptive algorithm for the
VSS peer link.
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* You should disable the LACP Graceful Convergence feature on all cluster-facing EtherChannel interfaces
for Cisco Nexus switches.

EtherChannels

* In Catalyst 3750-X Cisco IOS software versions earlier than 15.1(1)S2, the cluster unit did not support
connecting an EtherChannel to a switch stack. With default switch settings, if the cluster unit EtherChannel
is connected cross stack, and if the control unit switch is powered down, then the EtherChannel connected
to the remaining switch will not come up. To improve compatibility, set the stack-mac persistent timer
command to a large enough value to account for reload time; for example, 8 minutes or 0 for indefinite.
Or, you can upgrade to more a more stable switch software version, such as 15.1(1)S2.

* Spanned vs. Device-Local EtherChannel Configuration—Be sure to configure the switch appropriately
for Spanned EtherChannels vs. Device-local EtherChannels.

* Spanned EtherChannels—For cluster unit Spanned EtherChannels, which span across all members
of the cluster, the interfaces are combined into a single EtherChannel on the switch. Make sure each
interface is in the same channel group on the switch.

Switch Switch
— RIGHT Am—
VLAN 101 | | Spanned Data Ifc poga 1 Spanned Data Ifc p
port-ch1 port-ch1 . port-ch1 '

A

* Device-local EtherChannels—For cluster unit Device-local EtherChannels including any
EtherChannels configured for the cluster control link, be sure to configure discrete EtherChannels
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on the switch; do not combine multiple cluster unit EtherChannels into one EtherChannel on the

switch.
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Inter-Site Guidelines

See the following guidelines for inter-site clustering:

* Supports inter-site clustering in the following interface and firewall modes:

Interface Mode

Firewall Mode

Routed Transparent
Individual Interface Yes N/A
Spanned EtherChannel Yes Yes

333358

* For individual interface mode, when using ECMP towards a multicast Rendezvous Point (RP), we
recommend that you use a static route for the RP IP address using the Main cluster IP address as the next
hop. This static route prevents sending unicast PIM register packets to data units. If a data unit receives
a PIM register packet, then the packet is dropped, and the multicast stream cannot be registered.
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The cluster control link latency must be less than 20 ms round-trip time (RTT).

The cluster control link must be reliable, with no out-of-order or dropped packets; for example, you
should use a dedicated link.

Do not configure connection rebalancing; you do not want connections rebalanced to cluster members
at a different site.

The ASA does not encrypt forwarded data traffic on the cluster control link because it is a dedicated link,
even when used on a Data Center Interconnect (DCI). If you use Overlay Transport Virtualization (OTV),
or are otherwise extending the cluster control link outside of the local administrative domain, you can
configure encryption on your border routers such as 802.1AE MacSec over OTV.

The cluster implementation does not differentiate between members at multiple sites for incoming
connections; therefore, connection roles for a given connection may span across sites. This is expected
behavior. However, if you enable director localization, the local director role is always chosen from the
same site as the connection owner (according to site ID). Also, the local director chooses a new owner
at the same site if the original owner fails (Note: if the traffic is asymmetric across sites, and there is
continuous traffic from the remote site after the original owner fails, then a unit from the remote site
might become the new owner if it receives a data packet within the re-hosting window.).

For director localization, the following traffic types do not support localization: NAT or PAT traffic;
SCTP-inspected traffic; Fragmentation owner query.

For transparent mode, if the cluster is placed between a pair of inside and outside routers (AKA
North-South insertion), you must ensure that both inside routers share a MAC address, and also that both
outside routers share a MAC address. When a cluster member at site 1 forwards a connection to a member
at site 2, the destination MAC address is preserved. The packet will only reach the router at site 2 if the
MAC address is the same as the router at site 1.

For transparent mode, if the cluster is placed between data networks and the gateway router at each site
for firewalling between internal networks (AKA East-West insertion), then each gateway router should
use a First Hop Redundancy Protocol (FHRP) such as HSRP to provide identical virtual IP and MAC
address destinations at each site. The data VLANSs are extended across the sites using Overlay Transport
Virtualization (OTV), or something similar. You need to create filters to prevent traffic that is destined
to the local gateway router from being sent over the DCI to the other site. If the gateway router becomes
unreachable at one site, you need to remove any filters so traffic can successfully reach the other site’s
gateway.

For transparent mode, if the cluster is connected to an HSRP router, you must add the router HSRP MAC
address as a static MAC address table entry on the ASA (see Add a Static MAC Address for Bridge
Groups, on page 633). When adjacent routers use HSRP, traffic destined to the HSRP IP address will be
sent to the HSRP MAC Address, but return traffic will be sourced from the MAC address of a particular
router's interface in the HSRP pair. Therefore, the ASA MAC address table is typically only updated
when the ASA ARP table entry for the HSRP IP address expires, and the ASA sends an ARP request
and receives a reply. Because the ASA’s ARP table entries expire after 14400 seconds by default, but
the MAC address table entry expires after 300 seconds by default, a static MAC address entry is required
to avoid MAC address table expiration traffic drops.

For routed mode using Spanned EtherChannel, configure site-specific MAC addresses. Extend the data
VLANS across the sites using OTV, or something similar. You need to create filters to prevent traffic
that is destined to the global MAC address from being sent over the DCI to the other site. If the cluster
becomes unreachable at one site, you need to remove any filters so traffic can successfully reach the
other site’s cluster units. Dynamic routing is not supported when an inter-site cluster acts as the first hop
router for an extended segment.
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Additional Guidelines

» When significant topology changes occur (such as adding or removing an EtherChannel interface, enabling
or disabling an interface on the ASA or the switch, adding an additional switch to form a VSS or vPC)
you should disable the health check feature and also disable interface monitoring for the disabled interfaces.
When the topology change is complete, and the configuration change is synced to all units, you can
re-enable the interface health check feature.

* When adding a unit to an existing cluster, or when reloading a unit, there will be a temporary, limited
packet/connection drop; this is expected behavior. In some cases, the dropped packets can hang your
connection; for example, dropping a FIN/ACK packet for an FTP connection will make the FTP client
hang. In this case, you need to reestablish the FTP connection.

* If you use a Windows 2003 server connected to a Spanned EtherChannel, when the syslog server port
is down and the server does not throttle ICMP error messages, then large numbers of ICMP messages
are sent back to the ASA cluster. These messages can result in some units of the ASA cluster experiencing
high CPU, which can affect performance. We recommend that you throttle ICMP error messages.

* We do not support VXLAN in Individual Interface mode. Only Spanned EtherChannel mode supports
VXLAN.

* We do not support IS-IS in Spanned EtherChannel mode. Only Individual Interface mode supports IS-IS.

« It takes time to replicate changes to all the units in a cluster. If you make a large change, for example,
adding an access control rule that uses object groups (which, when deployed, are broken out into multiple
rules), the time needed to complete the change can exceed the timeout for the cluster units to respond
with a success message. If this happens, you might see a "failed to replicate command" message. You
can ignore the message.

Defaults for ASA Clustering

* When using Spanned EtherChannels, the cLACP system ID is auto-generated and the system priority is
1 by default.

* The cluster health check feature is enabled by default with the holdtime of 3 seconds. Interface health
monitoring is enabled on all interfaces by default.

* The cluster auto-rejoin feature for a failed cluster control link is unlimited attempts every 5 minutes.

* The cluster auto-rejoin feature for a failed data interface is 3 attempts every 5 minutes, with the increasing
interval set to 2.

* Connection rebalancing is disabled by default. If you enable connection rebalancing, the default time
between load information exchanges is 5 seconds.

+ Connection replication delay of 5 seconds is enabled by default for HTTP traffic.

Configure ASA Clustering

To configure clustering, perform the following tasks.
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Note To enable or disable clustering, you must use a console connection (for CLI) or an ASDM connection.

Back Up Your Configurations (Recommended)

When you enable clustering on a secondary unit, the current configuration is replaced with one synced from
the primary unit. If you ever want to leave the cluster entirely, it may be useful to have a backup configuration
with a usable management interface configuration.

Before you begin

Perform a backup on each unit.

Procedure

Step 1 Choose Tools > Backup Configurations.

Step 2 Back up at least the running configuration. See Back Up and Restore Configurations or Other Files, on page
938 for a detailed procedure.

Cable the Units and Configure Interfaces

Before configuring clustering, cable the cluster control link network, management network, and data networks.
Then configure your interfaces.
About Cluster Interfaces

You can configure data interfaces as either Spanned EtherChannels or as Individual interfaces. All data
interfaces in the cluster must be one type only. Each unit must also dedicate at least one hardware interface
as the cluster control link.

About the Cluster Control Link

Each unit must dedicate at least one hardware interface as the cluster control link.

Cluster Control Link Traffic Overview
Cluster control link traffic includes both control and data traffic.
Control traffic includes:

* Control unit election.
* Configuration replication.

* Health monitoring.

Data traffic includes:

» State replication.
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* Connection ownership queries and data packet forwarding.

Cluster Control Link Interfaces and Network
You can use any data interface(s) for the cluster control link, with the following exceptions:

* You cannot use a VLAN subinterface as the cluster control link.
* You cannot use a Management X/X interface as the cluster control link, either alone or as an EtherChannel.

* For the ASA 5585-X with an ASA FirePOWER module, Cisco recommends that you use ASA interfaces
for the cluster control link, and not interfaces on the ASA FirePOWER module. Module interfaces can
drop traffic for up to 30 seconds during a module reload, including reloads that occur during a software
upgrade. However, if needed, you can use module interfaces and ASA interfaces in the same cluster
control link EtherChannel. When the module interfaces drop, the remaining interfaces in the EtherChannel
are still up. The ASA 5585-X Network Module does not run a separate operating system, so it is not
affected by this issue.

Be aware that data interfaces on the module are also affected by reload drops. Cisco recommends always
using ASA interfaces redundantly with module interfaces in an EtherChannel.

For the ASA 5585-X with SSP-10 and SSP-20, which include two Ten Gigabit Ethernet interfaces, we
recommend using one interface for the cluster control link, and the other for data (you can use subinterfaces
for data). Although this setup does not accommodate redundancy for the cluster control link, it does
satisfy the need to size the cluster control link to match the size of the data interfaces.

You can use an EtherChannel or redundant interface.

Each cluster control link has an IP address on the same subnet. This subnet should be isolated from all other
traffic, and should include only the ASA cluster control link interfaces.

For a 2-member cluster, do not directly-connect the cluster control link from one ASA to the other ASA. If
you directly connect the interfaces, then when one unit fails, the cluster control link fails, and thus the remaining
healthy unit fails. If you connect the cluster control link through a switch, then the cluster control link remains
up for the healthy unit.

Size the Cluster Control Link

If possible, you should size the cluster control link to match the expected throughput of each chassis so the
cluster-control link can handle the worst-case scenarios. For example, if you have the ASA 5585-X with
SSP-60, which can pass 14 Gbps per unit maximum in a cluster, then you should also assign interfaces to the
cluster control link that can pass at least 14 Gbps. In this case, you could use 2 Ten Gigabit Ethernet interfaces
in an EtherChannel for the cluster control link, and use the rest of the interfaces as desired for data links.

Cluster control link traffic is comprised mainly of state update and forwarded packets. The amount of traffic
at any given time on the cluster control link varies. The amount of forwarded traffic depends on the
load-balancing efficacy or whether there is a lot of traffic for centralized features. For example:

* NAT results in poor load balancing of connections, and the need to rebalance all returning traffic to the
correct units.

* AAA for network access is a centralized feature, so all traffic is forwarded to the control unit.

* When membership changes, the cluster needs to rebalance a large number of connections, thus temporarily
using a large amount of cluster control link bandwidth.
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A higher-bandwidth cluster control link helps the cluster to converge faster when there are membership changes
and prevents throughput bottlenecks.

\}

Note If your cluster has large amounts of asymmetric (rebalanced) traffic, then you should increase the cluster
control link size.

Cluster Control Link Redundancy

We recommend using an EtherChannel for the cluster control link, so that you can pass traffic on multiple
links in the EtherChannel while still achieving redundancy.

The following diagram shows how to use an EtherChannel as a cluster control link in a Virtual Switching
System (VSS) or Virtual Port Channel (vPC) environment. All links in the EtherChannel are active. When
the switch is part of a VSS or vPC, then you can connect ASA interfaces within the same EtherChannel to
separate switches in the VSS or vPC. The switch interfaces are members of the same EtherChannel port-channel
interface, because the separate switches act like a single switch. Note that this EtherChannel is device-local,
not a Spanned EtherChannel.

Switch Virtual Switch Link Switch

d3azz2

Cluster Control Link Reliability

To ensure cluster control link functionality, be sure the round-trip time (RTT) between units is less than 20
ms. This maximum latency enhances compatibility with cluster members installed at different geographical
sites. To check your latency, perform a ping on the cluster control link between units.

The cluster control link must be reliable, with no out-of-order or dropped packets; for example, for inter-site
deployment, you should use a dedicated link.

Cluster Control Link Failure

If the cluster control link line protocol goes down for a unit, then clustering is disabled; data interfaces are
shut down. After you fix the cluster control link, you must manually rejoin the cluster by re-enabling clustering.
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\}

Note

When the ASA becomes inactive, all data interfaces are shut down; only the management-only interface can
send and receive traffic. The management interface remains up using the IP address the unit received from
the cluster IP pool. However if you reload, and the unit is still inactive in the cluster, the management interface
is not accessible (because it then uses the Main IP address, which is the same as the control unit). You must
use the console port for any further configuration.

Spanned EtherChannels (Recommended)

You can group one or more interfaces per chassis into an EtherChannel that spans all chassis in the cluster.
The EtherChannel aggregates the traffic across all the available active interfaces in the channel. A Spanned
EtherChannel can be configured in both routed and transparent firewall modes. In routed mode, the
EtherChannel is configured as a routed interface with a single IP address. In transparent mode, the IP address
is assigned to the BVI, not to the bridge group member interface. The EtherChannel inherently provides load

balancing as part of basic operation.
Inside Switch Outside Switch
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Spanned EtherChannel Benefits
The EtherChannel method of load-balancing is recommended over other methods for the following benefits:

* Faster failure discovery.

* Faster convergence time. Individual interfaces rely on routing protocols to load-balance traffic, and
routing protocols often have slow convergence during a link failure.

* Ease of configuration.
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Guidelines for Maximum Throughput .

Guidelines for Maximum Throughput

Load Balancing

N

To achieve maximum throughput, we recommend the following:

* Use a load balancing hash algorithm that is “symmetric,” meaning that packets from both directions will
have the same hash, and will be sent to the same ASA in the Spanned EtherChannel. We recommend
using the source and destination IP address (the default) or the source and destination port as the hashing
algorithm.

* Use the same type of line cards when connecting the ASAs to the switch so that hashing algorithms
applied to all packets are the same.

The EtherChannel link is selected using a proprietary hash algorithm, based on source or destination IP
addresses and TCP and UDP port numbers.

Note

On the ASA, do not change the load-balancing algorithm from the default. On the switch, we recommend
that you use one of the following algorithms: source-dest-ip or source-dest-ip-port (see the Cisco Nexus
OS or Cisco 10S port-channel load-balance command). Do not use a vlan keyword in the load-balance
algorithm because it can cause unevenly distributed traffic to the ASAs in a cluster.

The number of links in the EtherChannel affects load balancing.

Symmetric load balancing is not always possible. If you configure NAT, then forward and return packets will
have different IP addresses and/or ports. Return traffic will be sent to a different unit based on the hash, and
the cluster will have to redirect most returning traffic to the correct unit.

EtherChannel Redundancy

The EtherChannel has built-in redundancy. It monitors the line protocol status of all links. If one link fails,
traffic is re-balanced between remaining links. If all links in the EtherChannel fail on a particular unit, but
other units are still active, then the unit is removed from the cluster.

Connecting to a VSS or vPC

You can include multiple interfaces per ASA in the Spanned EtherChannel. Multiple interfaces per ASA are
especially useful for connecting to both switches in a VSS or vPC.

Depending on your switches, you can configure up to 32 active links in the spanned EtherChannel. This feature
requires both switches in the vPC to support EtherChannels with 16 active links each (for example the Cisco
Nexus 7000 with F2-Series 10 Gigabit Ethernet Module).

For switches that support 8 active links in the EtherChannel, you can configure up to 16 active links in the
spanned EtherChannel when connecting to two switches in a VSS/vPC.

If you want to use more than 8 active links in a spanned EtherChannel, you cannot also have standby links;
the support for 9 to 32 active links requires you to disable cLACP dynamic port priority that allows the use
of standby links. You can still use 8 active links and 8 standby links if desired, for example, when connecting
to a single switch.

The following figure shows a 32 active link spanned EtherChannel in an 8-ASA cluster and a 16-ASA cluster.
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The following figure shows a 16 active link spanned EtherChannel in a 4-ASA cluster and an 8-ASA cluster.
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The following figure shows a traditional 8 active/8 standby link spanned EtherChannel in a 4-ASA cluster
and an 8-ASA cluster. The active links are shown as solid lines, while the inactive links are dotted. cLACP
load-balancing can automatically choose the best 8 links to be active in the EtherChannel. As shown, cLACP
helps achieve load balancing at the link level.
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Individual Interfaces (Routed Firewall Mode Only)

Individual interfaces are normal routed interfaces, each with their own Local IP address. Because interface
configuration must be configured only on the control unit, the interface configuration lets you set a pool of
IP addresses to be used for a given interface on the cluster members, including one for the control unit. The
Main cluster |P address is a fixed address for the cluster that always belongs to the current control unit. The
Main cluster IP address is a data unit IP address for the control unit; the Local IP address is always the control
unit address for routing. The Main cluster IP address provides consistent management access to an address;
when a control unit changes, the Main cluster IP address moves to the new control unit, so management of
the cluster continues seamlessly. Load balancing, however, must be configured separately on the upstream
switch in this case.

Note

We recommend Spanned EtherChannels instead of Individual interfaces because Individual interfaces rely
on routing protocols to load-balance traffic, and routing protocols often have slow convergence during a link
failure.
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\}

When using Individual interfaces, each ASA interface maintains its own IP address and MAC address. One
method of load balancing is Policy-Based Routing (PBR).

We recommend this method if you are already using PBR, and want to take advantage of your existing
infrastructure. This method might offer additional tuning options vs. Spanned EtherChannel as well.

PBR makes routing decisions based on a route map and ACL. You must manually divide traffic between all
ASAs in a cluster. Because PBR is static, it may not achieve the optimum load balancing result at all times.
To achieve the best performance, we recommend that you configure the PBR policy so that forward and return
packets of a connection are directed to the same physical ASA. For example, if you have a Cisco router,
redundancy can be achieved by using Cisco I0S PBR with Object Tracking. Cisco IOS Object Tracking
monitors each ASA using ICMP ping. PBR can then enable or disable route maps based on reachability of a
particular ASA. See the following URLSs for more details:

http://www.cisco.com/c/en/us/solutions/data-center-virtualization/intelligent-traffic-director/index.html

http://www.cisco.com/en/US/products/ps6599/products_white paper09186a00800a4409.shtml

Note

If you use this method of load-balancing, you can use a device-local EtherChannel as an Individual interface.

Equal-Cost Multi-Path Routing (Routed Firewall Mode Only)

When using Individual interfaces, each ASA interface maintains its own IP address and MAC address. One
method of load balancing is Equal-Cost Multi-Path (ECMP) routing.

We recommend this method if you are already using ECMP, and want to take advantage of your existing
infrastructure. This method might offer additional tuning options vs. Spanned EtherChannel as well.
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. Nexus Intelligent Traffic Director (Routed Firewall Mode Only)

\}

ECMP routing can forward packets over multiple “best paths” that tie for top place in the routing metric. Like
EtherChannel, a hash of source and destination IP addresses and/or source and destination ports can be used
to send a packet to one of the next hops. If you use static routes for ECMP routing, then an ASA failure can
cause problems; the route continues to be used, and traffic to the failed ASA will be lost. If you use static
routes, be sure to use a static route monitoring feature such as Object Tracking. We recommend using dynamic
routing protocols to add and remove routes, in which case, you must configure each ASA to participate in
dynamic routing.

Note

If you use this method of load-balancing, you can use a device-local EtherChannel as an Individual interface.

Nexus Intelligent Traffic Director (Routed Firewall Mode Only)

When using Individual interfaces, each ASA interface maintains its own IP address and MAC address.
Intelligent Traffic Director (ITD) is a high-speed hardware load-balancing solution for Nexus 5000, 6000,
7000, and 9000 switch series. In addition to fully covering the functional capabilities of traditional PBR, it
offers a simplified configuration workflow and multiple additional features for a more granular load distribution.

ITD supports IP stickiness, consistent hashing for bi-directional flow symmetry, virtual IP addressing, health
monitoring, sophisticated failure handling policies with N+M redundancy, weighted load-balancing, and
application IP SLA probes including DNS. Due to the dynamic nature of load-balancing, it achieves a more
even traffic distribution across all cluster members as compared to PBR. In order to achieve bi-directional
flow symmetry, we recommend configuring ITD such that forward and return packets of a connection are
directed to the same physical ASA. See the following URL for more details:

http://www.cisco.com/c/en/us/solutions/data-center-virtualization/intelligent-traffic-director/index.html

Cable the Cluster Units and Configure Upstream and Downstream Equipment

Before configuring clustering, cable the cluster control link network, management network, and data networks.

Procedure

Cable the cluster control link network, management network, and data networks.

Note At a minimum, an active cluster control link network is required before you configure the units to
join the cluster.

You should also configure the upstream and downstream equipment. For example, if you use EtherChannels,
then you should configure the upstream and downstream equipment for the EtherChannels.

Examples

Note

This example uses EtherChannels for load-balancing. If you are using PBR or ECMP, your switch
configuration will differ.
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Cable the Cluster Units and Configure Upstream and Downstream Equipment .

For example on each of 4 ASA 5585-Xs, you want to use:

» 2 Ten Gigabit Ethernet interfaces in a device-local EtherChannel for the cluster control link.

» 2 Ten Gigabit Ethernet interfaces in a Spanned EtherChannel for the inside and outside network;
each interface is a VLAN subinterface of the EtherChannel. Using subinterfaces lets both inside
and outside interfaces take advantage of the benefits of an EtherChannel.

* 1 Management interface.

You have one switch for both the inside and outside networks.
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Purpose Connect Interfaces on each of 4 | To Switch Ports

ASAs

Cluster control link TenGigabitEthernet 0/6 and

8 ports total
TenGigabitEthernet 0/7 For each TenGigabitEthernet 0/6
and TenGigabitEthernet 0/7 pair,
configure 4 EtherChannels (1 EC
for each ASA).

These EtherChannels must all be
on the same isolated cluster control
VLAN, for example VLAN 101.
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Purpose Connect Interfaces on each of 4 | To Switch Ports
ASAs

Inside and outside interfaces TenGigabitEthernet 0/8 and 8 ports total
TenGigabitEthernet 0/9

Configure a single EtherChannel
(across all ASAs).

On the switch, configure these
VLANSs and networks now; for
example, a trunk including VLAN
200 for the inside and VLAN 201
for the outside.

Management interface Management 0/0 4 ports total

Place all interfaces on the same
isolated management VLAN, for
example VLAN 100.

Configure the Cluster Interface Mode on the Control Unit

)

You can only configure one type of interface for clustering: Spanned EtherChannels or Individual interfaces;
you cannot mix interface types in a cluster.

Note

Step 1

If you do not add data units from the control unit, you must set the interface mode manually on all units
according to this section, not just the control unit; if you add secondaries from the control unit, ASDM sets
the interface mode automatically on the data unit.

Before you begin

* You can always configure the management-only interface as an Individual interface (recommended),
even in Spanned EtherChannel mode. The management interface can be an Individual interface even in
transparent firewall mode.

* In Spanned EtherChannel mode, if you configure the management interface as an Individual interface,
you cannot enable dynamic routing for the management interface. You must use a static route.

* In multiple context mode, you must choose one interface type for all contexts. For example, if you have
amix of transparent and routed mode contexts, you must use Spanned EtherChannel mode for all contexts
because that is the only interface type allowed for transparent mode.

Procedure

In ASDM on the control unit, choose Tools > Command Line Interface.Show any incompatible configuration
so that you can force the interface mode and fix your configuration later; the mode is not changed with this
command:

cluster interface-mode {individual | spanned} check-details
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Configure the Cluster Interface Mode on the Control Unit .

Example:

‘@no Command Line Interface

Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would
prempt for confirmation, add an appropriate noconfirm option as parameter to the command and send it to the device. To make the changes
permanent, use the File > Save Running Configuration to Flash menu option to save the configuration to flash.

Command
(#) Single Line Multiple Line ™ Enable context sensitive help (7)
cluster interface-mode spanned check-details -
Response:

Result of the command: “cluster interface-mode spanned check-details"

ERROR: Please modify the following configuration elements that are incompatible with ‘spanned' interface-mode.
= A cluster IP address pool must be specified on interface Gi@/@(outside). Or remove IP address configuration.
= A cluster IP address pool must be specified on interface Ma@fﬂfmanaqemenl]‘ Or remove IP address configuration.

Clear Response

Help Close [E]

Caution  After you set the interface mode, you can continue to connect to the interface; however, if you reload
the ASA before you configure your management interface to comply with clustering requirements
(for example, adding a cluster IP pool), you will not be able to reconnect because cluster-incompatible
interface configuration is removed. In that case, you will have to connect to the console port to fix
the interface configuration.

Step 2 Set the interface mode for clustering:
cluster interface-mode {individual | spanned} force

Example:
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ano Command Line Interface

Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would
prompt for confirmation, add an appropriate noconfirm option as parameter to the command and send it to the device. To make the changes
permanent, use the File > Save Running Configuration to Flash menu option to save the configuration to flash.

Command
(*) Single Line Multiple Line [ Enable context sensitive help ()
cluster interface-mode spanned force r
Response:

Result of the command: "cluster interface-mode spanned force"

WARNING: Cluster interface-mode is changed to 'spanned' without walidating compatibility of the running configurat

Clear Response

Help Close

There is no default setting; you must explicitly choose the mode. If you have not set the mode, you cannot
enable clustering.

The force option changes the mode without checking your configuration for incompatible settings. You need
to manually fix any configuration issues after you change the mode. Because any interface configuration can
only be fixed after you set the mode, we recommend using the force option so that you can at least start from
the existing configuration. You can re-run the check-details option after you set the mode for more guidance.

Without the force option, if there is any incompatible configuration, you are prompted to clear your
configuration and reload, thus requiring you to connect to the console port to reconfigure your management
access. If your configuration is compatible (rare), the mode is changed and the configuration is preserved. If
you do not want to clear your configuration, you can exit the command by typing n.

To remove the interface mode, enter the no cluster interface-mode command.

Step 3 Quit ASDM and reload. ASDM needs to be restarted to correctly account for the cluster interface mode. After
you reload, you see the ASA Cluster tab on the home page:

Device Information

| General = License

Cluster Interface Mode: Spanned EtherChannel
Cluster is not enabled.

Details
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(Recommended; Required in Multiple Context Mode) Configure Interfaces on the Control Unit

You must modify any interface that is currently configured with an IP address to be cluster-ready before you
enable clustering. At a minimum, you must modify the management interface to which ASDM is currently
connected. For other interfaces, you can configure them before or after you enable clustering; we recommend
pre-configuring all of your interfaces so that the complete configuration is synced to new cluster members.
In multiple context mode, you must use the procedures in this section to fix existing interfaces or to configure
new interfaces. However, in single mode, you can skip this section and configure common interface parameters
within the High Availability and Scalability wizard (see Run the High Availability Wizard, on page 348). Note
that advanced interface settings such as creating EtherChannels for Individual interfaces are not available in
the wizard.

This section describes how to configure interfaces to be compatible with clustering. You can configure data
interfaces as either Spanned EtherChannels or as Individual interfaces. Each method uses a different
load-balancing mechanism. You cannot configure both types in the same configuration, with the exception
of the management interface, which can be an Individual interface even in Spanned EtherChannel mode.

Configure Individual Interfaces (Recommended for the Management Interface)

Individual interfaces are normal routed interfaces, each with their own IP address taken from a pool of IP
addresses. The Main cluster [P address is a fixed address for the cluster that always belongs to the current
primary unit.

In Spanned EtherChannel mode, we recommend configuring the management interface as an Individual
interface. Individual management interfaces let you connect directly to each unit if necessary, while a Spanned
EtherChannel interface only allows connection to the current primary unit.

Before you begin

* Except for the management-only interface, you must be in Individual interface mode.

 For multiple context mode, perform this procedure in each context. If you are not already in the context
configuration mode in the Configuration > Device List pane, double-click the context name under the
active device IP address.

* Individual interfaces require you to configure load balancing on neighbor devices. External load balancing
is not required for the management interface.

* (Optional) Configure the interface as a device-local EtherChannel interface, a redundant interface, and/or
configure subinterfaces.

* For an EtherChannel, this EtherChannel is local to the unit, and is not a Spanned EtherChannel.
* Management-only interfaces cannot be redundant interfaces.
* If you are connecting remotely to the management interface using ASDM, the current IP address of
prospective secondary units are for temporary use.

» Each member will be assigned an IP address from the cluster IP pool defined on the primary unit.

* The cluster IP pool cannot include addresses already in use on the network, including prospective
secondary IP addresses.

For example:

1. You configure the primary unit to use 10.1.1.1.
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2. Other units use 10.1.1.2, 10.1.1.3, and 10.1.1.4.

3. When you configure the cluster IP pool on the primary unit, you cannot include the .2, .3, or .4
addresses in the pool, because they are in use.

4. Instead, you need to use other IP addresses on the network, such as .5, .6, .7, and .8.

N

Note The pool needs as many addresses as there are members of the cluster, including
the primary unit; the original .1 address is the main cluster IP address that belongs
to the current primary unit.

5. After you join the cluster, the old, temporary addresses are relinquished and can be used

elsewhere.
Procedure
Step 1 Choose the Configuration > Device Setup > Interface Settings > Interfaces pane.
Step 2 Choose the interface row, and click Edit. Set the interface parameters. See the following guidelines:

* (Required for a management interface in Spanned EtherChannel mode) Dedicate this interface to
management only—Sets an interface to management-only mode so that it does not pass through traffic.
By default, Management type interfaces are configured as management-only. In transparent mode, this
command is always enabled for a Management type interface.

* Use Static IP—DHCP and PPPoE are not supported.

Step 3 To add the IPv4 cluster IP pool, MAC address pool, and site-specific MAC addresses, click the Advanced
tab and set ASA Cluster area parameters.
a) Create a cluster IP pool by clicking the ... button next to the IP Address Pool field. The valid range shown
is determined by the Main IP address you set on the General tab.
b) Click Add.

¢) Configure a range of addresses that does not include the Main cluster IP address, and that does not include
any addresses currently in-use on your network. You should make the range large enough for the size of
the cluster, for example, 8 addresses.

[-NaNs] Add IPv4 Pool

Mame: inside_pool
Starting |P Address: | 192.168.1.2

Ending IP Address: 192.168.1.9

00

Subnet Mask: 255.255.255.04 |

Help Cancel Ok |

THe4

d) Click OK to create the new pool.
e) Select the new pool you created, and click Assign, and then click OK.
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Step 4

Step 5
Step 6

f)

Configure Spanned EtherChannels .

The pool name appears in the IP Address Pool field.

(Optional) (Optional) Configure a MAC Address Pool if you want to manually configure MAC addresses.

To configure an IPv6 address, click the IPv6 tab.

a)
b)

d)
e)

f)

2)
h)

)

Check the Enable IPv6 check box.
In the Interface IPv6 Addresses area, click Add.

The Enable address autoconfiguration option is not supported.
The Add IPv6 Address for Interface dialog box appears.

In the Address/Prefix Length field, enter the global IPv6 address and the IPv6 prefix length. For example,
2001:0DB8::BA98:0:3210/48.

Click the ... button to configure the cluster IP pool.
Click Add.
2] (8] Add IPvE Pool
Name: inside_ipve_pool
Starting IP Address: 2001:DBE:: 1002 =2
Prefix Length: 32

Number of Addresses: al

Help Cancel oK |

Configure the starting IP address (network prefix), prefix length, and number of addresses in the pool.
Click OK to create the new pool.
Select the new pool you created, and click Assign, and then click OK.

The pool appears in the ASA Cluster IP Pool field.
Click OK.

Click OK to return to the Interfaces pane.
Click Apply.

Configure Spanned EtherChannels

A Spanned EtherChannel spans all ASAs in the cluster, and provides load balancing as part of the EtherChannel
operation.

Before you begin

* You must be in Spanned EtherChannel interface mode.

» For multiple context mode, start this procedure in the system execution space. If you are not already in
the System configuration mode in the Configuration > Device List pane, double-click System under the
active device IP address.

* For transparent mode, configure the bridge group. See Configure the Bridge Virtual Interface (BVI), on
page 515.
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* Do not specify the maximum and minimum links in the EtherChannel—We recommend that you do not
specify the maximum and minimum links in the EtherChannel on either the ASA or the switch. If you
need to use them, note the following:

* The maximum links set on the ASA is the total number of active ports for the whole cluster. Be
sure the maximum links value configured on the switch is not larger than the ASA value.

* The minimum links set on the ASA is the minimum active ports to bring up a port-channel interface
per unit. On the switch, the minimum links is the minimum links across the cluster, so this value
will not match the ASA value.

* Do not change the load-balancing algorithm from the default. On the switch, we recommend that you
use one of the following algorithms: source-dest-ip or source-dest-ip-port (see the Cisco Nexus OS
and Cisco IOS port-channel load-balance command). Do not use a vlan keyword in the load-balance
algorithm because it can cause unevenly distributed traffic to the ASAs in a cluster.

* When using Spanned EtherChannels, the port-channel interface will not come up until clustering is fully
enabled. This requirement prevents traffic from being forwarded to a unit that is not an active unit in the
cluster.

Procedure

Step 1 Depending on your context mode:

« For single mode, choose the Configuration > Device Setup > Interface Settings > Interfaces pane.

* For multiple mode in the System execution space, choose the Configuration > Context Management
> Interfaces pane.

Step 2 Choose Add > EtherChannel Interface.
The Add EtherChannel Interface dialog box appears.

Step 3 Enable the following:
» Port Channel ID

« Span EtherChannel across the ASA cluster
« Enable Interface (checked by default)

* Members in Group—In the Members in Group list, you need to add at least one interface. Multiple
interfaces in the EtherChannel per unit are useful for connecting to switches in a VSS or vPC. Keep in
mind that by default, a spanned EtherChannel can have only 8 active interfaces out of 16 maximum
across all members in the cluster; the remaining 8 interfaces are on standby in case of link failure. To
use more than 8 active interfaces (but no standby interfaces), disable dynamic port priority. When you
disable dynamic port priority, you can use up to 32 active links across the cluster. For example, for a
cluster of 16 ASAs, you can use a maximum of 2 interfaces on each ASA, for a total of 32 interfaces in
the spanned EtherChannel.

Make sure all interfaces are the same type and speed. The first interface you add determines the type and
speed of the EtherChannel. Any non-matching interfaces you add will be put into a suspended state.
ASDM does not prevent you from adding non-matching interfaces.
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Step 4

Step 5

Step 6

Step 7

Step 8
Step 9

Configure Spanned EtherChannels .

The rest of the fields on this screen are described later in this procedure.

(Optional) To override the media type, duplex, speed, and pause frames for flow control for all member
interfaces, click Configure Hardware Properties. This method provides a shortcut to set these parameters
because these parameters must match for all interfaces in the channel group.

Click OK to accept the Hardware Properties changes.

To configure the MAC address and optional parameters, click the Advanced tab.

* In the MAC Address Cloning area, set a manual global MAC address for the EtherChannel. Do not set
the Standby MAC Address; it is ignored. You must configure a MAC address for a Spanned EtherChannel
to avoid potential network connectivity problems. With a manually-configured MAC address, the MAC
address stays with the current control unit. If you do not configure a MAC address, then if the control
unit changes, the new control unit uses a new MAC address for the interface, which can cause a temporary
network outage.

In multiple context mode, if you share an interface between contexts, you should instead enable
auto-generation of MAC addresses so you do not need to set the MAC address manually. Note that you
must manually configure the MAC address using this command for non-shared interfaces.

(Routed mode) In the ASA Cluster area, for inter-site clustering set Site specific MAC Addresses and
IP addresses for a site by clicking Add and specifying a MAC address and IP address for the site ID (1
through 8). Repeat for up to 8 sites. The site-specific IP addresses must be on the same subnet as the
global IP address. The site-specific MAC address and IP address used by a unit depends on the site ID
you specify in each unit’s bootstrap configuration.

(Optional) If you are connecting the ASA to two switches in a VSS or vPC, then you should enable VSS
load balancing by checking the Enable load balancing between switch pairs in VSS or vPC mode
check box. This feature ensures that the physical link connections between the ASAs to the VSS (or vPC)
pair are balanced.

In the Member Interface Configuration area, you must then identify to which switch a given interface
is connected, 1 or 2.

Note We recommend that you do not set the Minimum Active Members and the Maximum Active
Members.

(Optional) Configure VLAN subinterfaces on this EtherChannel. The rest of this procedure applies to the
subinterfaces.

(Multiple context mode) Before you complete this procedure, you need to allocate interfaces to contexts.
a) Click OK to accept your changes.
b) Allocate interfaces.

¢) Change to the context that you want to configure: in the Device List pane, double-click the context name
under the active device IP address.

d) Choose the Configuration > Device Setup > Interface Settings > Interfaces pane, select the port-channel
interface that you want to customize, and click Edit.

The Edit Interface dialog box appears.

Click the General tab.

(Transparent Mode) From the Bridge Group drop-down list, choose the bridge group to which you want to
assign this interface.
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. Create or Join an ASA Cluster

Step 10
Step 11
Step 12

Step 13

Step 14
Step 15

In the Interface Name field, enter a name up to 48 characters in length.
In the Security level field, enter a level between 0 (lowest) and 100 (highest).

(Routed Mode) For an IPv4 address, click the Use Static IP radio button and enter the IP address and mask.
DHCP and PPPoE are not supported. For point-to-point connections, you can specify a 31-bit subnet mask
(255.255.255.254). In this case, no IP addresses are reserved for the network or broadcast addresses. For
transparent mode, you configure the IP address for the bridge group interface, not the EtherChannel interface.

(Routed Mode) To configure an IPv6 address, click the IPV6 tab.

For transparent mode, you configure the IP address for the bridge group interface, not the EtherChannel
interface.

a) Check the Enable IPv6 check box.
b) In the Interface IPv6 Addresses area, click Add.

The Add IPv6 Address for Interface dialog box appears.

Note The Enable address autoconfiguration option is not supported.

¢) Inthe Address/Prefix Length field, enter the global IPv6 address and the IPv6 prefix length. For example,
2001:DB8::BA98:0:3210/64.

d) (Optional) To use the Modified EUI-64 interface ID as the host address, check the EUI-64 check box. In
this case, just enter the prefix in the Address/Prefix Length field.

e) Click OK.

Click OK to return to the Interfaces screen.
Click Apply.

Create or Join an ASA Cluster

Each unit in the cluster requires a bootstrap configuration to join the cluster.

Run the High Availability Wizard

\}

Each unit in the cluster requires a bootstrap configuration to join the cluster. Run the High Availability and
Scalability wizard on one unit (that will become the control unit) to create the cluster, and then add data units
to it.

Note

For the control unit, if you want to change the default of the cLACP system ID and priority, you cannot use
the wizard; you must configure the cluster manually.

Before you begin

* For multiple context mode, complete this procedure in the system execution space. If you are not already
in the System configuration mode, in the Configuration > Device List pane, double-click System under
the active device IP address.
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Step 1
Step 2

Step 3

Run the High Availability Wizard .

» We suggest setting the cluster control link MTU to the maximum 9198 which requires you to enable
jumbo frame reservation on each unit before continuing with this procedure. Jumbo frame reservation
requires a reload of the ASA.

* The interfaces you intend to use for the cluster control link interface must be in an up state on the connected
switch.

* When you add a unit to a running cluster, you may see temporary, limited packet/connection drops; this
is expected behavior.

Procedure

Choose Wizards > High Availability and Scalability Wizard. See select wizard guidelines in the following
steps.

On the Interfaces screen, you cannot create new EtherChannels from this screen (except for the cluster control
link).
On the ASA Cluster Configuration screen, configure bootstrap settings including:

» Member Priority—Sets the priority of this unit for control unit elections, between 1 and 100, where 1
is the highest priority.

* (Routed mode; Spanned EtherChannel mode) Site Index—If you use inter-site clustering, set the site
ID for this unit so it uses a site-specific MAC address, between 1 and 8.

* (Optional) Shared Key—Sets an encryption key for control traffic on the cluster control link. The shared
secret is an ASCII string from 1 to 63 characters. The shared secret is used to generate the encryption
key. This parameter does not affect datapath traffic, including connection state update and forwarded
packets, which are always sent in the clear. You must configure this parameter if you also enable the
password encryption service.

* (Optional) Enable connection rebalancing for TCP traffic across all the ASAs in the cluster—Enables
connection rebalancing. This parameter is disabled by default. If enabled, ASAs in a cluster exchange
load information periodically, and offload new connections from more loaded devices to less loaded
devices. The frequency, between 1 and 360 seconds, specifies how often the load information is exchanged.
This parameter is not part of the bootstrap configuration, and is replicated from the control unit to the
data units.

Note Do not configure connection rebalancing for inter-site topologies; you do not want connections
rebalanced to cluster members at a different site.

* (Optional) Enable health monitoring of this device within the cluster—Enables the cluster unit health
check feature. To determine unit health, the ASA cluster units send heartbeat messages on the cluster
control link to other units. If a unit does not receive any heartbeat messages from a peer unit within the
holdtime period, the peer unit is considered unresponsive or dead.

Note When any topology changes occur (such as adding or removing a data interface, enabling or
disabling an interface on the ASA or the switch, adding an additional switch to form a VSS or
vPC) you must disable the health check and also disable interface monitoring for the disabled
interfaces. When the topology change is complete, and the configuration change is synced to
all units, you can re-enable the health check.
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Step 4

Step 5
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» Time to Wait Before Device Considered Failed—This value determines the amount of time

between unit keepalive status messages, between .3 and 45 seconds; The default is 3 seconds.

* (Optional) Broadcast keepalive messages to all EtherChannel cluster control link ports for

VSS/VPC support—If you configure the cluster control link as an EtherChannel (recommended),
and it is connected to a VSS or vPC pair, then you might need to enable this option. For some
switches, when one unit in the VSS/vPC is shutting down or booting up, EtherChannel member
interfaces connected to that switch may appear to be Up to the ASA, but they are not passing traffic
on the switch side. The ASA can be erroneously removed from the cluster if you set the ASA
holdtime timeout to a low value (such as .8 seconds), and the ASA sends heartbeat messages on
one of these EtherChannel interfaces. When you enable this option, the ASA floods the heartbeat
messages on all EtherChannel interfaces in the cluster control link to ensure that at least one of the
switches can receive them.

« (Optional) Replicate console output—Enables console replication from data units to the control unit.

This feature is disabled by default. The ASA may print out some messages directly to the console for
certain critical events. If you enable console replication, data units send the console messages to the
control unit so that you only need to monitor one console port for the cluster. This parameter is not part
of the bootstrap configuration, and is replicated from the control unit to the data units.

* Cluster Control Link—Specifies the cluster control link interface.

* MTU—Specifies the maximum transmission unit for the cluster control link interface to be at least

100 bytes higher than the highest MTU of the data interfaces, between 1400 and 9198 bytes. The

default MTU is 1500 bytes. If you already enabled jumbo frame reservation, we suggest setting the
MTU to the maximum. Because the cluster control link traffic includes data packet forwarding, the
cluster control link needs to accommodate the entire size of a data packet plus cluster traffic overhead.
For example, because the maximum MTU is 9198 bytes, then the highest data interface MTU can
be 9098, while the cluster control link can be set to 9198. Note: If you have not pre-enabled jumbo
frame reservation, you should quit the wizard, enable jumbo frames, and then restart this procedure.

On the Interfaces for Health Monitoring screen, you can exempt some interfaces from monitoring for failure.
You might want to disable health monitoring of non-essential interfaces, for example, the management
interface. To exempt a hardware module such as the ASA Firepower module from monitoring, check the
Exempt Service Module from Cluster health monitoring check box.

Note

When any topology changes occur (such as adding or removing a data interface, enabling or disabling
an interface on the ASA or the switch, adding an additional switch to form a VSS or vPC) you must
disable the health check and also disable interface monitoring for the disabled interfaces. When the
topology change is complete, and the configuration change is synced to all units, you can re-enable
the health check.

On the Interface Auto Rejoin settings screen, customize the auto-rejoin settings in case of an interface or
cluster control link failure. For each type, you can set the following:

» Maximum Rejoin Attempts—Define the number of attempts at rejoining the cluster by setting Unlimited

or a value between 0 and 65535. 0 disables auto-rejoining. The default value is Unlimited for the
cluster-interface and 3 for the data-interface.

* Rejoin Interval—Define the interval duration in minutes between rejoin attempts by setting the interval

between 2 and 60. The default value is 5 minutes. The maximum total time that the unit attempts to rejoin
the cluster is limited to 14400 minutes (10 days) from the time of last failure.

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8



| High Availability and Scalability
Customize the Clustering Operation .

« Interval Variation—Define if the interval duration increases by setting the interval variation between
1 and 3: 1 (no change); 2 (2 x the previous duration), or 3 (3 x the previous duration). For example, if
you set the interval duration to 5 minutes, and set the variation to 2, then the first attempt is after 5
minutes; the 2nd attempt is 10 minutes (2 x 5); the 3rd attempt 20 minutes (2 x 10), and so on. The default
value is 1 for the cluster-interface and 2 for the data-interface.

Step 6 Click Finish.

Step 7 The ASA scans the running configuration for incompatible commands for features that are not supported with
clustering, including commands that may be present in the default configuration. Click OK to delete the
incompatible commands. If you click Cancel, then clustering is not enabled.

After a period of time while ASDM enables clustering and reconnects to the ASA, the Information screen
appears confirming that the ASA was added to the cluster.

Note In some cases, there might be an error when joining the cluster after you finish the wizard. If ASDM
was disconnected, ASDM will not receive any subsequent errors from the ASA. If clustering remains
disabled after you reconnect ASDM, you should connect to the ASA console port to determine the
exact error condition that disabled clustering; for example, the cluster control link might be down.

Step 8 To add a data unit, click Yes.

If you are re-running the wizard from the control unit, you can add data units by choosing the Add another
member to the cluster option when you first start the wizard.

Step 9 In the Deployment Options area, choose one of the following Deploy By options:

« Sending CLI commands to the remote unit now—Send the bootstrap configuration to the data unit
(temporary) management [P address. Enter the data unit management IP address, username, and password.

» Copying generated CLI commands to paste on the remote unit manually—Generates the commands
so that you can cut and paste them at the data unit CLI or using the CLI tool in ASDM. In the Commands
to Deploy box, select and copy the generated commands for later use.

Deployment Options

Deploy By: | Copying generated CLI commands to paste on the remote unit manually =

Commands to Deploy:

cluster interface-mode spanned force
clear configure cluster
interface GigabitEthernet(/4
no shutdown
cluster group clusterl
local-unit asall
priority 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test
enable as-slave noconfirm

Customize the Clustering Operation

You can customize clustering health monitoring, TCP connection replication delay, flow mobility and other
optimizations.
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. Configure Basic ASA Cluster Parameters

Perform these procedures on the control unit.

Configure Basic ASA Cluster Parameters

Step 1

Step 2

Step 3

You can customize cluster settings on the control unit. If you do not use the wizard to add a unit to the cluster,
you can configure the cluster parameters manually. If you already enabled clustering, you can edit some cluster
parameters; others that cannot be edited while clustering is enabled are grayed out. This procedure also includes
advanced parameters that are not included in the wizard.

Before you begin

* Pre-configure the cluster control link interfaces on each unit before joining the cluster. For a single
interface, you must enable it; do not configure any other settings. For an EtherChannel interface, enable
it and set the EtherChannel mode to On.

» For multiple context mode, complete this procedure in the system execution space on the control unit.
If you are not already in the System configuration mode, in the Configuration > Device List pane,
double-click System under the active device IP address.

Procedure

Choose Configuration > Device Management > High Availability and Scalability > ASA Cluster.

If your device is already in the cluster, and is the control unit, then this pane is on the Cluster Configuration
tab.

Check the Configure ASA cluster settings check box.

If you uncheck the check box, the settings are erased. Do not check Participate in ASA cluster until after
you have set all your parameters.

Note After you enable clustering, do not uncheck the Configure ASA cluster settings check box without
understanding the consequences. This action clears all cluster configuration, and also shuts down
all interfaces including the management interface to which ASDM is connected. To restore
connectivity in this case, you need to access the CLI at the console port.

Configure the following bootstrap parameters:

* Cluster Name—Names the cluster. The name must be an ASCII string from 1 to 38 characters. You can
only configure one cluster per unit. All members of the cluster must use the same name.

* Member Name—Names this member of the cluster with a unique ASCII string from 1 to 38 characters.

» Member Priority—Sets the priority of this unit for control unit elections, between 1 and 100, where 1
is the highest priority.

« Site Index—If you use inter-site clustering, set the site ID for this unit so it uses a site-specific MAC
address, between 1 and 8.

* (Optional) Shared Key—Sets an encryption key for control traffic on the cluster control link. The shared
secret is an ASCII string from 1 to 63 characters. The shared secret is used to generate the encryption
key. This parameter does not affect datapath traffic, including connection state update and forwarded
packets, which are always sent in the clear. You must configure this parameter if you also enable the
password encryption service.
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Configure Basic ASA Cluster Parameters .

(Optional) Enable connection rebalancing for TCP traffic across all the ASAs in the cluster—Enables
connection rebalancing. This parameter is disabled by default. If enabled, ASAs in a cluster exchange
load information periodically, and offload new connections from more loaded devices to less loaded
devices. The frequency, between 1 and 360 seconds, specifies how often the load information is exchanged.
This parameter is not part of the bootstrap configuration, and is replicated from the control unit to the
data units.

(Optional) Enable health monitoring of this device within the cluster—Enables the cluster unit health
check feature, and determines the amount of time between unit heartbeat status messages, between .3
and 45 seconds; The default is 3 seconds. Note: When you are adding new units to the cluster, and making
topology changes on the ASA or the switch, you should disable this feature temporarily until the cluster
is complete, and also disable interface monitoring for the disabled interfaces (Configuration > Device
Management > High Availability and Scalability > ASA Cluster > Cluster Interface Health
Monitoring). You can re-enable this feature after cluster and topology changes are complete. To determine
unit health, the ASA cluster units send heartbeat messages on the cluster control link to other units. If a
unit does not receive any heartbeat messages from a peer unit within the holdtime period, the peer unit
is considered unresponsive or dead.

* (Optional) Broadcast keepalive messages to all EtherChannel cluster control link ports for
VSS/VPC support—If you configure the cluster control link as an EtherChannel (recommended),
and it is connected to a VSS or vPC pair, then you might need to enable this option. For some
switches, when one unit in the VSS/vPC is shutting down or booting up, EtherChannel member
interfaces connected to that switch may appear to be Up to the ASA, but they are not passing traffic
on the switch side. The ASA can be erroneously removed from the cluster if you set the ASA
holdtime timeout to a low value (such as .8 seconds), and the ASA sends heartbeat messages on
one of these EtherChannel interfaces. When you enable this option, the ASA floods the heartbeat
messages on all EtherChannel interfaces in the cluster control link to ensure that at least one of the
switches can receive them.

(Optional) Debounce Time—Configures the debounce time before the ASA considers an interface to
be failed and the unit is removed from the cluster. This feature allows for faster detection of interface
failures. Note that configuring a lower debounce time increases the chances of false-positives. When an
interface status update occurs, the ASA waits the number of milliseconds specified before marking the
interface as failed and the unit is removed from the cluster. The default debounce time is 500 ms, with
a range of 300 ms to 9 seconds.

(Optional) Replicate console output—Enables console replication from data units to the control unit.
This feature is disabled by default. The ASA may print out some messages directly to the console for
certain critical events. If you enable console replication, data units send the console messages to the
control unit so that you only need to monitor one console port for the cluster. This parameter is not part
of the bootstrap configuration, and is replicated from the control unit to the data units.

(Optional) Enable Clustering Flow Mobility. See Configure LISP Inspection, on page 358.

(Optional) Enable Director Localization for inter-DC cluster—To improve performance and reduce
round-trip time latency for inter-site clustering for data centers, you can enable director localization.
New connections are typically load-balanced and owned by cluster members within a given site. However,
the ASA assigns the Director role to a member at any site. Director localization enables additional Director
roles: a Local Director at the same site as the Owner, and a Global Director that can be at any site. Keeping
the Owner and Director at the same site improves performance. Also, if the original Owner fails, the
Local Director will choose a new connection Owner at the same site. The Global Director is used if a
cluster member receives packets for a connection that is owned on a different site.
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* Cluster Control Link—Specifies the cluster control link interface. This interface cannot have a name
configured; available interfaces are shown in the drop-down list.

* Interface—Specifies the interface ID, preferably an EtherChannel. Subinterfaces and Management
type interfaces are not allowed.

* IP Address—Specifies an IPv4 address for the IP address; IPv6 is not supported for this interface.
 Subnet Mask—Specifies the subnet mask.

* MTU—Specifies the maximum transmission unit for the cluster control link interface to be at least
100 bytes higher than the highest MTU of the data interfaces, between 1400 and 9198 bytes. The
default MTU is 1500 bytes. Because the cluster control link traffic includes data packet forwarding,
the cluster control link needs to accommodate the entire size of a data packet plus cluster traffic
overhead. We suggest setting the cluster control link MTU to the maximum, which requires you to
enable jumbo frame reservation. Jumbo frame reservation requires a reload of the ASA. For example,
because the maximum MTU is 9198 bytes, then the highest data interface MTU can be 9098, while
the cluster control link can be set to 9198.

* (Optional) Cluster LACP—When using Spanned EtherChannels, the ASA uses cLACP to negotiate the
EtherChannel with the neighbor switch. ASAs in a cluster collaborate in cLACP negotiation so that they
appear as a single (virtual) device to the switch.

+ Enable static port priority—Disables dynamic port priority in LACP. Some switches do not
support dynamic port priority, so this parameter improves switch compatibility. Moreover, it enables
support of more than 8 active spanned EtherChannel members, up to 32 members. Without this
parameter, only 8 active members and 8 standby members are supported. If you enable this parameter,
then you cannot use any standby members; all members are active. This parameter is not part of the
bootstrap configuration, and is replicated from the control unit to the data units.

* Virtual System MAC Address—Sets the cLACP system ID, which is in the format of a MAC
address. All ASAs use the same system ID: auto-generated by the control unit (the default) and
replicated to all secondaries; or manually specified in the form H.H.H, where H is a 16-bit
hexadecimal digit. For example, the MAC address 00-0C-F1-42-4C-DE is entered as
000C.F142.4CDE. This parameter is not part of the bootstrap configuration, and is replicated from
the control unit to the data units. However, you can only change this value if you disable clustering.

« System Priority—Sets the system priority, between 1 and 65535. The priority is used to decide
which unit is in charge of making a bundling decision. By default, the ASA uses priority 1, which
is the highest priority. The priority needs to be higher than the priority on the switch. This parameter
is not part of the bootstrap configuration, and is replicated from the control unit to the data units.
However, you can only change this value if you disable clustering.

Step 4 Check the Participate in ASA cluster check box to join the cluster.
Step 5 Click Apply.

Configure Interface Health Monitoring and Auto-Rejoin Settings

You might want to disable health monitoring of non-essential interfaces, for example, the management
interface. You can monitor any port-channel ID, redundant ID, or single physical interface ID, or the software
or hardware module, such as the ASA Firepower module. Health monitoring is not performed on VLAN
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Step 1

Step 2

Step 3

Step 4

Configure Interface Health Monitoring and Auto-Rejoin Settings .

subinterfaces or virtual interfaces such as VNIs or BVIs. You cannot configure monitoring for the cluster
control link; it is always monitored.

Procedure

Choose Configuration > Device Management > High Availability and Scalability > ASA Cluster >
Cluster Interface Health Monitoring.

In the Monitored Interfaces box, select an interface, and click Add to move it to the Unmonitored Interfaces
box.

Interface status messages detect link failure. If all physical ports for a given logical interface fail on a particular
unit, but there are active ports under the same logical interface on other units, then the unit is removed from
the cluster. If a unit does not receive interface status messages within the holdtime, then the amount of time

before the ASA removes a member from the cluster depends on the type of interface and whether the unit is
an established member or is joining the cluster. Health check is enabled by default for all interfaces.

You might want to disable health monitoring of non-essential interfaces, for example, the management
interface. You can specify any port-channel ID, redundant ID, or single physical interface ID. Health monitoring
is not performed on VLAN subinterfaces or virtual interfaces such as VNIs or BVIs. You cannot configure
monitoring for the cluster control link; it is always monitored.

When any topology changes occur (such as adding or removing a data interface, enabling or disabling an
interface on the ASA or the switch, or adding an additional switch to form a VSS or vPC) you should disable
the health check feature (Configuration > Device Management > High Availability and Scalability >
ASA Cluster) and also disable interface monitoring for the disabled interfaces. When the topology change
is complete, and the configuration change is synced to all units, you can re-enable the health check feature.

(Optional) Check the Exempt Service Module from Cluster Health Monitoring check box to exempt a
hardware or software module such as the ASA FirePOWER module.

For the ASA 5585-X, if you disable monitoring of the service module, you may also want to disable monitoring
of the interfaces on the module, which are monitored separately.

Click the Auto Rejoin tab to customize the auto-rejoin settings in case of an interface or cluster control link
failure. For each type, click Edit to set the following:

» Maximum Rejoin Attempts—Define the number of attempts at rejoining the cluster by setting Unlimited
or a value between 0 and 65535. 0 disables auto-rejoining. The default value is Unlimited for the
cluster-interface and 3 for the data-interface.

* Rejoin Interval—Define the interval duration in minutes between rejoin attempts by setting the interval
between 2 and 60. The default value is 5 minutes. The maximum total time that the unit attempts to rejoin
the cluster is limited to 14400 minutes (10 days) from the time of last failure.

* Interval Variation—Define if the interval duration increases by setting the interval variation between
1 and 3: 1 (no change); 2 (2 x the previous duration), or 3 (3 x the previous duration). For example, if
you set the interval duration to 5 minutes, and set the variation to 2, then the first attempt is after 5
minutes; the 2nd attempt is 10 minutes (2 x 5); the 3rd attempt 20 minutes (2 x 10), and so on. The default
value is 1 for the cluster-interface and 2 for the data-interface.

Click Restore Defaults to restore the default settings.
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Step 5 Click Apply.

Configure the Cluster TCP Replication Delay

Enable the cluster replication delay for TCP connections to help eliminate the “unnecessary work” related to
short-lived flows by delaying the director/backup flow creation. Note that if a unit fails before the
director/backup flow is created, then those flows cannot be recovered. Similarly, if traffic is rebalanced to a
different unit before the flow is created, then the flow cannot be recovered. You should not enable the TCP
replication delay for traffic on which you disable TCP randomization.

Procedure

Step 1 Choose Configuration > Device Management > High Availability and Scalability > ASA Cluster
Replication.

Step 2 Click Add and set the following values:

* Replication delay—Set the seconds between 1 and 15.

» HTTP—Set the delay for all HTTP traffic. This setting is enabled by default for 5 seconds for the
Firepower 4100/9300 chassis only.

« Source Criteria

« Source—Set the source IP address.

* Service—(Optional) Set the source port. Typically you set either the source or the destination port,
but not both.

» Destination Criteria
» Source—Set the destination IP address.
* Service—(Optional) Set the destination port. Typically you set either the source or the destination

port, but not both.

Step 3 Click OK.
Step 4 Click Apply.

Configure Inter-Site Features

For inter-site clustering, you can customize your configuration to enhance redundancy and stability.

Configure Cluster Flow Mobility

You can inspect LISP traffic to enable flow mobility when a server moves between sites.

About LISP Inspection

You can inspect LISP traffic to enable flow mobility between sites.
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About LISP

ASA LISP Support

LISP Guidelines

AoutLisP i

Data center virtual machine mobility such as VMware VMotion enables servers to migrate between data
centers while maintaining connections to clients. To support such data center server mobility, routers need to
be able to update the ingress route towards the server when it moves. Cisco Locator/ID Separation Protocol
(LISP) architecture separates the device identity, or endpoint identifier (EID), from its location, or routing
locator (RLOC), into two different numbering spaces, making server migration transparent to clients. For
example, when a server moves to a new site and a client sends traffic to the server, the router redirects traffic
to the new location.

LISP requires routers and servers in certain roles, such as the LISP egress tunnel router (ETR), ingress tunnel
router (ITR), first hop routers, map resolver (MR), and map server (MS). When the first hop router for the

server senses that the server is connected to a different router, it updates all of the other routers and databases
so that the ITR connected to the client can intercept, encapsulate, and send traffic to the new server location.

The ASA does not run LISP itself; it can, however, inspect LISP traffic for location changes and then use this
information for seamless clustering operation. Without LISP integration, when a server moves to a new site,
traffic comes to an ASA cluster member at the new site instead of to the original flow owner. The new ASA
forwards traffic to the ASA at the old site, and then the old ASA has to send traffic back to the new site to
reach the server. This traffic flow is sub-optimal and is known as “tromboning” or “hair-pinning.”

With LISP integration, the ASA cluster members can inspect LISP traffic passing between the first hop router
and the ETR or ITR, and can then change the flow owner to be at the new site.

» The ASA cluster members must reside between the first hop router and the ITR or ETR for the site. The
ASA cluster itself cannot be the first hop router for an extended segment.

* Only fully-distributed flows are supported; centralized flows, semi-distributed flows, or flows belonging
to individual units are not moved to new owners. Semi-distributed flows include applications, such as
SIP, where all child flows are owned by the same ASA that owns the parent flow.

* The cluster only moves Layer 3 and 4 flow states; some application data might be lost.

* For short-lived flows or non-business-critical flows, moving the owner may not be worthwhile. You can
control the types of traffic that are supported with this feature when you configure the inspection policy,
and should limit flow mobility to essential traffic.

ASA LISP Implementation

This feature includes several inter-related configurations (all of which are described in this chapter):

1. (Optional) Limit inspected EIDs based on the host or server IP address—The first hop router might send
EID-notify messages for hosts or networks the ASA cluster is not involved with, so you can limit the
EIDs to only those servers or networks relevant to your cluster. For example, if the cluster is only involved
with 2 sites, but LISP is running on 3 sites, you should only include EIDs for the 2 sites involved with
the cluster.

2. LISP traffic inspection—The ASA inspects LISP traffic on UDP port 4342 for the EID-notify message
sent between the first hop router and the ITR or ETR. The ASA maintains an EID table that correlates
the EID and the site ID. For example, you should inspect LISP traffic with a source IP address of the first
hop router and a destination address of the ITR or ETR. Note that LISP traffic is not assigned a director,
and LISP traffic itself does not participate in cluster state sharing.
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Configure LISP Inspection

Step 1

Step 2

3.

High Availability and Scalability |

Service Policy to enable flow mobility on specified traffic—You should enable flow mobility on
business-critical traffic. For example, you can limit flow mobility to only HTTPS traffic, and/or to traffic
to specific servers.

Site IDs—The ASA uses the site ID for each cluster unit to determine the new owner.

Cluster-level configuration to enable flow mobility—You must also enable flow mobility at the cluster
level. This on/off toggle lets you easily enable or disable flow mobility for a particular class of traffic or
applications.

You can inspect LISP traffic to enable flow mobility when a server moves between sites.

Before you begin

* Assign each cluster unit to a site ID according to Configure Basic ASA Cluster Parameters, on page 352.

* LISP traffic is not included in the default-inspection-traffic class, so you must configure a separate class

for LISP traffic as part of this procedure.

Procedure

(Optional) Configure a LISP inspection map to limit inspected EIDs based on IP address, and to configure
the LISP pre-shared key:

a)
b)
<)
d)

g)

Choose Configuration > Firewall > Objects > Inspect Maps > LISP.
Click Add to add a new map.

Enter a name (up to 40 characters) and description.

For the Allowed-EID access-list, click Manage.

The ACL Manager opens.

The first hop router or ITR/ETR might send EID-notify messages for hosts or networks the ASA cluster
is not involved with, so you can limit the EIDs to only those servers or networks relevant to your cluster.
For example, if the cluster is only involved with 2 sites, but LISP is running on 3 sites, you should only
include EIDs for the 2 sites involved with the cluster.

Add an ACL with at least one ACE according to the firewall configuration guide.
If necessary, enter the Validation Key.

If you copied an encrypted key, click the Encrypted radio button.
Click OK.

Add a service policy rule to configure LISP inspection:

a)
b)

¢)

Choose Configuration > Firewall > Service Policy Rules.
Click Add.
On the Service Policy page, apply the rule to an interface or globally.

If you have an existing service policy you want to use, add a rule to that policy. By default, the ASA
includes a global policy called global_policy. You can also create one service policy per interface if you
do not want to apply the policy globally. LISP inspection is applied to traffic bidirectionally so you do
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d)

e)
f)

2)
h)
i)
j)
k)

Manage Cluster Members .

not need to apply the service policy on both the source and destination interfaces; all traffic that enters or
exits the interface to which you apply the rule is affected if the traffic matches the class for both directions.

On the Traffic Classification Criteria page, click Create a new traffic class, and under Traffic Match
Criteria, check Source and Destination IP Address (uses ACL).

Click Next.

Specify the traffic you want to inspect. You should specify traffic between the first hop router and the
ITR or ETR on UDP port 4342. Both IPv4 and IPv6 ACLs are accepted.

Click Next.

On the Rule Actions wizard page or tab, select the Protocol Inspection tab.
Check the LISP check box,.

(Optional) Click Configure to choose the inspection map you created.
Click Finish to save the service policy rule.

Step 3 Add a service policy rule to enable Flow Mobility for critical traffic:

a)
b)
c)
d)

e)
f)

2
h)
i)
j)

Choose Configuration > Firewall > Service Policy Rules.
Click Add.
On the Service Policy page, choose the same service policy you used for LISP inspection.

On the Traffic Classification Criteria page, click Create a new traffic class, and under Traffic Match
Criteria, check Source and Destination IP Address (uses ACL).

Click Next.

Specify the business critical traffic that you want to re-assign to the most optimal site when servers change
sites. For example, you can limit flow mobility to only HTTPS traffic, and/or to traffic to specific servers.
Both IPv4 and IPv6 ACLs are accepted.

Click Next.

On the Rule Actions wizard page or tab, select the Cluster tab.

Check the Enable Cluster flow-mobility triggered by LISP EID messages check box.
Click Finish to save the service policy rule.

Step 4 Choose Configuration > Device Management > High Availability and Scalability > ASA Cluster >
Cluster Configuration, and check the Enable Clustering flow mobility check box.

Step 5 Click Apply.

Manage Cluster Members

After you deploy the cluster, you can change the configuration and manage cluster members.

Add a New Data Unit from the Control Unit

You can add additional secondaries to the cluster from the control unit. You can also add secondaries using
the High Availability and Scalability wizard. Adding a data unit from the control unit has the benefit of
configuring the cluster control link and setting the cluster interface mode on each data unit you add.

You can alternatively log into the data unit and configure clustering directly on the unit. However, after you
enable clustering, your ASDM session will be disconnected, and you will have to reconnect.
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Before you begin

 For multiple context mode, complete this procedure in the system execution space. If you are not already

in the System configuration mode, in the Configuration > Device List pane, double-click System under
the active device IP address.

* If you want to send the bootstrap configuration over the management network, be sure the data unit has
an accessible IP address.

Procedure

Step 1 Choose Configuration > Device Management > High Availability and Scalability > ASA Cluster >
Cluster Members.

Step 2 Click Add.

Step 3 Configure the following parameters:
» Member Name—Names this member of the cluster with a unique ASCII string from 1 to 38 characters.

» Member Priority—Sets the priority of this unit for control unit elections, between 1 and 100, where 1
is the highest priority.

» Cluster Control Link > IP Address—Specifies a unique IP address for this member for the cluster
control link, on the same network as the control unit cluster control link.

* In the Deployment Options area, choose one of the following Deploy By options:

+ Sending CLI commands to the remote unit now—Send the bootstrap configuration to the data

unit (temporary) management IP address. Enter the data unit management IP address, username,
and password.

» Copying generated CLI commands to paste on the remote unit manually—Generates the
commands so that you can cut and paste them at the data unit CLI or using the CLI tool in ASDM.
In the Commands to Deploy box, select and copy the generated commands for later use.

Deployment Options
Deploy By: | Copying generated CLI commands to paste on the remote unit manually =

Commands to Deploy:

cluster interface-mode spanned force
clear configure cluster
interface GigabitEthernet0/4
no shutdown
cluster group clusterl
local=unit asal0
priarity 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test
enable as=slave noconfirm

Step 4 Click OK, then Apply.
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Become an Inactive Member .

Become an Inactive Member

\}

To become an inactive member of the cluster, disable clustering on the unit while leaving the clustering
configuration intact.

Note

Step 1

Step 2

Step 3

When an ASA becomes inactive (either manually or through a health check failure), all data interfaces are
shut down; only the management-only interface can send and receive traffic. To resume traffic flow, re-enable
clustering; or you can remove the unit altogether from the cluster. The management interface remains up using
the IP address the unit received from the cluster IP pool. However if you reload, and the unit is still inactive
in the cluster (for example, you saved the configuration with clustering disabled), then the management
interface is disabled. You must use the console port for any further configuration.

Before you begin

* For multiple context mode, perform this procedure in the system execution space. If you are not already
in the System configuration mode in the Configuration > Device List pane, double-click System under
the active device IP address.

Procedure

Choose Configuration > Device Management > High Availability and Scalability > ASA Cluster >
Cluster Configuration.

Uncheck the Participate in ASA cluster check box.
Note Do not uncheck the Configure ASA cluster settings check box; this action clears all cluster
configuration, and also shuts down all interfaces including the management interface to which

ASDM is connected. To restore connectivity in this case, you need to access the CLI at the console
port.

Click Apply.

Deactivate a Data Unit from the Control Unit

)

To deactivate a data unit, perform the following steps.

Note

When an ASA becomes inactive, all data interfaces are shut down; only the management-only interface can
send and receive traffic. To resume traffic flow, re-enable clustering. The management interface remains up
using the IP address the unit received from the cluster IP pool. However if you reload, and the unit is still
inactive in the cluster (for example, if you saved the configuration with clustering disabled), the management
interface is disabled. You must use the console port for any further configuration.
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. Rejoin the Cluster

Before you begin

For multiple context mode, perform this procedure in the system execution space. If you are not already in
the System configuration mode in the Configuration > Device List pane, double-click System under the
active device IP address.

Procedure

Step 1 Choose Configuration > Device Management > High Availability and Scalability > ASA Cluster.
Step 2 Select the data unit that you want to remove, and click Delete.

The data unit bootstrap configuration remains intact, so that you can later re-add the data unit without losing
your configuration.

Step 3 Click Apply.

Rejoin the Cluster

If a unit was removed from the cluster, for example for a failed interface or if you manually deactivated a
member, you must manually rejoin the cluster.

Before you begin

* You must use the console port to reenable clustering. Other interfaces are shut down. The exception is
if you manually disabled clustering in ASDM, then you can reenable clustering in ASDM if you did not
save the configuration and reload. After reloading, the management interface is disabled, so console
access is the only method to reenable clustering.

* For multiple context mode, perform this procedure in the system execution space. If you are not already
in the System configuration mode in the Configuration > Device List pane, double-click System under
the active device IP address.

» Make sure the failure is resolved before you try to rejoin the cluster.

Procedure

Step 1 If you still have ASDM access, you can reenable clustering in ASDM by connecting ASDM to the unit you
want to reenable.

You cannot reenable clustering for a data unit from the control unit unless you add it as a new member.

a) Choose Configuration > Device Management > High Availability and Scalability > ASA Cluster.
b) Check the Participate in ASA cluster check box.
¢) Click Apply.

Step 2 If you cannot use ASDM: At the console, enter cluster configuration mode:
cluster group name

Example:
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Step 3

Leave the Cluster .

ciscoasa(config)# cluster group podl

Enable clustering.

enable

Leave the Cluster

Step 1

Step 2

Step 3

Step 4

If you want to leave the cluster altogether, you need to remove the entire cluster bootstrap configuration.
Because the current configuration on each member is the same (synced from the primary unit), leaving the
cluster also means either restoring a pre-clustering configuration from backup, or clearing your configuration
and starting over to avoid IP address conflicts.

Before you begin

You must use the console port; when you remove the cluster configuration, all interfaces are shut down,

including the management interface and cluster control link.

Procedure

For a secondary unit, disable clustering:

cluster group cluster_name
no enable

Example:

ciscoasa(config)# cluster group clusterl
ciscoasa(cfg-cluster)# no enable

You cannot make configuration changes while clustering is enabled on a secondary unit.

Clear the cluster configuration:

clear configure cluster

The ASA shuts down all interfaces including the management interface and cluster control link.
Disable cluster interface mode:

no cluster interface-mode

The mode is not stored in the configuration and must be reset manually.

If you have a backup configuration, copy the backup configuration to the running configuration:
copy backup_cfg running-config

Example:
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. Change the Control Unit

Step 5

Step 6

ciscoasa(config)# copy backup cluster.cfg running-config
Source filename [backup_ cluster.cfg]?
Destination filename [running-config]?

ciscoasa (config) #

Save the configuration to startup:

write memory

If you do not have a backup configuration, reconfigure management access. Be sure to change the interface
IP addresses, and restore the correct hostname, for example.

Change the Control Unit

A

Caution

Step 1
Step 2
Step 3
Step 4

The best method to change the control unit is to disable clustering on the control unit, wait for a new control
election, and then re-enable clustering. If you must specify the exact unit you want to become the control unit,
use the procedure in this section. Note, however, that for centralized features, if you force a control unit change
using this procedure, then all connections are dropped, and you have to re-establish the connections on the
new control unit.

To change the control unit, perform the following steps.

Before you begin

For multiple context mode, perform this procedure in the system execution space. If you are not already in
the System configuration mode in the Configuration > Device List pane, double-click System under the active
device IP address.

Procedure

Choose Monitoring > ASA Cluster > Cluster Summary.
From the drop-down list, choose a data unit to become master, and click the button to make it the control unit.
You are prompted to confirm the control unit change. Click Yes.

Quit ASDM, and reconnect using the Main cluster IP address.

Execute a Command Cluster-Wide

To send a command to all members in the cluster, or to a specific member, perform the following steps.
Sending a show command to all members collects all output and displays it on the console of the current unit.
Other commands, such as capture and copy, can also take advantage of cluster-wide execution.
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Monitoring the ASA Cluster .

Before you begin

Perform this procedure at the Command Line Interface tool: choose Tools > Command Line Interface.

Procedure

Send a command to all members, or if you specify the unit name, a specific member:
cluster exec [unit unit_name] command

Example:

ciscoasa# cluster exec show xlate

To view member names, enter cluster exec unit ? (to see all names except the current unit), or enter the show
cluster info command.

Examples

To copy the same capture file from all units in the cluster at the same time to a TFTP server, enter
the following command on the control unit:

ciscoasa# cluster exec copy /pcap capture: tftp://10.1.1.56/capturel.pcap

Multiple PCAP files, one from each unit, are copied to the TFTP server. The destination capture file
name is automatically attached with the unit name, such as capturel asal.pcap, capturel asa2.pcap,
and so on. In this example, asal and asa2 are cluster unit names.

The following sample output for the cluster exec show port-channel summary command shows
EtherChannel information for each member in the cluster:

ciscoasa# cluster exec show port-channel summary

maSter(LOCAL):***********************************************************
Number of channel-groups in use: 2

Group Port-channel Protocol Span-cluster Ports

—————— BT it e et it e e
1 Pol LACP Yes Gi0/0(P)

2 Po2 LACP Yes Gi0/1(P)
Slave:******************************************************************
Number of channel-groups in use: 2

Group Port-channel Protocol Span-cluster Ports

1 Pol LACP Yes Gi0/0 (P)
2 Po2 LACP Yes Gi0/1(P)

Monitoring the ASA Cluster

You can monitor and troubleshoot cluster status and connections.
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Monitoring Cluster Status

See the following screens for monitoring cluster status:
* Monitoring > ASA Cluster > Cluster Summary

This pane shows cluster information about the unit to which you are connected, as well as other units in
the cluster. You can also change the primary unit from this pane.

e Cluster Dashboard

On the home page on the primary unit, you can monitor the cluster using the Cluster Dashboard and the
Cluster Firewall Dashboard.

Capturing Packets Cluster-Wide
See the following screen for capturing packets in a cluster:

Wizards > Packet Capture Wizard

To support cluster-wide troubleshooting, you can enable capture of cluster-specific traffic on the control unit,
which is then automatically enabled on all of the data units in the cluster.

Monitoring Cluster Resources
See the following screens for monitoring cluster resources:
» Monitoring > ASA Cluster > System Resources Graphs > CPU
This pane lets you create graphs or tables showing the CPU utilization across the cluster members.

» Monitoring > ASA Cluster > System Resources Graphs > Memory. This pane lets you create graphs
or tables showing the Free Memory and Used Memory across the cluster members.

Monitoring Cluster Traffic
See the following screens for monitoring cluster traffic:
 Monitoring > ASA Cluster > Traffic Graphs > Connections.
This pane lets you create graphs or tables showing the Connections across the cluster members.
» Monitoring > ASA Cluster > Traffic Graphs > Throughput.

This pane lets you create graphs or tables showing the traffic throughput across the cluster members.

Monitoring the Cluster Control Link

See the following screen for monitoring cluster status:
Monitoring > Properties > System Resources Graphs > Cluster Control Link.

This pane lets you create graphs or tables showing the cluster control link Receival and Transmittal capacity
utilization.
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Monitoring Cluster Routing

See the following screen for cluster routing:
» Monitoring > Routing > LISP-EID Table
Shows the ASA EID table showing EIDs and site IDs.

Configuring Logging for Clustering

See the followingscreen for configuring logging for clustering:
Configuration > Device Management > Logging > Syslog Setup

Each unit in the cluster generates syslog messages independently. You can generate syslog messages with
identical or different device IDs to make messages appear to come from the same or different units in the
cluster.

Examples for ASA Clustering

These examples include all cluster-related ASA configuration for typical deployments.

Sample ASA and Switch Configuration

The following sample configurations connect the following interfaces between the ASA and the switch:

ASA Interface Switch Interface

GigabitEthernet 0/2 GigabitEthernet 1/0/15

GigabitEthernet 0/3 GigabitEthernet 1/0/16

GigabitEthernet 0/4 GigabitEthernet 1/0/17

GigabitEthernet 0/5 GigabitEthernet 1/0/18
ASA Configuration

Interface Mode on Each Unit

cluster interface-mode spanned force

ASA1 Control Unit Bootstrap Configuration

interface GigabitEthernet0/0
channel-group 1 mode on

no shutdown

|

interface GigabitEthernet0/1
channel-group 1 mode on
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no shutdown
|

interface Port-channell

description Clustering Interface

|
cluster group Moya
local-unit A

cluster-interface Port-channell ip 10.0.0.1 255.255.255.0

priority 10
key emphyriO
enable noconfirm

ASA2 Data Unit Bootstrap Configuration

interface GigabitEthernet0/0
channel-group 1 mode on

no shutdown

!
interface GigabitEthernet0/1
channel-group 1 mode on

no shutdown

!

interface Port-channell

description Clustering Interface

!
cluster group Moya
local-unit B

cluster-interface Port-channell ip 10.0.0.2 255.255.255.0

priority 11
key emphyri0
enable as-slave

Control Unit Interface Configuration

ip local pool mgmt-pool 10.53.195.231-10.53.195.232

interface GigabitEthernet0/2
channel-group 10 mode active
no shutdown

|

interface GigabitEthernet0/3
channel-group 10 mode active
no shutdown

|

interface GigabitEthernet0/4
channel-group 11 mode active
no shutdown

|

interface GigabitEthernet0/5
channel-group 11 mode active
no shutdown

|

interface Management0/0
management-only

nameif management

ip address 10.53.195.230 cluster-pool mgmt-pool

security-level 100
no shutdown
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Cisco 10S Switch Configuration .

interface Port-channellO

port-channel span-cluster

mac-address aaaa.bbbb.cccc

nameif inside

security-level 100

ip address 209.165.200.225 255.255.255.224
|

interface Port-channelll

port-channel span-cluster

mac-address aaaa.dddd.cccc

nameif outside

security-level O

ip address 209.165.201.1 255.255.255.224

Cisco 10S Switch Configuration

interface GigabitEthernetl/0/15
switchport access vlan 201
switchport mode access
spanning-tree portfast
channel-group 10 mode active

!

interface GigabitEthernetl/0/16
switchport access vlan 201
switchport mode access
spanning-tree portfast
channel-group 10 mode active

!

interface GigabitEthernetl/0/17
switchport access vlan 401
switchport mode access
spanning-tree portfast
channel-group 11 mode active

!

interface GigabitEthernetl/0/18
switchport access vlan 401
switchport mode access
spanning-tree portfast
channel-group 11 mode active

interface Port-channellO
switchport access vlan 201
switchport mode access

interface Port-channelll

switchport access vlan 401
switchport mode access
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. Firewall on a Stick

Firewall on a Stick

management
10.1.1.1/24 (Pool: .2-.9),
2001:DB8::1002/64
(Pool: 8 IPs)

ten0/8
man0/0
ten0/8

Cluster Control Link
192.168.1.1, .2, and .3

<[ port-ch1 Spanned | [
port-ch1.10 inside VLAN 10 10.10.10.5/24, 2001:DB8:2::5/64
MAC: 000C.F142.4CDE | |
port-ch1.20 outside VLAN 20 209.165.201.5/27, 2001:DB8:2::5/64

MAC: 000C.F142.5CDE

c..--—'—'_'_ o —

N a o]
port-ch5

VLAN 10, VLAN 20 Trunk
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Data traffic from different security domains are associated with different VLANS, for example, VLAN 10 for
the inside network and VLAN 20 for the outside network. Each ASA has a single physical port connected to
the external switch or router. Trunking is enabled so that all packets on the physical link are 802.1q
encapsulated. The ASA is the firewall between VLAN 10 and VLAN 20.

When using Spanned EtherChannels, all data links are grouped into one EtherChannel on the switch side. If
an ASA becomes unavailable, the switch will rebalance traffic between the remaining units.

Interface Mode on Each Unit

cluster interface-mode spanned force

ASA1 Control Unit Bootstrap Configuration

interface tengigabitethernet 0/8

no shutdown
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Firewall on a Stick .

description CCL
cluster group clusterl

local-unit asal

cluster-interface tengigabitethernet(0/8 ip 192.168.1.1 255.255.255.0
priority 1

key chuntheunavoidable

enable noconfirm

ASA2 Data Unit Bootstrap Configuration

interface tengigabitethernet 0/8

no shutdown
description CCL

cluster group clusterl

local-unit asaz

cluster-interface tengigabitethernet(0/8 ip 192.168.1.2 255.255.255.0
priority 2

key chuntheunavoidable

enable as-slave

ASA3 Data Unit Bootstrap Configuration

interface tengigabitethernet 0/8

no shutdown
description CCL

cluster group clusterl

local-unit asa3

cluster-interface tengigabitethernet0/8 ip 192.168.1.3 255.255.255.0
priority 3

key chuntheunavoidable

enable as-slave

Control Unit Interface Configuration

ip local pool mgmt 10.1.1.2-10.1.1.9
ipv6 local pool mgmtipvé 2001:DB8::1002/64 8
interface management 0/0

nameif management

ip address 10.1.1.1 255.255.255.0 cluster-pool mgmt
ipv6 address 2001:DB8::1001/32 cluster-pool mgmtipvé
security-level 100

management-only

no shutdown

interface tengigabitethernet 0/9

channel-group 2 mode active
no shutdown
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. Traffic Segregation

interface port-channel 2

port-channel span-cluster
interface port-channel 2.10

vlan 10

nameif inside

ip address 10.10.10.5 255.255.255.0
ipv6 address 2001:DB8:1::5/64
mac-address 000C.F142.4CDE
interface port-channel 2.20

vlan 20

nameif outside

ip address 209.165.201.1 255.255.255.224
ipv6 address 2001:DB8:2::8/64
mac-address 000C.F142.5CDE

Traffic Segregation

Cluster Control Link
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You may prefer physical separation of traffic between the inside and outside network.

As shown in the diagram above, there is one Spanned EtherChannel on the left side that connects to the inside
switch, and the other on the right side to outside switch. You can also create VLAN subinterfaces on each

EtherChannel if desired.
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Interface Mode on Each Unit

cluster interface-mode spanned force

ASA1 Control Unit Bootstrap Configuration

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on

no shutdown

interface port-channel 1

description CCL

cluster group clusterl

local-unit asal

cluster-interface port-channell ip 192.168.1.1 255.255.255.0
priority 1

key chuntheunavoidable
enable noconfirm

ASA2 Data Unit Bootstrap Configuration

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on

no shutdown

interface port-channel 1

description CCL

cluster group clusterl

local-unit asa2

cluster-interface port-channell ip 192.168.1.2 255.255.255.0
priority 2

key chuntheunavoidable
enable as-slave

ASA3 Data Unit Bootstrap Configuration

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7
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channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl

local-unit asa3

cluster-interface port-channell ip 192.168.1.3 255.255.255.0
priority 3

key chuntheunavoidable

enable as-slave

Control Unit Interface Configuration

ip local pool mgmt 10.1.1.2-10.1.1.9
ipv6 local pool mgmtipvé 2001:DB8::1002/64 8
interface management 0/0

nameif management

ip address 10.1.1.1 255.255.255.0 cluster-pool mgmt
ipv6 address 2001:DB8::1001/32 cluster-pool mgmtipvé
security-level 100

management-only

no shutdown

interface tengigabitethernet 0/8

channel-group 2 mode active

no shutdown

interface port-channel 2
port-channel span-cluster

nameif inside

ip address 10.10.10.5 255.255.255.0
ipv6 address 2001:DB8:1::5/64
mac-address 000C.F142.4CDE

interface tengigabitethernet 0/9

channel-group 3 mode active

no shutdown

interface port-channel 3

port-channel span-cluster

nameif outside

ip address 209.165.201.1 255.255.255.224
ipv6 address 2001:DB8:2::8/64
mac-address 000C.F142.5CDE

Spanned EtherChannel with Backup Links (Traditional 8 Active/8 Standby)

The maximum number of active ports in a traditional EtherChannel is limited to 8 from the switch side. If
you have an 8-ASA cluster, and you allocate 2 ports per unit to the EtherChannel, for a total of 16 ports total,
then 8 of them have to be in standby mode. The ASA uses LACP to negotiate which links should be active
or standby. If you enable multi-switch EtherChannel using VSS or vPC, you can achieve inter-switch
redundancy. On the ASA, all physical ports are ordered first by the slot number then by the port number. In
the following figure, the lower ordered port is the “control” port (for example, GigabitEthernet 0/0), and the
other one is the “data” port (for example, GigabitEthernet 0/1). You must guarantee symmetry in the hardware
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connection: all control links must terminate on one switch, and all data links must terminate on another switch
if VSS/vPC is used. The following diagram shows what happens when the total number of links grows as
more units join the cluster:

Houter or Router or Router or
Access Switch Access Switch Access Switch

Switch 1 Switch 2  Switch 1

i

Switch 2 Switch 1 Switch 2

==

Virtual Switch Link Virtual Switch Link EgI

Virtual Switch Link

1. Up to 4 units

ASA5
2. 5th unit joined

333218

3. Maximum of 8 units

The principle is to first maximize the number of active ports in the channel, and secondly keep the number
of active control ports and the number of active data ports in balance. Note that when a 5th unit joins the
cluster, traffic is not balanced evenly between all units.

Link or device failure is handled with the same principle. You may end up with a less-than-perfect load
balancing situation. The following figure shows a 4-unit cluster with a single link failure on one of the units.
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AS AL

a7

There could be multiple EtherChannels configured in the network. The following diagram shows an
EtherChannel on the inside and one on the outside. An ASA is removed from the cluster if both control and
data links in one EtherChannel fail. This prevents the ASA from receiving traffic from the outside network
when it has already lost connectivity to the inside network.
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Router or
Access Switch

Inside

Switch 3 Switch 4

Router or
Access Switch

333216

Interface Mode on Each Unit

cluster interface-mode spanned force
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ASA1 Control Unit Bootstrap Configuration

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/8

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/9

channel-group 1 mode on

no shutdown

interface port-channel 1

description CCL

cluster group clusterl

local-unit asal

cluster-interface port-channell ip 192.168.1.1 255.255.255.0
priority 1

key chuntheunavoidable
enable noconfirm

ASA2 Data Unit Bootstrap Configuration

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/8

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/9
channel-group 1 mode on

no shutdown

interface port-channel 1
description CCL

cluster group clusterl
local-unit asaz

cluster-interface port-channell ip 192.168.1.2 255.255.255.0
priority 2
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key chuntheunavoidable
enable as-slave

ASA3 Data Unit Bootstrap Configuration

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/8

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/9

channel-group 1 mode on

no shutdown

interface port-channel 1

description CCL

cluster group clusterl

local-unit asa3

cluster-interface port-channell ip 192.168.1.3 255.255.255.0
priority 3

key chuntheunavoidable
enable as-slave

ASA4 Data Unit Bootstrap Configuration

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/8

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/9
channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL
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cluster group clusterl

local-unit asa4

cluster-interface port-channell ip 192.168.1.4 255.255.255.0
priority 4

key chuntheunavoidable

enable as-slave

Control Unit Interface Configuration

ip local pool mgmt 10.1.1.2-10.1.1.9
interface management 0/0

channel-group 2 mode active
no shutdown

interface management 0/1

channel-group 2 mode active

no shutdown

interface port-channel 2

nameif management

ip address 10.1.1.1 255.255.255.0 cluster-pool mgmt
security-level 100

management-only

interface tengigabitethernet 1/6

channel-group 3 mode active vss-id 1
no shutdown

interface tengigabitethernet 1/7

channel-group 3 mode active vss-id 2

no shutdown

interface port-channel 3

port-channel span-cluster vss-load-balance
nameif inside

ip address 10.10.10.5 255.255.255.0
mac-address 000C.F142.4CDE

interface tengigabitethernet 1/8

channel-group 4 mode active vss-id 1
no shutdown

interface tengigabitethernet 1/9

channel-group 4 mode active vss-id 2

no shutdown

interface port-channel 4

port-channel span-cluster vss-load-balance
nameif outside

ip address 209.165.201.1 255.255.255.224
mac-address 000C.F142.5CDE
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OTV Configuration for Routed Mode Inter-Site Clustering

The success of inter-site clustering for routed mode with Spanned EtherChannels depends on the proper
configuration and monitoring of OTV. OTV plays a major role by forwarding the packets across the DCI.
OTYV forwards unicast packets across the DCI only when it learns the MAC address in its forwarding table.
If the MAC address is not learned in the OTV forwarding table, it will drop the unicast packets.

Sample OTV Configuration

//Sample OTV config:

//3151 - Inside VLAN, 3152 - Outside VLAN, 202 - CCL VLAN
//aaaa.1111.1234 - ASA inside interface global vMAC
//0050.56A8.3D22 — Server MAC

feature ospf
feature otv

mac access-list ALL MACs
10 permit any any
mac access-list HSRP VMAC
10 permit aaaa.l1111.1234 0000.0000.0000 any
20 permit aaaa.2222.1234 0000.0000.0000 any
30 permit any aaaa.1111.1234 0000.0000.0000
40 permit any aaaa.2222.1234 0000.0000.0000
vlan access-map Local 10
match mac address HSRP_VMAC
action drop
vlan access-map Local 20
match mac address ALL MACs
action forward
vlan filter Local vlan-list 3151-3152

//To block global MAC with ARP inspection:
arp access-list HSRP_VMAC ARP
10 deny aaaa.1111.1234 0000.0000.0000 any
20 deny aaaa.2222.1234 0000.0000.0000 any
30 deny any aaaa.1111.1234 0000.0000.0000
40 deny any aaaa.2222.1234 0000.0000.0000
50 permit ip any mac
ip arp inspection filter HSRP VMAC ARP 3151-3152

no ip igmp snooping optimise-multicast-flood
vlan 1,202,1111,2222,3151-3152

otv site-vlan 2222
mac-list GMAC DENY seq 10 deny aaaa.aaaa.aaaa ffff.ffff.ffff
mac-list GMAC DENY seq 20 deny aaaa.bbbb.bbbb ffff.ffff.ffff
mac-list GMAC_DENY seq 30 permit 0000.0000.0000 0000.0000.0000
route-map stop-GMAC permit 10

match mac-list GMAC_ DENY

interface Overlayl
otv join-interface Ethernet8/1
otv control-group 239.1.1.1
otv data-group 232.1.1.0/28
otv extend-vlan 202, 3151
otv arp-nd timeout 60
no shutdown

interface Ethernet8/1
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description uplink to OTV_cloud
mtu 9198

ip address 10.4.0.18/24

ip igmp version 3

no shutdown

interface Ethernet8/2

interface Ethernet8/3
description back to default vdc e6/39
switchport
switchport mode trunk
switchport trunk allowed vlan 202,2222,3151-3152
mac packet-classify
no shutdown

otv-isis default
vpn Overlayl
redistribute filter route-map stop-GMAC
otv site-identifier 0x2
//0TV flood not required for ARP inspection:
otv flood mac 0050.56A8.3D22 vlan 3151

0TV Filter Modifications Required Because of Site Failure

If a site goes down, the filters need to be removed from OTV because you do not want to block the global
MAC address anymore. There are some additional configurations required.

You need to add a static entry for the ASA global MAC address on the OTV switch in the site that is functional.
This entry will let the OTV at the other end add these entries on the overlay interface. This step is required
because if the server and client already have the ARP entry for the ASA, which is the case for existing
connections, then they will not send the ARP again. Therefore, OTV will not get a chance to learn the ASA
global MAC address in its forwarding table. Because OTV does not have the global MAC address in its
forwarding table, and per OTV design it will not flood unicast packets over the overlay interface, then it will
drop the unicast packets to the global MAC address from the server, and the existing connections will break.

//OTV filter configs when one of the sites is down

mac-list GMAC A seq 10 permit 0000.0000.0000 0000.0000.0000
route-map a-GMAC permit 10
match mac-list GMAC A

otv-isis default
vpn Overlayl
redistribute filter route-map a-GMAC

no vlan filter Local vlan-list 3151
//For ARP inspection, allow global MAC:
arp access-list HSRP_VMAC ARP Allow

50 permit ip any mac

ip arp inspection filter HSRP VMAC ARP Allow 3151-3152

mac address-table static aaaa.1111.1234 vlan 3151 interface Ethernet8/3
//Static entry required only in the OTV in the functioning Site
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When the other site is restored, you need to add the filters back again and remove this static entry on the OTV.
It is very important to clear the dynamic MAC address table on both the OTVs to clear the overlay entry for
the global MAC address.

MAC Address Table Clearing

When a site goes down, and a static entry for the global MAC address is added to OTYV, you need to let the
other OTV learn the global MAC address on the overlay interface. After the other site comes up, these entries
should be cleared. Make sure to clear the mac address table to make sure OTV does not have these entries in
its forwarding table.

cluster-N7k6-0TV# show mac address-table

Legend:

* - primary entry, G - Gateway MAC, (R) - Routed MAC, O - Overlay MAC
age - seconds since last seen,+ - primary entry using vPC Peer-Link,
(T) - True, (F) - False

VLAN MAC Address Type age Secure NTFY Ports/SWID.SSID.LID

————————— B T e e e R e e L P LT et
G - d867.d900.2e42 static - F F sup-ethl(R)

0 202 885a.92f6.44a5 dynamic - F F Overlayl

* 202 885a.92f6.4b8f dynamic 5 F F Eth8/3

O 3151 0050.5660.9412 dynamic - F F Overlayl

* 3151 aaaa.1111.1234 dynamic 50 F F Eth8/3

0TV ARP Cache Monitoring
OTYV maintains an ARP cache to proxy ARP for IP addresses that it learned across the OTV interface.

cluster-N7k6-0TV# show otv arp-nd-cache
OTV ARP/ND L3->L2 Address Mapping Cache

Overlay Interface Overlayl

VLAN MAC Address Layer-3 Address Age Expires In
3151 0050.5660.9412 10.0.0.2 1wOd 00:00:31
cluster-N7k6-0TV#

Examples for Inter-Site Clustering

The following examples show supported cluster deployments.

Individual Interface Routed Mode North-South Inter-Site Example

The following example shows 2 ASA cluster members at each of 2 data centers placed between inside and
outside routers (North-South insertion). The cluster members are connected by the cluster control link over
the DCI. The inside and outside routers at each data center use OSPF and PBR or ECMP to load balance the
traffic between cluster members. By assigning a higher cost route across the DCI, traffic stays within each
data center unless all ASA cluster members at a given site go down. In the event of a failure of all cluster
members at one site, traffic goes from each router over the DCI to the ASA cluster members at the other site.
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Spanned EtherChannel Routed Mode Example with Site-Specific MAC and IP Addresses

The following example shows 2 cluster members at each of 2 data centers placed between the gateway router
and an inside network at each site (East-West insertion). The cluster members are connected by the cluster
control link over the DCI. The cluster members at each site connect to the local switches using spanned
EtherChannels for both the inside and outside networks. Each EtherChannel is spanned across all chassis in
the cluster.

The data VLANSs are extended between the sites using Overlay Transport Virtualization (OTV) (or something
similar). You must add filters blocking the global MAC address to prevent traffic from traversing the DCI to
the other site when the traffic is destined for the cluster. If the cluster units at one site become unreachable,
you must remove the filters so traffic can be sent to the other site’s cluster units. You should use VACLs to
filter the global MAC address.For some switches, such as Nexus with the F3-series line card, you must also
use ARP inspection to block ARP packets from the global MAC address. ARP inspection requires you to set
both the site MAC address and the site IP address on the ASA. If you only configure the site MAC address
be sure to disable ARP inspection. See OTV Configuration for Routed Mode Inter-Site Clustering, on page
381 for more information.

The cluster acts as the gateway for the inside networks. The global virtual MAC, which is shared across all
cluster units, is used only to receive packets. Outgoing packets use a site-specific MAC address from each
DC cluster. This feature prevents the switches from learning the same global MAC address from both sites
on two different ports, which causes MAC flapping; instead, they only learn the site MAC address.

In this scenario:
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* All egress packets sent from the cluster use the site MAC address and are localized at the data center.

 All ingress packets to the cluster are sent using the global MAC address, so they can be received by any
of the units at both sites; filters at the OTV localize the traffic within the data center.

D o

Qutside

Global MAC
(blocked by OTV between sites)

Data Center '
Interconnect

Site MAC 2

Data Center 1 Data Center 2

For a sample OTV configuration and best practices, see OTV Configuration for Routed Mode Inter-Site
Clustering, on page 381.

Spanned EtherChannel Transparent Mode North-South Inter-Site Example

The following example shows 2 cluster members at each of 2 data centers placed between inside and outside
routers (North-South insertion). The cluster members are connected by the cluster control link over the DCIL.
The cluster members at each site connect to the local switches using spanned EtherChannels for the inside
and outside. Each EtherChannel is spanned across all chassis in the cluster.

The inside and outside routers at each data center use OSPF, which is passed through the transparent ASAs.
Unlike MACs, router IPs are unique on all routers. By assigning a higher cost route across the DCI, traffic

stays within each data center unless all cluster members at a given site go down. The lower cost route through
the ASAs must traverse the same bridge group at each site for the cluster to maintain asymmetric connections.
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In the event of a failure of all cluster members at one site, traffic goes from each router over the DCI to the
cluster members at the other site.

The implementation of the switches at each site can include:

* Inter-site VSS/vPC—In this scenario, you install one switch at Data Center 1, and the other at Data Center
2. One option is for the cluster units at each Data Center to only connect to the local switch, while the
VSS/vPC traffic goes across the DCI. In this case, connections are for the most part kept local to each
datacenter. You can optionally connect each unit to both switches across the DCI if the DCI can handle
the extra traffic. In this case, traffic is distributed across the data centers, so it is essential for the DCI to
be very robust.

* Local VSS/vPC at each site—For better switch redundancy, you can install 2 separate VSS/vPC pairs at
each site. In this case, although the cluster units still have a spanned EtherChannel with Data Center 1
chassis connected only to both local switches, and Data Center 2 chassis connected to those local switches,
the spanned EtherChannel is essentially “split.” Each local VSS/vPC sees the spanned EtherChannel as
a site-local EtherChannel.
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Spanned EtherChannel Transparent Mode East-West Inter-Site Example

The following example shows 2 cluster members at each of 2 data centers placed between the gateway router
and two inside networks at each site, the App network and the DB network (East-West insertion). The cluster
members are connected by the cluster control link over the DCI. The cluster members at each site connect to
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the local switches using spanned EtherChannels for both the App and DB networks on the inside and outside.
Each EtherChannel is spanned across all chassis in the cluster.

The gateway router at each site uses an FHRP such as HSRP to provide the same destination virtual MAC
and IP addresses at each site. A good practice to avoid unintended MAC address flapping is to statically add
the gateway routers real MAC addresses to the ASA MAC address table. Without these entries, if the gateway
at site 1 communicates with the gateway at site 2, that traffic might pass through the ASA and attempt to reach
site 2 from the inside interface and cause problems. The data VLANSs are extended between the sites using
Overlay Transport Virtualization (OTV) (or something similar). You must add filters to prevent traffic from
traversing the DCI to the other site when the traffic is destined for the gateway router. If the gateway router
at one site becomes unreachable, you must remove the filters so traffic can be sent to the other site’s gateway
router.
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See Spanned EtherChannel Transparent Mode North-South Inter-Site Example, on page 385 for information
about vPC/VSS options.

Reference for Clustering

This section includes more information about how clustering operates.

ASA Features and Clustering

Some ASA features are not supported with ASA clustering, and some are only supported on the control unit.
Other features might have caveats for proper usage.

Unsupported Features with Clustering

These features cannot be configured with clustering enabled, and the commands will be rejected.
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* Unified Communication features that rely on TLS Proxy
» Remote access VPN (SSL VPN and IPsec VPN)
* The following application inspections:

* CTIQBE

» H323, H225, and RAS

* [Psec passthrough

* MGCP

* MMP

* RTSP

» SCCP (Skinny)

* WAAS

*+ WCCP

* Botnet Traffic Filter

* Auto Update Server

* DHCP client, server, and proxy. DHCP relay is supported.
* VPN load balancing

* Failover

* ASA CX module

* Integrated Routing and Bridging

* Dead Connection Detection (DCD)

* FIPS mode

Centralized Features for Clustering

The following features are only supported on the control unit, and are not scaled for the cluster. For example,
you have a cluster of eight units (5516-X). The Other VPN license allows a maximum of 300 site-to-site [Psec
tunnels for one ASA 5516-X. For the entire cluster of eight units, you can only use 300 tunnels; the feature
does not scale.

Note Traffic for centralized features is forwarded from member units to the control unit over the cluster control
link.

If you use the rebalancing feature, traffic for centralized features may be rebalanced to non-control units before
the traffic is classified as a centralized feature; if this occurs, the traffic is then sent back to the control unit.

For centralized features, if the control unit fails, all connections are dropped, and you have to re-establish the
connections on the new control unit.
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* Site-to-site VPN
* The following application inspections:

* DCERPC

* ESMTP

* IM

* NetBIOS

* PPTP

* RADIUS

* RSH

* SNMP

* SQLNET

* SUNRPC

* TFTP

* XDMCP

* Dynamic routing (Spanned EtherChannel mode only)

* Multicast routing (Individual interface mode only)

» Static route tracking

* IGMP multicast control plane protocol processing (data plane forwarding is distributed across the cluster)
» PIM multicast control plane protocol processing (data plane forwarding is distributed across the cluster)
* Authentication and Authorization for network access. Accounting is decentralized.

» Filtering Services

Features Applied to Individual Units
These features are applied to each ASA unit, instead of the cluster as a whole or to the control unit.

* QoS—The QoS policy is synced across the cluster as part of configuration replication. However, the
policy is enforced on each unit independently. For example, if you configure policing on output, then
the conform rate and conform burst values are enforced on traffic exiting a particular ASA. In a cluster
with 3 units and with traffic evenly distributed, the conform rate actually becomes 3 times the rate for
the cluster.

* Threat detection—Threat detection works on each unit independently; for example, the top statistics is
unit-specific. Port scanning detection, for example, does not work because scanning traffic will be
load-balanced between all units, and one unit will not see all traffic.

* Resource management—Resource management in multiple context mode is enforced separately on each
unit based on local usage.
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* LISP traffic—LISP traffic on UDP port 4342 is inspected by each receiving unit, but is not assigned a
director. Each unit adds to the EID table that is shared across the cluster, but the LISP traffic itself does
not participate in cluster state sharing.

» ASA Firepower module—There is no configuration sync or state sharing between ASA Firepower
modules. You are responsible for maintaining consistent policies on the ASA Firepower modules in the
cluster using Firepower Management Center. Do not use different ASA-interface-based zone definitions
for devices in the cluster.

» ASA TIPS module—There is no configuration sync or state sharing between IPS modules. Some IPS
signatures require IPS to keep the state across multiple connections. For example, the port scanning
signature is used when the IPS module detects that someone is opening many connections to one server
but with different ports. In clustering, those connections will be balanced between multiple ASA devices,
each of which has its own IPS module. Because these IPS modules do not share state information, the
cluster may not be able to detect port scanning as a result.

AAA for Network Access and Clustering

AAA for network access consists of three components: authentication, authorization, and accounting.
Authentication and authorization are implemented as centralized features on the clustering control unit with
replication of the data structures to the cluster data units. If a control unit is elected, the new control unit will
have all the information it needs to continue uninterrupted operation of the established authenticated users
and their associated authorizations. Idle and absolute timeouts for user authentications are preserved when a
control unit change occurs.

Accounting is implemented as a distributed feature in a cluster. Accounting is done on a per-flow basis, so
the cluster unit owning a flow will send accounting start and stop messages to the AAA server when accounting
is configured for a flow.

Connection Settings

Connection limits are enforced cluster-wide (see Configuration > Firewall > Service Policy page). Each
unit has an estimate of the cluster-wide counter values based on broadcast messages. Due to efficiency
considerations, the configured connection limit across the cluster might not be enforced exactly at the limit
number. Each unit may overestimate or underestimate the cluster-wide counter value at any given time.
However, the information will get updated over time in a load-balanced cluster.

FTP and Clustering

* If FTP data channel and control channel flows are owned by different cluster members, then the data
channel owner will periodically send idle timeout updates to the control channel owner and update the
idle timeout value. However, if the control flow owner is reloaded, and the control flow is re-hosted, the
parent/child flow relationship will not longer be maintained; the control flow idle timeout will not be
updated.

* If you use AAA for FTP access, then the control channel flow is centralized on the control unit.

Identity Firewall and Clustering

Only the control unit retrieves the user-group from the AD and the user-ip mapping from the AD agent. The
control unit then populates the user information to data units, and data units can make a match decision for
user identity based on the security policy.
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Multicast Routing and Clustering

Multicast routing behaves differently depending on the interface mode.

Multicast Routing in Spanned EtherChannel Mode

In Spanned EtherChannel mode, the control unit handles all multicast routing packets and data packets until
fast-path forwarding is established. After the connection is established, each data unit can forward multicast
data packets.

Multicast Routing in Individual Interface Mode

In Individual interface mode, units do not act independently with multicast. All data and routing packets are
processed and forwarded by the control unit, thus avoiding packet replication.

NAT and Clustering

NAT can affect the overall throughput of the cluster. Inbound and outbound NAT packets can be sent to
different ASAs in the cluster, because the load balancing algorithm relies on IP addresses and ports, and NAT
causes inbound and outbound packets to have different IP addresses and/or ports. When a packet arrives at
the ASA that is not the NAT owner, it is forwarded over the cluster control link to the owner, causing large
amounts of traffic on the cluster control link. Note that the receiving unit does not create a forwarding flow
to the owner, because the NAT owner may not end up creating a connection for the packet depending on the
results of security and policy checks.

If you still want to use NAT in clustering, then consider the following guidelines:

* No Proxy ARP—For Individual interfaces, a proxy ARP reply is never sent for mapped addresses. This
prevents the adjacent router from maintaining a peer relationship with an ASA that may no longer be in
the cluster. The upstream router needs a static route or PBR with Object Tracking for the mapped addresses
that points to the Main cluster IP address. This is not an issue for a Spanned EtherChannel, because there
is only one IP address associated with the cluster interface.

* No interface PAT on an Individual interface—Interface PAT is not supported for Individual interfaces.

» PAT with Port Block Allocation—See the following guidelines for this feature:

* Maximum-per-host limit is not a cluster-wide limit, and is enforced on each unit individually. Thus,
in a 3-node cluster with the maximum-per-host limit configured as 1, if the traffic from a host is
load-balanced across all 3 units, then it can get allocated 3 blocks with 1 in each unit.

* Port blocks created on the backup unit from the backup pools are not accounted for when enforcing
the maximum-per-host limit.

* When a PAT IP address owner goes down, the backup unit will own the PAT IP address,
corresponding port blocks, and xlates. If it runs out of ports on its normal PAT address, it can use
the address that it took over to service new requests. As the connections eventually time out, the
blocks get freed.

* On-the-fly PAT rule modifications, where the PAT pool is modified with a completely new range
of IP addresses, will result in xlate backup creation failures for the xlate backup requests that were
still in transit while the new pool became effective. This behavior is not specific to the port block
allocation feature, and is a transient PAT pool issue seen only in cluster deployments where the
pool is distributed and traffic is load-balanced across the cluster units.
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NAT pool address distribution for dynamic PAT—The control unit evenly pre-distributes addresses
across the cluster. If a member receives a connection and they have no addresses assigned, then the
connection is forwarded to the control unit for PAT. If a cluster member leaves the cluster (due to failure),
a backup member will get the PAT IP address, and if the backup exhausts its normal PAT IP address, it
can make use of the new address. Make sure to include at least as many NAT addresses as there are units
in the cluster, plus at least one extra address, to ensure that each unit receives an address, and that a failed
unit can get a new address if its old address is in use by the member that took over the address. Use the
show nat pool cluster command to see the address allocations.

Reusing a PAT pool in multiple rules—To use the same PAT pool in multiple rules, you must be careful
about the interface selection in the rules. You must either use specific interfaces in all rules, or "any" in
all rules. You cannot mix specific interfaces and "any" across the rules, or the system might not be able
to match return traffic to the right node in the cluster. Using unique PAT pools per rule is the most reliable
option.

No round-robin—Round-robin for a PAT pool is not supported with clustering.

Dynamic NAT xlates managed by the control unit—The control unit maintains and replicates the xlate
table to data units. When a data unit receives a connection that requires dynamic NAT, and the xlate is
not in the table, it requests the xlate from the control unit. The data unit owns the connection.

Stale xlates—The xlate idle time on the connection owner does not get updated. Thus, the idle time might
exceed the idle timeout. An idle timer value higher than the configured timeout with a refent of 0 is an
indication of a stale xlate.

Per-session PAT feature—Although not exclusive to clustering, the per-session PAT feature improves
the scalability of PAT and, for clustering, allows each data unit to own PAT connections; by contrast,
multi-session PAT connections have to be forwarded to and owned by the control unit. By default, all
TCP traffic and UDP DNS traffic use a per-session PAT xlate, whereas ICMP and all other UDP traffic
uses multi-session. You can configure per-session NAT rules to change these defaults for TCP and UDP,
but you cannot configure per-session PAT for ICMP. For traffic that benefits from multi-session PAT,
such as H.323, SIP, or Skinny, you can disable per-session PAT for the associated TCP ports (the UDP
ports for those H.323 and SIP are already multi-session by default). For more information about per-session
PAT, see the firewall configuration guide.

No static PAT for the following inspections—
* FTP

* PPTP
* RSH
* SQLNET
* TFTP
+ XDMCP
* SIP
If you have an extremely large number of NAT rules, over ten thousand, you should enable the

transactional commit model using the asp rule-engine transactional-commit nat command in the device
CLI. Otherwise, the unit might not be able to join the cluster.
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Dynamic Routing and Clustering

This section describes how to use dynamic routing with clustering.

Dynamic Routing in Spanned EtherChannel Mode

)

Note

IS-IS is not supported in Spanned EtherChannel mode.

In Spanned EtherChannel mode: The routing process only runs on the control unit, and routes are learned
through the control unit and replicated to data units. If a routing packet arrives at a data unit, it is redirected
to the control unit.

Figure 59: Dynamic Routing in Spanned EtherChannel Mode
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After the data unit learn the routes from the control unit, each unit makes forwarding decisions independently.

The OSPF LSA database is not synchronized from the control unit to data units. If there is a control unit
switchover, the neighboring router will detect a restart; the switchover is not transparent. The OSPF process
picks an IP address as its router ID. Although not required, you can assign a static router ID to ensure a
consistent router ID is used across the cluster. See the OSPF Non-Stop Forwarding feature to address the
interruption.
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Dynamic Routing in Individual Interface Mode

In Individual interface mode, each unit runs the routing protocol as a standalone router, and routes are learned
by each unit independently.

Figure 60: Dynamic Routing in Individual Interface Mode
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In the above diagram, Router A learns that there are 4 equal-cost paths to Router B, each through an ASA.
ECMP is used to load balance traffic between the 4 paths. Each ASA picks a different router ID when talking
to external routers.

You must configure a cluster pool for the router ID so that each unit has a separate router ID.

EIGRP does not form neighbor relationships with cluster peers in individual interface mode.

Note If the cluster has multiple adjacencies to the same router for redundancy purposes, asymmetric routing can
lead to unacceptable traffic loss. To avoid asymmetric routing, group all of these ASA interfaces into the same
traffic zone. See Configure a Traffic Zone, on page 558.

SCTP and Clustering

An SCTP association can be created on any unit (due to load balancing); its multi-homing connections must
reside on the same unit.
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SIP Inspection and Clustering

A control flow can be created on any unit (due to load balancing); its child data flows must reside on the same
unit.

TLS Proxy configuration is not supported.

SNMP and Clustering

An SNMP agent polls each individual ASA by its Local IP address. You cannot poll consolidated data for
the cluster.

You should always use the Local address, and not the Main cluster IP address for SNMP polling. If the SNMP

agent polls the Main cluster IP address, if a new control unit is elected, the poll to the new control unit will
fail.

When using SNMPv3 with clustering, if you add a new cluster unit after the initial cluster formation, then
SNMPv3 users are not replicated to the new unit. You must re-add them on the control unit to force the users
to replicate to the new unit, or directly on the data unit.

STUN and Clustering

STUN inspection is supported in failover and cluster modes, as pinholes are replicated. However, the transaction
ID is not replicated among units. In the case where a unit fails after receiving a STUN Request and another
unit received the STUN Response, the STUN Response will be dropped.

Syslog and NetFlow and Clustering

* Syslog—Each unit in the cluster generates its own syslog messages. You can configure logging so that
each unit uses either the same or a different device ID in the syslog message header field. For example,
the hostname configuration is replicated and shared by all units in the cluster. If you configure logging
to use the hostname as the device ID, syslog messages generated by all units look as if they come from
a single unit. If you configure logging to use the local-unit name that is assigned in the cluster bootstrap
configuration as the device ID, syslog messages look as if they come from different units.

» NetFlow—Each unit in the cluster generates its own NetFlow stream. The NetFlow collector can only
treat each ASA as a separate NetFlow exporter.

Cisco TrustSec and Clustering

Only the control unit learns security group tag (SGT) information. The control unit then populates the SGT
to data units, and data units can make a match decision for SGT based on the security policy.

VPN and Clustering

Site-to-site VPN is a centralized feature; only the control unit supports VPN connections. Distributed site-to-site
VPN clustering is supported. Search for High Availability options in this pdf for details.

N

Note Remote access VPN is not supported with clustering.
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. Performance Scaling Factor

VPN functionality is limited to the control unit and does not take advantage of the cluster high availability
capabilities. If the control unit fails, all existing VPN connections are lost, and VPN users will see a disruption
in service. When a new control unit is elected, you must reestablish the VPN connections.

When you connect a VPN tunnel to a Spanned EtherChannel address, connections are automatically forwarded
to the control unit. For connections to an Individual interface when using PBR or ECMP, you must always
connect to the Main cluster IP address, not a Local address.

VPN-related keys and certificates are replicated to all units.

Performance Scaling Factor

When you combine multiple units into a cluster, you can expect a performance of approximately:
* 70% of the combined throughput
* 60% of maximum connections

* 50% of connections per second

For example, for throughput, the ASA 5585-X with SSP-40 can handle approximately 10 Gbps of real world
firewall traffic when running alone. For a cluster of 8 units, the maximum combined throughput will be
approximately 70% of 80 Gbps (8 units x 10 Gbps): 56 Gbps.

Control Unit Election

Members of the cluster communicate over the cluster control link to elect a control unit as follows:

1. When you enable clustering for a unit (or when it first starts up with clustering already enabled), it
broadcasts an election request every 3 seconds.

2. Any other units with a higher priority respond to the election request; the priority is set between 1 and
100, where 1 is the highest priority.

3. If after 45 seconds, a unit does not receive a response from another unit with a higher priority, then it
becomes the control unit.

Note

If multiple units tie for the highest priority, the cluster unit name and then the serial number is used to determine
the control unit.

4. If a unit later joins the cluster with a higher priority, it does not automatically become the control unit;
the existing control unit always remains as the control unit unless it stops responding, at which point a
new control unit is elected.

5. Ina "split brain" scenario when there are temporarily multiple control units, then the unit with highest
priority retains the role while the other units return to data unit roles.

Note

You can manually force a unit to become the control unit. For centralized features, if you force a control unit
change, then all connections are dropped, and you have to re-establish the connections on the new control
unit.
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High Availability Within the ASA Cluster

ASA Clustering provides high availability by monitoring unit and interface health and by replicating connection
states between units.

Unit Health Monitoring

Each unit periodically sends a broadcast heartbeat packet over the cluster control link. If the control unit does
not receive any heartbeat packets or other packets from a data unit within the configurable timeout period,
then the control unit removes the data unit from the cluster. If the data units do not receive packets from the
control unit, then a new control unit is elected from the remaining members.

If units cannot reach each other over the cluster control link because of a network failure and not because a
unit has actually failed, then the cluster may go into a "split brain" scenario where isolated data units will
elect their own control units. For example, if a router fails between two cluster locations, then the original
control unit at location 1 will remove the location 2 data units from the cluster. Meanwhile, the units at location
2 will elect their own control unit and form their own cluster. Note that asymmetric traffic may fail in this
scenario. After the cluster control link is restored, then the control unit that has the higher priority will keep
the control unit’s role. See Control Unit Election, on page 396 for more information.

Interface Monitoring

Each unit monitors the link status of all named hardware interfaces in use, and reports status changes to the
control unit.

* Spanned EtherChannel—Uses cluster Link Aggregation Control Protocol (cLACP). Each unit monitors
the link status and the cLACP protocol messages to determine if the port is still active in the EtherChannel.
The status is reported to the control unit.

* Individual interfaces (Routed mode only)—Each unit self-monitors its interfaces and reports interface
status to the control unit.

When you enable health monitoring, all physical interfaces (including the main EtherChannel and redundant
interface types) are monitored by default; you can optionally disable monitoring per interface. Only named
interfaces can be monitored. For example, the named EtherChannel must fail to be considered failed, which
means all member ports of an EtherChannel must fail to trigger cluster removal (depending on your minimum
port bundling setting).

A unit is removed from the cluster if its monitored interfaces fail. The amount of time before the ASA removes
a member from the cluster depends on the type of interface and whether the unit is an established member or
is joining the cluster. For EtherChannels (spanned or not), if the interface is down on an established member,
then the ASA removes the member after 9 seconds. The ASA does not monitor interfaces for the first 90
seconds that a unit joins the cluster. Interface status changes during this time will not cause the ASA to be
removed from the cluster. For non-EtherChannels, the unit is removed after 500 ms, regardless of the member
state.

Status After Failure

When a unit in the cluster fails, the connections hosted by that unit are seamlessly transferred to other units;
state information for traffic flows is shared over the control unit's cluster control link.

If the control unit fails, then another member of the cluster with the highest priority (lowest number) becomes
the control unit.

ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8 [JJj



High Availability and Scalability |
. Rejoining the Cluster

The ASA automatically tries to rejoin the cluster, depending on the failure event.

\}

Note When the ASA becomes inactive and fails to automatically rejoin the cluster, all data interfaces are shut down;
only the management-only interface can send and receive traffic. The management interface remains up using
the IP address the unit received from the cluster IP pool. However if you reload, and the unit is still inactive
in the cluster, the management interface is disabled. You must use the console port for any further configuration.

Rejoining the Cluster

After a cluster member is removed from the cluster, how it can rejoin the cluster depends on why it was
removed:

» Failed cluster control link when initially joining—After you resolve the problem with the cluster control
link, you must manually rejoin the cluster by re-enabling clustering.

* Failed cluster control link after joining the cluste—The ASA automatically tries to rejoin every 5 minutes,
indefinitely. This behavior is configurable.

* Failed data interface—The ASA automatically tries to rejoin at 5 minutes, then at 10 minutes, and finally
at 20 minutes. If the join is not successful after 20 minutes, then the ASA disables clustering. After you
resolve the problem with the data interface, you have to manually enable clustering. This behavior is
configurable.

* Failed ASA FirePOWER module on the ASA 5585-X—The ASA automatically tries to rejoin at 5
minutes.

* Failed ASA FirePOWER software module—A fter you resolve the problem with the module, you must
manually enable clustering.

* Failed unit—If the unit was removed from the cluster because of a unit health check failure, then rejoining
the cluster depends on the source of the failure. For example, a temporary power failure means the unit
will rejoin the cluster when it starts up again as long as the cluster control link is up and clustering is still
enabled. The ASA attempts to rejoin the cluster every 5 seconds.

* Internal error—Internal failures include: application sync timeout; inconsistent application statuses; and
so on. After you resolve the problem, you must manually rejoin the cluster by re-enabling clustering.

See Configure Basic ASA Cluster Parameters, on page 352.

Data Path Connection State Replication

Every connection has one owner and at least one backup owner in the cluster. The backup owner does not
take over the connection in the event of a failure; instead, it stores TCP/UDP state information, so that the
connection can be seamlessly transferred to a new owner in case of a failure. The backup owner is usually
also the director.

Some traffic requires state information above the TCP or UDP layer. See the following table for clustering
support or lack of support for this kind of traffic.
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Table 19: Features Replicated Across the Cluster

Traffic State Support Notes

Up time Yes Keeps track of the system up time.

ARP Table Yes —

MAC address table Yes —

User Identity Yes Includes AAA rules (uauth) and
identity firewall.

IPv6 Neighbor database Yes —

Dynamic routing Yes —

SNMP Engine ID No —

Centralized VPN (Site-to-Site) No VPN sessions will be disconnected

if the control unit fails.

How the ASA Cluster Manages Connections

Connections can be load-balanced to multiple members of the cluster. Connection roles determine how
connections are handled in both normal operation and in a high availability situation.

Connection Roles

See the following roles defined for each connection:

Owner—Usually, the unit that initially receives the connection. The owner maintains the TCP state and
processes packets. A connection has only one owner. If the original owner fails, then when new units
receive packets from the connection, the director chooses a new owner from those units.

Backup owner—The unit that stores TCP/UDP state information received from the owner, so that the
connection can be seamlessly transferred to a new owner in case of a failure. The backup owner does
not take over the connection in the event of a failure. If the owner becomes unavailable, then the first
unit to receive packets from the connection (based on load balancing) contacts the backup owner for the
relevant state information so it can become the new owner.

As long as the director (see below) is not the same unit as the owner, then the director is also the backup
owner. If the owner chooses itself as the director, then a separate backup owner is chosen.

For inter-chassis clustering on the Firepower 9300, which can include up to 3 cluster units in one chassis,
if the backup owner is on the same chassis as the owner, then an additional backup owner will be chosen
from another chassis to protect flows from a chassis failure.

If you enable director localization for inter-site clustering, then there are two backup owner roles: the
local backup and the global backup. The owner always chooses a local backup at the same site as itself
(based on site ID). The global backup can be at any site, and might even be the same unit as the local
backup. The owner sends connection state information to both backups.

Director—The unit that handles owner lookup requests from forwarders. When the owner receives a new
connection, it chooses a director based on a hash of the source/destination IP address and ports, and sends
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amessage to the director to register the new connection. If packets arrive at any unit other than the owner,
the unit queries the director about which unit is the owner so it can forward the packets. A connection
has only one director. If a director fails, the owner chooses a new director.

As long as the director is not the same unit as the owner, then the director is also the backup owner (see
above). If the owner chooses itself as the director, then a separate backup owner is chosen.

If you enable director localization for inter-site clustering, then there are two director roles: the local
director and the global director. The owner always chooses a local director at the same site as itself (based
on site ID). The global director can be at any site, and might even be the same unit as the local director.
If the original owner fails, then the local director chooses a new connection owner at the same site.

Forwarder—A unit that forwards packets to the owner. If a forwarder receives a packet for a connection
it does not own, it queries the director for the owner, and then establishes a flow to the owner for any
other packets it receives for this connection. The director can also be a forwarder. If you enable director
localization, then the forwarder always queries the local director. The forwarder only queries the global
director if the local director does not know the owner, for example, if a cluster member receives packets
for a connection that is owned on a different site. Note that if a forwarder receives the SYN-ACK packet,
it can derive the owner directly from a SYN cookie in the packet, so it does not need to query the director.
(If you disable TCP sequence randomization, the SYN cookie is not used; a query to the director is
required.) For short-lived flows such as DNS and ICMP, instead of querying, the forwarder immediately
sends the packet to the director, which then sends them to the owner. A connection can have multiple
forwarders; the most efficient throughput is achieved by a good load-balancing method where there are
no forwarders and all packets of a connection are received by the owner.

N

Note We do not recommend disabling TCP sequence randomization when using
clustering. There is a small chance that some TCP sessions won't be established,
because the SYN/ACK packet might be dropped.

Fragment Owner—For fragmented packets, cluster units that receive a fragment determine a fragment
owner using a hash of the fragment source IP address, destination IP address, and the packet ID. All
fragments are then forwarded to the fragment owner over the cluster control link. Fragments may be
load-balanced to different cluster units, because only the first fragment includes the 5-tuple used in the
switch load balance hash. Other fragments do not contain the source and destination ports and may be
load-balanced to other cluster units. The fragment owner temporarily reassembles the packet so it can
determine the director based on a hash of the source/destination IP address and ports. If it is a new
connection, the fragment owner will register to be the connection owner. If it is an existing connection,
the fragment owner forwards all fragments to the provided connection owner over the cluster control
link. The connection owner will then reassemble all fragments.

When a connection uses Port Address Translation (PAT), then the PAT type (per-session or multi-session)
influences which member of the cluster becomes the owner of a new connection:

Per-session PAT—The owner is the unit that receives the initial packet in the connection.

By default, TCP and DNS UDP traffic use per-session PAT.

Multi-session PAT—The owner is always the control unit. If a multi-session PAT connection is initially
received by a data unit, then the data unit forwards the connection to the control unit.

By default, UDP (except for DNS UDP) and ICMP traffic use multi-session PAT, so these connections
are always owned by the control unit.
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You can change the per-session PAT defaults for TCP and UDP so connections for these protocols are handled
per-session or multi-session depending on the configuration. For ICMP, you cannot change from the default
multi-session PAT. For more information about per-session PAT, see the firewall configuration guide.

New Connection Ownership

When a new connection is directed to a member of the cluster via load balancing, that unit owns both directions
of the connection. If any connection packets arrive at a different unit, they are forwarded to the owner unit
over the cluster control link. For best performance, proper external load balancing is required for both directions
of a flow to arrive at the same unit, and for flows to be distributed evenly between units. If a reverse flow
arrives at a different unit, it is redirected back to the original unit.

Sample Data Flow

The following example shows the establishment of a new connection.

4 N
1.SYN T~ 1.8YN
SYN/AC
Server
- y—
-‘f\ I
Inside Outside /
[
A— Director AE——
Client
After step 4, all _ 2. SYN/ACK
remaining packets <—
are forwarded T/
directly to the owner. Forwarder 2
. J 2
Cluster

=

N

w

o &

o

The SYN packet originates from the client and is delivered to one ASA (based on the load balancing
method), which becomes the owner. The owner creates a flow, encodes owner information into a SYN
cookie, and forwards the packet to the server.

The SYN-ACK packet originates from the server and is delivered to a different ASA (based on the load
balancing method). This ASA is the forwarder.

Because the forwarder does not own the connection, it decodes owner information from the SYN cookie,
creates a forwarding flow to the owner, and forwards the SYN-ACK to the owner.

The owner sends a state update to the director, and forwards the SYN-ACK to the client.

The director receives the state update from the owner, creates a flow to the owner, and records the TCP
state information as well as the owner. The director acts as the backup owner for the connection.

Any subsequent packets delivered to the forwarder will be forwarded to the owner.
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7. If packets are delivered to any additional units, it will query the director for the owner and establish a
flow.

8. Any state change for the flow results in a state update from the owner to the director.

Rebalancing New TCP Connections Across the Cluster

If the load balancing capabilities of the upstream or downstream routers result in unbalanced flow distribution,
you can configure overloaded units to redirect new TCP flows to other units. No existing flows will be moved
to other units.

History for ASA Clustering

Feature Name Version | Feature Information

Improved cluster unit 9.8(1) | You can now configure a lower holdtime for the unit health check: .3 seconds minimum. The
health-check failure previous minimum was .8 seconds. This feature changes the unit health check messaging scheme
detection to heartbeats in the data plane from keepalivesin the control plane. Using heartbeats improves
the reliability and the responsiveness of clustering by not being susceptible to control plane CPU
hogging and scheduling delays. Note that configuring a lower holdtime increases cluster control
link messaging activity. We suggest that you analyze your network before you configure a low
holdtime; for example, make sure a ping from one unit to another over the cluster control link
returns within the holdtime/3, because there will be three heartbeat messages during one holdtime
interval. If you downgrade your ASA software after setting the hold time to .3 - .7, this setting
will revert to the default of 3 seconds because the new setting is unsupported.

We modified the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster

Director localization: 9.7(1) | To improve performance and keep traffic within a site for inter-site clustering for data centers,
inter-site clustering you can enable director localization. New connections are typically load-balanced and owned
improvement for data by cluster members within a given site. However, the ASA assigns the director role to a member
centers at any site. Director localization enables additional director roles: a local director at the same

site as the owner, and a global director that can be at any site. Keeping the owner and director
at the same site improves performance. Also, if the original owner fails, the local director chooses
anew connection owner at the same site. The global director is used if a cluster member receives
packets for a connection that is owned on a different site.

We modified the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster > Cluster Configuration

Support for site-specific |9.6(1) |For inter-site clustering in routed mode with Spanned EtherChannels, you can now configure

IP addresses in Routed, site-specific IP addresess in addition to site-specific MAC addresses. The addition of site IP
Spanned EtherChannel addresses allows you to use ARP inspection on the Overlay Transport Virtualization (OTV)
mode devices to prevent ARP responses from the global MAC address from traveling over the Data

Center Interconnect (DCI), which can cause routing problems. ARP inspection is required for
some switches that cannot use VACLs to filter MAC addresses.

We modified the following screen: Configuration > Device Setup > Interface Settings >
Interfaces > Add/Edit EtherChannel Interface > Advanced
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Feature Name

Version

Feature Information

ASA 5516-X support for
clustering

9.5(2)

The ASA 5516-X now supports 2-unit clusters. Clustering for 2 units is enabled by default in
the base license.

We did not modify any ASDM screens.

LISP Inspection for
Inter-Site Flow Mobility

9.5(2)

Cisco Locator/ID Separation Protocol (LISP) architecture separates the device identity from its
location into two different numbering spaces, making server migration transparent to clients.
The ASA can inspect LISP traffic for location changes and then use this information for seamless
clustering operation; the ASA cluster members inspect LISP traffic passing between the first
hop router and the egress tunnel router (ETR) or ingress tunnel router (ITR), and then change
the flow owner to be at the new site.

We introduced or modified the following screens:

Configuration > Device Management > High Availability and Scalability > ASA Cluster >
Cluster Configuration

Configuration > Firewall > Objects > Inspect Maps > LISP
Configuration > Firewall > Service Policy Rules > Protocol Inspection
Configuration > Firewall > Service Policy Rules > Cluster

Monitoring > Routing > LISP-EID Table

Carrier Grade NAT
enhancements now
supported in failover and
ASA clustering

9.5(2)

For carrier-grade or large-scale PAT, you can allocate a block of ports for each host, rather than
have NAT allocate one port translation at a time (see RFC 6888). This feature is now supported
in failover and ASA cluster deployments.

We did not modify any screens.

Configurable level for | 9.5(2) | By default, all levels of clustering events are included in the trace buffer, including many low
clustering trace entries level events. To limit the trace to higher level events, you can set the minimum trace level for
the cluster.
We did not modify any screens.
Site-specific MAC 9.5(1) | Youcan now use inter-site clustering for Spanned EtherChannels in routed mode. To avoid MAC

addresses for inter-site
clustering support for
Spanned EtherChannel in
Routed firewall mode

address flapping, configure a site ID for each cluster member so that a site-specific MAC address
for each interface can be shared among a site’s units.

We modified the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster > Cluster Configuration

ASA cluster 9.5(1) | You can now customize the auto-rejoin behavior when an interface or the cluster control link
customization of the fails.
auto-rejoin behavior We introduced the following screen: Configuration > Device Management > High Availability
when an interface or the e .

. . and Scalability > ASA Cluster > Auto Rejoin
cluster control link fails
The ASA cluster supports [ 9.5(1) | The ASA cluster now supports GTPv1 and GTPv2 inspection.

GTPvl and GTPv2

We did not modify any screens.
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Feature Name Version | Feature Information
Disable health 9.5(1) |By default when using clustering, the ASA monitors the health of an installed hardware module
monitoring of a hardware such as the ASA FirePOWER module. If you do not want a hardware module failure to trigger
module in ASA failover, you can disable module monitoring.
clustering We modified the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster > Cluster Interface Health Monitoring
Cluster replication delay | 9.5(1) | This feature helps eliminate the “unnecessary work” related to short-lived flows by delaying the
for TCP connections director/backup flow creation.
We introduced the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster Replication
Enable and disable ASA |9.4(1) | You can now enable or disable health monitoring per interface. Health monitoring is enabled by
cluster health monitoring default on all port-channel, redundant, and single physical interfaces. Health monitoring is not
per interface performed on VLAN subinterfaces or virtual interfaces such as VNIs or BVIs. You cannot
configure monitoring for the cluster control link; it is always monitored. You might want to
disable health monitoring of non-essential interfaces, for example, the management interface.
We introduced the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster > Cluster Interface Health Monitoring.
ASA clustering support |9.4(1) | You can now configure DHCP relay on the ASA cluster. Client DHCP requests are load-balanced
for DHCP relay to the cluster members using a hash of the client MAC address. DHCP client and server functions
are still not supported.
We did not modify any screens.
SIP inspection supportin | 9.4(1) | You can now configure SIP inspection on the ASA cluster. A control flow can be created on any
ASA clustering unit (due to load balancing), but its child data flows must reside on the same unit. TLS Proxy
configuration is not supported.
We did not modify any screens.
Inter-site deployment in | 9.3(2) | You can now deploy a cluster in transparent mode between inside networks and the gateway
transparent mode with router at each site (AKA East-West insertion), and extend the inside VLANs between sites. We
the ASA cluster recommend using Overlay Transport Virtualization (OTV), but you can use any method that
firewalling between ensures that the overlapping MAC Addresses and IP addresses of the gateway router do not leak
inside networks between sites. Use a First Hop Redundancy Protocol (FHRP) such as HSRP to provide the same
virtual MAC and IP addresses to the gateway routers.
BGP support for ASA  |9.3(1) | We added support for BGP with ASA clustering.
Clustering We modified the following screen: Configuration > Device Setup > Routing > BGP > IPv4
Family > General.
Support for cluster 9.2(1) | You can now place cluster members at different geographical locations when using Spanned

members at different
geographical locations
(inter-site) for transparent
mode

EtherChannel mode in transparent firewall mode. Inter-site clustering with spanned EtherChannels
in routed firewall mode is not supported.

We did not modify any ASDM screens.
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History for ASA Clustering .

Feature Name

Version

Feature Information

Static LACP port priority
support for clustering

9.2(1)

Some switches do not support dynamic port priority with LACP (active and standby links). You
can now disable dynamic port priority to provide better compatibility with spanned EtherChannels.
You should also follow these guidelines:

* Network elements on the cluster control link path should not verify the L4 checksum.
Redirected traffic over the cluster control link does not have a correct L4 checksum. Switches
that verify the L4 checksum could cause traffic to be dropped.

* Port-channel bundling downtime should not exceed the configured keepalive interval.

We modified the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster.

Support for 32 active
links in a spanned
EtherChannel

9.2(1)

ASA EtherChannels now support up to 16 active links. With spanned EtherChannels, that
functionality is extended to support up to 32 active links across the cluster when used with two
switches in a vPC and when you disable dynamic port priority. The switches must support
EtherChannels with 16 active links, for example, the Cisco Nexus 7000 with F2-Series 10 Gigabit
Ethernet Module.

For switches in a VSS or vPC that support 8 active links, you can now configure 16 active links
in the spanned EtherChannel (8 connected to each switch). Previously, the spanned EtherChannel
only supported 8 active links and 8 standby links, even for use with a VSS/vPC.

Note If you want to use more than 8 active links in a spanned EtherChannel, you cannot
also have standby links; the support for 9 to 32 active links requires you to disable

cLACP dynamic port priority that allows the use of standby links.

We modified the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster.

Support for 16 cluster
members for the ASA
5585-X

9.2(1)

The ASA 5585-X now supports 16-unit clusters.

We did not modify any screens.

ASA 5500-X support for
clustering

9.1(4)

The ASA 5512-X, ASA 5515-X, ASA 5525-X, ASA 5545-X, and ASA 5555-X now support
2-unit clusters. Clustering for 2 units is enabled by default in the base license; for the ASA
5512-X, you need the Security Plus license.

We did not modify any ASDM screens.

Improved VSS and vPC
support for health check
monitoring

9.1(4)

If you configure the cluster control link as an EtherChannel (recommended), and it is connected
to a VSS or vPC pair, you can now increase stability with health check monitoring. For some
switches, such as the Cisco Nexus 5000, when one unit in the VSS/vPC is shutting down or
booting up, EtherChannel member interfaces connected to that switch may appear to be Up to
the ASA, but they are not passing traffic on the switch side. The ASA can be erroneously removed
from the cluster if you set the ASA holdtime timeout to a low value (such as .8 seconds), and
the ASA sends keepalive messages on one of these EtherChannel interfaces. When you enable
the VSS/vPC health check feature, the ASA floods the keepalive messages on all EtherChannel
interfaces in the cluster control link to ensure that at least one of the switches can receive them.

We modified the following screen: Configuration > Device Management > High Availability
and Scalability > ASA Cluster.
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Feature Name

Version

Feature Information

Support for cluster 9.1(4) | You can now place cluster members at different geographical locations when using Individual
members at different Interface mode.

geographical locations . .

(inter-site): Individual We did not modify any ASDM screens.

Interface mode only

ASA Clustering for the |9.0(1) | ASA Clustering lets you group up to 8 ASAs together as a single logical device. A cluster provides

ASA 5580 and 5585-X

all the convenience of a single device (management, integration into a network) while achieving
the increased throughput and redundancy of multiple devices. ASA clustering is supported for
the ASA 5580 and the ASA 5585-X; all units in a cluster must be the same model with the same
hardware specifications. See the configuration guide for a list of unsupported features when
clustering is enabled.

We introduced or modified the following screens:

Home > Device Dashboard

Home > Cluster Dashboard

Home > Cluster Firewall Dashboard

Configuration > Device Management > Advanced > Address Pools > MAC Address Pools
Configuration > Device Management > High Availability and Scalability > ASA Cluster
Configuration > Device Management > Logging > Syslog Setup > Advanced
Configuration > Device Setup > Interface Settings > Interfaces > Add/Edit Interface >
Advanced

Configuration > Device Setup > Interface Settings > Interfaces > Add/Edit Interface > IPv6
Configuration > Device Setup > Interface Settings > Interfaces > Add/Edit EtherChannel
Interface > Advanced

Configuration > Firewall > Advanced > Per-Session NAT Rules

Monitoring > ASA Cluster

Monitoring > Properties > System Resources Graphs > Cluster Control Link

Tools > Preferences > General

Tools > System Reload

Tools > Upgrade Software from Local Computer

Wizards > High Availability and Scalability Wizard

Wizards > Packet Capture Wizard

Wizards > Startup Wizard
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CHAPTER 1 2

ASA Cluster for the Firepower 4100/9300 Chassis

Clustering lets you group multiple Firepower 4100/9300 chassis ASAs together as a single logical device.
The Firepower 4100/9300 chassis series includes the Firepower 9300 and Firepower 4100 series. A cluster
provides all the convenience of a single device (management, integration into a network) while achieving the
increased throughput and redundancy of multiple devices.

Note Some features are not supported when using clustering. See Unsupported Features with Clustering, on page
445.

* About Clustering on the Firepower 4100/9300 Chassis, on page 407

* Requirements and Prerequisites for Clustering on the Firepower 4100/9300 Chassis, on page 414
* Licenses for Clustering on the Firepower 4100/9300 Chassis, on page 415

* Clustering Guidelines and Limitations, on page 416

* Configure Clustering on the Firepower 4100/9300 Chassis, on page 421

* FXOS: Remove a Cluster Unit, on page 438

* ASA: Manage Cluster Members, on page 439

* ASA: Monitoring the ASA Cluster on the Firepower 4100/9300 chassis, on page 444

* Reference for Clustering, on page 445

* History for ASA Clustering on the Firepower 4100/9300, on page 458

About Clustering on the Firepower 4100/9300 Chassis

The cluster consists of multiple devices acting as a single logical unit. When you deploy a cluster on the
Firepower 4100/9300 chassis, it does the following:

* Creates a cluster-control link (by default, port-channel 48) for unit-to-unit communication.

For intra-chassis clustering (Firepower 9300 only), this link utilizes the Firepower 9300 backplane for
cluster communications.

For inter-chassis clustering, you need to manually assign physical interface(s) to this EtherChannel for
communications between chassis.

* Creates the cluster bootstrap configuration within the application.

When you deploy the cluster, the chassis supervisor pushes a minimal bootstrap configuration to each
unit that includes the cluster name, cluster control link interface, and other cluster settings. Some parts
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. Bootstrap Configuration

of the bootstrap configuration may be user-configurable within the application if you want to customize
your clustering environment.

* Assigns data interfaces to the cluster as Spanned interfaces.

For intra-chassis clustering, spanned interfaces are not limited to EtherChannels, like it is for inter-chassis
clustering. The Firepower 9300 supervisor uses EtherChannel technology internally to load-balance traffic
to multiple modules on a shared interface, so any data interface type works for Spanned mode. For
inter-chassis clustering, you must use Spanned EtherChannels for all data interfaces.

N

Note Individual interfaces are not supported, with the exception of a management
interface.

* Assigns a management interface to all units in the cluster.

The following sections provide more detail about clustering concepts and implementation. See also Reference
for Clustering, on page 445.

Bootstrap Configuration

When you deploy the cluster, the Firepower 4100/9300 chassis supervisor pushes a minimal bootstrap
configuration to each unit that includes the cluster name, cluster control link interface, and other cluster
settings. Some parts of the bootstrap configuration are user-configurable if you want to customize your
clustering environment.

Cluster Members

Cluster members work together to accomplish the sharing of the security policy and traffic flows.

One member of the cluster is the control unit. The control unit is determined automatically. All other members
are data units.

You must perform all configuration on the control unit only; the configuration is then replicated to the data
units.

Some features do not scale in a cluster, and the control unit handles all traffic for those features. See Centralized
Features for Clustering, on page 446.

Master and Slave Unit Roles

One member of the cluster is the master unit. The master unit is determined automatically. All other members
are slave units.

You must perform all configuration on the master unit only; the configuration is then replicated to the slave
units.

Some features do not scale in a cluster, and the master unit handles all traffic for those features. See Centralized
Features for Clustering, on page 446.
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Cluster Control Link .

Cluster Control Link

The cluster-control link is an EtherChannel (port-channel 48) for unit-to-unit communication. For intra-chassis
clustering, this link utilizes the Firepower 9300 backplane for cluster communications. For inter-chassis
clustering, you need to manually assign physical interface(s) to this EtherChannel on the Firepower 4100/9300
chassis for communications between chassis.

For a 2-chassis inter-chassis cluster, do not directly-connect the cluster control link from one chassis to the
other chassis. If you directly connect the interfaces, then when one unit fails, the cluster control link fails, and
thus the remaining healthy unit fails. If you connect the cluster control link through a switch, then the cluster
control link remains up for the healthy unit.

Cluster control link traffic includes both control and data traffic.
Control traffic includes:

* Control unit election.

* Configuration replication.

* Health monitoring.

Data traffic includes:
» State replication.

* Connection ownership queries and data packet forwarding.

Size the Cluster Control Link

\}

If possible, you should size the cluster control link to match the expected throughput of each chassis so the
cluster-control link can handle the worst-case scenarios. For example, if you have the ASA 5585-X with
SSP-60, which can pass 14 Gbps per unit maximum in a cluster, then you should also assign interfaces to the
cluster control link that can pass at least 14 Gbps. In this case, you could use 2 Ten Gigabit Ethernet interfaces
in an EtherChannel for the cluster control link, and use the rest of the interfaces as desired for data links.

Cluster control link traffic is comprised mainly of state update and forwarded packets. The amount of traffic
at any given time on the cluster control link varies. The amount of forwarded traffic depends on the
load-balancing efficacy or whether there is a lot of traffic for centralized features. For example:

* NAT results in poor load balancing of connections, and the need to rebalance all returning traffic to the
correct units.

» AAA for network access is a centralized feature, so all traffic is forwarded to the control unit.

» When membership changes, the cluster needs to rebalance a large number of connections, thus temporarily
using a large amount of cluster control link bandwidth.

A higher-bandwidth cluster control link helps the cluster to converge faster when there are membership changes
and prevents throughput bottlenecks.

Note

If your cluster has large amounts of asymmetric (rebalanced) traffic, then you should increase the cluster
control link size.
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Cluster Control Link Redundancy

We recommend using an EtherChannel for the cluster control link, so that you can pass traffic on multiple
links in the EtherChannel while still achieving redundancy.

The following diagram shows how to use an EtherChannel as a cluster control link in a Virtual Switching
System (VSS) or Virtual Port Channel (vPC) environment. All links in the EtherChannel are active. When
the switch is part of a VSS or vPC, then you can connect ASA interfaces within the same EtherChannel to
separate switches in the VSS or vPC. The switch interfaces are members of the same EtherChannel port-channel
interface, because the separate switches act like a single switch. Note that this EtherChannel is device-local,
not a Spanned EtherChannel.

Virtual Switch Link
Switch Switch

33222

Cluster Control Link Reliability

To ensure cluster control link functionality, be sure the round-trip time (RTT) between units is less than 20
ms. This maximum latency enhances compatibility with cluster members installed at different geographical
sites. To check your latency, perform a ping on the cluster control link between units.

The cluster control link must be reliable, with no out-of-order or dropped packets; for example, for inter-site
deployment, you should use a dedicated link.

Cluster Control Link Network

The Firepower 4100/9300 chassis auto-generates the cluster control link interface IP address for each unit
based on the chassis ID and slot ID: 127.2.chassis id.dlot_id. You cannot set this IP address manually, either
in FXOS or within the application. The cluster control link network cannot include any routers between units;
only Layer 2 switching is allowed. For inter-site traffic, Cisco recommends using Overlay Transport
Virtualization (OTV).
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Cluster Interfaces

For intra-chassis clustering, you can assign both physical interfaces or EtherChannels (also known as port
channels) to the cluster. Interfaces assigned to the cluster are Spanned interfaces that load-balance traffic
across all members of the cluster.

For inter-chassis clustering, you can only assign data EtherChannels to the cluster. These Spanned
EtherChannels include the same member interfaces on each chassis; on the upstream switch, all of these
interfaces are included in a single EtherChannel, so the switch does not know that it is connected to multiple
devices.

Individual interfaces are not supported, with the exception of a management interface.

Connecting to a VSS or vPC

We recommend connecting EtherChannels to a VSS or vPC to provide redundancy for your interfaces.

Configuration Replication

All units in the cluster share a single configuration. You can only make configuration changes on the control
unit, and changes are automatically synced to all other units in the cluster.

ASA Cluster Management

One of the benefits of using ASA clustering is the ease of management. This section describes how to manage
the cluster.

Management Network

We recommend connecting all units to a single management network. This network is separate from the cluster
control link.

Management Interface

You must assign a Management type interface to the cluster. This interface is a special individual interface
as opposed to a Spanned interface. The management interface lets you connect directly to each unit.

The Main cluster IP address is a fixed address for the cluster that always belongs to the current control unit.
You also configure a range of addresses so that each unit, including the current control unit, can use a Local
address from the range. The Main cluster IP address provides consistent management access to an address;
when a control unit changes, the Main cluster IP address moves to the new control unit, so management of
the cluster continues seamlessly.

For example, you can manage the cluster by connecting to the Main cluster IP address, which is always
attached to the current control unit. To manage an individual member, you can connect to the Local IP address.

For outbound management traffic such as TFTP or syslog, each unit, including the control unit, uses the Local
IP address to connect to the server.
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Control Unit Management Vs. Data Unit Management

All management and monitoring can take place on the control unit. From the control unit, you can check
runtime statistics, resource usage, or other monitoring information of all units. You can also issue a command
to all units in the cluster, and replicate the console messages from data units to the control unit.

You can monitor data units directly if desired. Although also available from the control unit, you can perform
file management on data units (including backing up the configuration and updating images). The following
functions are not available from the control unit:

* Monitoring per-unit cluster-specific statistics.

* Syslog monitoring per unit (except for syslogs sent to the console when console replication is enabled).
* SNMP

* NetFlow

RSA Key Replication

When you create an RSA key on the control unit, the key is replicated to all data units. If you have an SSH
session to the Main cluster IP address, you will be disconnected if the control unit fails. The new control unit
uses the same key for SSH connections, so that you do not need to update the cached SSH host key when you
reconnect to the new control unit.

ASDM Connection Certificate IP Address Mismatch

By default, a self-signed certificate is used for the ASDM connection based on the Local IP address. If you
connect to the Main cluster IP address using ASDM, then a warning message about a mismatched IP address
might appear because the certificate uses the Local IP address, and not the Main cluster IP address. You can
ignore the message and establish the ASDM connection. However, to avoid this type of warning, you can
enroll a certificate that contains the Main cluster IP address and all the Local IP addresses from the IP address
pool. You can then use this certificate for each cluster member. See https://www.cisco.com/c/en/us/td/docs/
security/asdm/identity-cert/cert-install.html for more information.

Spanned EtherChannels (Recommended)

You can group one or more interfaces per chassis into an EtherChannel that spans all chassis in the cluster.
The EtherChannel aggregates the traffic across all the available active interfaces in the channel. A Spanned
EtherChannel can be configured in both routed and transparent firewall modes. In routed mode, the
EtherChannel is configured as a routed interface with a single IP address. In transparent mode, the IP address
is assigned to the BVI, not to the bridge group member interface. The EtherChannel inherently provides load
balancing as part of basic operation.
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For inter-site installations, you can take advantage of ASA clustering as long as you follow the recommended

guidelines.

You can configure each cluster chassis to belong to a separate site ID.

Site IDs work with site-specific MAC addresses and IP addresses. Packets egressing the cluster use a
site-specific MAC address and IP address, while packets received by the cluster use a global MAC address
and IP address. This feature prevents the switches from learning the same global MAC address from both
sites on two different ports, which causes MAC flapping; instead, they only learn the site MAC address.
Site-specific MAC addresses and IP address are supported for routed mode using Spanned EtherChannels

only.

Site IDs are also used to enable flow mobility using LISP inspection, director localization to improve
performance and reduce round-trip time latency for inter-site clustering for data centers.

See the following sections for more information about inter-site clustering:

* Sizing the Data Center Interconnect—Requirements and Prerequisites for Clustering on the Firepower
4100/9300 Chassis, on page 414

* Inter-Site Guidelines—Clustering Guidelines and Limitations, on page 416

* Configure Cluster Flow Mobility—Configure Cluster Flow Mobility, on page 435

* Enable Director Localization—Configure Basic ASA Cluster Parameters, on page 432
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Requirements and Prerequisites for Clustering onthe Firepower
4100/9300 Chassis

Maximum Clustering Units Per Model

* Firepower 4100—16 chassis

* Firepower 9300—16 modules. For example, you can use 1 module in 16 chassis, or 2 modules in 8
chassis, or any combination that provides a maximum of 16 modules.

Hardware and Software Requirements for Inter-Chassis Clustering
All chassis in a cluster:

* For the Firepower 4100 series: All chassis must be the same model. For the Firepower 9300: All security
modules must be the same type. For example, if you use clustering, all modules in the Firepower 9300
must be SM-40s. You can have different quantities of installed security modules in each chassis, although
all modules present in the chassis must belong to the cluster including any empty slots.

Must run the identical FXOS software except at the time of an image upgrade.

Must include the same interface configuration for interfaces you assign to the cluster, such as the same
Management interface, EtherChannels, active interfaces, speed and duplex, and so on. You can use
different network module types on the chassis as long as the capacity matches for the same interface IDs
and interfaces can successfully bundle in the same spanned EtherChannel. Note that all data interfaces
must be EtherChannels in inter-chassis clustering. If you change the interfaces in FXOS after you enable
clustering (by adding or removing interface modules, or configuring EtherChannels, for example), then
perform the same changes on each chassis, starting with the data units, and ending with the control unit.
Note that if you remove an interface in FXOS, the ASA configuration retains the related commands so
that you can make any necessary adjustments; removing an interface from the configuration can have
wide effects. You can manually remove the old interface configuration.

Must use the same NTP server. Do not set the time manually.

ASA: Each FXOS chassis must be registered with the License Authority or satellite server. There is no
extra cost for data units. For permanent license reservation, you must purchase separate licenses for each
chassis. For Firepower Threat Defense, all licensing is handled by the Firepower Management Center.

Switch Requirements

* Be sure to complete the switch configuration and successfully connect all the EtherChannels from the
chassis to the switch(es) before you configure clustering on the Firepower 4100/9300 chassis.

* For supported switch characteristics, see Cisco FXOS Compatibility.

Sizing the Data Center Interconnect for Inter-Site Clustering

You should reserve bandwidth on the data center interconnect (DCI) for cluster control link traffic equivalent
to the following calculation:
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# of cluster members per site

2

X cluster control link size per member

If the number of members differs at each site, use the larger number for your calculation. The minimum
bandwidth for the DCI should not be less than the size of the cluster control link for one member.

For example:
* For 4 members at 2 sites:
* 4 cluster members total
* 2 members at each site

* 5 Gbps cluster control link per member

Reserved DCI bandwidth = 5 Gbps (2/2 x 5 Gbps).
» For 6 members at 3 sites, the size increases:
* 6 cluster members total
* 3 members at site 1, 2 members at site 2, and 1 member at site 3

* 10 Gbps cluster control link per member

Reserved DCI bandwidth = 15 Gbps (3/2 x 10 Gbps).

» For 2 members at 2 sites:

« 2 cluster members total
* 1 member at each site

* 10 Gbps cluster control link per member

Reserved DCI bandwidth = 10 Gbps (1/2 x 10 Gbps = 5 Gbps; but the minimum bandwidth should not
be less than the size of the cluster control link (10 Gbps)).

Licenses for Clustering on the Firepower 4100/9300 Chassis

The clustering feature itself does not require any licenses. To use Strong Encryption and other optional licenses,
each Firepower 4100/9300 chassis must be registered with the License Authority or satellite server. There is
no extra cost for data units. For permanent license reservation, you must purchase separate licenses for each
chassis.

The Strong Encryption license is automatically enabled for qualified customers when you apply the registration
token. When using the token, each chassis must have the same encryption license. For the optional Strong
Encryption (3DES/AES) feature license enabled in the ASA configuration, see below.

In the ASA license configuration, you can only configure smart licensing on the control unit. The configuration
is replicated to the data units, but for some licenses, they do not use the configuration; it remains in a cached
state, and only the control unit requests the license. The licenses are aggregated into a single cluster license
that is shared by the cluster units, and this aggregated license is also cached on the data units to be used if one
of them becomes the control unit in the future. Each license type is managed as follows:
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Clustering

* Standard—Only the control unit requests the Standard license from the server. Because the data units
have the Standard license enabled by default, they do not need to register with the server to use it.

* Context—Only the control unit requests the Context license from the server. The Standard license includes
10 contexts by default and is present on all cluster members. The value from each unit’s Standard license
plus the value of the Context license on the control unit are combined up to the platform limit in an
aggregated cluster license. For example:

* You have 6 Firepower 9300 modules in the cluster. The Standard license includes 10 contexts; for
6 units, these licenses add up to 60 contexts. You configure an additional 20-Context license on the
control unit. Therefore, the aggregated cluster license includes 80 contexts. Because the platform
limit for one module is 250, the combined license allows a maximum of 250 contexts; the 80 contexts
are within the limit. Therefore, you can configure up to 80 contexts on the control unit; each data
unit will also have 80 contexts through configuration replication.

* You have 3 Firepower 4110 units in the cluster. The Standard license includes 10 contexts; for 3
units, these licenses add up to 30 contexts. You configure an additional 250-Context license on the
control unit. Therefore, the aggregated cluster license includes 280 contexts. Because the platform
limit for one unit is 250, the combined license allows a maximum of 250 contexts; the 280 contexts
are over the limit. Therefore, you can only configure up to 250 contexts on the control unit; each
data unit will also have 250 contexts through configuration replication. In this case, you should only
configure the control unit Context license to be 220 contexts.

* Carrier—Required for Distributed S2S VPN. This license is a per-unit entitlement, and each unit requests
its own license from the server. This license configuration is replicated to the data units.

* Strong Encryption (3DES) (for pre-2.3.0 Cisco Smart Software Manager satellite deployment, or for
tracking purposes)—This license is a per-unit entitlement, and each unit requests its own license from
the server.

If a new control unit is elected, the new control unit continues to use the aggregated license. It also uses the
cached license configuration to re-request the control unit license. When the old control unit rejoins the cluster
as a data unit, it releases the control unit license entitlement. Before the data unit releases the license, the
control unit's license might be in a non-compliant state if there are no available licenses in the account. The
retained license is valid for 30 days, but if it is still non-compliant after the grace period, you will not be able
to make configuration changes to features requiring special licenses; operation is otherwise unaffected. The
new active unit sends an entitlement authorization renewal request every 12 hours until the license is compliant.
You should refrain from making configuration changes until the license requests are completely processed.
If a unit leaves the cluster, the cached control configuration is removed, while the per-unit entitlements are
retained. In particular, you would need to re-request the Context license on non-cluster units.

Guidelines and Limitations

Switches for Inter-Chassis Clustering

» Make sure connected switches match the MTU for both cluster data interfaces and the cluster control
link interface. You should configure the cluster control link interface MTU to be at least 100 bytes higher
than the data interface MTU, so make sure to configure the cluster control link connecting switch
appropriately. Because the cluster control link traffic includes data packet forwarding, the cluster control
link needs to accommodate the entire size of a data packet plus cluster traffic overhead.
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For Cisco I0S XR systems, if you want to set a non-default MTU, set the 10S interface MTU to be 14
bytes higher than the cluster device MTU. Otherwise, OSPF adjacency peering attempts may fail unless
the mtu-ignore option is used. Note that the cluster device MTU should match the I0S |Pv4 MTU. This
adjustment is not required for Cisco Catalyst and Cisco Nexus switches.

On the switch(es) for the cluster control link interfaces, you can optionally enable Spanning Tree PortFast
on the switch ports connected to the cluster unit to speed up the join process for new units.

On the switch, we recommend that you use one of the following EtherChannel load-balancing algorithms:
source-dest-ip or source-dest-ip-port (see the Cisco Nexus OS and Cisco IOS port-channel load-balance
command). Do not use a vlan keyword in the load-balance algorithm because it can cause unevenly
distributed traffic to the devices in a cluster. Do not change the load-balancing algorithm from the default
on the cluster device.

If you change the load-balancing algorithm of the EtherChannel on the switch, the EtherChannel interface
on the switch temporarily stops forwarding traffic, and the Spanning Tree Protocol restarts. There will
be a delay before traffic starts flowing again.

Some switches do not support dynamic port priority with LACP (active and standby links). You can
disable dynamic port priority to provide better compatibility with Spanned EtherChannels.

Switches on the cluster control link path should not verify the L4 checksum. Redirected traffic over the
cluster control link does not have a correct L4 checksum. Switches that verify the L4 checksum could
cause traffic to be dropped.

Port-channel bundling downtime should not exceed the configured keepalive interval.

On Supervisor 2T EtherChannels, the default hash distribution algorithm is adaptive. To avoid asymmetric
traffic in a VSS design, change the hash algorithm on the port-channel connected to the cluster device
to fixed:

router(config)# port-channel id hash-distribution fixed

Do not change the algorithm globally; you may want to take advantage of the adaptive algorithm for the
VSS peer link.

Unlike ASA hardware clusters, Firepower 4100/9300 clusters support LACP graceful convergence. So
for the Firepower platform, you can leave LACP graceful convergence enabled on connected Cisco
Nexus switches.

When you see slow bundling of a Spanned EtherChannel on the switch, you can enable LACP rate fast
for an individual interface on the switch. FXOS EtherChannels have the LACP rate set to fast by default.
Note that some switches, such as the Nexus series, do not support LACP rate fast when performing
in-service software upgrades (ISSUs), so we do not recommend using ISSUs with clustering.

EtherChannels for Inter-Chassis Clustering

For connecting switches, set the EtherChannel mode to Active; On mode is not supported on the Firepower
4100/9300 chassis, even for the cluster control link.

In Catalyst 3750-X Cisco 10S software versions earlier than 15.1(1)S2, the cluster unit did not support
connecting an EtherChannel to a switch stack. With default switch settings, if the cluster unit EtherChannel
is connected cross stack, and if the control unit switch is powered down, then the EtherChannel connected
to the remaining switch will not come up. To improve compatibility, set the stack-mac persistent timer
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command to a large enough value to account for reload time; for example, 8 minutes or 0 for indefinite.
Or, you can upgrade to more a more stable switch software version, such as 15.1(1)S2.

* Spanned vs. Device-Local EtherChannel Configuration—Be sure to configure the switch appropriately
for Spanned EtherChannels vs. Device-local EtherChannels.

+ Spanned EtherChannels—For cluster unit Spanned EtherChannels, which span across all members
of the cluster, the interfaces are combined into a single EtherChannel on the switch. Make sure each
interface is in the same channel group on the switch.

Switch Switch
-—= RIGHT WRONG
VLAN 101 | | Spanned Data Ifc g 1 N 101 | Spanned Data Ifc p
port-ch1 port-ch1 p%i-ch1 | | port-ch1

N [\ tenoss

port-ch2
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port-ch3
ten0/6 ten a
|
ASA4 Y it-cha A

v U en @

* Device-local EtherChannels—For cluster unit Device-local EtherChannels including any
EtherChannels configured for the cluster control link, be sure to configure discrete EtherChannels

on the switch; do not combine multiple cluster unit EtherChannels into one EtherChannel on the
switch.

. ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8

334621



| High Availability and Scalability

Clustering Guidelines and Limitations .

Switch

Switch
RIGHT

VLAN 101| | Cluster Control Link

Cluster Control Link

port-ch1 port-ch1 ASA1 port-ch1

k" /M ten0/6 F ten0/6
[ ) | ] tenor7

N Ny

port-ch3 port-ch1
/\ ten0/6
{ ] | ] ten0s7

port-ch1

M\ /\ ten0/6 /\ ten0/6
[ ] [ ] tenor7 [ ) tenos7
N N\

Inter-Site Clustering
See the following guidelines for inter-site clustering:

* The cluster control link latency must be less than 20 ms round-trip time (RTT).

* The cluster control link must be reliable, with no out-of-order or dropped packets; for example, you
should use a dedicated link.

* Do not configure connection rebalancing; you do not want connections rebalanced to cluster members
at a different site.

» The ASA does not encrypt forwarded data traffic on the cluster control link because it is a dedicated link,
even when used on a Data Center Interconnect (DCI). If you use Overlay Transport Virtualization (OTV),
or are otherwise extending the cluster control link outside of the local administrative domain, you can
configure encryption on your border routers such as 802.1AE MacSec over OTV.

* The cluster implementation does not differentiate between members at multiple sites for incoming
connections; therefore, connection roles for a given connection may span across sites. This is expected
behavior. However, if you enable director localization, the local director role is always chosen from the
same site as the connection owner (according to site ID). Also, the local director chooses a new owner
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at the same site if the original owner fails (Note: if the traffic is asymmetric across sites, and there is
continuous traffic from the remote site after the original owner fails, then a unit from the remote site
might become the new owner if it receives a data packet within the re-hosting window.).

For director localization, the following traffic types do not support localization: NAT or PAT traffic;
SCTP-inspected traffic; Fragmentation owner query.

For transparent mode, if the cluster is placed between a pair of inside and outside routers (AKA
North-South insertion), you must ensure that both inside routers share a MAC address, and also that both
outside routers share a MAC address. When a cluster member at site 1 forwards a connection to a member
at site 2, the destination MAC address is preserved. The packet will only reach the router at site 2 if the
MAC address is the same as the router at site 1.

For transparent mode, if the cluster is placed between data networks and the gateway router at each site
for firewalling between internal networks (AKA East-West insertion), then each gateway router should
use a First Hop Redundancy Protocol (FHRP) such as HSRP to provide identical virtual IP and MAC
address destinations at each site. The data VLANSs are extended across the sites using Overlay Transport
Virtualization (OTV), or something similar. You need to create filters to prevent traffic that is destined
to the local gateway router from being sent over the DCI to the other site. If the gateway router becomes
unreachable at one site, you need to remove any filters so traffic can successfully reach the other site’s
gateway.

For transparent mode, if the cluster is connected to an HSRP router, you must add the router HSRP MAC
address as a static MAC address table entry on the ASA (see Add a Static MAC Address for Bridge
Groups, on page 633). When adjacent routers use HSRP, traffic destined to the HSRP IP address will be
sent to the HSRP MAC Address, but return traffic will be sourced from the MAC address of a particular
router's interface in the HSRP pair. Therefore, the ASA MAC address table is typically only updated
when the ASA ARP table entry for the HSRP IP address expires, and the ASA sends an ARP request
and receives a reply. Because the ASA’s ARP table entries expire after 14400 seconds by default, but
the MAC address table entry expires after 300 seconds by default, a static MAC address entry is required
to avoid MAC address table expiration traffic drops.

For routed mode using Spanned EtherChannel, configure site-specific MAC addresses. Extend the data
VLANS across the sites using OTV, or something similar. You need to create filters to prevent traffic
that is destined to the global MAC address from being sent over the DCI to the other site. If the cluster
becomes unreachable at one site, you need to remove any filters so traffic can successfully reach the
other site’s cluster units. Dynamic routing is not supported when an inter-site cluster acts as the first hop
router for an extended segment.

Additional Guidelines

When significant topology changes occur (such as adding or removing an EtherChannel interface, enabling
or disabling an interface on the Firepower 4100/9300 chassis or the switch, adding an additional switch
to form a VSS or vPC) you should disable the health check feature, and also disable interface monitoring
for the disabled interfaces . When the topology change is complete, and the configuration change is
synced to all units, you can re-enable the health check feature.

When adding a unit to an existing cluster, or when reloading a unit, there will be a temporary, limited
packet/connection drop; this is expected behavior. In some cases, the dropped packets can hang
connections; for example, dropping a FIN/ACK packet for an FTP connection will make the FTP client
hang. In this case, you need to reestablish the FTP connection.

If you use a Windows 2003 server connected to a Spanned EtherChannel interface, when the syslog
server port is down, and the server does not throttle ICMP error messages, then large numbers of ICMP
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messages are sent back to the cluster. These messages can result in some units of the cluster experiencing
high CPU, which can affect performance. We recommend that you throttle ICMP error messages.

* We recommend connecting EtherChannels to a VSS or vPC for redundancy.

» Within a chassis, you cannot cluster some security modules and run other security modules in standalone
mode; you must include all security modules in the cluster.

Defaults

* The cluster health check feature is enabled by default with the holdtime of 3 seconds. Interface health
monitoring is enabled on all interfaces by default.

+ Connection rebalancing is disabled by default. If you enable connection rebalancing, the default time
between load information exchanges is 5 seconds.

* The cluster auto-rejoin feature for a failed cluster control link is set to unlimited attempts every 5 minutes.

* The cluster auto-rejoin feature for a failed data interface is set to 3 attempts every 5 minutes, with the
increasing interval set to 2.

+ Connection replication delay of 5 seconds is enabled by default for HTTP traffic.

Configure Clustering on the Firepower 4100/9300 Chassis

You can easily deploy the cluster from the Firepower 4100/9300 chassis supervisor. All initial configuration
is automatically generated for each unit. This section describes the default bootstrap configuration and optional
customization you can perform on the ASA. This section also describes how to manage cluster members from
within the ASA. You can also manage cluster membership from the Firepower 4100/9300 chassis. See the
Firepower 4100/9300 chassis documentation for more information.

Procedure

Step 1 FXOS: Add an ASA Cluster, on page 421

Step 2 ASA: Change the Firewall Mode and Context Mode, on page 429
Step 3 ASA: Configure Data Interfaces, on page 430

Step 4 ASA: Customize the Cluster Configuration, on page 432

Step 5 ASA: Manage Cluster Members, on page 439

FXO0S: Add an ASA Cluster

You can add a single Firepower 9300 chassis as an intra-chassis cluster, or add multiple chassis for inter-chassis
clustering. For inter-chassis clustering, you must configure each chassis separately. Add the cluster on one
chassis; you can then copy the bootstrap configuration from the first chassis to the next chassis for ease of
deployment
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Set the scope to the image version.

You can easily deploy the cluster from the Firepower 4100/9300 chassis supervisor. All initial configuration
is automatically generated for each unit.

For inter-chassis clustering, you must configure each chassis separately. Deploy the cluster on one chassis;
you can then copy the bootstrap configuration from the first chassis to the next chassis for ease of deployment.

In a Firepower 9300 chassis, you must enable clustering for all 3 module slots, even if you do not have a
module installed. If you do not configure all 3 modules, the cluster will not come up.

For multiple context mode, you must first deploy the logical device, and then enable multiple context mode
in the ASA application.

To change the ASA to transparent firewall mode, complete the initial deployment, and then change the firewall
mode within the ASA CLI.

When you deploy a cluster, the Firepower 4100/9300 chassis supervisor configures each ASA application
with the following bootstrap configuration. You can later modify parts of the bootstrap configuration from
the ASA, if desired (shown in Bold text).

interface Port-channel48
description Clustering Interface
cluster group <service type name>
key <secret>
local-unit unit-<chassis#-module#>
site-id <number>
cluster-interface port-channel48 ip 127.2.<chassis#>.<module#> 255.255.255.0
priority <auto>
health-check holdtime 3
health-check data-interface auto-rejoin 3 5 2
health-check cluster-interface auto-rejoin unlimited 5 1
enable

ip local pool cluster ipv4_pool <ip address>-<ip_ address> mask <mask>

interface <management ifc>
management-only individual
nameif management
security-level 0
ip address <ip address> <mask> cluster-pool cluster_ ipv4_pool
no shutdown

http server enable
http 0.0.0.0 0.0.0.0 management
route management <management host ip> <mask> <gateway ip> 1

Note

The local-unit name can only be changed if you disable clustering.

Before you begin

» Download the application image you want to use for the logical device from Cisco.com, and then upload
that image to the Firepower 4100/9300 chassis.

* Gather the following information:
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Step 1

Step 2
Step 3

Create an ASA Cluster .

* Management interface ID, IP address, and network mask

» Gateway IP address

Procedure

Configure interfaces.

a)

b)

Add at least one Data type interface or EtherChannel (also known as a port-channel) before you deploy
the cluster. See Add an EtherChannel (Port Channel), on page 194 or Configure a Physical Interface, on
page 193.

For inter-chassis clustering, all data interfaces must be Spanned EtherChannels with at least one member
interface. Add the same EtherChannels on each chassis. Combine the member interfaces from all cluster
units into a single EtherChannel on the switch. See Clustering Guidelines and Limitations, on page 416
for more information about EtherChannels for inter-chassis clustering.

Add a Management type interface or EtherChannel. See Add an EtherChannel (Port Channel), on page
194 or Configure a Physical Interface, on page 193.

The management interface is required. Note that this management interface is not the same as the chassis
management interface that is used only for chassis management (in FXOS, you might see the chassis
management interface displayed as MGMT, management0, or other similar names).

For inter-chassis clustering, add the same Management interface on each chassis.

For inter-chassis clustering, add a member interface to the cluster control link EtherChannel (by default,
port-channel 48). See Add an EtherChannel (Port Channel), on page 194.

Do not add a member interface for intra-chassis clustering. If you add a member, the chassis assumes this
cluster will be inter-chassis, and will only allow you to use Spanned EtherChannels, for example.

On the Interfaces tab, the port-channel 48 cluster type interface shows the Operation State as failed if
it does not include any member interfaces. For intra-chassis clustering, this EtherChannel does not require
any member interfaces, and you can ignore this Operational State.

Add the same member interfaces on each chassis. The cluster control link is a device-local EtherChannel
on each chassis. Use separate EtherChannels on the switch per device. See Clustering Guidelines and
Limitations, on page 416 for more information about EtherChannels for inter-chassis clustering.

Choose Logical Devices.

Click Add Device, and set the following parameters:
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Add Device 2%
Device Name: asa_cluster
Template: Cisco: Adaptive Security Appliance 4
Image Version: 9.12.1 v
Instance Type: Native ki
Usage: Standalone (€ Cluster
Do you want ta: O Create New Cluster Join Existing Cluster
QK Cancel

a) Provide a Device Name.

This name is used internally by the chassis supervisor to configure management settings and to assign
interfaces; it is not the device name used in the application configuration.

b) For the Template, choose Cisco Adaptive Security Appliance.
¢) Choose the Image Version.

d) For the Instance Type, only the Native type is supported.

e) For the Usage, click the Cluster radio button.

f) Click the Create New Cluster radio button.

g) Click OK.

You see the Provisioning - device name window.
Step 4 Choose the interfaces you want to assign to this cluster.
All valid interfaces are assigned by default.

Step 5 Click the device icon in the center of the screen.

A dialog box appears where you can configure initial bootstrap settings. These settings are meant for initial
deployment only, or for disaster recovery. For normal operation, you can later change most values in the
application CLI configuration.

Step 6 On the Cluster Information page, complete the following.
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Cisco: Adaptive Security Appliance - Bootstrap |7/
Configuration

Cluster Information Settings

Security Module

Security Module-1,Security Module-2,Security Module-3

Interface Information

Chassis 1D: 1
Site ID: 1
Cluster Key: aar

Confirm Cluster Key: aar

Cluster Group Name:

asa_cluster
Management Interface: Ethernet1/4 v
CCL Subnet IP: Eg:x.x.0.0
DEFAULT
Address Type: IPv4 anly R
IPvd
Management IP Pool: 10.89.5.10 T 110.89.5.22
Virtual IPv4 Address: 10.89.5.25
Network Mask: 255,255,255.192
Network Gateway: 10.89.5.1

OK Cancel

a) For inter-chassis clustering, in the Chassis ID field, enter a chassis ID. Each chassis in the cluster must
use a unique ID.

This field only appears if you added a member interface to cluster control link Port-Channel 48.

b) For inter-site clustering, in the Site ID field, enter the site ID for this chassis between 1 and 8.
¢) Inthe Cluster Key field, configure an authentication key for control traffic on the cluster control link.

The shared secret is an ASCII string from 1 to 63 characters. The shared secret is used to generate the
key. This option does not affect datapath traffic, including connection state update and forwarded packets,
which are always sent in the clear.

d) Set the Cluster Group Name, which is the cluster group name in the logical device configuration.

The name must be an ASCII string from 1 to 38 characters.

e) Choose the Management Interface.
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This interface is used to manage the logical device. This interface is separate from the chassis management
port.

f) Choose the Address Type for the management interface.

This information is used to configure a management interface in the ASA configuration. Set the following
information:

» Management IP Pool—Configure a pool of Local IP addresses, one of which will be assigned to
each cluster unit for the interface, by entering the starting and ending addresses separated by a hyphen.

Include at least as many addresses as there are units in the cluster. Note that for the Firepower 9300,
you must include 3 addresses per chassis, even if you do not have all module slots filled. If you plan
to expand the cluster, include additional addresses. The Virtual IP address (known as the Main cluster
IP address) that belongs to the current control unit is not a part of this pool; be sure to reserve an IP
address on the same network for the Main cluster IP address. You can use [Pv4 and/or IPv6 addresses.

» Network Mask or Prefix Length
» Network Gateway

* Virtual IP address—Set the management IP address of the current control unit. This IP address
must be on the same network as the cluster pool addresses, but not be part of the pool.

Step 7 On the Settings page, complte the following.
a) Enter and confirm a Password for the admin user.

The pre-configured ASA admin user is useful for password recovery; if you have FXOS access, you can
reset the admin user password if you forget it.

Step 8 Click OK to close the configuration dialog box.
Step 9 Click Save.

The chassis deploys the logical device by downloading the specified software version and pushing the bootstrap
configuration and management interface settings to the application instance. Check the Logical Devices page
for the status of the new logical device. When the logical device shows its Status as online, you can add the
remaining cluster chassis, or for intra-chassis clusteringstart configuring the cluster in the application. You
may see the "Security module not responding" status as part of the process; this status is normal and is
temporary.
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Step 10

Create an ASA Cluster .

System Tools Help

@ Refresh | | () Add Device

B7% (40 of 46) Cores Available

& '** ]

Status

@unline &0 *# Ol

For inter-chassis clustering, add the next chassis to the cluster:
a) On the first chassis Firepower Chassis Manager, click the Show Configuration icon at the top right; copy
the displayed cluster configuration.

b) Connect to the Firepower Chassis Manager on the next chassis, and add a logical device according to this
procedure.

¢) Choose Join an Existing Cluster.

d) Click the Copy config check box, and click OK. If you uncheck this check box, you must manually enter
the settings to match the first chassis configuration.

e) Inthe Copy Cluster Details box, paste in the cluster configuration from the first chassis, and click OK.

f) Click the device icon in the center of the screen. The cluster information is mostly pre-filled, but you must
change the following settings:

* Chassis ID—Enter a unique chassis ID.
« Site ID—Enter the correct site ID.

* Cluster Key—(Not prefilled) Enter the same cluster key.

Click OK.
g) Click Save.

The chassis deploys the logical device by downloading the specified software version and pushing the
bootstrap configuration and management interface settings to the application instance. Check the Logical
Devices page for each cluster member for the status of the new logical device. When the logical device
for each cluster member shows its Status as online, you can start configuring the cluster in the application.
You may see the "Security module not responding" status as part of the process; this status is normal and
is temporary.
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System Tools Help

% Refresh | | () Add Device

87% (40 of 46) Cores Available

il e
Status
@Dnline & -1}# Gl
Step 11 Connect to the control unit ASA to customize your clustering configuration.

Add More Cluster Members

Add or replace an ASA cluster member.

\}

Note This procedure only applies to adding or replacing a chassis; if you are adding or replacing a module to a
Firepower 9300 where clustering is already enabled, the module will be added automatically.

Before you begin

» Make sure your existing cluster has enough IP addresses in the management IP address pool for this new
member. If not, you need to edit the existing cluster bootstrap configuration on each chassis before you
add this new member. This change causes a restart of the logical device.

* The interface configuration must be the same on the new chassis. You can export and import FXOS
chassis configuration to make this process easier.

» For multiple context mode, enable multiple context mode in the ASA application on the first cluster
member; additional cluster members will inherit the multiple context mode configuration automatically.

Procedure

Step 1 On an existing cluster chassis Firepower Chassis Manager, choose Logical Devices to open the Logical
Devices page.

Step 2 Click the Show Configuration icon (' ~ ) at the top right; copy the displayed cluster configuration.
Step 3 Connect to the Firepower Chassis Manager on the new chassis, and click Add Device.

Step 4 For the Device Name, provide a name for the logical device.

Step 5 For the Template, choose Cisco Adaptive Security Appliance.
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Step 6 For the Image Version, choose the ASA software version.

Step 7 For the Device Mode, click the Cluster radio button.

Step 8 Choose Join an Existing Cluster.

Step 9 Click the Copy config check box, and click OK. If you uncheck this check box, you must manually enter the
settings to match the first chassis configuration.

Step 10 In the Copy Cluster Details box, paste in the cluster configuration from the first chassis, and click OK.

Step 11 Click the device icon in the center of the screen. The cluster information is mostly pre-filled, but you must

change the following settings:

* Chassis ID—Enter a unique chassis ID.
« Site ID—Enter the correct site ID.

* Cluster Key—(Not prefilled) Enter the same cluster key.

Click OK.

Step 12 Click Save.

The chassis deploys the logical device by downloading the specified software version and pushing the bootstrap
configuration and management interface settings to the application instance. Check the Logical Devices page
for each cluster member for the status of the new logical device. When the logical device for each cluster
member shows its Status as online, you can start configuring the cluster in the application. You may see the
"Security module not responding" status as part of the process; this status is normal and is temporary.

System Tools Help

@ Refresh | | () Add Device

B7% (40 of 46) Cores Available

Status

@ online &0 *# Ol

ASA: Change the Firewall Mode and Context Mode

By default, the FXOS chassis deploys a cluster in routed or transparent firewall mode, and single context
mode.

* Change the firewall mode— To change the mode after you depoy, change the mode on the control unit;
the mode is automatically changed on all data units to match. See Set the Firewall Mode (Single Mode),
on page 215. In multiple context mode, you set the firewall mode per context. See Configure a Security
Context, on page 258.
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* Change to multiple context mode—To change to multiple context mode after you deploy, change the
mode on the control unit; the mode is automatically changed on all data units to match. See Enable
Multiple Context Mode, on page 253.

ASA: Configure Data Interfaces

This procedure configures basic parameters for each data interface that you assigned to the cluster when you
deployed it in FXOS. For inter-chassis clustering, data interfaces are always Spanned EtherChannel interfaces.

\}

Note The management interface was pre-configured when you deployed the cluster. You can also change the
management interface parameters in ASA, but this procedure focuses on data interfaces. The management
interface is an individual interface, as opposed to a Spanned interface. See Management Interface, on page
411 for more information.

Before you begin

* For multiple context mode, start this procedure in the system execution space. If you are not already in
the System configuration mode in the Configuration > Device List pane, double-click System under the
active device IP address.

* For transparent mode, configure the bridge group. See Configure the Bridge Virtual Interface (BVI), on
page 515.

* When using Spanned EtherChannels for inter-chassis clustering, the port-channel interface will not come
up until clustering is fully enabled. This requirement prevents traffic from being forwarded to a unit that
is not an active unit in the cluster.

Procedure

Step 1 Depending on your context mode:
» For single mode, choose the Configuration > Device Setup > Interface Settings > Interfaces pane.

* For multiple mode in the System execution space, choose the Configuration > Context Management
> Interfaces pane.

Step 2 Select the interface, and click Edit.
The Edit Interface dialog box appears.

Step 3 Set the following:
* (For EtherChannels) MIO Port-channel ID—Enter the same ID used in FXOS.
« Enable Interface (checked by default)

The rest of the fields on this screen are described later in this procedure.

Step 4 To configure the MAC address and optional parameters, click the Advanced tab.

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.8



| High Availability and Scalability

Step 5

Step 6

Step 7
Step 8

Step 9
Step 10
Step 11

Step 12

ASA: Configure Data Interfaces .

* In the MAC Address Cloning area, set a manual global MAC address for the EtherChannel. Do not set
the Standby MAC Address; it is ignored. You must configure a MAC address for a Spanned EtherChannel
to avoid potential network connectivity problems. With a manually-configured MAC address, the MAC
address stays with the current control unit. If you do not configure a MAC address, then if the control
unit changes, the new control unit uses a new MAC address for the interface, which can cause a temporary
network outage.

In multiple context mode, if you share an interface between contexts, you should instead enable
auto-generation of MAC addresses so you do not need to set the MAC address manually. Note that you
must manually configure the MAC address using this command for non-shared interfaces.

» In the ASA Cluster area, for inter-site clustering set Site specific MAC Addresses, and for routed mode,
the IP addresses for a site by clicking Add and specifying a MAC address and IP address for the site ID
(1 through 8). Repeat for up to 8 sites. The site-specific IP addresses must be on the same subnet as the
global IP address. The site-specific MAC address and IP address used by a unit depends on the site ID
you specify in each unit’s bootstrap configuration.

(Optional) Configure VLAN subinterfaces on this EtherChannel. The rest of this procedure applies to the
subinterfaces.

(Multiple context mode) Before you complete this procedure, you need to allocate interfaces to contexts.

a) Click OK to accept your changes.

b) Allocate interfaces.

¢) Change to the context that you want to configure: in the Device List pane, double-click the context name
under the active device IP address.

d) Choose the Configuration > Device Setup > Interface Settings > Interfaces pane, select the port-channel
interface that you want to customize, and click Edit.

The Edit Interface dialog box appears.

Click the General tab.

(Transparent Mode) From the Bridge Group drop-down list, choose the bridge group to which you want to
assign this interface.

In the Interface Name field, enter a name up to 48 characters in length.
In the Security level field, enter a level between 0 (lowest) and 100 (highest).

(Routed Mode) For an IPv4 address, click the Use Static IP radio button and enter the IP address and mask.
DHCP and PPPoE are not supported. For point-to-point connections, you can specify a 31-bit subnet mask
(255.255.255.254). In this case, no IP addresses are reserved for the network or broadcast addresses. For
transparent mode, you configure the IP address for the bridge group interface, not the EtherChannel interface.

(Routed Mode) To configure an IPv6 address, click the IPv6 tab.

For transparent mode, you configure the IP address for the bridge group interface, not the EtherChannel
interface.

a) Check the Enable IPv6 check box.
b) In the Interface IPv6 Addresses area, click Add.

The Add IPv6 Address for Interface dialog box appears.

Note The Enable address autoconfiguration option is not supported.

¢) Inthe Address/Prefix Length field, enter the global IPv6 address and the IPv6 prefix length. For example,
2001:DB8::BA98:0:3210/64.
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d) (Optional) To use the Modified EUI-64 interface ID as the host address, check the EUI-64 check box. In
this case, just enter the prefix in the Address/Prefix Length field.
e) Click OK.
Step 13 Click OK to return to the Interfaces screen.
Step 14 Click Apply.

ASA: Customize the Cluster Configuration

If you want to change bootstrap settings after you deploy the cluster or configure additional options, such as
clustering health monitoring, TCP connection replication delay, flow mobility, and other optimizations, you
can do so on the control unit.

Configure Basic ASA Cluster Parameters

You can customize cluster settings on the control unit.

Before you begin

 For multiple context mode, complete this procedure in the system execution space on the control unit.
If you are not already in the System configuration mode, in the Configuration > Device List pane,
double-click System under the active device IP address.

* The local-unit Member Name and several other options can only be set on the FXOS chassis, or they
can only be changed on the ASA if you disable clustering, so they are not included in the following
procedure.

Procedure

Step 1 Choose Configuration > Device Management > High Availability and Scalability > ASA Cluster.
Step 2 (Optional) Configure the following optional parameters:

+ Enable connection rebalancing for TCP traffic across all the ASAs in the cluster—Enables connection
rebalancing. This parameter is disabled by default. If enabled, ASAs in a cluster exchange load information
periodically, and offload new connections from more loaded devices to less loaded devices. The frequency,
between 1 and 360 seconds, specifies how often the load information is exchanged. This parameter is
not part of the bootstrap configuration, and is replicated from the control unit to the data units.

Enable health monitoring of this device within the cluster—Enables the cluster unit health check
feature, and determines the amount of time between unit heartbeat status messages, between .3 and 45
seconds; The default is 3 seconds. Note: When you are adding new units to the cluster, and making
topology changes on the ASA or the switch, you should disable this feature temporarily until the cluster
is complete, and also disable interface monitoring for the disabled interfaces (Configuration > Device
Management > High Availability and Scalability > ASA Cluster > Cluster Interface Health
Monitoring). You can re-enable this feature after cluster and topology changes are complete. To determine
unit health, the ASA cluster units send heartbeat messages on the cluster control link to other units. If a
unit does not receive any heartbeat messages from a peer unit within the holdtime period, the peer unit
is considered unresponsive or dead.
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Step 3

Step 4

Step 5

Configure Basic ASA Cluster Parameters .

* Debounce Time—Configures the debounce time before the ASA considers an interface to be failed and
the unit is removed from the cluster. This feature allows for faster detection of interface failures. Note
that configuring a lower debounce time increases the chances of false-positives. When an interface status
update occurs, the ASA waits the number of milliseconds specified before marking the interface as failed
and the unit is removed from the cluster. The default debounce time is 500 ms, with a range of 300 ms
to 9 seconds.

Replicate console output—Enables console replication from data units to the control unit. This feature
is disabled by default. The ASA may print out some messages directly to the console for certain critical
events. If you enable console replicat